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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - EISEE O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Oradke Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracle andior fs afflstes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andlor s af filates. Otfer names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your lcense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, modify, liense,
transmit, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice i
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inciuding any operating system, inegrated
software, any programs installed on the hardware, andior documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, & Sign Out[QA]
Change Password

m  UserInfo i3]

— Change Password — Click to change the current password.
L 7 I— TR

-
ek

Ir

s
e
-
-
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions | Users -
Database Server Log Files
View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 D2/18/2016 06: 1% 11 AD »
ALERT lob 395 02/22{2016 03:58:16 AN_|
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSYPRC_EN_100_01_DB12C_3854338 lob 116750 02/22/2016 05:36:42 A} 7
JSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 AP =
4 m ] r
r
File Content
View = Format ~ Freeze I Detach &l Wrap o0} 7 Beginning @ End  # of Lines ' 50 [E] Show File
Text
0 7:44:11: 45:FLL:1v_use BI::¥ [
o 7:44:11: cmnsyp cl_DOD_Dl.get_syp parameter value value: weblagic
0 4:11 .get_syp parameter value value: http://ofss2221142.in.oracle.com:.
0 4:11 .get_syp_parameter_value value: http://ofss2221142.in.oracle.com:
o 4:11 .get_syp parameter value value: /scratch/work area/DEV/QAL43REL/r. |
0. S JSV_BI_USER
o} 4:11 1.get_syp_parameter_value parame J5V_REPORT_ARCHIVE_DIRECTICRY
0 4:11 1.get_syp_parameter value parameter: JSV_REPORTS SERVER TIMECUT A

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

» DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @ | Access x (0 Gose
Applcation Retrieval{Originatior) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild Fpadd || ZEdt | [Fvien || At
, 3
Account Documents(Servicing) Vew~ Fomat~ | B Freeze (o Detach virap ®
Access(Setup User)
P ————— Organization Divion Company Branch Alowsd
‘rsnssc ors(sevieng ntefoces e R AL AL ¥
Applcation Entry(Origination) e e AL AL ¥
Audit Tables(Setup Systerm) e B AL AL \
Advances(Servicng Batch Transactions) e P04 AL AL A

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA + [=}

Sales ead x Close
> DashBoard s L.

/Le;aknl’l’v Follow-p | Maintenance
% Fresze

Applicant Information

= )
e

L-00003002 121772015 uso1 £onD rES rorE
L-o0002002 121212015 uso1 usii PIANINDRA ciioa tore
L-o0002004 12/12/201 uso1 usii DoRCH oocRT 1ot X
Looooco02 02/02/2010 uso1 usiio N 20510 CONSULTATION  OFTLINC APPLICA.. 1IOM ADD1 A
Loooo1001 121072015 uso: usko ANDRES ManTInez o8/06/1980 CONSULTATION  wes ENTRY HowE LeAD ey 22
L aoooson2 122372015 uso: usko A san 11232901 HowE UNITEDSTATES 123 ronce

ke || Reauest

b add || Z oo |[ Elview || o ave
rrrrrr 2 petact @

rrent

Te
CARJMOBILE PHONE

Phone Cur
(0045323923 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
5

o Efioctach

AUL) PAULA 02/09/2010 crarceporr error VeRourru
20160100014000:000 SUmAN G2ioa/200 Clianccoorr CRnon Vemoun
uetach wee | @
Vue e
o350t ¥
\ Y

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE' 1 ABSHEKAR ¥ g Signout O
Financial Services Lending and Leasing

a‘| Origination » || Origination 5 | Crigination x = Origination x (36 Close
Search/Task  Funding: 0000001010 | Review Requests (Pendng: 0) £
> DashBoard
Origination Application: 0000001010: MILLEN JOHN Elvew | o Audt
- - Fresze i Detach 0 virzp v Wam v
pr—— View ~ Format B i P W overide ok jarming CK MANUAL Contract
ot A= Sub Unit Status nanasen SE8E  produce tame mrd‘::fr COMBEL o geting Customer  Dupicate Appication Cantact 3
imple Application Entry
07/25/2036 0000001030 UNDEFINED APPROVED - FUND... FUNDED MN-00004: SOUT.. (612)451-2211 N ¥
Application Entry = & .
Underwriting
Funding
Application Retrieval
S Anys Summary | Appicant | Request | Decision | Contract | Colateral | Comments || Trackng | Document | Verification | Correspondence | Tools
Application Documents
Image Mantenance At
Reports
Producers Applicant
s Pl Relation Type First Name Last Name Brth Dt Own fRented
2| PRIMARY JOHN MILLEN 07/17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IfPmt Amt. Assets Amt Lisbilties (3 Net-Worth Amt
> 0 0.00 0.00 0.00 0.00
Bureau
> Servicing
> Collections Bureau
> WEP Buresu Report Name FICO Score Tradelines Auto Tradelines ¢ P BI® Notices (FE)  Type ot
> Tools [ » [o0 CREDIT REPORT ... JONATHAN JENKINS 536 % % o 0 MANUAL 07/26,
> Setup bl . -
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Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |:to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" # Welcome, VavAIDYA - ESTROWIGN O
Financial Services Lending and Leasing

Close.
> DashBoard Origination x —

origination Search/Tosk | Funding: 0000000378 | Review Requests (Pending: 0)

Application: 0000000378: TIFFANY RUSSEL / GRACE B view || o audt
Vieww Format~ B ] Freeze i Detach wap | @) OvemideOK ¥ WamingOK ¥

— Hentfication
Applcation Coptac ' i
01/01/2012 0000000378 UNDEFINED APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Origination Stage

ot App Sub Unit status e

pre
Producer liame Co Bxisting Customer
t
, Summary
Requested  Approved
1500000 1500000

8.9900 43900
3 3

Summary | Applicant | Request || Decision | Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

> Applicant

‘ » Ratios

> Bureau

> Checklist Change Status

Status APPROVEE

Collateral

Collateral

Asset Type SubType Primary  Year Hake Hodel Hileage New Wholesale Value
~ Servidng VEHICLE AR Y 2012 CHEVROLET. MONTE CARLO on 10,000.00
> Collections Type =
3 Sub v
RAWED Trade-In Type
> Tools * Comment
> Setup Trade-In > -

Add Comment
= Alert

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Customer service EE
seach
Quick Search
Elven || Pasit ek
foen ® @ B ©CurenO shon O GoupFolowss
bt At = ot DayspastDue urency PayOfiAnt  amountue Stais OdestoueDt  DiQesson
oETED 0170100010057 | LOANVEHICLE () o 153855 2,21 (R opoporr steameToR.
Bwat| [ @oex
Servee | AcountDetal | Customer Detals | Customer Prferences | Transacion story | Pt Modes || Benknptcy | Repoffrecoare | Defency | Clatrl | Bureau | Timelne || Crossfp sl Acotes | Extena nterfoces
Q= =
Aerts Condtions
B tiextAccont
Alerts Conditions
At Account Condien ConditonstartDt Folowp 0t
. o e Accant
Nodata o deply Repossession pmy ooz L
oemaET csmy o P —
e RESAA 5]
sy B
Account Details OtherInformation o
Dues Colateral Information
sy ejomy  oomy  oeomy  osiop Py Descon Uertfatm s Year At AmetTipe  SbTie
g =m0 =0 3 9 sz v P6CEROETHONECRLO DR BAPASGORIRIS2 205 N Wz om
s 2
3 Customer Information Hpostgoment | | @0
T = e etien = oD o e oliaiil
7 oo HAOHAN ORACE ProwRy o casiises noened o =
ot ozwn «
=
o1 EDULSRSIQOMAL COM E . =
s Actve [
P Corrspdence N
Colector DEMOCOLL
Address Information =
pemsson
e Coment PSS ey adkess e )
Activities e v v e s &
x Charge offot =
- ity Dty N "
i 2 5 Employment Information

B Postcal ctvity | [ @ Clesr

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘ldentification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to

increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.
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Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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1.4.2

1.5

1.5.1

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pau\ewR!qhe:t‘\Penmng:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt
Vieww Format 5} Freeze PfiDetach | Jwap | @) & @ Curent O showAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eun'n'al‘,‘ Customer Service = Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSeH»‘-L‘t\‘,‘\tie:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Con
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

b

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬂr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
! I | | |cotiateral Sub Tyoe |CreditBureau
Jproduct et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B 12 Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED
LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
LOAN-UN i &1 /01/1800 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT
LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT
s NORMDSER. 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT
o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
opacLe
Financial Services Lending and Leasing g C)

—— Ly customer serce =
> Origination Search | G : quest (Pending: 0) -
Servicing
Setiia Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view || «2 Audt
Cusbootns Senice Vieww Formatw [ Freeze 5 Detach o wrap W & @ curent O ShowAll C: Group Follow-up
Securitization Company Branch Sub Unit Account Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 2012020000231 LEASEVEHICLE 01 000 0.00 ACTIVE o2j10/2015

Post Date Checks
Escrow Transactions =
e Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes || Bankuptcy | Repo/Foreclosure  Deficiency  Collateral | Bureau | Cross/Up Sell Activites
ccount Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence  Letters Document Tracking

Repoits
Producers
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions Views Formatv [ Freeze B Detach Wrap W Frrost [ vod
bk Transaction Status Batch

ADD CUSTOMER ADDRESS PHONE POSTED
TERMINATE ERROR

Interfaces TERMINATE VoID 4
nunbnts EEusION o
Detached Table *
View~| Format v [ Frecze [[EBetadh vap @ ot [5hvoid
Date Monetary Transaction Status Batch
0aj10ja016 N ADD CUSTOMER ADDRESS PHONE POSTED 0
01/07/2016 id TERMINATE ERROR N
oy/05/2016 v TERMIATE von N
01/06/2016 i EXTENSION Vol N
Lot v PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze £ Detach wap @
> Collections Transaction Processing Detils
SWER. (] | Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE" % Welcome, VAVATDYA v o

Financial Services Lending and Leasing
i Customer Service x Wcloe
> Origination Search | G quest (Pending: 0)
Serviding
sarviing Account(s): 20151200010012: MADHU BOBBURI Eview |[ Pt

Customer Service View v Fomaty [ Freeze i Detach Nrap W & ® curent O showAll O Group Follow-up

Securitization Company Branch Sub Unit Account = Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt

skl uso1 usHg 2015120001002 LOANVEHICLE (FR), 5031881 ERUERT] ACTIVE:DELQ:NON PERFO.. (BTN

Transaction Batch Information

Escron Transactions 5
g B Sunmary | Customer Service | Account Detals || Customer Details | Transaction History | Pt Hodes || Bankruptcy | RepojForedos’ ¢ 2= =
Collateral Management Call Activities Maintenance Commen ts || Promises | Checkists | Tracking Attributes || References  Correspondence | Letters [ Jgearch T —
® a1 O any
Transaction Batch Information f o add |/ gat iew || < Audit
View v Formatv [ Freeze ! Detach Wrap (5] EPost  [G1 Void cription
Date Wonetary Transaction ACCOUNT CL r 3
a/10f2016 ¥ pltase Search: Transacti
‘ 01/25/2016 [ ACCOUNT SUB UNIT TRANSFER AiSTET
03/22/2016 », ACH MAINTENANCE esciplion Seany s
oyj072016 [ ACH ONE TIME PHONE PA pl i L
/ i ACHON NE PAY ADIUSTIENT Match @ all © Any
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD by
o 5

Reset | | AddFields ~|| Rearder

Date 02/10/2016
* Monetary @

ok || Cancel
> Collections B | [ Freeze £ petach )
Cil Required
MR o data to dicplay.
> Tools
bisen Result ,

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02 : PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
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1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a

combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt +y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the

keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Operating

monic

Browser Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
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1.7

1.8

1.8.1

1.8.2

1.8.3

Shortcut Action

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
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Usage of styles and formatting elements
Documentation in simple language to ensure easy understanding

Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE
Financial Services Lending and Leasing

Nelcome, PRAKRRAO v o

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

&P Reset Criteriz || @8 Search
View = Fomatv  [E| @Fresze Fivemch | o Wrap &

e ~]
Lixe = =
Lixe ~l
EQU [~
LIKE ~]

Lie vl
EQUAL =
e I~
ke ~
EQuAL ~]
e [~
e ~]
LIKE >l
Lixe ~]
Lixe ~T
Lixe [~ =
) Lixe ~1
e

<

L Open Account

Search Results
View » Fomatv B Frecze A Detsch oo | @
> Collections ‘Company Branch Account F Date Title Product Status. dD:y«:quency Amount Dus

v I
g

> WFP No data ta display.
<

> Tools

> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002
Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL . o .
Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817°)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817°)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

e 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
o 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an
application number greater than or equal to 0000000278.

Criteria Comparison Operator | Value

FIRST NAME EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria Comparison Operator | Value

FIRST NAME LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR

e JAN FISHER

e JANE MEYERS

e JANETTE NORDSTROM
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Application Status

While you are searching for an application in the Origination screens, the Search Result/
Task tab lists all the available applications and also the status of each application for edits.
The following table indicates the application status:

ORACLE’
Financial Services Lending and Leasing

DashBoard Origination (] Close
‘Origination SeardﬂTask Application Entry: 0000001023~ Review Requests (Pending: 0)
s -
;;;:ZG:S‘E:::;" ey App % D0DDDDIS37 SN Identification # B submit
Underwriting
Funding Queue [] | B Next Application
Application Retrieval
Scenario Analysis > Search Criteria
Application Documents
Image Maintenance ﬂl New Application D Open Application @ View Application Unlock Application
Reports
Producers Search Results/Task
Vendors View Fomaty [ Freee EiDetach | dwep @) vewAl M
Critical Locked  Allowsd  Company Branch Datz Tite Product Status Sub Status
e s USHQ 12/12/2015 CHODA PHANINDRA /... LEASE VEHICLE APPROVED FUNDED
0 UsoL UsHQ 12/14/2015 MADHU BOBBURI / BA... LOAN VEHICLE (FR) NEW BLANK i)
@ us01 USHQ 093 06/01/2015 HONEYSINGH YOYO LEASE VEHICLE APPROVED FUNDED
@ usot UsHQ 56 12/15/2015 BOND JAMES LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ UsoL UsHQ 62 02/02/2016 55AM LOAN VEHICLE (FR) APPROVED FUNDED
1 @ usoL UsHQ 05 08/01/2015 HOOD MARK LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ usot USHQ 01/04/2016 KABADE KIRAN LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL USHQ 02/02/2016 VANKAYA JOGAIAH LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL UsHQ 94 12/19/2015 MARTINEZ ANDRES / A... LINE HE (FR) APPROVED VERIFYING
@ UsoL UsR1 58 02/01/2012 LEWISJERRY [ JEAN LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 03/01/2012 JONATHAN RYAN / JUL... LOAN VEHICLE (FR} APPROVED FUNDED
%] NLZ NLRI [ PETER [ SHAR... LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 05/01/201 LKER SIDNEY / SAM... LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsR1 J0i: ER ANDY [ JEAN  LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 01/01/2012 TIFFANY RUSSEL/ GR.. LOAN VEHICLE (FR) APPROVED FUNDED
& Usot UsHQ 02/01/2012 TOLMAN GREG [EVA  LOAN VEHICLE (FR) APPROVED AUTO APPROVED
@ usot UsR1 03/01/2012 STANDFORD MICHEAL.. LOAN VEHICLE (FR) APPROVED FUNDED v
@ UsoL UsR1 04/01/2012 SAXTON MARTIN / CH... LOAN VEHICLE (FR) APPROVED FUNDED
< >
» Servicing
> Collections
> WEP
> Toals
» Setup

Description | Example Expression

CRITICAL Whenever any application is updated with dealer comments, a system
generated alert will be posted in the application and a critical icon would
be displayed in this column against that application. Once User has
acted on the critical item, the alert flag should be manually be
unchecked by the User to remove the 'Critical’ flag on the application.

LOCKED An application already opened by another User will have a lock icon in
this column against the application. User with appropriate privileges can
unlock the application and proceed.

ALLOWED This field displays whether you can open the application from the
respective Origination Screen or not i.e. if the application is in decision
stage, a red flag will be displayed in Application Entry stage indicating
that the application can only be viewed and User has to open the appli-
cation in Underwriting for actioning. User can also see a green flag in
Underwriting against this application indicating that it can be actioned in
Underwriting.
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2.2

2.21

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE" - 5
Financial Services Lending and Leasing
Cl
e DashBoard 5 [] Close.
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Product End Date Batch Job Status
Process Files No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App # Fricrity
No data to display.

My Pending Review Requests By Priority
Priority Count
No data to display.

5 Servicing Producer Vendor
Number of Queues Hard Assigned
A Producers Count By Status Vendors Count By Status
Queus Description Count
TR Status Count Status Count
ACTIVE 2 ACTIVE 35
Number of Accounts Pl eisc A
Queue Description R Producers Expiring in Next One Month Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.
My Pending Review Requests By Accounts
AcE Priority
No data to display.
> Origination My Pending Review Requests By Priority
Priority Count v
> Servicing No data to display.
> Collections
> WFP
> Tools
> Setup

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Loan origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.
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Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE
Financial Services Lending and Leasing

inatie Close
TeT Origination E]
Origination Search/Task | Application Entry | Review Requests (Pending: 0)
Quick Search
Simple Application Entry . e ) = .
Application Entry App # sEN Identification # [ submit
Undenwriting
Funding Queus [] | [ next Application
Application Retrieval
Scenario Analysis > search Criteria
Application Documents
Image Maintenance P New application | | (L Qpen Application || [5] View application Unleck Application
Reports
Producers Search Results/Task
Vendars View~ Format~ [ Freeze [fiDetach | ol wrap W viewan O]
Crit Loc AlloCompany  Branch App 3 Date Title Product Status Sub Status Qu
Mo data to display.
< >
Columns Hidden 1
Pl
> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE
Financial Services Lending and Leasing

Origination x

DashBoard

Searci/Task || Application Bty || Review Reuuets (Pordiu: 0)
© Qulck search

Search Criteria

view - rormatw  [E¥] [ Fresss EfiDsmon ol wrep =N

~
Comparicon Oparator Bl vaive
EquaL <
EquAL ~
CREATER 1 HAN Ok ELUA -~ £
e =] =1
e < <
Like =
e =
Lice =
ke =]
e =
Like <l
Like ~
ke =l
e =
=F [~
e =
- New anpiicarion | | () Gnen Appiicarion | | (] view appiicarion Linkeric Applicarion
Search Results/Task
\iew ~ rormat—  [ER Froaza Eili Detach 1 wirsp @ view A ]
Bearh s + Oal Tt Product Status Sub Stats Qu

> Servicing
> Collections
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Loan origination, the results are sorted according to the priority of application and
application identification number. However you can sort the records using any criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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2.2.2

The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
S Close
DashBoord Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Requests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || 2 audt
View v Fomat~ g Freeze i Detach Wrap @ OverideoK v  Waming OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  RTOdUCE! Bxsting Customer  DURHCR® Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACEH... (818)-761-2277 N
>
Summary || Applicant || Business || Request || Dedision || Contract || Collateral || Comments || Tracking || Document | Verification || Correspondence || Toals
Venders > Applicant
> Ratios
> Bureau
4
“
> Checklist
Collateral
Collateral
Asset Type Sub Type Primary  Year raka Model Mileage New Wholesale Volue  Retail
VEHICLE = ¥ 2015 Aupr A oy 15,000.00 18,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification * Year Make Model BaseRetail Amt  Addons
> Serviang vERICLE 2015 DODGE RAM... 3GCPCRECSEG145195 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
vErICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools
> Requested -
> Setup

You are now ready to begin work on the application.

Quick Search section

Quick Search enables to search for an application using any one of the following values -
Application Number, SSN, Identification Number or Queue.

To load an application using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. Inthe Quick Search section’s App # field, specify the application number you want to load
and click Submit.

You can also load the application by specifying the last 4 digits of the SSN Number. System
retrieves only those applications where the searched SSN is of the Primary Applicant. If
multiple matches are found, system displays an error message as ‘Multiple Matches found for
the SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

Queve <1 ([ Next Appication

Search Results/Task
i Format+ B Freere i ntach T viewan O]
ny = Date Title

> Servicing
> Collections
> WEP

> Tools
> Setup

The system loads the selected application.

To load an application from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Application.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

2.2.2.2 Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Loan information, credit
bureau data, and collateral information. The new application will have status/sub status as
NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE
Financial Services Lending and Leasing

P —— Origination i (3 Gose

Origination (@ Information

Application copy successful. New application # success
Search/Task | Underwriting: D00DDD1S57 | Review Requests (Pending: 0)

Quick Search
pp £ | 0000001537 SSN Identification £ [ submit
Queue [~] | BB Next Application
> Search Criteria
(] open Appication || [E] view appication | | Py unlock Application | £ [{Z] o
Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar O
Crit Loc Alle Company  Branch fop # Date Title: Product Status Sub Status Qu

No data to display.

> Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

Financial Services Lending and Leasing
iginati Close
mET Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
N Application: 0000001533 SIGG MARK Zede | Evew | o aude
simple Application Entry 7 —
Application Entry View - Format~ [ Freeze i Detach Wrap W overideok v  Waming Ok v
Undenwriting Origination Stage Producer Contact q Duplicate
i Dt App # Sub Unit Status Code Producer Nama Nuribar Existing Customer application ‘Conttact
Application Retrieval 05/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary  Applicant = Business Request Decision Bureau = Collateral Comments  Tracking Document \Verification ~Comespondence  Tools
Froducers
Vendors
Comments
i Elsaveandstay || [ save and Retum || G Retum
View v Format~  [Bp Fresze (i Detach 1l Wrap =)
Alert Type Sub Type ‘Comment Comment By ‘Comment Dt
O REGULAR [v] | LoAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
o
DECISION_MULTI OFFER LETTER GENERATED. ~ i
O SYSTEM GENERATED SYSTEM GENERATED {CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST ID: ¥
CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©1/29/2016 11:24:13 PM
> Servicing
> Collections
> WFP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" 2 Welcome, PRAKRRAO ~ o
Financial Services Lending and Leasing

i Close.
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

Sales Lead Quibchiseanch

Simple Application Entry ’ _ T 2 =
Apolication Entry App ¥  DO00001622 E=Y Identification # B submit
Underwriting & Warning *

Funding Queus 2 By

Boplication el [ [l Application is locked by: KGOUDU Phone: 0 - Ext.: 0

G Aol > search Criteria (oK)

Application Dacuments ||| — | e -

Image Maintenance (] Cpen Application | | [Z] view Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View » Format v [0 Freeze 5 Detach Vrap W viewan []

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status Qu
No data to display.
<

 Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service

screen. The search tab available in the screen enables you to locate an account or customer

using a broad range of search criteria.

To view the Search screen during Loan servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.

ORACLE

Financial Services Lending and Leasing

> DashBoard
» Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
‘Account Documents
Collateral Management
Reports
Producers
Vendars
Batch Transactions
Advances
Payments
Fees
> Collections
> WP
> Tools
> setup

@ Customer Service

m

Search | Customer Service || Review Request (Pending: 0)
Quick Search
Ac# Customer 1d
Queue/ Condition [=]

I Search Criteria

4 Search Results

Vien~ Format~ [Ef [[Freez= Eivetach

¢
Company Branch Account #
usot uso 0123456
uso usHo 1008226531
uso1 usHQ 11111111
uso1 usHQ 12
uso1 usHQ 1236459789
uso1 usHQ 20000100010385
uso1 usHQ 20000100010533
uso1 usHQ 20000100011820
uso1 usHQ 20000100011846

Queue Assignment.

ssh Identification #

autoRun [0 | B Nextaccount | | [5§ Hitered Account

= @
)
Date: Tite Product Status
01/20/2000 Downprtamt Test . LOAN VEHICLE (<R} CHARGED OFF
01j01/2017 BAUER CHRISTIAN  LOAN VEHICLE (FR) ACTIE:DELQ
01/20/2000 Downpmtamt Test ... LOAN VEHICLE {FR) CHARGED OFF
012012017 ORACLEMADHAN  LOAN VEHICLE (FR) ACTIVE
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 ALIVE PRI /DEAS... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 ALIVE PRI [DEAS... LOAN VEHICLE (FR) CHARGED OFF

@ chse
|
B submt

) 0pen Account
Sizuuency it o S;t:::dmg
o 0.00 0.00 -
217 158288 g0m.00 [
Gl 0.00 0.00
35 0.00 8,226.25
0 0.00 0.00
0 0.00 0.00
a 0.00 0.00
0 0.00 0.00
0 0.00 0.00 -

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating

‘Cannot open secured account’.

3. Click the Search Criteria tab.

ORACLE’

Financial Services Lending and Leasing

> DashBoard
> Origination
Servicing
Serviding
Customer Service
Securiization
Transaction Autherization
Post Date Checks
Escrow Transactions
Account Documents
Collaeral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfoces
AP Transactions
GLTransactions
CASA Recandliation
Conversion Accounts

> Collections
> WFP
> Tools

> setup

Customer Service

Search | Customer Service || Review Request (Pending: 0)

Quick Search

‘Search Criteria

View~ Format~ [Ep Freeze  {fiDetach Wrap
Criteria
ACCOUNT &
ACCOUNT STATUS
PRODUCT
CUSTOMER SSN
CUSTOMER LAST NAVE
CUSTOMER FIRST NAME
CUSTOMER D
BUSINESS NAME
N
YEAR
MAKE
MODEL
ASSETTYPE
PRODUCER #
PRODUCER NAME
ACCOUNT CONDITION
QUELE NAME (UNDEFINED FOR DEFALLT)
QUELEE DESCRIFTION

Comparisan Cperator

i W
LIKE [+]
e =
EQuAL [=]
i W
e =]
EQUAL [+
e [=]
LIKE [=]
EquAL [=]
Lxe [=]
i [=]
e W
LIKE [=]
LE =]
e [=]
i 7]
e =]

[ ese

Search Options: @ Acseunt € Customer () Business

& Reset Criteria. || @8 Search

i

Value

£3]

SLOAN%

=

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and
Value columns.

2. Click Search. System displays all accounts that meet the search criteria in the Results

tab.

3. Onthe Search Results/Task screen, select the account you want to load and click Open

Account.
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2.31

The system loads account on Customer Service screen.

ORACLE'

Financial Services Lending and Leasing

# Wekome, ABSHEKAR + _ (@]

Customer Service

View v Formatv &y
Company Branch
uso1 UsHQ

Search  Customer Service: 20180600010108  Review Request (Pending: 0)

Account(s): 20180600010108: BANNER BRUCE

(] Close
Queue Assignment 2
Elven | o hudi
Freeze ffiDetach  clWep @) B @ Curent® show Al D Group Folow-up
Sub Unit Account = Product Days Past Due Currency Pay Off Amt. Amount Due Status Oldest Due Dt oLl
UNDEFINED 2018060000108 LOAN VEHICLE (FR) -12 Usb 13,335.25 0.00 ACTIVE 08/13/2018

|

Alerts
Alerts
Alert
No data to display.
r
Account Details
Dues
07/13/2018
0.00 0.00
DelgDue 0.00
LCDue 0.00
NSFDue 0.00

Other Due 0.00
TotalDue 0.00

Total Duefind current 0.00
due)

Summary | Colections |~ Customer Service  Account Details | Customer Detals | Customer Preferences | Transaction History | PmtModes | Bankruptry | RepojForedosure | Defidency  Colateral | Bursau  Timeline | CrossUps > ™ *

0.00 0.00

TodaysPayoff 13,335.25
Future Payoff 13,379.70
Future PayoffDate 08/11/2013
Future PmtDt 08/13/2018
OldestDue Dt 08/13/2018
Amt Paid Excess 0,00

0 ] '

Conditions

m

Conditions
Account Condition Condtion Start Dt Follonup Dt
ON ACTIVE MILITARY DUTY 07/11/2018 07/18/2018
DO NOT CHARGE OFF 077112018 07/18/2018

Other Information

Collateral Information
Primary Description Identification # Year  AssetClass  AssetType SubT
0.00 Y 2018 TOYOTA CAMRY 2018 NEW VEHICLE CAR
< m 7

Memo Excess Amount 0,00 —

PaidTerm 1 y
Customer Information

OUston e Relstion SN Nationl 1D Birth Dt

Remaining Term 11
Days to TimeBar 36156
000000... BRUCEBANNER PRIMARY

< n,

o 7656 -0 07/0a/1950
]

Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/

Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform customer service task on the application, click Customer

Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE ) . SSHEKAR y g oo ©
Financial Services Lending and Leasing
@ Customer Service x [ Close
Search  Custome: Service | Review Request (Pending: 0) | Queve Assgnment
> DashBoard Quick Search
> Origination
Servicing Acc# Customer Id SSN Identification # 3 submit
S
Customer Senvice Quete/ Coniton [#] Autorn [ | 3 NextAccount | | (5§ Fitered Account
Securitization
Transaction Authorization » Search Criteria
Post Date Checks T
Escrow Transactions 3
A(Tun( I‘Z)n[umenfs 4 Search Results
Collateral Mz it =
S vien~ Fomat~ || [[[Frezze EiDetach U
Reports 4
Producers ¢ %
Deli Qutstandi
eriors Company Branch Account # Date Tite Product Status de'”q”E”q Amount Due B“‘ S prog
Batch Transactions ays alance
o n— No data to display.
‘ i ] v
Payments
Fees -
> Collections
5 WEP
> Tools
> Setup

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria
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Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

s Clase
> DashBoard Customer Service 5]
 Grigkation Search | Customer Service  Revien Request (Pending: 0) i
Servicing > Quick Search
Servicng
Customer Service Search Criteria
Securitization Search Options: () Account @) Customer ©) Business
Transaction Authorization
Past Date Checks & resetCritera | @@ Search
Escrow Transactions View v Format~ Freeze i Detach Wirap ®
Account Documents Criteria Camparison Operatar Valuz
Colateral Management  cusTomER = s =l
Henis CUSTOMER FIRST NAME Lne [=]
Producers
Ve CUSTOMER LAST NAME LIKE [=]
Baiteh Transactions CUSTOMER S5N EQUAL [l
Advances CUSTOMER NATIONAL ID LIKE [=] =
“
Payments CUSTOMER PASSPORT NUMBER LKE [=]
i CUSTOMER PHONE NUMBER EQUAL [=]
e CUSTOMER ZIP CODE LIKE [=]
AP Transactions =
GL Transactions
Conversion Accounts TR
Search Results
View > Format> P Freeze [ Detach ol wrap o)
Customer 1d National ID First Name Last Name ssn Passport = zp
No data to display.
» Collections
AL vew~ Fomatv B [lFreeze [iDetach e | @
> Tools Company Branch Account # product Currency Pay OFf Amt Amount Due Status Oldest Due Dt Type
b Setup No data to display.
B i 7l |

1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.

ORACLE
Financial Services Lending and Leasing

Customer Service

»» DashBoard

> Origination Search | Customer Service | Review Request (Pending: 0)
Servidng Quick Search

Serviang

Customer Service Ac# Customer Id

Securitization

Conversion Accounts

> Collections
> WP

> Tools

> Setup

=

Transaction Authorization Queue/ Condition [=] autorun [ | [ NextAccount

Post Date Checks

Escrow Transactions » Search Criteria

Account Documents

Collaterl Management

Reports

Producers Search Results

Vendors View ~ Format~ [ Freeze i Detach )

Batch Transactions Customer Id National ID
Advances 31030 45-632-1789
Payments jd
Fees

Interfaces -

S A View v Format+ [ Freeze [fiDetach | o wrap ®
GL Transactions Company Branch Account # Product Currency
uso1 usHQ 20160200015584  LOAN VEHICLE (FR) USD

First Name
SATKRISHNAN

Pay Off Amt
5,037.08

Identification #

Last Name
K

Amount Due
422.78

SsN
0o0e@S56

Status
ACTIVEDELQ

[gose

[ submit

(2] Qpen Account

Passport # Zp
00775

Oldest Due Dt Type

03/01/2016 PRIMARY

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Product

The Loan product of the account.
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2.3.3

In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE
Financial Services Lending and Leasing

Close
e Customer Service [EE
[ Ot Search | Customer Service || Review Request (Pending: 0)
S LY » Quick Search
Serviang
Customer Service Search Criteria
Securtzation Search Options: @ Account (©) Customer () Business
Transaction Autharization
Past Date Checks & Resetiiteria || @8 Search
Escron Transactions Vien ¥ Format~ B Freeze  {f Detach Wrap W L
Account Documents Crteria Comparison Operator Value 1
Collateral Management EEANT R e =
R ACCONT STATUS e = |
Producers
e propucT e = o
EaE—— CUSTOMER SSN EQUAL =
Advances i CUSTOMER LAST NAME LKE =
Payments CLSTONER FIRST NAME e =
= CUSTOMER 1D EQuAL [=]
Interfoces =
S BUSINESS NAME LKE -
L Transactons v 3 =
CASA Recandlton e e =
Conversion Accounts MAKE e =
MODEL LIE [=l
ssser e e =
FRoDUCER = e =
> Collections PRODUCER NAME LIKE [=l
> WEP ACCOUNT CONDITION LIKE ] [=]
> Tools 'QUEUE NAME (UNDEFINED FOR DEFAULT) LIKE [=]
> Setup ‘QUEUE DESCRIPTION LKe [=] s

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the accounts that meet your search
criteria on Results screen.

ORACLE’
Financial Services Lending and Leasing

> DashBoard {Customer Service

> Origination

feaoy Quick Search
Senvidng
Customer Service Acc

Seauritzation
Transaction Authorization
Post Date Checks

Escrow Transactions

Queve/ Condition

» Search Criteria

Account Documents
Colateral Management
Reports
Producers Search Results
Vendors View v Formatv [
Batch Transactions
q Company Branch
Advances
Payments usoL usio
Fees usot usHo
Interfaces usoL usHg
AP Transactions us0L UsHQ
GL Transactions uso1 UsHQ
CASA Reconcliation uso1 usHQ
Conversion Accounts s usHQ
usoL usHQ
usoL UsHQ
usoL UsHQ
usoL usHQ
> Collections usot usHo
> WP ERE UsHQ
usoL UsHQ
> Tools T o
> Setup <

Search Customer Service | Review Request (Pending: 0)

Customer 1d s5N Identification # [ submit
[ Auorn [ [ B NextAccount
(L Gpen Account
Frecze  fiDetach weo @

Account £ Date Title Broduct Status ::‘Y‘Z""E"EV Amount Due :;:f:d‘”g Producer
0151200011060 12/10/2015 NATHNATH LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002: RAND) +
DISIWO0LI0L  12/18/2015 MADELLASURESH  LOAN VEHICLE (FR) ACTIVEDELQ 1 147182 25030.00  CA00002:RANDY
2151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002: RAND"
151200012349 12/17/2015 SOF SDF LOAN VEHICLE (FR) PENDING 0 0.00 0.00 AK-00001 : FELL
DIS1V0012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002 : RANDY
2151200012894 12/24/2015 ASHOKPADMA  LOANVEHICLE (FR) AcTIvE 12 0.00 20,00000  CA-00001:DEMO
DISIVO0L3008  12/30/2015 i3 LOAN VEHICLE (FR) ACTIE -18 0.00 100,000.00  CA-0000S : HARR
0160100013082 01/06/2016 SPARROW MARYY  LOAN VEHICLE (FR) AcTIvE 2 0.00 S0,000.00  CA-00001:DEMO
2160100013216 01/14/2016 IONES ANGELINA  LOAN VEHICLE (FR) AcTvE % 0.00 S0,000.00  CA-00001:DEMO
210100013274 01/18/2016 RANADE SHIWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 500,000.00  CA-00001: DEMO
2160100013414 01/19/2016 DALEALAN LOAN VEHICLE (FR) AcTIvE £ 0.00 200000 CA00002: RAND'
DIE0100013563  01/20/2016 0 LOAN VEHICLE (FR) ACTIVE -0 0.00 1500000 GA-00002: ADVAM
2151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002: RAND"
DIDI00L4145  01/20/2016 HEGDE SUBHASH /... LOAN VEHICLE (FR) ACTIvE 4 0.00 1500000 GA-00002 : ADVA
160100014206 01/20/2016 HEGDE SUBHASH ... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00

GA-00002 : ADVAM +
i v

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Loan product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.
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The system loads the account under the tab

ORACLE
Financial Services Lending and Leasing

#, Welcome, VAVAIDYZ

234

ustomer Service x lose
> DashBoard Sistomen 56 =
> origination Search  Customer Service: 20151000011054 _ Reviev: Request (Pending: 0)
Servicing
e Account(s): 20151000011054: K NAVIN [l view |[ 2 auit
Customer Senvice Vieww Formatv B3 | ([[|Freeze PliDetach | owrep @ & © Curtent O Showall O GroupFollowup
Securitization Company Branch Sub Unit Account # Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usia UNDEFINED 2015100011054 LOAN VEHICLE (FR) 531462 0.00 ACTIVE 10012016
Post Date Checks
Escrow Transactions
e Summary | Customer Service || Account Details | Custamer Details | Transaction Hstory | Pt Modes | Bankruptcy || RepojForecosure | Deficency | Collteral | Bureau | Cross/up Sell Actites
Collateral Management
Reports Alerts Conditions
Producers
Vendors Alerts Conditions
Batch Transactions Alert Condition Start 0t Followup Dt
A TEST No data to display.
s
Fees
Interfaces
AP Transactions
6L Transactons
Chsh Reconcliation
b Account Details Other Information
Conversion Accounts ‘
Dues Collateral Information
Descrption Hentfication = Year hssetTwe  SubType
om0 0 00 000 om0 o 0 1 2
0 0 1 2
DelgDue 0.00 Totsl ue. 20,00 Future Pt DE 10/01/2016 o 0 i 2
LCDue 0.0 Todays Payoff 4531462 Oldest Due Dt 10/01/2016
NFDue 2000 Future Payoff 45376.30 Amt Paid Excess 0,00 5
Other Due 0.00 Future Payoff Date 02/27/2016 Customer Information
. . Customer . me Relation S5 Birth Dt Gender
Delinquency Information *
0 96 150 (80 [Caeooy [baw 000000... RAVINK; PRIMARY o 008677 0/12/1967
0 0 0 0 0 0 0 a7 000000... RICHARD MURRAY 3R PRIMARY o332 12081985 UNDEFINED
,
nsF(Ufe) 1 Collector DEMOCOLL
wsF(vear) 1 Enmil Privacy Opt Out ¥
Language ENGLISH Active Military Duty N
Activities Marital Status top ¥ Time Zone
> Collections ) chRe a
Acive Dt 12/40/2015 App# 0000001013 Last Pt Amt. 0,00 orrespondence
> WFP Last Activity Dt 02/17/2016 Paid Off Dt Charge Off Dt
> Tools Due Day 1 Effective Dt 10/12/2015 .
Last Pmt Dt Current Pmt 3,981.80 Address Information
> Setup Customer Grade B Last Bll Amt 0.00 Type current PEMISH aiing address Phone. i

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen
On the Oracle Financial Services Lending and Leasing home screen, click Servicing >

Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

ORACLE’
Financial Services Lending and Leasing
68 Customer Service [ Close.
Search | Customer Service | Review Request (Pending: 0) | Queue Assignment =
> DashBoard » Quick Search
> Origination
Serviding Search Criteria
E Search Options: Account () Customer @) Business
ervidng
R & Resetciitera | @@ search
Seauritization
Transaction Autiorizstion ey~ papets | | Mo ffivses we | @
Post Date Checks Criteria Comparison Operator Value
Escrow Transactions BUSINESS # LIKE =
Account Goauments BUSINESS NAME e [+]
Collateral Management — — =
Reperts STaRTDATE GREATRTHANOREQUA.  [=] Y
Producers < =
Wiy PrONE NUVBER cqun =
Batch Transactions I CODE L =
Advances
Payments =
:W“E" (LA Open Accaunt
ees
Interfaces
Search Results
2P Transactions .
S View~ Formatv Freeze ffi Detach rap @
PoRETE Business # Business Name. Tax1d Start Dt Phone Number Zp
No data to display.
> Collections
> WFP View v Format v | Ep Freeze  {oft Detach wrap [o:)
e Company Branch Account # Product Currency Pay OFf Amt. Amount Due Status Oldest Due Dt
00 No data to cispay.
> Setup

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear

the Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the records that meet your search

criteria on ‘Search Results’ section.

ORACLE'
Financial Services Lending and Leasing

=)

@  Customer Service

Search Results

Vew v Formatv | Freeze i Detach ap
> DashBoard 5 i L
- Business # Business Name
> Origination 0000021005 oFsiL
Servicing
Servidng

Customer Service Ve Fomatv [ Fresze i Detach wap | @
R AR X Company Branch Account # Product
Transaction Autherization Uso1 usHQ 20170200029956  LOAN VEHICLE (FR)
Past Date Checks

Escrow Transactions
Account Documents

L Transactions

Conversion Accounts Addresses | Telecoms | Partners || Affiiates | Tracking Attributes

T Address Information
view ™ Formatv [ Freeze Efpetach | o wiep 5}
il Address Type Current Country Address =
7 Tools WORK Y UNITED STATES
> setup 1 I}

Collateral Management e
Reports
Producers i Business Details
Vendors
Batch Transactions
Advances view = Format~ B | [[[Frecce fiDetach weo | @
Payments
el OrganizatonType  Type of usiness  Business Category  Name of the Business
Interfaces ccorp CORPORATE CORPORATE orsiL
1P Transactions ‘ I

[ ose
TaxId Start Dt Phone Number Zp
5523 02/08/2010 (000}-000-0000 01152
Currency Pay Off Amt ‘Amount Due Status Oldest Due Dt
usp 10,000.00 0.00 ACTIVE 03/15/2017
[E vew
LegalName T = sertot ofEmployess(ar) s of
OFsLL X0000t5236 02/08/2010 200
] »
B
state Postal Type StreetPre Street Name Street Type st
MASSACHUSETTS  NORMAL ADDRESS
F

You can view the view the following information for each business record:

In this field: View this:

Business #

The registered business number of the company.

Business Name

The name of the business.

Tax ID The taxation identity number of the business.

Start Dt

The date when the business was initiated.

Phone Number

The contact number of the business.

Zip The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Loan product of the account.

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.

Amount Due

The total amount due on the account.

Status The status of the account.

Oldest Due Dt

The oldest payment due date on the account.
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Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the tab

ORACLE'

Financial Services Lending and Leasing

> DashBoard

> Origination

Servicing

Senvidng

Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers

GL Transactions
CasA Reconciliation

Conversion Accounts.

> Collections
> WP

> Tools

> Setup

Customer Service x [ close
seah| G + 2015100011054 quest (Pending: 0)
Account(s): 20151000011054: K NAVIN Byew | o audgit
View v Formatv B [[]Freeze i Detach wap | @ & © cument O showall O Group Fallov-up
Company Branch Sub Unit nt = Product Days Past Due Currency Pay OFF Amt Amount Due Status Oldest Due Dt
uso1 ushg UNDEFINED 2151000011054 LOAN VEHICLE (FR) 227 UsD 4531362 0.00 A 100172016,
Summany || Customer Senice | Account Details | Customer Details | Transaction History | P Modes | Bankruptcy | Repo/Foreclosure | Deficiency | Collateral | Bureau | Cross/Up Sell Activities
Alerts Conditions
Alerts Conditions
Aert Condition Start Dt Followup Dt
esT o data to display
Account Details Other Information T
Dues Collateral Information
Description Hentification = Year AssetClass AssetTpe  SubType
000 000 000 000 000 0 0 1 i
0 0 x i
Delg Due 0.00 Total Due 2000 Future Pt DE 10/01/2016 0 0 1 i
LCDue 0.0 Todays Payoff 4531462 Oldest Due DE 10/01/2016
NF Due 2000 Future Payoff 45,376.30 At Paid Excess 000 :
& Customer Information
Other Due 0.00 Future Payoff Date 02/27/2016
: . Customer e Relation = Bith Dt Gender
Delinquency Information *
e 30 0 @ 20 0 180 Category Days 000000... KAVIN K PRINARY 010068677 02/12/1987
e £ 5 5 : & = 000000... RICHARD MURRAY JR PRIMARY 00009332 12/08/1585 UNDEFINED
,
BR(Lfe) 0 NSF(Life) 1 Collctor DEMOCOLL
ep(Year) 0 NsF(Year) 1 Email Privacy Opt Out Y
o Language ENGLISH Active Mitary Duty N
Activities Marita Status Stop N Time Zone
Adive Ot 12/10/2015 App # 0000001013 LastPmt Amt. 0.00 Correspondence
Last Actiity Ot 02/17/2016 Paid Off Dt Charge Off Dt
Due Day Effective Dt 10/12/2015 N "
LastPmt Dt Current Pt 3,981.80 jAddress Information
Customer Grade B Last Bil Amt 0.00 e Curent PSS hing address Phone -
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

ORACLE" i ) = Welcome, PRAKRRAO ~ =
Financial Services Lending and Leasing

DashBoard B glose

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. Product End Date Batch Job Sttus
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priorty Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A~ Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority o
> Servicing | prienty Count

> Collections

> WFP

> Tools

> setup

Features

Following are the features of Dashboard:
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3.3

3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing Loan
origination and servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination).The system
updates these details on daily basis.

Using the User Productivity Setup screen, you can review the following daily tallies:

e Number of applications entered, by user

e Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by
user

e Number of funding decisions (verified or funded), by user
e Number of applications entered, by queue

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing Underwriting/Funding tasks

Daily tallies from the

e Collector Activity

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.
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To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:

e Users

e Activity Details

2. In the Users section, you can view the following information.

ORACLE

Financial Services Lending and Leasing

PRAKRRAQ + o

DashBoard
DashBoard
Dashgoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

Users
View~ Formaty [
User
No data to display.

Users Productivity x

Apglication Ertry | Underwiting || Funding | Origination Queues | Collector Activity: | Senvice/Collection Queuss:

Activity Details
Vieww Fomat~ [ Freeze
Queue Name
No data to display.

LeftMessages  Promise To Pay

Neme

No Answer

[ Close

Accounts Call Activities

Other Total

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. Inthe Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field:

View this:

Queue Name

Displays the queue name.

Left Messages

Displays the left message activity count.

Promise To Pay

Displays the promise to pay activity count.

No Answer

Displays the no answer activity count.

Other

Displays the other activity count.
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3.4

3.4.1

Field: View this:

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:

e Batch Job Sets

e Batch Jobs

e Batch Jobs Threads
e Request Details

e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE’ . W PRAKRRAO ~ o
Financial Services Lending and Leasing

e System Monitor » 3 Close

Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Users Productivity

System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wirap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Frequency Frequency Value  Start Time Encbled Critical Last Run Dt Next Run DI
SET-AAT ACCOUNT CREATL.. READY DAILY DAILY 10:00 &M N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N Y 08/07/2003 08/08/2003
< >
Batch Jobs
Vieww Formatw [ Freeze i Detach Wrap @) BB Re-submit Job
Seq Job Type Job Code Status Job Description Threads Comemit Count Errors Allowed Weskend Holiday
1 PROCEDURE AATPRC_B1_100_01  COMPLETED APPLICATION TO. i ¥
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACOOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
§ View~ Fomat~ B Fresze ) Detach Wrap (65
Thread Status Errors Records Trace Level Enzbled
11DLE 0 ] oy
Request Details
View » Format+ [ Fresze ) Detach Wrap (5]
Request Type Stotus Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
Vieww Fomate [ Frezze 2! Detach Wrap W
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.

Frequency Code Displays the frequency at which the job set is to be executed.
Frequency Value Displays the value of frequency code chosen for the job set.
Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.

e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.
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The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.
Job Type Displays the batch job request type.

Job Code Displays the batch job request code.
Status Displays the job status.

Job Description

Displays the batch job description.

Threads

Displays the number of threads used by the job.

Commit Count

Displays the number of rows after which auto-commit is
triggered.

Errors Allowed

Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field:

View this:

Thread

Displays the name of thread.
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Field: View this:

Status Displays the status of thread.
Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.

Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).

Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.
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To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE’

Financial Services Lending and Leasing

System Monitor x

Batch Jobs | Jobs

Job Details

View ~ Format

Request Type

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE
<

Services || Database Server Log Files

Batch  Back Ground || Credit Request

-
Status

COMPLETED.
COMPLETED
COMPLETED
COMPLETED
COMPLETED
COMPLETED

Freeze  pfiDetach

Parked Transactions | Users

§) viewlsst @ 1Day() 1week© 1MonthByDate StartDt EndDt @ view ©) Failed ® All

Valid Execution
Job Set Job Description Thread Errors Records Run Start Date/Tme Run End Date/Time  Process Dt Period Start

DateTime
SET-TRE TXNDDT_B1_100_. TXNDDT_B1_100_ 2 0 2 09/19/2017 11:52: _ 09/18/2017 11:52: . 03/20/2017 08/18/2017 11:52;
SET-TRE TXNDDT_BJ_100_.. TXNDDT_B1_100_ 1 0 & 09/19/2017 11:40: . 09/18/2017 11:41:. 03/20/1017 08/13/2017 11:40
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 0 2 09/19/2017 03:31: . 09/18/2017 08:31: .. 08/20/2017 08/13/2017 09:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 [ 2 09/19/2017 08:31:... 09/18/2017 08:31:... 08/20/2017 08/13/2017 08:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 o 2 09/18/2017 07:31:... 09/18/2017 07:31: .. 08/20/2017 08/13/2017 07:31
SET-QRT QCSPRC_BI_I00_ . QCSPRC_BI_100_ 1 0 2 09/19/3017 06:31: .. 09/18/2017 06:31:... 08/20/2017 08/13/2017 06:31

7

[ Close

Job Detail Description
THNDDT_B_100_0 1. TXNDDT_B1_100_01(6006)

Job Results
View » Formatv [P

Request Result
in Ani St

Freeze i Detach

Description

2. Onthe Job screen, you can select any of the following type of jobs which are available in

separate tabs:

Select: System Displays:
Batch Batch jobs (used primarily for the nightly processes).
Back Ground User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.

1 Month All the types of jobs selected in Jobs Type section in last one-month.

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.
Job Set Displays the job set code.
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3.4.3

Field:

View this:

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.
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2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE’
Financial Services Lending and Leasing

& Welcome, PRAKRRAO o

o Cose
e —— System Monitor 5 [E3fe
DashBaard
Dashgcard

Users Productivity .
System Monitor Services

Producer Analysis View  Format~ Ep Freeze
Process Files Service

BatchJobs  Jobs | Services Database Server Log Files | Parked Transactions | Users

! Detach Wrap @) @ status st Clstop
Description

CREDIT BUREAU SERVICE (EFX TEST FILES)
UREAL SERVICE (EXP TEST FILES)

Company Branch
v AL AL
sV AL ALL CRED)
v AL AL CREDIT BUREAU SERVICE (TUC TEST FILES)
BC AL ALL JOB SCHEDULER
sV AL AL JOB SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE" . . 5w ABSHEKAR ~ 1@ Signout
Financial Services Lending and Leasing
@ Svstem Monitor (3] Close:
Batchlobs Jobs | Services  Database Server Log Files | Parked Transactions | Users 2
DashBoard
DashBoard - Database Server Log Files
DachBoard | “i‘e"'t B 1 O e @ T Mo e B B D2k Erd Dt % @@ Vien © Alert® Debug @ Interfaces
as
Users Productivity = -
View v Format » Freeze i Detach Wrap iSUstFies [ Download File =
System Maritor e & E W == G2
¥t A L File Name File Type File Size File Time
o T xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6574056.log fie 171338 08/28/2017 07:42:07 PM [
JSVPRC_EN_000_01_DB12102_7283859.log file 19897 09/10/2017 10:39:59 AM
g XAEUPD_EM_100_02_FMWW 116_7203940.log fie 26704 09/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log fie 1108 09/08/2017 06:00:34 AM -
> Origination Fle:Conimat
View = Format = Fr i Detach firap @ Begmning D End 2 ofLines 50 Show File
> Servicing = 50} 5]
- Text
& Colerions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WEP 08/31 :32: cmnsyp_cl 00 get_syp paramever value parameter: XAEPRC EM_100_02_DEBUG_LEVEL
> Tools 2: xaeprc_em submit for Bpp No:
: User code: INTERNAL
> Setup = x
2: 1v_statement - SELECT ptc_cur_currency code FROM xae ptc_evw WHERE FTC_COMEANY = :bl 1 |-

2. Inthe Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start D’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.

6. To sortthe view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

3.4.5 Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE' e, ABSHEKAR 1 Signout &
Financial Services Lending and Leasing

System Monitor [®Close
Batch Jobs || Jobs | Services || Datsbase Server Log Files | Parked Transactions  Users 2
User Logins
Vien v Formatv 5y Freeze ffiDetach Wrap | ) ViewLast © 1Day © 1Week® 1Month @ By Date  start Dt 2 EndDt @ View User ) Current User @ All Users
User User Name: Detaiis Login Date and Tine L0002t Date and
Time
SURABH SURABHI DESAL 09/20/2017 04:56:... 12/30/4000 12:30s...
SURABHI SURABH DESAL 09/20/2017 04:44%... 12/30/4000 12:30:...
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30:...
SKsK SALSK 09/20/2017 03:5%.. 12/30/4000
» PRITAM PRITAM JENA 09/20/2017 03:47:... 12/30/4000 1
NAVEEN NAVEEN RECDY 09/20/2017 03:47:... 09/20/2017 04:55:
JAYANTA JAYANTAC 09/20/2017 02:37:... 12/30/4000 12:30:
SKSK SALSK 09/20/2017 02:35:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 02:08:... 12/30/4000 12:30:
PRITAM PRITAM JENA 09/20/2017 01:45:... 12/30/4000 12:30:
JAYANTA JAYANTAC 09/20/2017 01:45:... 09/20/2017 02:37:
PRITAM PRITAM JENA 09/20/2017 01:27:... 12/30/4000 12:30:
susv SHRIVATS SINGH 09/20/2017 01:20:... 12/30/4000 12:30
NAVEEN NAVEEN REDDY 09/20/2017 01: 14:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/20/2017 12:35:... 12/30/4000 12:30:
ABSHEKAR ANAND SHEKAR 09/18/2017 11:45:... 12/30/4000 12:30:
PHACHODA PHANINDRA CHODA 03/18/2017 11:37:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:32:.. 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:21:... 05/13/2017 11:32: b

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.
User Name Displays the user name.
Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

Monitoring JMS Queues

OFSLL uses MDB infrastructure as an interface for asynchronous communication with third-
party integrated applications and all the outgoing communications through all the interfaces
are tracked in ‘JMS Queues’ tab.

The ‘JMS Queues’ tab in System Monitor screen facilitates as a dashboard to monitor the
status of all the configured MDB (Message-Driven Bean) queues and provides a statistics of
the total messages / requests that are sent from OFSLL to external system along with their
status.

The ‘JMS Queues’ tab has the following sub tabs:

e Status sub tab - to view the last status of configured MDB
e Messages sub tab

— To view the list of configured interfaces and total messages triggered to the
interface.

— To view the status of response for the message received from the interface.
— To ‘Re-submit’ failed messages.
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To view the status of all the configured MDB
1. Click Dashboard > Dashboard > System Monitor > JMS Queues. The Status sub tab
is displayed by default.

ORACLE 2 Welcome, ABSHEKAR ~ o
Financial Services Lending and Leasing

System Monitor 5 [#] Close

Batch Jobs  Jobs | Services  Database Server Log Files | Parked Transactions | Users  JMS Queues

Status = Messages

Status
View v Format v ’%’ Freeze ﬁ' Detach | Wrap @E} (@ Status

&
Service Description Last Updated Status
BIP MDB BIP INETRFACE MDB SUBMITTED -

! DIR TRACKMDB  DEALER TRACK INTERFACE MDB ronving |

EFX MDB EFX INTERFACE MDB R |
EMALL MDB EMALL MDB runving |
EXP MDB EXP INTERFACE MDB R |
GAI MDB GENERIC AUCTION INTERFACE MDB Runving |
GRI MDB GENERIC RECOVERY INTERFACE MDB roemng |
POSTDEALER MDE  POST DEALER INETRFACE MDB R e
ROUTEONEMDE  ROUTECNE INTERFACE MDB
TORQUETTSMDB  TORGUE ITS INTERFACE MDB

2. In the ‘Status’ section, you can view the following details of configured MDB:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Last Updated Status | Displays the status of MDB interface. Following are the status
displayed:

* UNKNOWN - indicates that no MDB infrastructure is con-
nected or status ping message is not sent to that MDB.

*« SUBMITTED - indicates that a dummy ping message is sent
to MDB.

* RUNNING - indicates that the message is consumed by
MDB infrastructure.

*« STOPPED - indicates if MDB infrastructure is down.

3. Inthe ‘Status’ section, select the required service for which you need the status and click
Click & button. On clicking, a dummy ping is sent to the interfaced server and status in
‘Last Updated Status’ column is updated as ‘SUBMITTED’.

4. Click @l (refresh) button, to fetch the latest status and the response received is updated
in ‘Last Updated Status’ column.
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To view the messages triggered to all configured MDB

1.

Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

ORACLE’ 2 Welcome, ABSHEKAR = (&)
Financial Services Lending and Leasing
=
System Monitor [3€] Close
Batch Jobz ~ Jobs  Servicez  Database Server Log Files  Parked Transactionz | Users  JMS Queues =
Status  Messages
View Last @) 1Day () 1 Week ) 1Month () By Date startDt End Dt )
Messages
View  Format v ﬁ Freeze iﬂl Detach | Wrap GE!
Service Description Submitted Completed Failed Resubmitted 3
VERTEX MOB VERTEX INTERFACE MDE 218 3 215 o
BIF MDEB BIP INETRFACE MDB 12 Q 12 a
Message Details E] vew
View » Format v ﬁ Freeze d‘ Detach | Wrap @ﬁ |_—|5 Re-submit
& %%, [Zy
Message ID Request Type Request SubType  Message Type Status Message Content Time:
742CBBET098B325... OUTBOUND VERTEX INVOICE SERVICE FAILED REQUEST_TYPE=OUTBOU... 08/24/2018 05:20:... ~
742CBSET7098C32... OUTBOUND VERTEX INVOICE_SERVICE FAILED REQUEST_TYPE=OUTBOU... 08/24/2018 05:20:...
742CBSE7098D32... OUTBOUND VERTEX INVOICE_SERVICE = FAILED REQUEST_TYPE=OUTBOU... 08/24/2018 05:20:...
742CBSE7098E325... OUTBOUND VERTEX INVOICE_SERVICE FAILED REQUEST_TYPE=OUTBOU... 08/24/2018 05:20:...
749CRAFTNARFT7A N RO NN VFRTFY TMUNTCOE SFRVTOE  FATIFR REAIIFST TVRE=NITRANIT  NR/241901R NS0 b

2.

In the ‘Messages’ section, select the ‘View Last’ option to display the messages based on
elapsed days by selecting 1 Day (default) / 1 Week / 1 Month / By Date. If ‘By Date’ option
is selected, you can specify a date range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields
using the adjoining calendar.

The ‘Messages’ section displays the list of configured interfaces and the total of
messages exchanged between OFSLL and MDB in Submitted, Completed, Failed and
Resubmitted status. Click &l (refresh) button to update the latest status.

In the ‘Messages’ section, you can view the following details:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Submitted Displays the total count of requests submitted.

Completed Displays the total count of requests completed.

Failed Displays the total count of requests failed.

Resubmitted Displays the total count of only those requests which are

failed and resubmitted again for processing.

To ‘Re-submit’ failed messages

1.
2.
3.

Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.
In the ‘Messages’ section, select the required MDB interface.

The ‘Message Details’ section below displays the list of messages sent to the interface
with the following details:

Field View this:

Message ID View the system generated MDB message ID
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Field

View this:

Request Type View the message request type
Request SubType View the message request sub type
Message Type View the message identifier

Status View the message processing status

Message Content

View the message content

Time

View the message time stamp

4. Inthe ‘Message Details’ section, select the message in ‘Failed’ status. Click @l (refresh)
button to update the latest status.

5. (Optional) You can click ‘View’ to display the selected record in ‘Message Details’ section.

6. Click B Re-submit. The details are triggered again for processing and the ‘Resubmitted’

counter in ‘Messages’ section is updated along with other counters.

Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications

sourced by different Producers.

Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE
Financial Services Lending and Leasing

DashBoard Producer Analysis x

Select Criteria
Users Productivity
System Monitor
Froducer Analysis
Process Files

Company ALL [v]
Branch ALL[w]
Region ALL [v]

Producers | Territories

- Dealer

No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

» Setup

Territory -
Sales Agent ALL 2]

Underwriter ALL [v]

Activity | Volume || Mix

Recent Activity
Last Funded
No data to display.

Recently Approved Applications
Applicant Name _ Application # Amt

No data to display.

Recently Funded Applications
Applicant Name Application # Amt

i No data to display.

Recent Comments
o Detach

Date Comment Desc
Mo data to display.

Funder ALL [v]

Status -

Approved

Collateral Desc

Collateral Desc

¥l Close

(3 submit

Funded Comments

You can filter producer details based on any or all of the following criteria:

e Company
e Branch
e Region
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e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System
displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #

e Name

e Company

e Branch

e Type
Select the producer you need to view the statistics. The system displays the statistics under
‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’
sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year

e Total Apps
e Approved

¢ Conditioned
e Rejected

e Withdrawn
e Funded

e Amount

The system displays the following details under ‘Applications’ sub tab:

e Company

e Branch
e App#

° Date

° Title

e Product
e Status

e Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with

other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
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information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

e CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

e UIX_INCOMING_FILE_PATH
e UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

e If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to ‘Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.

Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system forimmediate processing.

ORACLE
Financial Services Lending and Leasing

Process Files [ Close

Incoming Process File | Outgoing Process File

Incoming Process File

View » Format~ [ Freeze  LHiDetach rap W iSustrles  BFupioad
on &
selectAl ] Directory Name File Name File Type File Size(bytes) File Date Status
i~k Jscratchfwork_area/DEV/DE... callactivity_test XV.bet 39 08/12/2016 05:23:01 AM NONE

" uploaded Files

View = Format v [ Freeze  Efi Detach Wirap @) viewlest © 10Day(@ 2Days@ 5Days@ Al Days [G Download Bad Data  [5, Download Log Data
File Name File Type File Dt Status User
SampleResponseAssets. json FACTORY DATA UPLOAD 08/14/2017 12:41:17 PM UPLOADED INTERNAL INT %
SampleResponseAssets.fson FACTORY DATA LPLOAD 08/14/2017 12:39:22 PM UPLOADED INTERNAL INT
LookupResponselWithl ookupDescPassedAs_CALC.json FACTORY DATA LPLOAD 08/04/2017 01:07:23 PM UPLOADED INTERNAL INT
LookupResponselWithLookupDescPassedAs_CALC.jsan FACTORY DATA LPLOAD 08/04/2017 11:45:18 AM UPLOADED INTERNAL INT
LookupResponseWithL ookupDescPassedAs_CALC.json FACTORY DATA UPLOAD 08/04/2017 01:26:24 AM UPLOADED INTERNAL INT
LookupResponseWithL ookupDescPassedAs_CALC. json FACTORY DATA UPLOAD 08/04/2017 01:20:29 AM UPLOADED INTERNAL INT
LookupResponseWithLookupDescPassedAs_CALC. json FACTORY DATA UPLOAD 08/03/2017 09:37:30 PM UPLOADED INTERNAL INT
LookupResponselWithLookupDescPassedAs_CALC.jsan FACTORY DATA LPLOAD 08/03/2017 09:34:58 PM UPLOADED INTERNAL INT
LookupResponseWithL ookupDescPassedAs_CALC. json FACTORY DATA UPLOAD 08/03/2017 02:23:56 AM UPLOADED INTERNAL INT
LookupResponseWithL ookupDescPassedAs_CALC.json FACTORY DATA UPLOAD 08/03/2017 02:18:27 AM UPLOADED INTERNAL INT = !

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files.

A brief description of the fields is given below:

Field: Description:

Select All Select this option to select all the listed files.
Directory Name View the directory path where incoming file is stored.
File Name View the name of the file.
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Field:

Description:

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date View the date and time when the incoming file was placed in
the directory.
Status View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click

Select All check box to perform a bulk upload of all the listed files.

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2

Days / 5 Days / All Days. You can click [@) to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.
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3.6.2 Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

ORACLE’ ABSHEKAR ~ 1@ Signout
Financial Services Lending and Leasing
Process Files [ Qose
Incoming Process Fle  Outgoing Process File =
Outgoing Process File
view v Formatv B Freeze it Detach Wrap @ B Download  ViewLast @ 1Day®) 2Days©) 5Days ®) Al Days
select Al £] File Name File Type File Date File Size(bytes) Status
B customer_ach OUT PUT DATA FILE 07/10/2017 05:29:20 PM 533 GENERATED =
] customer_ach OUT PUT DATAFILE 07/10/201705:28:18 PM 533 GENERATED L
L" customer_ach OUT PUT DATAFILE 07/10/2017 05:29:18 PM 533 GENERATED 1
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 17 PM 533 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 16 PM 533 GENERATED L
i B customer_ach OUT PUT DATAFILE 07/10/201705:29:15PM 533 GENERATED 1
data_change_ien_07102017_172914.dat OUT PUT DATAFILE 07/10/201705:29:14PM 0 GENERATED
] customer_ach OUT PUT DATAFILE 07/10/2017 05:28:13PM 533 GENERATED
E customer_ach OUT PUT DATAFILE 07/10/2017 05:28:12PM 533 GENERATED
] customer_ach QUT PUT DATA FILE 07/10/2017 05:28: 11PM 533 GENERATED &
History
View = Format~  [EF Freere i Detach 1] irap o0
User Download Dt
DILEEP GRANDHI 08/10/2017 06:42:22 PM
DEMO SUPERUSER 07/31/2017 03:28:20 PM -

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.

On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click 4 to refresh the grid
data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

3-19 ORACLE



History

The history section displays the following details:

Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4.2

4. Sales Lead

Introduction

The Sales Lead screen enables you to record information gathered during a sales query or a
call from a potential borrower. A sales representative can then use Sales Lead screen to
follow-up with the borrower. This is not a mandatory screen. You can always begin Loan
origination process directly using the Application Entry screen Information on Sales Lead
screen can be attached to the Application Entry screen as optional information. Attaching a
lead to an application can help the sales department analyze the effectiveness of following-
up with prospective borrowers. Once a lead is attached to an application from the Sales Lead
screen, the system changes its status to COMPLETED.

Lead Entry

The Lead Entry screen enables you to record information regarding prospective borrowers
from a sales query or a call to be used in a follow-up call. The initial status for the lead can be
set as NEW or FOLLOW-UP.

To Navigate to Lead Entry screen

1. On the Oracle financial Services Lending and Leasing Application home screen, click
Origination > Origination > Sales Lead.
2. Onthe Sales Lead screen, click Lead Entry tab.

ORACLE’
Financial Services Lending and Leasing

Close
oy Sales Lead Eils
Origination Lead Entry | Followlp = Maintenance
Qrigination
S Applicant Information e add | Ed v 7 Aud
Simple Application Enfry s
Application Entry View v Format~ [Ep Freeze  Eff Detach v (55
Underwriting Lead # Lead Dt Company Branch First Name Last Name Birth Dt Channel Source
Funding UNDEFINED: 02/04/2016
Application Retrieval L-00002006 NLOZ NLHQ ROSEMARY BLACK 12/08/1987 CONSULTATION ~ WEBENTRY A
e e 1-00001002 uso1 UstQ TEST TEST LAST NAME  01/01/1990 ESTATEAGENT  FAXIN
Application Documents 1-00003002 us1 UsHQ BOND JAMES 0 97 WEB WEB ENTRY
Image Maintenance L-00002002 uso1 USHQ PHANINDRA CHODA 1 82 CONSULTATION  WEB ENTRY
Reports L-00002004 us01 UsHQ BOREN ROBERT 12/01/1570 v VEB ENTRY
R L-00008002 us0t UsHQ NITIN 05HI 07/25/1988 CONSULTATION  OFFLINE APPLICV
gy L-00004004 12/19/2015 uso1 USHQ ANDRES MARTINEZ 08/06/1989 CONSULTATION  WEB ENTRY
<
Applicant Information
[ saveand add || [ saveand stay | [ Save and Retum || Ga Retum
Applicant Information Address
Lead # UNDEFINED “Type = zip -
Lead Dt 02/04/2016 i
. * Gountry UNITED STATES [v] aty
* Company I~ ey ™
*Postal Type NORMAL ADDRESS [~ '
anch [+ __ Email
La lame mail
- Street Pre [
First Name PRAKRRAD
* Birth Dt 2 e us NEW v
*Channel ) Street Type 2| Status Dt 02/04/2016
= Source [~ ~ * Followup Dt [
Telecoms Comments | Documents  Requests
= Telecom Information o add || 7 Edi 5 vi ? Aud
st Vieww Fomatv B Freeze 4 Detach i ®
> Collections Telecom Type Phane Current
> WFP No data to display.
> Tools
> Setup

3. Inthe Lead Entry screen, perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:
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Applicant Information

Applicant Information Section

Field Do this

Lead # View the sales lead number.

Lead Date View the sales lead date. System defaults the current date.
Company Select the company name.

Branch Select the branch name.

First Name Specify the applicant’s first name.

Last Name Specify the applicant’s last name.

Birth Dt Specify the birth date.

Channel Select the channel of the sales lead.

Source Select the source of the sales lead.

Address Section

Field Do this

Type Select the address type.

Postal Type Select the postal address type.
Address # Specify the address.

Street Pre Select the street prefix (directional).

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt # Specify the apartment number.
Address 1 Specify the first address line.
Address 2 Specify the second address line.
City Specify the city.
State Select the state.
Zip Select the zip code.

Note: For non US country, you have to enter zip code.
Country Select the country code.
Email Specify the e-mail address.
Alternate Specify the alternate e-mail address.
Email
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4.2.2

Field Do this

Assigned By | View the user code creating the sale lead.

Status Select the status for the sale lead.

Status Dt View the last sales lead status change date.

Follow-up Dt | Specify the sales lead follow-up date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Telecoms Sub Tab

The Telecoms sub tab records phone numbers for the sales lead.
1. Click Telecoms sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Telecom Select the type of telecommunications device

Type

Phone Specify the phone number

Current Select the Current check box to indicate the phone
number is in service.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments sub tab

The Comments sub tab records any comments regarding the sales lead.
1. Click Comments sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the comment type.
Sub Type Select the comment sub type.
Comment Specify the comment.

Comment Dt | View the date when comment was entered and saved.

Comment By | View the user id of the person who entered and saved
the comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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423 Documents sub tab

The Documents sub tab needs to be completed if:

e The customer had requested any documents
e Any document has been sent to the customer during sales lead entry.

1. Click Documents sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Document Select the document type.

Type

Sub Type Select the document sub type.

Documents Specify the document.

Document Dt | View the date when document was entered and saved.
Document By | View user id of the person who entered and saved the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

424 Requests sub tab

The Requests sub tab records product the customer is interested in and the requested
amount for each product.

1. Click Requests sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Product Specify the requested product as Loan.
Requested Specify the requested amount.
Amount

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.3 Follow-Up tab

The Follow-Up tab enables you to update customer information based on sales lead follow-
ups with customer.
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1. On the Sales Lead screen, click Follow-Up tab.

ORACLE

Financial Services Lending and Leasing

2 Welcome, PRAKRRAO v o

DashBoard
Origination
‘Onigination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Agplication Retrievl
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

» Servicing
> Collections
> WEP

> Tools

» Setup

Sales Lead s

Lead Entry  Follow-Up  Maintenance

Follow-Up Details

View ~ Fomat- B Freeze G Detach 1 weap B @ newO Followup O ail

Company Branch Followup Dt Lead # Lead Dt
No data to display.
<

Follow-Up Details

Company
Branch
Follawup Dt
Lead &

[ save and Sty || [ Saveand Retum | {3 Retumn

(%) Close

Status Status Dt

Assigned By
Status
Status Dt

2. In the Status field, click:
— New to view all leads on the Follow-Up screen with status of NEW.

_O r_

— Follow Up to view all leads on the Follow-Up screen with status of FOLLOW UP.

_0 r_

— All to view all leads on Follow-Up screen.

3. Inthe Assigned field, click:

— Assigned By to view all leads on the Follow-Up screen assigned to the current user.

_0 r_

— All to view all leads on the Follow-Up screen assigned to any user.

4. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Company View the company name of sales lead.
Branch View the branch name of the sales lead.
Followup Dt Select the follow-up date of the sales lead.
Lead # View the sales lead number.

Lead Date View the creation date of the sales lead.
Name View the applicant’s name.

Assigned by | View the user assigned to the sales lead.
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Field Do this

Status Select the status of the sales lead.

Status Dt View the last sales lead status change date.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Maintenance tab

The Maintenance tab enables you to attach a sales lead to a different or missed application
or change status of lead as NEW.

To attach a sales lead to an application

1. On the Sales Lead screen, click Maintenance tab.

ORACLE
Financial I Services Lending and Leasing

You can view the following information:

Field View this

Lead # View the sales lead number.

Last Name View the last name of the sales lead.

First Name View the first name of the sales lead.

Status View the status of the sales lead.
Company View the company of the sales lead.
Branch View the branch of the sales lead.

Days of Inac- | View the number of days of inactivity regarding the sales

tivity lead.

2. Select the sales lead you want to attach to the application and click Attach to an
Application button.

3. You can view the following details of application attached to the lead:

Field View this

Priority The priority of the sales lead.
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Field

View this

Application# | The application number of the sales lead.
Date The date of the application.

Title The title of the application.

Product The product of the application.

Status

The status of the application.

Producer

The producer of the application.

If the wrong sales lead was attached to an application, detach it from the existing application
by clicking Change to New Status, then attach it to the correct application clicking Attach to

an Application, completing the App # field, and clicking Post.
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5.2

5. Simple Application Entry

Introduction

The first step in the Loan origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Simple Application Entry screen
enables you to specify information from the credit application into the system and request a
credit bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in the Applications
section. The product defines the type of credit application: Loan as well as any collateral,
such as vehicles or homes, associated with the Loan. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Loan such as Loan amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by the credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

To enter a new application

1. Click Origination > Origination > Simple Application Entry.
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2. The Simple Application Entry screen appears, opened at the Search link’s Results

screen.

ORACLE"
Financial Services Lending and Leasing

e Origination 5
Origination Bearch/Task | Simple Application Entry || Review Requests (Pending: 0)
Origination =
ales Leat Quick Search
Simple Application Entry :
Appliatice; Bty App = ssN Identfication =
Underwiting
Funding Queue [l Next Application
Application Refrievel
SERAS ek > Search Criteria
Application Documents
Image Maintznance o New application
Reports
Producers Search Results/Task
Vendors Viewv Formate | [ Freeze i Detach ) W vewal
Critical Locked Allowed Company Branch App # Date Title Product
No data to display.
<
)
> Servicing
> Collections
> WFP
> Tools
> Setup

[ Close:

Submit

[ Open Application | | [5] View Application Unlock Application

Status Sub Status Q

The Recreate Instance button appears only when the BPEL parameter is YES.

3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s

Applications Entry screen opens at the Simple Application Entry tab.

ORACLE’
Financial Services Lending and Leasing
e Origination 5 [ Close
Origination Search/Task | Simple Application Entry: 0000001533 | Review Requests (Pending: 0) 7~
Origination
ey Application: 0000001533: SIGG MARK
Simple Application Entry
Aepliation Eitry View v Formaty [ Freeze [ Detach dl W OvemideOK v WamingOK v {8 Process Application 5% Pre-Qualify Application
Underwriting Origination Stage Producer Contact & Duplicate
e Dt App # Sub Unit Status Code Producer Nama Number Bwisting Customer Application Contact
Application Retrieval i | 08/05/2015 0000001533 REJECTED - AUTO... NEW CA-D0003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
Reports Application
Producers (aReturn
Vendors
App # 0000001533 Billing Cydle MONTHLY Class SMALL BUSINESS
Dt 09/05/2015 Purpose VEHICLE LOAN OR LEASE Sales Agent DEMOSUPR
Product LOAN VEHICLE (FR) Producer DEALER Joint _
Channel WEB ENTRY Producer Name  CA-00003 @ ACE HEADQUARTERS INC( ACTIVE ) CoSigned
Priority NORMAL R s i Contact
Company US01 Contact Lead # L-00001002 : TEST TEST LAST NAME
B Branch USHQ Number o8 Pull ¥ 0
Sub Unit PI1 Region ALL Override OK V'
Status REJECTED - AUTO REJECTED Teritory ALL Warning OK ¥
Origination Stage Code NEW
Duplicate —
Application
Loan Currency USD
Applicant  Business | Request Collateral ~Comments Tracking Verification
Applicant  Customer Search
Applicant oadd | AEdt | Elview | < Audit
View v Formate  [Ep Freeze i Detach
= Relation Type First Name MI 5N Birth Dt License # License State L
> Servicing fh
= 5 10 PRIMARY MARK DOUGLAS Si6G R 08660 01/03/1985 COLORADO &
> Collections
< >
> WFP
> Tools Address | Employments | Telecoms
v
» Setup

For field description refer Applications of the Underwriting chapter:
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5.3

Copying Lead details

After selecting the sales lead number in the Lead # field and on clicking Copy Lead Details,
the applicant details which were captured in the Sales Lead screen are populated in the
Simple Application Entry screen. The Copy Lead Details button will be enabled only when you
select the lead number in the Lead # field.

Pre-qualifying an Application

After entering the basic details of the applicant like identification and demographic details
along with the address, employment, assets, liabilities and other income information and
requested details, the user has to check whether the application pre-qualifies or not by
clicking Pre-qualify Application button. This is governed by a set of Pre-qualification edits.

If pre-qualified edits are satisfied, the status is changed to NEW-PREQUALIFY APPROVED
and user can modify or update any further details in the Application Entry screen.

If the edits are not satisfied, application will be pushed to REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY REJECTED. You can also view rejected
pre-qualification in the Underwriting screen.

When specific services listed in Dashboard -> System Monitor -> Services tab are 'stopped’,
the application status will display 'NEW PRE-SCREEN APPROVED' and user will not be able
to change the status manually to move it to Underwriting queue. In such cases, services
should be started post which the application is processed automatically by the system and
falls in the appropriate queue as per work flow.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes

e Summary

e Credit Scores

e Duplicate Applicant

e Existing Accounts.
The system uses information on Financial and Liabilities sub tabs to determine the applicant’s
net worth. The system uses information on Employments tab and Other Incomes sub tab to
calculate applicant’s debt-to-income ratio.

Note the following while completing frequency fields:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information, refer appendix Payment Amount Conversion.
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To complete the Applicants Details screen

1. On the Simple Application Entry tab, click Applicant > Applicant.

ORACLE’

Financial Services Lending and Leasing

SHEKAR ~ 1@ Sign out &

2. For details on this screen refer Applicant Tab of the Underwriting chapter.

Business Tab

> Origmat Close
 DashBoard rigination 3]
Origination
Applicant Elvew || < Audit
Origination o7 e
i vew~ Fomatv | B eze [liDetach )
Simple Appiication Eniry Relation Type First Name MI LastName Suffix ssN Birth Dt License # License State Language
Application Entry
No data to display.
Underwiting P - .
Funding
Application Retrieval i
Scenario Analysis Applicant
Application Documents GaRetum
Image Maintenance
n Ty Prior Applica oy
Reports Relation Type rior Applicant _ Bankruptcy Discharge Dt
Producers Salutation Existing Customer __
Vendors First Name Existing Customer ID KYC
Mt Existing Customer #
Last Name Reference #
Famiy Name Other Details Status “
Suffix ] =
Birth Dt Name in Local Language
Gender
SSN
e Mother's Maiden Name Birth Place:
= Birth Country
Emal Education i
L — Permanent LS Resident Status __
Time Zone o
Dependents
Power of Atterney
Identity Information Marital Status
= Power of Attorney __
Nationality Race [I—
> Servicing National ID Ethnicity PR
Passport # Disability __ roniis
> Collections g Privacy '
Passport Issue Dt . riv OptOut Ty
> WFP Passport Expiry Dt Insurnce Optiout. Telephone Number
* Tools Visa # Marketing Opt Out _
License # Share Credit Opt Out __
KRS License State Prior Bankruptcy __ =
About

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving Loan
application during underwriting. The Business Applicant screen is available for Loan and

contains the following sub screens:

To

Address
Telecoms
Financials
Liabilities
Partners
Affiliates
Other details

complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on Application Entry screen.
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2. On the Application Entry

screen, click Business.

ORACLE
Financial Services Lending and Leasing

i Close
g Origination 5 [E3fe
Origination Search/Task  Simple Application Entry: 0000001537 = Review Requests (Pending: 0) a
Qrigination
S Application: 0000001537: RODRIGUEZ ROBINSON [Elview || o Audit
Simple Application Entry "
Application Entry View~ Formaty @ Freeze it Detach 1 wrap @ overideox v waming OK v
Underwriting Origination Stage Producer Contact el Duplicate
it Dt App = Sub Unit Status Code Producer Name Nu Buisting Customer Appiication Contact
Application Retrieval | 08/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
Sieparts Applicant || Business || Request | Collateral || Comments || Tracking || Vertfication
Producers.
Vendors Business | Business Search
Business Details o Audic
View~ Fomat~ [ Freeze A Detach o)
Organiznbon Typs: {BusrcssTyps! | Busiess Catogoey Business Name Lagal Name Tax D # Start Dt Fof Em”“?;f; # of Employeas
| CCoRP. SERVICE SETME INTERSHELL INTE.. INTERSHELL INTE. 0000987 01/01/1968 12 32
4 < >
“
Business Details
&a Retum
Qrganization Type CCOR? # of Employess(Cur) 12 Loan Currency Avg Checking 87790
Business Typs SERVICE # of Employees 32 Balonce
Business Category SETME SHARP # of Locations 34
Business Name  INTERSHELL INTERNATIONAL am Managemert Since 1580
corp 735334066 Existing Business.
Legs| Name INTERSHELL US DOLLAR Existing Business Name UNDEFINED
INTERNATIONAL 2
&l - Existing Business # 0000000000
e ey Aug Chacking Balance 87,750.00
Start Dt 01/01/1968
Address = Telecoms = Finandals Liabilities = Partners  Affiliates  Other Details
> Servicing Address Information View || o Audit
> Collections View ~ Format+ (B Freeze i Detach | wrap W
> WFP Address Type Country Address # Gty State: OwnjlLease Comment Fostal Type Street Pre
BUSINESS UNITED STATES 100 CORPORATE CANTON MASSACHUSETTS ~ RENT NORMAL ADDRESS  NORTH
> Tools < >
v
> Setup

For details on this screen, refer Business Tab of Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested tab

To complete Request tab:
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1. On the Application Entry tab, click Request tab.

Financial Services Lending and Leasing
i i Close.
T Origination x =
Origination Search/Task  Simple Application Entry: 0000001536 Review Reguests (Pending: 0)
Origination
Sy Application: 0000001536: RODRIGUEZ MILDRED view || o audi
simple Application Entry . e =
‘Application Entry View v Formatw [ Freeze o Detach Virap @) OverideOK v  Waming OK v
Underwriting Qriginaticn Stage Producer Contact 3 Duglicate:
sl ot App# Sub Unit Status b Producer Name  {150UCE Existing Customer LBV Contact
Application Retrisval 03/05/2015 0000001536 APPROVED - FUN..  FUNDED CAD0003 : ACEH.. (818)-761-2277 ¥ ¥
Scenario Analysis >
Application Documents
Image Maintenance
Reports Applicant  Business  Request Collstersl Comments Tracking | Verification
Producers
Vendors .
Requested o audit
View Format [ Freeze [ Detach Wrap ]
Credit Limit Advance Promotion
16,900.00 18,500.00 NONE
Requested
Kl <A Retum
“
Credit Limit 18,900.00 Advance 18,900.00 Promotion UNDEFINED
Itemization  Trade-In | Subvention
Itemization Syew || o audit
View v Format~  [5p Freeze 54, Detach ol wrap 50
Ttemization +- Requested Amt Comment
TTM OTHER FEE + 0.00
ITM AMOUNT PAID ON MY LOAN ACC... + 18,900.00
ITM AMOUNT PAID TO OTHERS ON M. + 0.00
ITM AMOUNT GIVEN TO ME DIRECTLY  + 0.00
Total Requestad 18,500.00
> Servicing
> Collections
> WFP
> Tools
> Setup

For details on this screen refer Request Tab of the Underwriting chapter:

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screens: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
screens share. If you are entering an unsecured Loan, the Collateral tab is present but

inactive; in which case, skip this step.
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To enter vehicle information from the Collateral tab

1.

ORACLE"

Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral.

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
‘Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination 5 [ Close
Search/Task | Simple Application Entry: 0000001536  Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED fiew | o Audit
View w Format— [ Fre & Detach p W Override 0K v Waming OK ¥
Origination Stage Producer Contact - Duplicate
ot App # Sub Unit status i Producer Name  Fro%<e Existing Customer (LS Contact
] 050572015 0000001536 APPROVED - FUN... FUNDED CADODI : ACEH... (B18)7612277 ¥ ¥
< >
Applicant | Business | Request  Collateral || Comments | Tracking || Verification
Collateral
Home Evew || 2 aud
Vieww Format [ Freeze E Detach ®
DY Eristing Assetld  Primary  Asset Class Asset Type Sub Type Occupancy Identification #  Country. Address =
N ¥ NEWVEHICE  HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSET ST
< >
‘
Valuation | Tracking
Vvaluation & adit
View v Formatw B Freere Effi Detach &l o]
Loan Currency Usage Value Amt |
Qument . Loen CUTeRY Retal Base Amt (1) valuation ot Source Currency Edition Supplement wholesa
|3 15,000.00 18,500.00 0.00 09/05/2015 INVOICE US DOLLAR
< >
Addons View || of Audit
View » Format~ [P Freeze Bt Detach ol wrap (20}
Description value Amount Loan Currency Amount
ANTI THEFT 230.00 290.00

To enter home information from the Collateral tab

1.

ORACLE'
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On the Application Entry tab, click Collateral sub tab.

DashBoard
Origination
Origination
Sales Lead
Simpie Application Entry
Application Entry
Underwriting
Funding
Apglication Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEFP

> Tools

> Setup

Origination x (3] Close
Search/Task ~ Simple Application Entry: 0000001536 ~ Review Requests [Pending: 0) -
Application: 0000001536: RODRIGUEZ MILDRED Bl vew | o pudt
Viewv Formatv [ Fresze EfiDetach | o Wiap @ overideok v Waming OK v
Dt App= Sub Unit Status g:g;“am" S8 producer Name :ﬁb“‘;’ Contact  Eyicting Customer E:;!I::;fm Contact
[ 09f05/2015 0000001536 APPROVED - FUN..  FUNDED CA-00003 : ACE H... (818)-761-2277 s ¥
>
Applicant | Business | Request| Collateral | Comments  Tracking || Verification
Collateral
Home [El view ||« Aud
View v Fomat~ [ Freeze g Detach i)
Xen0  Bastingassetld  Prmary  Asset Class asset Type Sub Type Oceupancy Identification £ Country Address & A
i~ ¥ NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 'UNITED STATES ‘480 NEPONSET S1
4 <
4
Home
{3 Retum
Buisting_ State MASSACHUSETTS Legal Deseription
Asset County NORFOLK Lot 23
g Sub Division
-ﬁ;mt u . Type & Description st
il Census Tract / BNA Code Niebes-Boninds.
t NEW HOME -
Aﬂﬁ‘ass o MSA Code Flood Zone
ReETipe GEO Code 1098 Not Required ¥
] quire
Sub Type SINGLE FAMILY HOME Condition GOOD CONDITIGNED
Occupancy OCCUPIED BY OWNER AS PRINCIPAL RESIDENCE Description 3015 INVERNIZZT e
Identification E26A119602 CONSTRUCTION CO VILLA
: Year 2015 Construction Permit Dt 01/30/2016
ribe Age 0 Desd Dt 01/30/2016
g Make INVERNIZZI CONSTRUCTION D« F
Country UNITED STATES ueaidPIacafD Issue AMESBURY
P rties Bou om East
Address # 480 NEPONSET 5T R o roper undary from =
‘ddress Line width 1200 N: :
west
] Length 3400 i
Address 16 RS e -
P PO # 122 RABEIT
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If collateral is any other, the Collateral link displays information about that collateral.

ORACLE’
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DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Froducers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x (3 Qoze
Search/Task  Underwriting: 0000001533 | Review Requesis (Pending: 0) ~
Application: 0000001533: SIGG MARK A Edt || Elvew || & audt
Viewy Formate [ = Hfivetach  Jwap | B OvenideOK ¥  Waming OK v
Origination Stage Producer Contact 2 Duplicate
Dt App = Sub Unit Status Code Producer Name Nur Existing Customer Application Contact
‘\D‘J[ﬂSﬂZEILS 0000001533 REJECTED - AUTO... NEW CA-00003 : ACEH.. (818)-761-2277 N N
>
Summary | Applicant || Business || Request || Dedsion | Bureau | Collateral | Comments | Tracking | Document | Verfication | Comespondence = Teols
Collateral | Seller
Other Collateral E view || < Audit
View  Fomat~ B Freeze fiDetach | ol Wrap B Existing Asset 1d hd
zsh;”g Existing AssetTd Primary  Asset Class Asset Type Sub Typs Status Year Age Make Model
In B ]
N oy NEW VEHICLE VEHICLE CAR NOT DEFINED 2015 0 AUDI A4
< > 5
Other Collateral
A ssveandadd | Bl Saveand Stay || [ Save and Retun || 3 Retum
Existing Asset Body z =
Existing Asset Id = Registration # UNDEFINED Zip Extn
* Frimary ] e
Identification #
* Asset Class NEW ASSET [v] Gity
Description T
F—— State [v]
Aezel Tye [HOUEEHOLD HO00S ¥ Condition GOOD CONDITIONED [~ M ~
g v
= Sub Type | GENERAL HOUSEHOLD GOODS / EC[v | =
* Status |NOT DEFINED [v] Address Usage Details
= Country UNITED STATES [v] %
Select Make and Model - " Start |0
Address 2 %
ek [ B i Basz 0
ddress Line 1 -
Age i *Bxra 0
Make burslint =Total 0
Model * Charge Amt 0.0
Valuation | Tracking v

For details on this screen, refer Collateral Tab of the Underwriting chapter.

Comments Tab

When using the Simple Application Entry screen, you can add comments to an application at
any time in the application entry process by clicking Comments tab.
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To complete the Comments tab

1. On the Application Entry tab, click comments.

ORACLE
Financial Services Lending and Leasing
DashBoard i
Origination Search/Tesk  Simple Application Entry | Review Requests (Pending: 0)
Originaticn
s L i
Sy Application
Simple Application Entry 5
Application Entry View v Format~ cze L Detach ] Wrap @ Override OK __ Warning OK __
underariting Origination Stage Producer Contact
s ot App % Sub Uit Status ik Producer Name ([ oCL<
Application Retrival No d(a!a o display.
Scenario Analysis
Application Documents.
Image Maintenance
Reports Applicant | Request = Comments —Tracking | Verification
Froducers
Vendors
Comments
Viewv Formaty B Freeze i Detach Wrap 5]
Aot Type Sub Type Comment
U REGULAR [v] | Loan oRIGINATION [v]
4
> Servicing
> Collections
> WFP
> Tools
> Setup

| Bl seve and stay || Bl save and Retum || Gagetum

Fadd | Aede | 5 view || o audic
Bsting Customer  DuPlicats Contact
Application
>

Comment By Comment Dt

PRAKRRAQ' 102/04/2016 05:54:58 AM

For details on this screen, refer tabtabComments Tab of the Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.

What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click the Tracking tab.

ORACLE" & Welcome, VAVAIDYA ~ o
Financial Services Lending and Leasing

R Origination x (3 Qlose

Origination Search/Task  Simple Application Entry | Review Requests (Pending: 0)

Origination

Sales Lead Application e add | Edit View || < Audit
Simple Application Entry
‘Application Entry View » Formatw [ Freeze ! Detach Wrap @ Overide OK_  Warning OK __
l:::jr’:;mmq ot App % Sub Unit Status Oigination St20°  producer Name Col Existing Customer E:;"‘f::in Contac
~Application Retrieval s S Rl
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Applicant || Request || Comments = Tracking | Verffication
Vendors
Tracking Attributes | Field Investigation
Tracking Attributes A Edit || of audit
View + Formatw (B Freeze ffi Detach Wrap 7] o Load Tracking

Sub-Parameter Parameter value
No data to display.

> Servicing
» collections
> WFP
> Tools

©» Setup

For details on this screen, refer Tracking Tab of the Underwriting chapter

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

Ifitis an Error, the system will not allow you to change application’s status and approve Loan
until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

To validate a credit application

1. Enter all the information associated with the application on the Application Entry screen.
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2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing

& welcome, vavaova - [ElSETGIGN O

V Close
DashBoard Origination —

Origination Search/Task  Simple Application Entry Review Requests (Pending: 0)

Application
View v Formaty B Freeze & Detach Wrap T Overide 0K

dadd | AEdt || Elvew || & audit

Pr

e
ot App # Sub Unit Status Producer Name Co Bxisting Customer  UPlicate Contac
o Application

No data to display.
< >

Applicant | Request | Comments | Tracking Verificatiort

Edits

Edit Types

View~ Format~ [ Freeze i Detach Wrap 0] Edit Type [V] 48 Check Edits
Date Edit Typ:
No data to display.
Edit Details
View w Formatw |58 Freeze [ Detach Wrap 50

Edit Name. Resuit
No data to display.
<

Expected Value  Actual Value  Override Responsibility

> Servicing
> Collections
> WEP

> Tools

> Setup

For details on this screen, refer Verification Tab of the Underwriting chapter.

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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5.10 Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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6.1

6.2

6. Application Entry

Introduction

The first step in the Loan origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Application Entry screen enables
you to specify information from credit application into the system and request a credit bureau
report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in Applications
section. The product defines the type of credit application: Loan as well as any collateral,
such as vehicles or homes, associated with the Loan. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Loan such as Loan amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen. Pre-
qualification edits can be viewed from the 'Verification' sub tab.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

Credit Application via External Interface

You can also load credit applications created in external system into Oracle Financial
Services Lending and Leasing for further processing.
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OFSLL integrating with external system facilitates to transfer the pre-populated credit
application data into the system through an xml file. Such credit applications are categorized
in OFSLL as either 'eCONTRACT/DEALER CONTRACT in the actions section. However,
OFSLL generated credit applications are marked as MANUAL CONTRACT.

Once a credit application is successfully validated and loaded in Application Entry screen, a
response is sent back from OFSLL to the external system. Similarly, all subsequent status
changes initiated in OFSLL are updated to the external system. All communications between
OFSLL and external systems are recorded into a log and is accessible through Dashboard >
System Monitor > Database Server Log Files screen. Also the ‘Comments’ screen facilitates
to exchange information regarding credit application processing between OFSLL and external
system as comments, provided the comment Sub Type is selected as 'OUTBOUND TO
INTERFACE' for such communications.

Hence effectively you can by-pass the need to re-create the application in OFSLL and helps
in faster processing of credit applications and decision making.

To enter a new application
1. Click Origination > Origination > Application Entry.

2. The Application Entry screen appears, opened at the Search link’s Results screen.

ORACLE’
Financial Services Lending and Leasing

: Close.
> DashBoard Origination x —

Origination SearchfTask | Appication Enfry | Review Requests Pending: 0)

Quick Search

App # ssh Identification # [ scbmit
Queue [=] | BB bextAppication
> Search Criteria
o New Application | | [ Open Application Unlock Application
Search Results/Task
vew~ Fomatv [EJ| (e flivetach | o weap W vewn @

& %FUNDED%

GitLod Al Company  Branch App # Date Tile Product Status 5ub Status
No data to display.

Columns Hidden 1
4

> Servicing
> Collections
- WFP

> Tools

- Setup

The Recreate Instance button appears only when the BPEL parameter is YES.
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3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Application Entry tab.

ORACLE
Financial Services Lending and Leasing

Origination
 DashBoard sl
Origination Search/Task  Application Entry: 0000001105 | Review Requests (Pending: 0)
Qrigination A
Sales Lead Application: 0000001105: HOOD MARK AEt | [¥en | o At
j'mi"g :ppllgai;nn L View » Format v E [ Freeze ﬁ‘ Detach cﬂ Wrap @ﬂ Overide OK ¥ WarmingOK ¥ {0 Process Application 40 Pre-Qualfy Application
pplication Entry i
Underwriting 6’ Eb it
Funding Sub Origination Producer Existing  Duplicate
Application Retrieval ot App # it Stetus Stage Code Frodicer Name Contact Number Customer Application Sales Agent
Scenario Analysis 08/01/2015 000000105 | NEW-REVIEWREQUIRED REVIEW | CA-00009:HARRYMOTO.. (515)-8879876 N N DEMOSALES
Application Documents| 4 Ul }
Image Maintenance
Reports l}
Froducers Application
Vendors B Save and Stay B Save andRetum || (aRetum
| e
3 App # 0000001105 *8ling Cyde MONTHLY = *Class INDIVIDUAL =)
+ i
Dt 08/01/2015 & Purpose VEHICLE LOAN OR LEASE = Sales Agent DEMOSALES
® \ 3 * i
; Product LOAN VEHICLE (FR) B * Producer DEALER. g y Jmn; H
* " CoSigne:
oot (M N B <rodicebane cadoons ek MoTORS(ACTIE) & L
* Priority NORMAL E| Producer Contact (618)-887-9876 e
Nurber #
*Company LUS01 [+ Lead [+
Region ALL +crg pul m
*Branch LSH Territory 7
Q = erritory ALL * Ouerride Ok 1
Sub Unit SUB_UNIT1 Exdsting Customer __ *\arming OK ‘-ﬂ
Status NEW -REVIEW REQUIRED Duplicate __ e
Origination Stage Code  REVIEW Application
Loan Currency  USD
Summary Applicant | Request Dedsion  Bureau Collatersl Comments Tracing Document  Verification  Correspondence  Tooks

For details on this screen refer Applications section in Underwriting chapter.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes sub screens
e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts
e Tracking Attributes

The system uses the information on the Financial and Liabilities sub tabs in determining the

applicant’s net worth. The system uses information on the Employments screen and Other
Incomes sub screen to calculate the applicant’s debt-to-income ratio.
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To complete the Applicants Details screen

1. On the Application Entry tab, click Applicant > Applicant.

ORACLE ABSHEKAR ¥ 1 Signout &
Financial Services Lending and Leasing
inatic Close
T Originatian x [l
Origination Applicant
Save and Stay Save and Return Retun
Origination = d d &
Sdestead | | R o
= " = rior Applcant ; E,
Simple Applicat] Relation Type | COSIGNER [=] ool Bankruptzy Discharge Dt 73
Existing Customer _
application Ent] Salutation [=]
- Existing Customer ID NONE [0] KvC
i *First Name | RAF Existing Customer # 0000000000
Funding
Mt Reference ¥
ppamrae| Other Details
Scenario Analy| * LastName | GERWYH] Status [+l
| “
Application Do Family Name Name in Local
Image Mainten| FATCA
Qe Suffix EI Language I}i
Reports - @ Gender UNDEFINED [=
Producers Bithot 07/04/1590 By Birth Place
3 Mother's Maiden Name
Vendors SN XXK0X-4564 Birth Country =
& Education [=] -
Class | NORMAL B3] Permanent US Resident [F]
A e *+Language ENGLISH [=] Status
£ *Dependents 0
Tine Zone [+ Power of Attorney
Marital Status [=]
Identity Tnformation ECOA THDIVIDUAL = Power of Attorney [0 A
Race = Holder Name
* Nationality USA Address
Ethnidty =
*National D 4-654-1561 - Loy
Passport & *Dishbty ;‘ Natonality
= * Privacy opt out [ Telephone Number
- Passportlosue Ot o * Insurance Opt out [
] ’ Passpart Expiry Dt & * Marksting Opt out [7]
> Servicing Viea & * Share CreditOpt out [
 Collections License # *prior Barkruptey [
> wrp License State [=]
> Tools Address | Employments | Telecoms | Summary || Credit Scores | Duplicate Applicant | Existing Accounts || Tracking Attributes
> Setup
About

For details on this screen refer Applicant Tab section in Underwriting chapter.

Business Applicants Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving the Loan
application during underwriting. The Business Applicant screen is available for Loan and

contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

e Affiliates

e Other details

To complete the Business Applicant screen

1. If SME business information is included on the application, select SMALL BUSINESS

inClass field on Applications section and click Save.

The Business tab appears on the Application Entry screen.
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2. On the Application Entry screen, click Business.

ORACLE

Financial Services Lending and Leasing

& welcome, DEMOSUPR 2 signout O
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Simple Application Entry
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Type *2of g Balance
5 5“5:}’255 Employees *zof
ame
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Business il
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Mo data to display.
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For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested link

To complete the request tab:
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1. On the Application Entry tab, click Request tab.

‘DRACLE
Financial Services Lending and Leasing

Fe— Close
i Origination =
e by Search/Task  Application Entry: 0000001015 Review Requests (Fending: 0)
Origination
SalesLead Application: 0000001015: K NAVIN Elven || o At
Simple Application Entry i - 2 o
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Application Entry & o = : L > = ‘
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Application Documents
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View » Formatw [ Freeze [fiDetach | ¢l Wirap 5]
Itemization +- Requested Amt Comment
TTM OTHER FEE + 0.00
ITM AMOUNT PAID GN MY LOAN ACEO... + 0.00
ITM AMOLINT PAID TO OTHERS ON MY ... + 0.00
ITM AMOUNT GIVENTO MEDIRECTLY  + 35,000.00
Total Requested Amt 35,000.00
» Servicing
> Collections
> WFP
> Tools
» Setup

For details on this screen refer Request Tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays credit report (if pulled) for an applicant. If there is a need for another
pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab

1. Open the Application Entry screen and load the application you want to work with.
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2. Click Bureau

ORACLE’
Financial Services Lending and Leasing

iginati Close
T Origination x [E]
Origination Search/Task | Application Entry | Review Requests (Pending: 0) -
Origination *
Sales Lead
Simple Appication Entry
Application Entry Applicalion Fpadd | SEdt | [Fvien | of Audt
Underariting view = Format v [f5H| Freeze  EffDetach 1] Wrap @ overideck _ WamingOK _
Funding o
Application Retrieval ¢ % = ey — T
: 4 u rigination roducer xistng  Duplicat
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Image Maintenance T = = 3
Reports
Producers
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Bureau Details qpadd | ZEdt | [ view | o Audi
g IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissible purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable
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View v Formatv  Ep Freeze ffiDetach | ol Wrap @) 3 submitRequest
Type Bureau # Status Dt Report S’S“j‘;";ﬁ“
No data to display.
< NI »
Bureau Details
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Bureau Details
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> Servidng Applicant/Customer Details
> Collections i Brevious Dext ast
> WFP
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> Tools First Name Include Debt State
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For details on this screen refer Bureau Tab section in Underwriting chapter.

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screen: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
link’s screens share. If you are entering an unsecured Loan, the Collateral link is present but
inactive; in which case, skip this step.

To enter vehicle information from the Collateral tab
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Collateral link displays information about the vehicle

ORACLE"

Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral. If the collateral is a vehicle, the
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‘Origination
Sales Lead
Simple Application Entry
Application Entry
Undenwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination x

Search/Task

Simple Application Entry: 0000001536

Application: 0000001536: RODRIGUEZ MILDRED

Review Requests (Pending: 0)

View~ Formate [ Freeze i Detach J wrap W overideOK v  Warning OK v
ot app = Sub Unit Status Qrighelion S0e | oroducer fame FrodUcer Contact
[0 osjosy2015 0000001536 APPROVED - FUN... FUNDED CADOD03 : ACEH... (818)-761-2277 ¥
Applicant | Business || Request | Collateral | Comments | Tracking || Verfication
Collateral
Home
View v Format~ [ Freeze  FiDetach ol Wrap 5]
ME"E;”Q Existing Asset1d  Primary  Asset Class Asset Type Sub Type Oceupancy Identification #
in B NEW VEHICLE HOME SINGLE FAMILY H.. OCCUPIED BY OW. . E26A119602
il <
valuation | Tracking
Valuation
View » Format-  [Ep Freeze i Detach irap 5]
an Currency i Usage Value Amt
Cument R e Retail Base Amt {1 veluation Dt Source Currency Edition
¥ 15,000.00 19,500.00 0.00 03/05/2015 IWOICE US DOLLAR
<
Addons
View » Fomstw [Ep | wrap (5]
Description Value
ANTI THEFT

Existing Customer

Country Address #
UNITED STATES 480 NEPONSET 5T
>
4
B view || o awit
Supplement Wholess
>
View || P Adit
Amount Loan Currency Amount.
290.00 290.00

[ Close.
Bl o || 2 pudit
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If the collateral is a home, the Collateral link displays information about the home.

ORACLE’
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No data to display,

If the collateral is any other, the Collateral link displays information about that collateral.
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6.9

For details on this screen refer Collateral Tab section in Underwriting chapter.

ORACLE
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Comments Tab

When using the Application Entry screen, you can add comments to an application at any time
in the application entry process by clicking the Tracking tab.

To complete the Comments screen

On the Application Entry tab, click Comments.

ORACLE’
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d

For details on this screen refer tabtabComments Tab section in Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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6.10.1

To track attributes

1. On the application entry screen, click Tracking tab.

ORACLE’
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For details on this screen refer Tracking Tab section in Underwriting chapter.

Document Tab

Document Sub Tab

Application Entry’s Documents screen enables you to view Application Documents and
Application Documents Details.
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For details on this screen refer Document Tab section in Underwriting chapter.
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Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

If it is a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed,;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move application to queue of the user with required authority.)

To validate a credit application
1. Enter all the information associated with the application on the Application Entry screen.

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.
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Application Entry & dh @ = 3 g
jic N sul Origination Producer Existing  Duplicate
Unddemmhng Dt App # tnit  Stats Stage Code  Producer Name Contact Mumber Customer Application C7¢t Sales Agent
Funding No data to display.
Application Retrieval o = o ¥
Scenario Analysis
Application Docments
Image Maintenance
Reports summary | Applicant = Request Dedsion  Bureau | Contract —Comments | Tracking  Document —Verfication | Correspondence
Producers
Vendors Edits Audits History
Edit Types
View v Format~ [P Freeze i Detach tirap @ Edit Type [=] 4§ ChedEdis
Date Edit Type
No data to display.
4
v
Edit Details
View v Formatw B Freeze 5t Detach Wrap ;]
Edit Name Result Expected Value Actual Value Override Responsiility
No data to display.
> Servicing
 Collections
> WEP
> Tools
 Setup

For details on this screen refer Verification Tab section in Underwriting chapter.
Tools tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer Tools chapter.
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6.12.1

6.13

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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7. Underwriting

71 Introduction

Underwriting is the next step after application entry in Loan origination cycle. At the beginning
of underwriting process, the application has been entered into Oracle Financial Services
Lending and Leasing, receiving an application number. The application, then passes through
the initial prescreening checks, and receives a credit bureau report. (Credit bureau pulls are
based upon zip code setup.) The system assigns it a custom credit score and based on this,
the application automatically updates its status and sent to the appropriate queue. In doing
s0, one of three things happen to the application:

The application passes all the prescreening requirements and is automatically approved
based on the auto-decisioning process. The system, then, automatically notifies the
producer with a decision fax. You can use the Underwriting screen to view the
application and decision information and proceed to funding.

The application fails the prescreening requirements and is automatically rejected based
on the auto-decisioning process. Again, the system notifies the producer with a decision
fax. You can use the Underwriting screen to view application and decision information.
Also, you can rehash the application.

The application receives a status requiring a manual review and is sent to the
underwriting queue. It is now up to the underwriter to verify data and manually change
the status of application using Underwriting screen.

This chapter explains how to use the Underwriting screen to complete the following tasks:

Loading an application on the Underwriting screen
Verifying the applicant information

Verifying the credit bureau data

Calculating and validate the debt-to-income ratios
Requesting a credit bureau report manually
Adding comments and tracking attributes

Making a decision about an application

Verifying the edits

Rehashing an application

Ageing an application.

Review Requests

7.2 Underwriting Screen - an overview

The underwriting process follows these basic steps:

Opening the Underwriting screen and loading the application you want to work with.
Viewing and verifying information about the applicant supplied during application entry.
Viewing information from the credit bureau report.

Viewing and verifying information regarding the collateral, if present.

Viewing and verifying information regarding the trade-ins, if present.

Calculating and validating the debt-to-income ratios.

Selecting the pricing for the application.
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7.3

7.3.1

e Specifying information regarding stipulations, itemizations, check lists, and rate
schedules (variable rate Loan only), if required. (The checklist can be configured to
display a list of tasks to follow when using the Underwriting screen.)

e Making a decision on the Loan (APPROVE, REJECT, or CONDITION).
e Performing an edits check to verify the information on Underwriting screen.

e Viewing errors and warnings from the edits check and make the required corrections to
the data.

e Changing the status of the application.

Loading an Application on the Underwriting screen

The first step in the underwriting process is to load the application you want to work with. For
details about using the Loading an application, refer Searching for an Application in the
chapter Search Function.

Applications

The Underwriting screen’s Applications section appears at the top of the screen opened from
Underwriting master tab. The screen displays the application number and name on the
header and contains information such as application purpose, product and producer.

In this section, you can perform any of the Basic Operations mentioned in Navigation chapter

ORACLE"
Financial Services Lending and Leasing

: o
DashBoard Origination —

Search/Task | Underwriting | Review Requests (Pending: 0)

Application
View~ Formatv B

No data to display.
< >

Application

Super Summary

Applicant

> Servicing
> Collections
> WFP

> Tools

> Setup

sssss

A brief description of the fields is given below:

Field: View this:

App # The application number

Dt The application date

Product The Loan product of the application.

Channel How the application information was received.
Priority The priority of the application.
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Field:

View this:

Company The company of the application.

Branch The branch of the company.

Sub Unit View the Sub Unit associated with the company/branch
combination. System automatically displays the Sub Unit
mapped in Setup > User > Companies > Branch Definition
screen.

Status The status of the application.

Origination Stage Code

The origination stage code of the application.

Billing Cycle

The billing cycle of the application. System displays the
applicable billing cycle by default based on the product
and the calculation method defined at Setup > Products
screen. The editable nature of billing cycle is controlled by
the system parameter UIX_BILL_CYCLE_AL-
LOWED_IND. However, for Rent Factor type of lease cal-
culation, only ‘Monthly’ is applicable and system displays
an error on save if any other value is selected.

Purpose

The purpose of the application.

Producer

The producer type and producer of the application.

Producer Name

The name of the producer of the application. The Producer
Name is displayed as a hyperlink and clicking on the same
will open ‘Producers’ page with details of the producer.

Producer Contact Num-
ber

The system displays the contact number of the producer.

Region

The region of the producer.

Territory

The territory of the producer.

Existing Customer

Indicates if the customer is an existing customer.

Duplicate Application

Indicates if the application is a duplicate application.

Loan Currency

The Loan currency of the application.

Class The class of the application.

Sales Agent The sales agent of the application.

Contract Type The type of application. ‘Manual’ indicates OFSLL gener-
ated application, where as ‘eContract/Dealer’ indicates
that application is generated from external system.

Joint If selected, indicates this is a joint application.

Cosigned If selected, indicates this is a co-signed application.

Contact The contact of the application.
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7.3.2

Field: View this:

Lead # The lead number will appear in the list only if a lead is
already created using the Sales Lead link.

CRB Pull Check this box to pull an initial credit bureau report, after
the application passes the pre screen edits. Uncheck the
box, if you want to enter an application without pulling a
credit report. To use a previously pulled credit bureau
report, uncheck this box and specify the Bureau and
Bureau Reorder # fields on the Primary Applicant screen.

Override Ok Check this box to ignore the overrides.

If the application has been marked as ‘Override OK’ then
the system would allow you to change the application sta-
tus even when override condition exists.

Warning Ok Check this box to ignore the warnings.

If the application has been marked as ‘Warning OK’ then
the system would allow you to change the application sta-
tus even when warning exists.

Proxy for Underwriter If you are acting as a proxy for an Underwriter, then you
can select the Underwriter’'s name from the adjoining
options list. The list displays all the associated Underwrit-
ers, Underwriting Supervisors, and Underwriting Manag-
ers.

However, this is not mandatory and can be used while
auctioning an application on behalf of another underwriter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Changing the Status of the Application

You can use underwriting screen’s Applications master screen to change the status and sub
status of the application.

To change the status of the application

1. On the Underwriting form’s Application master screen, change the status of application
to either APPROVED, CONDITIONED, or REJECTED in the Status field and click Save.

The system checks the information on the Underwriting form using guidelines
established during implementation.

The system finds an error based on these guidelines, a Warning message appears
stating “Validation Error exist, Unable to Change the status. Please check the Edits.”

2. Click the Verification link and begin verifying edits on the Edits screen (For more
information, see the Verification link section in this chapter.)

During status change:

e Ifthereis an errorin the edit, system displays an error message as ‘Errors exist. Cannot
change status. Please Verify Edits.” and previous status is retained.

e Ifthere is an edit which requires override, the system displays an override message as
‘Override Required. Do you want to continue?’

— If you select ‘Yes’, the system will continue with OVERRIDE_REQUIRED
processing by changing the status.
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7.3.3

7.3.4

7.4

— If you select ‘No’, the system will change the status back to old status.

During status change, if there is a warning in the edit, the system displays an error message
as ‘Warning Exists. Do you want to continue?’.

o If you select ‘Yes’, the system will continue processing by changing the status.
e If you select ‘No’, the system will change the status back to old status.

Rehashing an Application

Once the application moves to status of APPROVED, REJECTED, or CONDITIONED status,
you cannot amend the information. However, you can amend the application, by changing the
sub status of the application to REHASHING.

To Rehash the Application

1. Open the Underwriting screen and load the application you want to change with the
APPROVED, REJECTED, or CONDITIONED status.

2. Inthe Applications master section, select REHASHING in the Sub Status field and click
Save.

After you enter the information required in the application, you can change the status to
APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more information,
refer Decision Tab section in this chapter.)

Once the status is changed to Approved, Rejected, conditioned, or Withdrawn, you
cannot make further changes to the information on the Decision tab.

Aging an Application

The Underwriting screen can be configured so that applications will be moved to a separate
queue after a certain amount of time. (This time frame is determined in setup). This
applications receive a sub status of AGED APPLICATION. This housekeeping function allows
you to keep your system free of stagnant application by moving them into an archive.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, you can view the following details in their respective sections:

e Super Summary

e Applicant
e Ratios

e Bureau

e Checklist
e Collateral
e Trade-In

e Requested

e Approved

e Decision Itemizations

e Decision History

e Comments

e Stipulations/Adverse Actions
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To view the Super Summary
1. Open the Underwriting screen and load the application you want to work with.

2. Click Summary tab. By default the system opens the summary tab. Expand the Super
Summary section.

oRacte

Financial Services Lending and Leasing

> DashBoard Origination x (3] Cose
Origination Search/Task  Underwriting: 0000001015  Review Requests (Pending: 0)

Origination
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Funding
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T . g Origination Stage.
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Producer Name Co Bxisting Customer Contact Sales Agent Branch Proy
i

Vendors
Super Summary

Super Summary

Applicant Requested <
Relation Type PRIMARY Req. CrLimit 200,000.00 Req. Advance 35,000.00
Name NAVINK
S5 200008677 Decision
National Id -84 Credit Limit 200,000.00 DrawTem 6
Birth Dt 12/02/1967 Rate(%) 13.9800 Repayment Term 24

Address AR NAR1BCHN = AR2 AR3
COAMO PR 00769 US

Contract
Phone (( -000-0000 Credit Limit 0.00 DrawTerm 0
Qwin or Rent  QWNNS HOME First Pmt Dt Repayment Term 0
Stated Amount(Monthiy) 0.00 Term 0
00

Actual Amount{
G Secng Stated Time at Residencel i
> Collections Actual Time at Residencel 0
> WER {53 Verify Address

> Tools

Employment @
> Setup -
Twne FUIL TIME

The Super Summary tab provides a snapshot of all relevant details in a single screen and
contains details of Applicant, Employment, Ratios, Bureau, Requested financials, Decision
updates, Contract updates and Primary Collateral details. You need not have to navigate to
each of these tabs for specific information on the application. Also clicking on the hyperlinks
of Address, Employment, Ratios, and Trade-In helps you to directly navigate to respective
tab(s),

During the Underwriting and Funding stages, 'verified' button is displayed just below the
address and employment details for each of the applicants. This would be enabled only when
the Verified by and Verified Dt in the respective tabs are blank. You can verify the details from
the Super Summary tab. Clicking on Verified will do the following:

1. System will copy the stated values to Actual values.

2. System will stamp the “Verified By” as 'User Name' and 'Verified Date' as 'Current GL
Date' for the respective applicant.

3. If'Verified Details' are already updated in tab or if the details are stamped, this button will
be disabled.

4. ‘'Verified' button will be available when 'Actual Amount' equal to ZERO or 'Verified By' or
‘Verified Date' is NULL.

You need not navigate to Address and Employment tab for verifying applicant details.

Decision details will be displayed when application has Origination Stage as “Review,
Decisioned, Contract or Funded”. In case an application is Rehashed, only Decision
information will be displayed and Contract information will not be displayed. Contract details
will be displayed when application has Origination Stage as “Contract or Funded”.

The system displays the collateral details maintained in the collateral tab on click of navigation

button under the headings Primary Collateral and Secondary Collateral. Collateral details for
Unsecured loan also will be displayed if they are maintained.
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7.5

All the trade-in details, if any, maintained in the application would be displayed on click of
Navigation button.

Applicant Tab

Having selected and loaded an application, you can view the information about applicant in
the Applicants tab. This is information that was recorded on the Application Entry screen or
gathered during the credit pull. You can edit data from the Application Entry screen at anytime
in the following steps. Remember to save your work with each change. Information from the
credit bureau pull is available to view only.

Using the information supplied on the application, complete the Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

e Tracking Attributes

Primary Applicant details are required for SME applications also. The system uses
information on the Financial and Liabilities sub tabs in determining the applicant’s net worth.
The system uses information on the Employments screen and Other Incomes sub screen to
calculate the applicant’s debt-to-income ratio.

To verify applicant information on the Underwriting screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Applicants tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

ORACLE HEAR > 1 Signout O
Financial Services Lending and Leasing
Close
> DashBoard Gopmation mg
Origination Applicant
Save and Stay Save and Retum Return
Origination * E 8 CB
Sales Lead P ksl A
. 1 = rior Applcant _ y Dischar B,
Simple Applicat Relation Type COSIGNER [+ ol Bankruptey Discharge Dt D
Existing Customer __
Application Ent Salutation =
Existing Customer 1D NONE [0] Kve
Underwiting S -
First Name: Existing Customer # 0000000000
Funding
ML Reference #
Applcation Re| Other Details
Scenaria Analy *Last Name | QERW/YH) Status [l
| “
Application Dog Famiy Name Name in Local
Image Mainten| FATCA
g i = Language B
Reports = Gender UNDEFINED =
Producers *Birth Dt 07/04/1990 bl Birth Place
: = Mother's Maiden N
Vendors =SSN NX0K-A554 R e =
5 Education [=] =
Class NORMAL [+ Permanent US Resident ]
*Language | ENGLISH -
: Email guage [z Status
B *Dependents 0
Time Zone [+] Power of Attorney
Marital Status [=]
Identity Information ECOA | INDIVIDUAL = Power of Attorney [ A
oy = Holder Name
*Nationality USA ) Address
Ethricity [+l
* National ID 4-654-1561 . Country
Passport £ Disabiity | Natonality
= *Privacy Opt Telephone Number
.l Passport Issue Dt ) ol
i ' Passport Expiry DE & * Marketing Opt
> Servicing Visa # * Share Credit Opt
* Collections s * prior Bankruptey [
> WP License State [=]
) Address | Employments || Telecoms || Summary || Credit Scores | Dupicate Applicant | Existing Accounts | Tracking Attributes
> setup

About.
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A brief description of the fields is given below:

Field

Do this

Relation Type

Select the relationship type from the adjoining drop-down list. For
example, primary, spouse, secondary, or cosigner.

Salutation Select the salutation from the adjoining drop-down list.
First Name Specify the applicant’s first name.

Mi Specify the applicant’s middle name.

Last Name Specify the applicant’s last name.

Family Name

Specify the applicant’s family name.

Suffix Select the name suffix/generation from the adjoining drop-down list.

Birth Dt Specify the applicant’s date of birth.

SSN Specify the applicant’s social security number.

Class Select the classification of the applicant from the adjoining drop-down
list. For example, NORMAL or EMPLOYEE. The system uses this
information to restrict access to the database by recognizing employ-
ees as ‘secured applications’.

You can create a SME (Small Medium Enterprise) application by
selecting SMALL BUSINESS. When you select SMALL BUSINESS
and save your entry, the Business Applicants link on the Applicants
link is available. (required).

Email Specify the personal Email ID of the applicant.

Time Zone Specify the time zone to which the applicant belongs. This information

appears when you enter and save the zip code for the primary appli-
cant’s current home address on the Address sub screen. You can also
manually complete this field.

Identity Informa

tion Section

Nationality Select the applicant’s nationality from the adjoining drop-down list.
National ID Specify the national identification number.

Passport # Specify the passport number.

Passport Select the date on which passport was issued.

Issue Dt

Passport Select the passport’s expiration date.

Expiry Dt

Visa # Specify the applicant’s visa number.

License # Specify the applicant’s license number.

License State

Select the state where the license was issued, from the adjoining
drop-down list.
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Field Do this

Prior Appli- Check this box to indicate that the customer is an existing customer.

cant

Existing Cus- | Check this box to indicate that this applicant has a previous account.

tomer

Existing Cus- | Specify the customer ID if the applicant is an existing customer.

tomer ID

Existing Cus- | Specify the customer number if the applicant is an existing customer.

tomer # On saving the applicant details, the data in ‘Existing Customer # is
displayed as a link in ‘Applicant’ section header and clicking on the
same will display the customer details in Search Results section of
Servicing module.

Update Cus- Check this box to indicate if system can override the existing cus-

tomer Info tomer information and create the record with latest address and com-

munication details of the customer.

Other Details section

Name in Local

Specify the applicant’s name in local language.

Language
Gender Select the gender of the applicant from the adjoining drop-down list.
Mother’s Specify the mother’s maiden name.

Maiden Name

Education Select the education of the applicant from the adjoining drop-down
list.

Language Select the applicant’s native language from the adjoining drop-down
list.

Dependents Specify the number of dependents.

Marital Status

Select the marital status of the applicant from the adjoining drop-down
list.

ECOA Select the ECOA (Equal Credit Opportunity Act) code, from the
adjoining drop-down list. This defines the various possibilities on who
is liable; individual, joint, cosigner and so on.

Race Select the applicant’s race from the adjoining drop-down list.

Ethnicity Select the applicant’s ethnicity from the adjoining drop-down list. This
is the information the Home Mortgage Disclosure Act requires to be
reported.

Disability Check this box if the application has a disability.

Privacy Opt Check this box to indicate that the applicant has elected to refrain

Out from the non-public sharing of information.

Insurance Opt
Out

Check this box to indicate that the applicant has elected to refrain
from insurance related inquiries.
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Field

Do this

Marketing Opt
Out

Check this box to indicate that the applicant has elected to refrain
from marketing related inquiries.

Share Credit

Check this box to indicate that the applicant has elected to refrain

Opt Out from financial information and share credit related inquiries.
Prior Bank- Check this box if prior bankruptcy exists.

ruptcy

Bankruptcy Enter the discharge date of prior bankruptcy (if one exists).

Discharge Dt

KYC Section

Reference #

Specify the reference number.

Status Select the status of the applicant from the adjoining drop-down list.
FATCA Section

Birth Place Specify the birth place of the applicant.

Birth Country | Select the country of birth of the applicant.

Permanent US | Check this box if the applicant has permanent US resident status.

Resident Sta-
tus

Power of Attorn

ey Section

Power of
Attorney

Check this box if you hold a power of attorney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the holder.

Country Specify the country of the power of attorney holder.
Nationality Specify the nationality of the power of attorney holder.
Telephone Specify the telephone number of the power of attorney holder.
Number

Military Service
details and can b

- this section can be used to capture applicant’s Active Military Duty
e validated with applicant Bureau Details.

Active Mili-
tary Duty

Check this box to indicate if applicant is on Active Military Duty.

Effective Dt

Select the date from when the applicant is on Active Military duty
using adjoining calendar.

Order Ref # Specify the Order Reference number which indicates the applicant’s
Active Military duty service.
Release Dt Select the date from when the applicant was released from Active Mil-

itary duty using adjoining calendar.
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7.5.1

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can verify the personal information about the applicant. Two check boxes indicate if
this is an existing customer or a prior applicant. The Existing Customer field enables you
to select the existing customer.

Address Sub Tab

You can specify more than one address for each applicant, such as a home address, second
home address, and vacation home address. However, at least one must be marked as
current. Also, only one address can be selected as the mailing address, and that address
must be marked as current. Finally, while you can have more than one Home type address,
only one can be marked as current.

To complete the Address sub tab
1. Click Address sub tab.

2. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

Based on the country chosen in the address tab, the fields for capturing the address will
vary.

A brief description of the fields is given below:

Field Do this

Address Type | Select the type of address from the adjoining option list.

Current Check this box if this is a current address.

The mailing address must be marked as current.

Confirmed Check this box if the address is the confirmed one

Mailing Check this box if this is the mailing address. Only one address entry
can be marked as the mailing address.

Permission to | Check this box if customer has provided permission to contact
Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Permission to | Check this box if customer has provided permission to contact

Text through text message.
Country Select the country of mailing address from the adjoining drop-down
list.

Address Details section

Postal Type Select the postal address type from the adjoining drop-down list.

Address # Specify the address number of the mailing address

Street Pre Select the street prefix (directional) from the adjoining drop-down
list.

Street Name Specify street name.
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Field

Do this

Street Type

Select the street type from the adjoining drop-down list.

Street Post

Select the street postfix (directional) from the adjoining drop-down
list.

Apt #

Specify the apartment number.

Address Line
1

Specify the first address line.

Address Line
2

Specify the second address line.

Address Line
3

Specify the third address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the extension of the zip code.

City Specify the city of the mailing address.

State ISelect the state of the mailing address, from the adjoining drop-down
ist.

Phone Specify the phone number.

Additional Information section

Own / Rent Select the ownership type from the adjoining drop-down list.
Landlord Specify the landlord’s name.

Landlord Specify the landlord’s phone number.

Phone

Contact Specify the person contacted on behalf of landlord.
Contact Title Specify title of the person contacted on behalf of landlord.

Contact Phone

Specify phone number of the person contacted on behalf of landlord.

Extn

Specify the extension of the phone of the person contacted on behalf
of landlord.

Census Tract/

Specify census tract/BNA (block numbering area). These are defined

BNA code by the US Census Bureau code.

MSA Code Specify the metropolitan statistical area (MSA) code. These are sim-
ilar in concept to a zip code, but used mostly on government reports.

Comment Specify a comment.

Address Rent M

ortgage Stated section

Years

Specify the stated number of years at residence.
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Field Do this

Months Specify the stated number of months at residence.

Currency Select the currency code of payment amount, from the adjoining
drop-down list.

Pmt Amount Specify the stated payment amount.

Frequency Specify the stated payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Address Rent Mortgage Actual section

Years Specify the Actual number of years at residence.
Months Specify the Actual number of months at residence.
Pmt Amount Specify the Actual payment amount.

Frequency Specify the Actual payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. |If there are more than one addresses associated with the applicant, click Save And Add
on the Address sub screen and add address details.

7.5.2 Employments Sub Tab

Use the Employment sub screen to record employment information about the applicant. You
can have more than one entry.

To complete the Employments sub tab
1. Click Employments sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Check this box if this is the current employment.

Permission to Call | Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-quali-
fication of the application. Else, an error message is dis-
played.
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Field:

Do this:

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Type Select the address type from the adjoining drop-down list.
Employer Specify the employer’s name.

Occupation Select the occupation from the adjoining drop-down list.
Title Specify the title.

Department Specify the department of the employer.

Employee ID Specify the employee identification.

Employer Address section

Country

Select the country from the adjoining drop-down list.

Address #

Specify the building number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the zip code extension.

City Specify the city.

State Select the state from the adjoining drop-down list.

Additional Information section

Phone Specify the work phone number.

Extn Specify phone extension.

Contact Specify the person contacted on behalf of the employer.
Contact Title Specify title of the person contacted on behalf of the employer.

Contact Phone

Specify phone number of the person contacted on behalf of
the employer.

Contact Extn

Specify the extension of the phone of the person contacted on
behalf of the employer.

Comment

Specify a comment.

Employment Details Stated section

Years

Specify the stated number of years with the employer.

Months

Specify the stated number of months with the employer.
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Field: Do this:

Pay Day Select the stated payment day of the month using the adjoin-
ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the stated payment frequency from the adjoining drop-
down list.

Currency Select the currency code from the adjoining drop-down list

Income Amt Specify the stated income.

Salary View the salary of the customer.

Employment Details Actual section

Years Specify the Actual number of years with the employer.
Months Specify the Actual number of months with the employer.
Pay Day Select the Actual payment day of the month using the adjoin-

ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the Actual payment frequency from the adjoining drop-
down list.

Income Amt Specify the Actual income.

Salary View the salary of the customer.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.3 Telecoms Sub Tab

The Telecoms sub screen only needs to be completed if additional phone numbers exist. If
not, this sub screen can be left blank.

To complete the Telecoms sub tab
1. Click the Telecoms sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the telecommunication type from the drop-down list.
Phone Specify the phone number.

Extn Specify the phone extension.
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Field Do this

Current Check this box if this Telecom number is current.

Permission | Check this box if customer has provided permission to contact through

to Call the specified phone number.
Atleast one phone number per application should have the permission
to call (flagged as 'Y') for the successful pre-qualification of the applica-
tion. Else, an error message is displayed.

Permission | Check this box if customer has provided permission to contact through

to Text text message.

Time Zone Select the applicant’s time zone from the drop-down list.

Start Time Specify the best time to start the call.

Period Select the time period for the best time to call start time, AM or PM, from
the drop-down list.

Best day to | Select the preferred day of the week to contact the customer from the

call drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM or PM, from

the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary Sub Tab

The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the

Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub

screen, the Liabilities sub screen during application entry, and the credit bureau pull.

To View Summary sub tab

1. Click the Summary sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field

Do this

What if Pmt Amt

Specify the payment amount you want to use in the ratios.

Score View the credit score for the application
Grade View the credit grade for the application
Totals

Amt

Monthly Income- Stated

The stated monthly income.
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Field

Do this

Monthly Debt- Stated
Amt

The stated monthly liability.

Monthly Income- Actual
Amt

The actual monthly income.

Monthly Debt- Actual
Amt

The actual monthly liability.

Assets Amt - Liabilities
Amt

The net worth amount.

Ratios

Debt - Stated Before (%)

The debt amount stated before.

Debt - Stated After (%)

The debt amount stated after.

Debt - Actual Before (%)

The actual debt amount before.

Debt - Actual After (%)

The actual debt amount after.

Disposable Inc - Stated
Before (%)

The disposable income stated before.

Disposable Inc - Stated
After (%)

The disposable income stated after.

Disposable Inc - Actual
Before (%)

The actual disposable income before.

Disposable Inc - Actual
After (%)

The actual disposable income after.

Revolving Debt - Stated
Before (%)

The stated revolving debt before.

Revolving Debt -Stated
After (%)

The stated revolving debt after.

Revolving Debt - Actual
Before (%)

The actual revolving debt before.

Revolving Debt - Actual
After (%)

The actual revolving debt after.

Pmt to Income - Stated
Before (%)

The stated income payment before.

Pmt to Income - Stated
After (%)

The stated income payment after.

Pmt to Income - Actual
Before (%)

The actual income payment before.

Pmt to Income - Actual
After (%)

The actual income payment after.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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Once the payment amount is approved in Decision screen, it will be copied and
displayed in the What if Payment field in Summary sub screen.

Calculating Debt Ratios

The system offers powerful tools to the underwriter for analyzing an applicant’s debt-to-
income ratios (total of an applicant’s debt obligation divided by that person’s regular income).
The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

An underwriter may also add information to the Incomes and Liabilities sections on the
Summary sub screen during the underwriting process.

The debt-to-income ratios in the Ratios section can be recalculated by including or excluding
information from the Incomes section, Liabilities section and Financials sub screen.

To calculate debt ratios
1. Open the Underwriting screen and load the application you want to work with.
2. In the Underwriting link bar, click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
Show in the Details column.

4. Click Summary sub tab.

5. On the Summary sub screen, view the display only data in the Totals section.

Field: View this:

Monthly Income (Stated) | The stated monthly income.

Monthly Income (Actual) | The actual monthly income.

Monthly Debt (Stated) The stated monthly liability.

Monthly Debt (Actual) The actual monthly liability.

Assets The assets.
Liabilities The liabilities.
Net-Worth The net-worth.

6. Inthe What if Pmt Amt field, enter the payment amount you want to use in the ratios.
Once the payment amount is approved in Decision screen, it will be copied in the What if
Payment field and the ratios are updated accordingly.

Whenever you modify the ‘What If pmt Amt’ field, system automatically calculates the
below ratio's:

— Stated Before DTI - if liabilities, stated income or applicant financials are updated.

— Stated After DTI - if decision payment amount, liabilities, stated income or applicant
financials are updated.

— Actual Before DTI - if liabilities, actual income or applicant financials are updated.

— Actual After DTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.
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— Stated PTI - if decision payment amount, stated income or applicant financials are
updated.

— Actual PTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

7.5.4.1 Financials Sub Tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

To complete the Financials sub tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

1. Click Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select financial type from the drop-down list. For example, liquid
assets, retirement assets, and so on.

Source Specify source; for example, stocks, 401K, rent received, and so on.
Account # Specify the account number.

Currency Select the currency code from the drop-down list.

Loan Cur- View the Loan currency amount.

rency Amount

Amount Specify amount.
Include Check this box to indicate that the Asset is included.
Comment Specify comment, if any.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.2 Liabilities Sub Tab

All the liabilities of the applicant that are entered during application entry are displayed in this
tab. For example: Rent. In addition, if you need to record additional liabilities for an applicant
the same can be done in this tab. Also any liability information of the applicant received
through credit pull will be displayed under 'Credit Bureau Data' in Liabilities sub tab.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Include Check this box to indicate that the liability is included.
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Field Do this

Liability Type Select the liability type from the adjoining drop-down list.
Currency Select the currency code from the adjoining drop-down list.
Amount Specify the liability amount.

Loan Currency

View the Loan currency amount.

Amount
Frequency Select the frequency from the adjoining drop-down list.
Account Type Specify the account type.

Account Balance

Specify the account balance.

Loan

View the Loan currency amount.

Comment

Specify a comment, if any.

Credit Bureau Data

Bureau View the name of credit Bureau.

Open Dt View the opening date of credit account.
Pmt Manner View the mode of payment.

Account # View the account number.

Status View the current status of credit account.
Account Type View the type of account maintained.

Creditor's Name

View the name of the Creditor.

Subscriber # View the Subscriber number.

ECOA View the ECOA (Equal Credit Opportunity Act) code.
Term View the term of credit.

Credit Limit View the total credit limit amount.

High Balance View the high balance amount if any.

Past Due Amt

View the total past due amount if any.

30 View the number of delinquency days.
60 View the number of delinquency days.
90 View the number of delinquency days.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Dedupe Liabilities button removes duplicate (“de-dupes”) liabilities that may be
present from subsequent (manual) credit bureau pulls for nonspousal joint applications
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7.5.4.3 Other Incomes Sub Tab

The Other Incomes sub tab only needs to be completed if other incomes exist on the
application. If not, this sub screen can be left blank.

To complete the Other Incomes sub tab

1. Click the Other Incomes sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the income type from the adjoining drop-down list.
Note: In case, the other income of the applicant is from Employment,
then the details of Actual Amount specified in the Employments
Sub Tab is auto populated. Also if the income is verified in the
Employments Sub Tab, then Verified By and Verified Dt details are
auto populated. You can also verify the details here using the current
system date.

Currency Select the currency from the adjoining drop-down list.

Stated Amount Specify the monthly stated income.

Frequency Select the income frequency from the adjoining drop-down list.

Loan Currency

View the Loan currency amount stated.

Amount Stated
Comment Specify a comment, if any.
Include By default the include check box is selected indicating that the other

income details are included. You can deselect the same if not
required.

When Include check box is selected system automatically adds the
‘Loan Currency Amount Stated’ and ‘Loan Currency Amount Actual’
details to Applicant > Summary Tab. Also system calculates the DTI
and PTI ratio's based on ‘Actual Amount’ specified.

Actual Amount

Specify the actual monthly income amount.

Loan Currency
Amount Actual

View the actual Loan currency amount.

Verified By The Verified By field is auto populated with the logged in user name
only after the record has been verified and saved.
Verified Dt You can verify the record by selecting the current system date from

the adjoining calendar icon.

Note: System displays an error message if any other dates is
selected apart from current system date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.5.4.4 Rescoring a Credit Bureau Report Manually

Any manually pulled credit bureau reports can be used to rescore an application.

To manually rescore a credit bureau report
1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click Applicants.

3. Onthe Applicants Details screen, select the applicant you want to work with and click
View.

4. Click the Credit Scores sub tab.

5. Inthe Rescore Applicant section, select in the Credit Report ID field, the bureau report
you want to use to rescore the applicant.

6. Click Rescore.

The system displays the new information in the Credit Scores and Parameters sections.
This new score automatically appears in the System Recommendation section on the
Decision link.

7.5.5 Credit Score Sub Tab

You can view the credit score based on the system’s internal scoring models in Credit Scores
sub tab.

To View Credit Scores sub tab

1. Click the Credit Scores sub tab.

You can view the following details:

e Credit Score
— Model
— Bureau
—  Credit Report ID
— Credit Grade
— Score
—  Current

e Parameters
— Parameters
— Value
— Score

Note

If you select No Bureau in the Credit Bureau Report ID field and click Rescore, the best
match internal scoring is used for rescoring the applicant without credit bureau report.

7.5.6 Duplicate Applicant Sub Tab

Click De-dupe Applicants to display the existing customer details of the applicant. While
reviewing the de-dupe results, if the current applicant's credentials are exactly matching with
an existing customer record, you can attach the current application to the existing customer.
The same can be done by just keying in the customer ID in the applicants tab and clicking
save.
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In case a particular customer has more than one account, on clicking De-dupe Applicants the
system displays only one account in ‘Duplicate’ sub tab. However, you can view all the
accounts held by customer in 'Existing accounts' sub tab.

To View duplicate applicant’s details, click Duplicate Applicant sub tab. In this section you
can view the duplicate applicant’s details.

A brief description of the fields is given below:

Field Do this

Source Type View the source type of the duplicate applicant

Applicant Id/ Cus Id View the applicant ID if the source type is applicant and the
customer ID if the source type is customer.

Application # View the application number of the existing applicant details
for the respective records.

Days since last appli- View the total number of days elapsed since the last applica-
cation tion date. System auto calculates this value as ‘Current sys-
tem date (minus) Last application date’.

ID View the applicant ID

First Name View the first name of the duplicate applicant

Middle Name View the middle name of the duplicate applicant

Last Name View the last name of the duplicate applicant

Date of Birth View the date of birth of the duplicate applicant

CIF View the CIF no of the duplicate applicant

SSN #/ National ID View the national ID or SSN number of the duplicate appli-
cant

Driving License # View the driving license number of the duplicate applicant

City View the city of the duplicate applicant

State View the state of the duplicate applicant

Zip View the zip of the duplicate applicant

7.5.7 Existing Account Sub Tab

The Existing Account Sub Tab displays the applicant's details, if it has been previously
maintained in the system. Also along with the applicant's details, the account number of the
applicant is displayed as a hyperlink. Clicking on the hyperlink will display the respective
account details through the Customer Service screen of Servicing module.

In case you do not see a hyperlink associated with the account number, then you might have
restricted access to the Servicing module. You can request your system administrator to
navigate to Setup > User > Access screen, and enable the ‘ACCESS TO SERCOLL UCS
CUSTOMER SERVICE TAB’ option in Security Access Definition section available in the
'Screen' tab. For more information, on defining user privileges, refer to ‘3.3.2 Screen’ section
in Setup guide.
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View the following details:

Field: View this:

Account # The account number.

Title The account title.
Relation The customer relationship.
Product The Loan product.

Payoff Amount The payoff amount.

Amount Due

The delinquent amount due.

Oldest Due Dt

The due date.

Status The account status.
Company The company.
Branch The branch.

Total Pay Off Amt

The payoff amount.

Total Amt Due

The total due amount.

7.5.8 Tracking Attributes Sub Tab

You can add tracking attribute information to an application at any time in the underwriting
process by using the Tracking Attribute tab.

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.

To track attributes

1. Click Tracking Attributes sub tab.

2. Select the item you want to track.

3. Click Edit to edit the following information:

Field

Do this

Sub-Parameter

View the sub-parameter

Parameter

View the parameter.

Value

Specify the information about the corresponding Value field.

4. Save changes you made to the account.

7.5.8.1 Create Tracking

1. Click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute

box.

e If your system has been configured to use the Sub Code field, only attributes in a
particular group appear in the Parameter display.
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7.5.9

7.6

2. Specify the requested parameter in the Value field and click Save.

Customer Search Tab

While creating an application for an existing customer, you can retrieve and copy the
customer details into the new application by using the Customer Search section of the
Simple Application Entry screen.

You can modify only the address, employment, financial details and not the demographic and
identification details.

To copy the Customer Details
1. On the Underwriting screen, click Applicants tab.
2. Click Customer Search tab.

3. Inthe Search Criteria screen, use the Comparison Operator and Values columns to
create the search criteria you want to use to find a customer.

4. Click the Search button.

The system locates and displays all the customer details that meet your search criteria
in the Search Results section.

Select Reset Criteria at any time to clear the Comparison Operator and Values columns
on the Criteria screen.

5. Inthe Search Results section, select a customer you want to load.

6. Select the relation type and click Copy Customer Details.

Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business section to assist in approving the Loan
application during underwriting. The Business Applicant screen is available and contains the
following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

If there are no business information associated with the application, the Business Applicant
tab is unavailable.

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on the Underwriting screen.
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2. Click BusinessTab.
ORACLE
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Organization Type Select the organization type.

Business Type Select the type of the business.

Business Name Specify the name of the business.

Legal Name Specify the legal name of the business.

Tax ID Specify the tax identification.

Start Date Specify the business start date.

# of Employees (Cur) Specify the current number of employees at the business.

# of Employees Specify the number of employees at the business after
financing.

Contact Person Specify the contact person at the business.

Business Checking Specify the bank name of the business’s checking account.
Bank

Bank Acc # Specify the bank account number.

Avg Checking Balance | Specify the average checking balance.

# of Locations Specify the number of locations of the business.
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7.6.1

Field:

Do this:

Management Since

4. Perform any of the Basic Actions mentioned in Navigation chapter

Address Sub Tab

You can enter more than one address for the business.

To complete the Address Sub Tab
1. Click Address Sub Tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Current

Check this box if this is a current address.

The mailing address must be marked as current.

Permission to Call

Check this box if customer has provided permission to
contact through the specified phone number.

Atleast one phone number per application should have
the permission to call (flagged as 'Y') for the successful
pre-qualification of the application. Else, an error mes-
sage is displayed.

Permission to Text

Check this box if customer has provided permission to
contact through text message.

Mailing Check this box if this is the mailing address. Only one
address entry can be marked as the mailing address.

Address Type Select the address type.

Country Select the country.

Address # Specify the building number.

Own /Loan Select the ownership type.

Comment Specify a comment.

Postal Type Select the address type.

Street Pre Select the street prefix (directional).

Street Name

Specify street name

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt #

Specify the apartment number.

Address Line 1

Specify the first address line.
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7.6.2

7.6.3

Field:

Do this:

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
Phone Specify the phone number.

3. Perform any of the Basic Actions mentioned in Navigation chapter

4. |f there are more than one addresses associated with business, click Save And Add and
add the address details.

Telecoms Sub Tab

The Business tab’s Telecoms sub tab needs to be completed, if additional phone numbers for
the business exist. If not, this sub tab can be ignored.

To complete the

Telecoms sub tab

1. Click Telecoms sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Permission | Check this box if customer has provided permission to

to Call contact through the specified phone number.
Atleast one phone number per application should
have the permission to call (flagged as 'Y") for the suc-
cessful pre-qualification of the application. Else, an
error message is displayed.

Permission | Check this box if customer has provided permission to

to Text contact through text message.

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current If selected, indicates that this is a current telecom.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Financials Sub Tab

The Business tab’s Financials sub screen only needs to be completed if financial assets exist
on the application for the business. If not, this sub screen can be left blank.
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To complete the Financials sub tab
1. Click the Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select financial type; for example, liquid assets, retirement assets,
and so on.

Source Specify source; for example, stocks, 401K, rent received, and so
on.

Currency Select the currency of the asset.

Amount Specify amount.

Loan Currency The system displays the Loan currency amount

Amount

Comment Specify comment, if any.

Include Check this box to include this record in calculations on the Other
Details sub section.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.6.4 Liabilities Sub Tab

The Business Applicant link’s Liabilities sub screen only needs to be completed if financial
liabilities exist on the application for the business. If not, this sub screen can be left blank.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Type Select the liability type.
Currency Select the currency.

Loan Currency Amount | The system displays the Loan currency amount

Amount Specify the liability amount.

Frequency Select the frequency.

Account Type Specify the account type.

Loan Currency Account | The system displays available Loan currency account
Balances balance.

Account Balance Specify the account balance.

7-29 ORACLE



7.6.5

Field:

Do this:

Comment

Specify comments, if any.

Include

Check this box to include this record in calculations on
the Other Details sub screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Partners Sub Tab

You can enter more than one partner for the business.

To complete the Partners sub tab
1. Click Partners sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

First Name Specify the partner’s first name.

Mi Select the partner’s middle name.

Last Name Specify the partner’s last name.

Suffix Specify the partner’s suffix.

SSN # Specify the partner’s social security number.
Birth Dt Specify the partner’s birth date.

Birth Place Specify the partner’s birth place.

Title Select the partner’s title.

Ownership (%)

Specify the percentage of ownership held by the customer.

Net worth

Specify the partner’s net worth.

Gross Income

Specify the partner’s gross income.

Language Specify the partner’s language.
Nationality Specify the partner’s nationality.
Country Select the partner’s country code.
Address # Specify the partner’s address number.
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7.6.6

Field: Do this:

Address Line 1 | Specify the partner’s first address.

Address Line 2 | Specify the partner’s second address line.

Zip Select the partner’s zip code.

For non-US country, you have to enter zip code.

Zip Extn Specify the partner’s zip extension.
City Specify the partner’s city.

State Select the partner’s state.

Phone Specify the partner’s phone number.
Extn Specify the partner’s phone extension.
Email Specify the partner’s email.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Affiliates Sub Tab

You can enter more than one affiliate for the business.

To complete the Affiliates sub tab
1. Choose Affiliates sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Organization Select the affiliate’s organization type

Type

Legal Name Specify the affiliate’s legal name

Business Name Specify the affiliate’s business name

Tax ID Specify the affiliate’s tax identification

Ownership (%) Specify the affiliate’s percentage of ownership

# of Employees Specify the affiliate’s number of employees

NAICS CODE Specify the affiliate’s North American Industry Classification
System code.

Country Select the affiliate’s country code.

Address # Specify the affiliate’s address number.

Address Line 1 Specify the affiliate’s first address line.

Address Line 2 Specify the affiliate’s second address line.
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Field:

Do this:

Zip

Select the affiliate’s zip code.

For non US country, you have to enter zip code.

Zip Extension

Specify the affiliate’s zip extension.

City

Specify the affiliate’s city.

State

Select the affiliate’s state.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Other Details Sub Tab

The Other Details sub screen records information regarding monetary amounts associated
with the business such as profits, sales, and expenses.

To complete the Other Details sub tab
1. Click Other Details sub tab.

2. Click Edit.

3. Verify financial details as well as assets and liabilities linked to the business.

A brief description of the fields is given below:

Field:

Do this:

Other Details section

Currency

Select the currency.

Business Type

Select the type of business.

Analysis Frequency

Select the analysis frequency.

Loan Currency Gross
Margin Factor

The system displays the Loan currency business’s gross
margin factor

Gross Margin Factor

Specify the business’s gross margin.

Organization Type

Select the type of organization.

Loan Currency Income

The system displays the Loan currency business income
amount.

Income

Specify the business’s income amount.

Loan Currency Collec-
tion Average

Specify the Loan currency collection average.

Collection Average

Specify the collection average.

LoanCurrency Proj Coll
Avg Annual

Specify the Loancurrency annual projected collection aver-
age.

Proj. Coll.Avg.Annual

Specify the annual projected collection average.

LoanCurrency Book List

Specify the Loancurrency business booklist.
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Field:

Do this:

Book List

Specify the business booklist.

LoanCurrency Turn
Over

Specify the Loancurrency turnover amount.

Turn Over

Specify the turnover amount.

LoanCurrency Capital
Amount

Specify the Loancurrency capital amount.

Capital Amt

Specify the capital amount.

LoanCurrency Earned
Surplus

Specify the Loancurrency earned surplus amount.

Earned Surplus

Specify the earned surplus amount.

LoanCurrency Gross
Profit

Specify the Loancurrency gross profit amount.

Gross Profit

Specify the gross profit amount.

LoanCurrency Net Profit

Specify the Loancurrency net profit amount.

Net Profit

Specify the net profit amount.

LoanCurrency Working
Capital

Specify the Loancurrency working capital amount.

Working Capital

Specify the working capital amount.

LoanCurrency Annual
Sales

Specify the Loancurrency annual sales amount.

Annual Sales

Specify the annual sales amount.

LoanCurrency Pro-
jected Sales

Specify the Loancurrency projected sales amount.

Projected Sales

Specify the projected sales amount.

LoanCurrency Equity

Specify the Loancurrency equity amount.

Equity

Specify the equity amount.

Open Delq

Specify the open delinquency amount.

LoanCurrency Business
Expenses

Specify the Loancurrency business expenses amount.

Business Expenses

Specify the business expenses amount.

LoanCurrency Personal
Expenses

Specify the Loancurrency personal expenses amount.

Personal Expenses

Specify the personal expenses amount.

LoanCurrency Total
Expenses

View the Loancurrency total expenses amount.
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Field: Do this:

Total Expenses View the total expenses amount.

LoanCurrency Annual View the Loancurrency annual projected collection amount.
Proj Sales Amt

Annual Proj Sales Amt View the annual projected collection amount.

LoanAnnual Proj Exp View the Loan annual projected expenses amount.
Amt

Annual Proj Exp Amt View the annual projected expenses amount.
LoanCurrency Current View the Loancurrency current assets.

Assets

Current Assets/Liability View the current asset to liability ratio.

ratio

LoanCurrency Fixed View the Loancurrency fixed assets.
Assets

Fixed Assets View the fixed assets.

LoanCurrency Intangible | View the Loancurrency intangible assets.

Assets

Intangible Assets View the intangible assets.

Loan View the Loan

Current Liabilities View the current liabilities.

Loan View the Loan

Long Term Liabilities View the long term liabilities.

Loan View the Loan

Total Assets View the total asset amount.

Loan View the Loan total net worth amount.
Total Net worth View the total net worth amount.
Loan View the Loan

Total Liability View the total liability amount.

Debt Net worth Ratio View the debt to net worth ratio.
Current Assets/Liability View the current asset to liability ratio.
ratio

Signatures

Title 1-4 Specify the title.

Signature1-4 Specify the signature.
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Request Tab

In the Request tab you can define the required Loan parameters and calculate Payment,
Interest Rate, Term and Loan Amount using the quick calculator. By default, system
calculates for monthly repayment term basis. The payment frequency can be changed only in
the Underwriting tab during decisioning.

To complete Request section:

1. On the Application Entry tab, click Request tab.

Financial Services Lending and Leasing
Origination » (%] Close
Summary = Applicant | Business =~ Request = Dedsion = Customer CreditLimit ~Bureau | Collateral | Comments || Tracking || Document | Verification | Correspondence | Tools
Requested [S] view || o Audit
View = Formatw [y Fresze Bl Detach \tirap [on)
Reglcsd Adva::i Pmt Amt. Term Requested Rate Down Pmt % Dawn Pmt Approx Prc Promotion Balloon Amt
60,000.00 0.00 24 7.0000 0.00 0.00 0.00 NONE 0.00
Requested
{aReturn
Requested Advance Amt 60,000.00 DownPmt % 0 Baloon Amt 0.00 ‘
Pmt Amt 0.00 Down Pmt 0.00 Signing Dt
Term 24 Approx Prc 0.00 Probable Delivery Dt
Requested Rate 7.0000 Promotion UNDEFINED
Ttemization | Trade-In | Subwvention
Tramizatinn Elview | o audit =

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields are given below:

Field Do this

Requested Advance Amt Specify the requested advance amount

Pmt Amt Specify the requested payment amount.

Term Specify the requested term (number of payments).
Requested Rate Specify the requested rate of interest.

Down Pmt% Specify the down payment percentage

Down Pmt Specify the down payment amount

Approx Prc Specify the approximate cash price

Promotion Select the promotion type from the drop-down list.
Balloon Amt Specify the balloon amount.

Signing Dt Specify the signing date

Probable Delivery Dt Specify the probable delivery date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe ‘Requested’ section, there is a drop-down list adjacent to the ‘Calculate’ button with
following options to auto calculate different Loan parameters based on the data provided.
Select the record you want to work with and from the drop-down option, select the option
you want system to calculate:
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7.7.2

— CALCULATE PAYMENT

— CALCULATE INTEREST RATE
— CALCULATE TERM

— CALCULATE LOAN AMOUNT

5. Click Calculate. The system displays the requested calculation in the respective field.

Itemization Sub Tab

The Itemizations sub tab enables you to add or verify any itemized amounts associated with
the application. The list of itemizations is determined by the product you select in the master
screen during the application entry process. The ltemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the Itemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub tab on the Underwriting screen.

Application request details need to be essentially entered in the itemization sub tab for pre-
screening to be successful. Else, the system displays error and application would not proceed
to the next level in work flow. The details of down payment, trade-in, insurance, fees etc. and
the total sale price are recorded under itemization.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
ltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Loan amount.

Requested Amt Specify the requested amount.

Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Trade-In.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-In

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Body Specify the body of the asset.
Identification # Specify the identification number.
Description View the asset description.
Valuation

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Pay Off Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supplement | Specify the valuation supplement.

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Subvention Sub Tab

With the Subvention sub tab, available only for Loan, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Decision Tab

If the application was initially approved automatically, the system displays its
recommendations on the Decision tab’s Approved section.

If the application was initially rejected automatically, the system displays its reasons on
the Decision link’s Stipulation sub tab.

If you choose to approve or reject the Loan manually, you must manually select the
pricing (rule) set by the portfolio company for a specific product. The system validates this
pricing against the information in the System Recommendation sections. The information in
the Requested section comes from the application entry process and can be edited.

e If the data meets your approval, change the status of the application to either
APPROVED or REJECTED and enter any stipulations.

e If you reject the application, change the status to REJECTED and enter the reasons for
the adverse action on the Stipulations sub screen.

You can use the quick calculator provided with the drop-down list adjacent to the
‘Calculate’ button to calculate the required Loan parameters. You can also use the
calculator available in Tools section for completing this step. For detailed information on
using the Calculator tools, refer “Tools” chapter in the document.

To verify the application decision data

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Decision tab.

ORACLE’
Financial Services Lending and Leasing

P — o

. Close:
R Origination x [E3fe
Origination Search/Task | Underwriting: 0000001533  Review Requesis (Pending: 0) A
Origination
Sl s Application: 0000001533: SIGG MARK Eyew | o2 audit
Simple Application Entry
Application Entry View v Formatw B Frecze T Detach Wrap @) Override OK v  Warning OK ¥
Undenwriting Ori i Duplicate
Fudes Dt App # Sub Unit Status pak Ca Buistng Customer {5, Con
Porieabdi e 08/05/2015 0000001533 APPROVED - FUNDED F. CA-D0003 : ACE HEADQUA . (. N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Summary || Applicant || Business || Request Decision | Contract | Collateral || Comments | Tracking | Document | Verfication | Correspondence | Tools
Vendors
Decision Information
View » Formatw [ Freeze [z} Detach Wrap [0}
Current Grade Seore  Max Advance Amt LTV1  Max Financed Amt v Decision Term Decision Rati
¥ D GRADE [ 18,900.00 95.50 18,900.00 95.50 15 4,990
< >
Decision Information Pl
<3 Betwm
Pricing
Pricing VEHICLE LOAN PRICING-FR Status APPROVED Decision Dt 01/30/2016
Current ¥ Sub Status BLANK Underwriter VEROUTHU
Approved
Decision Term 15 Down Pmt Amt 1,890.00 Bureau 1 NONE
Pmt Amt 1,302.31 Max Advance % 0.0000 Bureau 2
Index FLAT RATE Max Advance Amt 18,900.00 Bureau 3
Index Rate 0.0000 Max Financed % 0.0000 Grade D GRADE
Decision Margin Rate 4.9800 Max Financed Amt 18,300.00 Score 0
Decision Rate 4.9900 Maturity Index. FLAT RATE Collateral Value 19,790.00
. Pricing Buy Rate 2.9900 Maturity Margin Rt 4.9900 LTv1 9550
Eenneing Approved Buy Rate 2.9500 Balloon Amt 0.00 T2 8550
> Collections Down Pmt % 10.0000 Decision APR 00000 Comments
> WFP
> Tools
v
> Setup

3. Perform any of the Basic Operations mentioned in Navigation chapter.

— A brief description of the fields is given below:

Field:

Do this:

Pricing section

Current

Check this box to indicate that this is the current deci-
sion.

Pricing

View the pricing.

Decision Dt

View the decision date.

Underwriter

View the underwriter id.

Status

View the application status.

Sub Status

View the application sub-status.

Approved section

Decision Term

Specify the approved decision term.

Pmt Amt

Specify the approved payment amount.

Index

Specify the index type.

Index Rate

Specify the approved index rate.

Decision Margin Rate

Specify the approved decision margin rate.
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Field:

Do this:

Decision Rate

Specify the approved decision rate.

Note: For Islamic products this field is displayed as
‘Profit Rate’.

Pricing Buy Rate

View the pricing buy rate.

Approved Buy Rate

View the approved buy rate which is by default the Pric-
ing Buy Rate displayed above. You can also specify the
required approved buy rate.

Down Pmt %

Specify the approved down payment percentage.

Down Pmt Amt

Specify the approved down payment amount.

Max Advance %

Specify the approved advance percentage.

Max Advance Amt

Specify the approved advance amount.

Max Financed %

Specify the maximum amount financed percentage.

Max Financed Amt

Specify the maximum amount financed.

Maturity Index

Select the approved post maturity index.

Maturity Margin Rt

Specify the maturity rate.

Balloon Amt Specify the balloon amount.
Decision APR Specify the decision APR.
Bureau 1 Specify the Bureau 1.
Bureau 2 Specify the Bureau 2.
Bureau 3 Specify the Bureau 3.
Grade Select the credit grade.
Score Specify the credit score.

Collateral Value

View the collateral value.

LTVA View the loan to value ratio.
LTV2 View the loan to value ratio.
Comments Specify comments, if any.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Select Pricing.
The system determines the best pricing match of all enabled Loan pricing strings in the

Setup menu and displays the results in the Pricing and Approved sections.

Quick Calculate

In the ‘Decision Information’ section, there is a drop-down list adjacent to the ‘Calculate’
button with following options to auto calculate different Loan decision parameters based
on the data provided. Select the required option from the drop-down list and click

‘Calculate’:
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7.

9.

— CALCULATE PAYMENT

— CALCULATE INTEREST RATE

— CALCULATE TERM

— CALCULATE LOAN AMOUNT

The system displays the requested calculation in the respective field.

Re-Score

A 'Re-Score' button is available next to 'Calculate’. Whenever any sensitive Financial or
Collateral information is amended in the Application, OFSLL displays a warning
message 'Scoring sensitive information is changed. Re-score the application'. You need
to click on Re-Score to re-validate the grade and pricing accordingly.

The display of the warning message to Re-score the application can be controlled using
the respective System parameter. If the defined System Parameter is flagged 'Y, only
then the message is displayed.

If you are underwriting a Loan, record the following information on the Decision tab:
If you are approving the application, complete the Approved section with the values you
want to approve as an underwriter. You can update the default values that appeared

when you selected the pricing string in step 3. (The system calculator may be of use when
completing this section. For more information, refer the Tools chapter).

Click Calculate. The system displays the decision calculation in the respective field.

System Recommendation

The System Recommendation sub screen displays the system generated Score, Decision
and Grade. You will also be able to view the request details of the application under

'Requested' section itself.

A brief description of the fields in System Recommendation section are given below:

Field: Do this:

Score View the system recommended score.
Decision View the system recommended decision.
Grade View the system recommended grade.

A brief description of the fields in

Requested section are given below:

Field

Do this

Requested Advance Amt

View the requested advance amount

Pmt Amt

View the requested payment amount.

Term

View the requested term (number of payments).

Requested Rate

View the requested rate of interest.

Down Pmt%

View the down payment percentage

Down Pmt View the down payment amount
Approx Prc View the approximate cash price
Promotion View the promotion type from the drop-down list.
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Field Do this

Balloon Amt View the balloon amount.
Signing Dt View the signing date
Probable Delivery Dt View the probable delivery date.

Stipulations Sub Tab

The Stipulations sub screen allows to add any stipulations or reasons for adverse action you
want to attach to the application. Stipulations are items that need to be addressed before the
Loan can be funded.

If the application was automatically rejected during the application entry edits, the system
displays the automatically generated adverse action codes in this sub screen. If the
application is manually rejected by the Underwriter due to adverse action reasons received
from bureau or otherwise, the same can be recorded for each of the applicant.

In addition, you can enter comments against specific stipulations as required. Whenever a
Stipulation is marked as 'Not Applicable' it becomes mandatory to specify the reason in
comments field. Else, system prompts for the reason while processing the application.

To add or view stipulations or reasons for adverse action

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below.

Field: Do this:

Type Select the reason type. Type can be Stipulation Reasons or Adverse
Action Reasons and Adverse Action Reasons can also be those
received from Bureau.

Name The system displays all applicant’'s name in the drop down list. You

can select the name of the applicant for whom adverse action reason
needs to be recorded. In case the stipulation reason is at the appli-

cation level, then select ALL.

Code Select the reason.

Description Specify the required description.

Stips Satisfied Use the Yes/No/NA buttons to indicate if you verified the stipula-
tion(s) in the Type field

Comment Specify the comment.

Verified By The system updates the user ID of the person who verified the
details

Verified Dt The system updates the date when the details are verified.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.8.2.2

7.8.2.3

7.8.3

If your system is set up to manually load predefined stipulations, click the Load Stipulations
button (For more information, refer the following section, Loading Stipulations.)

Add Multiple

The system enables you to add multiple records to stipulations using the 'Add Multiple' option.
To add multiple stipulations
1. Click the drop down list adjacent to the 'Add Multiple' button.

2. Select the check box against to the required stipulations. You can also select ’All’ to load
all the available stipulations.

Click Add Multiple.

4. |If required, you can perform any of the Basic Actions mentioned in Navigation chapter.

Copying Stipulations

The system enables you to automatically transfer stipulations from previous decisions on the
Stipulations sub screen with the Copy Stipulations button. This is particularly useful when you
are rehashing an application and want to use the same stipulations as those in place for the
previous decision.

Loading Stipulations

The system supports the automatic generation of default stipulations on the Underwriting
screen’s Stipulations sub screen. The default stipulations can be maintained by company,
branch, product, state, application status and application sub-status. When the application
status changes (either manually and automatically), the system populates the maintained
stipulations with a Stips Satisfied indicator of ‘No’. You can review and update the stipulations
accordingly.

You have the option to manually load predefined stipulations by clicking the Load Stipulations
button on the Stipulation screen.

To load predefined stipulations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations.

Click Load Stipulations. The system loads the default stipulations on the Stipulations
sub screen.

4. Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the
stipulation(s) in the Type field.

5. Click Save on the Stipulations sub screen.

Itemization Sub Tab

The Itemizations sub screen enables you to add or verify any itemized amounts associated
with the application. The list of itemizations is determined by the product you selected in the
master screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the Itemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub screen on the Underwriting screen.
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To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
ltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Loan amount.

Requested Amt Specify the requested amount.
Approved Amt Specify the approved amount.
Discount Rate Specify the discount rate.
Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Trade-In sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-in section

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.

Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Identification # Specify the identification number.
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7.8.6

Field: Do this:

Body Specify the body of the asset.
Description View the asset description.
Valuation section

Wholesale Amt Specify the wholesale value.
Base Retail Amt Specify the retail value.
Addons Amt (+) Specify the add ons value.
Payoff Amt (-) Specify the payoff amount.
Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.
Valuation Supple- Specify the valuation supplement.
ment

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Rate Schedule Sub Tab

The Rate Schedule sub screen is only available for variable rate Loan and displays the rate
adjustment frequency information based on product setup.

To view the Rate Schedule sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Rate Schedule sub tab. Click View.

A brief description of the fields is given below:

Field: View this:

Seq The rate adjustment sequence number.

Adjustment Frequency Type The rate adjustment frequency type.

Period The rate adjustment period for the frequency.

# of Adjustments The number of rate adjustments for the frequency.

Subvention Sub Tab

With the Subvention sub tab, available only for Loan, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.
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To complete the Subvention sub tab

1.

with.

Open the Underwriting screen and load the underwriting application you want to work

2. Click Decision > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Plan Select the subvention plan.
Description View the subvention plan description.
Sub Plan Select the sub plan.

Sub Plan Description

View the subvention sub plan description.

Subvention Type

View the subvention type.

Include

Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5.

Navigation chapter.

In Subvention Detail section, perform any of the Basic Operations mentioned in

A brief description of the fields is given below.

Subvention Detail section:

Participant

View the participant.

Participant Type

View the participant type.

Collection Method

View the collection method.

Rate

View the subvention rate.

Rent Factor

View the rent factor

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Include

View if the subvention is included in the application or not.

Total Subvention Rate

View the total subvention rate.

Total Subvention Amt

View the total subvention amount.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Select the Initialize button to reset the subvention amount to zero.

8. Select the Calculate button to calculate the subvention amount.
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Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between
the finance company and the dealer for Loan transactions.

To complete the Compensation (Loan) sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click the Decision > Compensation sub tab.

On the Compensation sub screen’s Compensation section, select in the Compensation
Plan section the compensation plan you want to use from the drop-down list. Note that,

the compensation plan will use decision information to calculate compensation.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method

View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Paid % View the percentage of chargeback paid.
Paid Basis View the charge back paid basis.
Paid Term View the charge back paid term.
Paid Days View the charge back paid days.

Charge off Calc Method

View the charge back calculation method (charge off).

Charge off % View the charge back percentage (charge off).
Charge off Basis View the charge back basis (charge off).
Charge off Term View the charge back term (charge off).

Days View the charge back days (charge off).

Calculation section

Spread Formula

View the compensation spread formula.

Buy Rate Specify the buy rate.
Factor View the compensation factor.
Addl Factor View the additional compensation factor.
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Field:

Do this:

Max Spread %

View the maximum spread or percent allowed.

Upfront %

View the upfront compensation percentage.

Flat Amt

View the flat amount.

Upfront Comp Amt

View the compensation amount paid upfront.

Rem Comp Amt

View the compensation amount remaining.

Comp Amt

View the compensation amount.

5. Make any necessary changes in the Approved Buy Rate and Maximum Financed
Amount fields in the Decision tab.

6. Click Calculate.

The system displays the details and amounts for this compensation plan.

Multiple Offers sub tab

When you click Select Pricing on the Decision tab’s Pricing section, multiple offers appear on
the new Multiple Offers sub page. Use the Multiple Offer sub page to select the offer you want

to use.

Note

The Multiple Offers sub tab will be enabled only if the Multioffer company parameter is set

to Yes.

To view multiple pricing offers

1. Open the Underwriting screen and load the application you want to work with.

2. Click Decision, then click the Multiple Offers sub tab.

3. If you are underwriting a Loan, view the following information on the Multiple Offers sub:

Field: Do this:

Pricing View the pricing.

Term Specify the approved term.

Rate Specify the approved rate.

Pmt Amt Specify the approved payment amount.
Index View the approved index.

Index Rate View the approved index rate.

Margin Rate Specify the approved margin.

Maturity Index

Specify the approved maturity index.

Maturity Rate

Specify the approved maturity rate.
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Field: Do this:

Accepted If selected, indicates that the pricing is accepted. Only
one of the current pricings can be accepted.

Current If selected, indicates that the pricing is current.

Note: All the available pricings are selected as current.

4. On the Multiple Offers sub tab, select the offer once the application is move to Approved
status.

Customer Credit Limit tab

This tab is available only if the selected product has the ‘Customer Credit Limit' check box in
selected in Products setup screen (Setup > Products > Products).

Customer Credit limit in general refers to the maximum amount of credit that a financial
institution can extend to a prospective customer which can then be leveraged by an
underwriter while funding an application.

In Oracle Financial Services Lending and Leasing, you can define the Customer Credit Limit
during underwriting stage based on the customer credit worthiness or historical customer
data. Using this limit, applications can be funded up to the credit limit amount allowed.
However, application funding with or without customer credit limit is controlled based on the
setup and applications can still be funded with the normal process when a particular customer
is not allocated with any credit limit.

A customer credit limit facilitates for quick decisioning by an underwriter and also facilitates
for auto approval of accounts on-boarded from external system with basic validations. While
approving, underwriter has to ensure that the sum of utilizations should always be equal to
the financed amount which can be distributed within applicants primary / secondary or
business categories.

A minimum of one application has to be funded to define customer credit limit for funding
subsequent applications and the defined information is updated into credit limit details. A
credit limit once defined can further be increased from servicing module by posting the

required transaction which is referenced in origination module during application funding.

On receiving a payment, the amount is reinstated to the credit limit balance which can be re-
used while funding next application. Similarly, the credit limit balance is also updated when
account is moved to VOID status. On reversing a payment, the Total Utilization of credit limit
is increased by the principal portion of the payment and decreased with the Available Amt
field. Also, the Suspended and Hold amount fields are increased and decrease based on the
respective transactions posted.

When two applications are being funded simultaneously (i.e. moving application to ‘Approved
Funded’ status), the utilization amount will be considered for first application while the second
one will be on HOLD since there could be a difference in the available credit limit after funding.
In such a case, you need to re-hash the application, fetch the details in Origination > Decision
tab, (if required) increase credit limit from servicing module, and then proceed for funding.

While processing applications using Customer Credit Limit, the ‘Update Customer Info’ (check
box in applicant tab) and ‘Link to Existing Customer’ (check box in contract tab) are selected
by default for all the existing customers. This is to ensure the application details are
propagated to customer accounts.
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On funding a new application for an existing customer using customer credit limit, the details
are updated into the existing customer details in the Servicing module.

To define Credit Limit Details

1. Open Underwriting screen and load the underwriting application you want to work with.

2. Click ‘Customer Credit Limit’ tab.

ORACLE’
Financial Services Lending and Leasing

BSHEKAR ~ 1 signout

Origination

Summary | Appicant | Business Request  Dedson  Customer Creditlimit Bureau  Colatersl | Comments | Tracking

Credit Limit Details

View v Formatv (& Freeze  EfiDetach ol wrap o)
Relation Type st tanr 2 MName Max Limit % of Utiization Utlization Amt
Business #
PRIMARY 0000000000 PRITAM APP CRDE 0.00 0.00 0.00
BUSINESS 0000000000 oo 10,000,000.00 100.00 0.00

Document | Verification | Correspondence | Tools

Total Utlized Amt Available Amt
0.00 0.00
0.00 10,000,000.00

< i

Credit Limit Details

Relation Type PRIMARY Total Utiized Amt 0,00
Customer # 0000000000 Available Amt 0,00
Name PRITAM APP CROEIT LIMIT Hold Amt 000

* Max Limit 0.00 Suspended Amt 0.00

Application Utilization

* o, of Utiization  0.00 * Utiization Amt 0.00

[ save and stay

Grade
*Max Late Charge 0.0000
* Limit Expiry 12/31/4000

*Limit Next Renewal  12/31/4000

[ lose

o Edit = view | <7 Audit

Suspended Amt Grade

0.00
0.00 A GRADE

!

[ saveandretum || CaRewm

=

& &
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3. Perform any of the Basic Operations mentioned in Navigation chapter. A brief description
of the fields are given below: Perform any of the Basic Actions mentioned in Navigation

Field: Do this:

Relation Type View the relationship type. This field is pre-populated with
details from Applicant tab.

Customer #/ Busi- | This field is displayed blank for new customer/business and

ness # for an existing customer/business, the details are populated

from Servicing > Customer Service > Customer details.

Name View the customer name. This field is pre-populated with
details from Applicant tab.

Max Limit Specify the value of maximum credit limit amount that can be
provided to the customer.

For new customer/business, the amount is pre-populated
based on selected pricing in Decision tab for new applicant/
business. However, you can override the amount by entering
the required value.

Total Utilized Amt View the total credit limit amount utilized for previously
funded applications.

Available Amt View the available credit limit amount on the account which
is the difference of Max Limit - (Hold + Total Utilized + Sus-
pended) amount.

Hold Amt View the credit limit amount on hold which is based on the
Hold transaction posted in servicing.

Suspended Amt View the credit limit amount suspended which is based on
suspended transaction posted in servicing.

Grade Select the required grade from the drop-down list. There is
no validation performed on the selected grade and can be
selected based on customer credit worthiness.

Max Late Charge Specify the maximum late charge amount.

Limit Expiry Select the credit limit expiry date from the adjoining calendar.
The expiry date is validated if application is being funded
based on customer credit limit.

Limit Next Renewal | Select the date on which the credit limit has to be renewed
from the adjoining calendar.

Application Utilization section - This section allows you to define the portion
(either percentage or amount) of credit limit utilization against the financed amount.

For example,

if the amount financed it 10,000 $ and percentage of Utilization for Primary is 80%
then Utilized amount should be 10,000*0.8 = 8000 $.

Similarly, if the percentage of Utilization for Spouse is 20% the Utilized amount
should be 10,000*0.2 = 2000 $.

Note: On specifying either percentage or amount of utilization, the other field is auto
calculated based on financed amount.
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Field: Do this:

% of Utilization Specify the percentage of credit limit utilization allowed
against each applicant (Customer and business) added to
the application.

Utilization Amt Specify the amount of credit limit utilization allowed against
each applicant (Customer and business) added to the appli-
cation.

chapter.
Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

If there are any adverse comments received from the Bureau, system displays them under
'Exceptions/ Comments' section against the specific Bureau record to alert the User.
Following are some of the reasons:

1. Application Indicates Potential Fraud

Bureau Indicates Social Security Number Variance
Duplicate Application Exists

Bureau Indicates a Possible Current Delinquency
Bureau Indicates Bankruptcy

Bureau Indicates Consumer Statement

Bureau Indicates a Possible Repossession

Bureau Reports OFAC hit

9. Bureau Reports Applicant as Deceased

© N o g~ w D

10. Potential Delinquencies for Auto Loans in Past 12 Months
11. Customer Rate (APR) Exceeds the State Usury Rate

12. Open Consumer Credit Counselling

The reasons will also be displayed in the Summary tab in 'Bureau' details under 'Exceptions
/Comments' section.

To verify the credit bureau data using the Bureau tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Bureau.

ORACLE
Financial Services Lending and Leasing
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In the Bureau Details section, view the following information:

Field:

View:

Type

The credit bureau request type.

Bureau

The credit bureau.

#

The credit bureau request number.

Status

The status of credit bureau request.

Dt

The credit bureau request date.

Report

The credit bureau report type.

Credit Bureau
Reorder#

The credit bureau reorder number.

App Ind

If selected, indicates that a bureau was pulled for an application.

4.

In the Applicant/Customer Detail section, view the following information:

Field:

Do this:

Type

View the relation type.

First Name

Specify the first name.

Specify the middle name.

Last Name

Specify the last name.

Status

View the credit bureau request status.
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Field:

Do this:

Birth Dt Specify the date of birth.

SSN Specify the social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Suffix Select the generation.

Include Debt | Select to include credit bureau information in the Liabilities section of
the Summary sub screen.

Populate Select to load debt information from the credit bureau in the Liabili-

Debt ties section of the Summary sub screen.

Address Type | Select the address type.

Country Select the country.

Address # Specify the building number.

City Specify the city.

State Select the state code.

Street Pre Select the street pre type.

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street post type.

Apt #

Specify the apartment number.

Address Line
2

Specify the address line 2.

Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
Phone Specify the phone number.

5. In the Report Header section, view the following information:

Field: View:

Bureau The bureau.
First Name The first name.
Mi The middle initial.
Last Name The last name.
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Field: View:

SSN The social security number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Birth Dt The birth date.

Note: The SSN and Birth Dt fields in Report Header section are displayed in red if
there is a mismatch in the respective data present in the above Applicant/Customer
Details section.

Report Dt The report date.

Onfile Dt The on file date.

Credit Report | The credit report id.
id

Best Match The best match.

6. Click Bureau Report.

The system parcels out the details from the credit bureau report in the Bureau screen’s
sub tabs (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud
Messages, Inquiries, Also Known As, Consumer Statements, and Credit Scores).

7. Click Summary 1 sub tab.

8. You can view the following information:

Field: View:

Trades Records of extended installment payments, mortgage and revolving
credit, as detailed in the credit bureau report.

Bankruptcy | The total number of times the applicant has applied for Chapter 7,
Chapter 11 and Chapter 13 bankruptcies, recently and throughout life.

Past Due The total number of times the applicant has been past due on pay-
ments by 30, 60, or 90 days in the last year, two years, and throughout
life.

Public Number of legal actions, including liens, public records, and judgments

Records over the course of the applicant’s life, as well as any that are currently
open.

Collection Trades referred to an outside vendor for collection.

Credit View the FICO and bankruptcy scores.

Scores

Statistical Ages of the oldest and newest trades, as well as the average age of

Trade Ages | the open and total trades.

Derogatory | Tradelines that an action other than being late was reported; this
Trades includes collections, repossessions, charge offs, and bankruptcies.

9. Click Summary 2 sub tab
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10. You can view the following information:

In this .

. View:

section:

Trades Records of extended credit for auto, bank, credit card, retail, Loan-
finance, and sales finance Loan, as detailed in the credit bureau
report.

Inquiries Requests for a credit report regarding Loan in the Trades section over
the last six months, as well as total requests over 6, 12, and 24-month
periods, as well as the newest and oldest request.

Balance The total balance of retail and bank trades, as well as the high balance
of each.

Open The following information for all of the customer’s open trade lines: the

Derogatory | shortest and longest period of time (in months) since the customer’s
most recent minor derogatory (30-60 days late), major derogatory (90-
180 days late), and derogatory (bankruptcy, repossession, or charge
off).

Derogatory | The following information for all of the customer’s total trade lines

(open and closed): the shortest and longest period of time (in months)
since the customer’s most recent minor derogatory (30-60 days late),
major derogatory (90-180 days late), and derogatory (bankruptcy,
repossession, or charge off).

11. Click Tradelines sub tab to view information about trade lines, such as the creditor’s
name, trade’s status, type and code and balance information

12. View the following details:

Field: View:

Creditors The creditors name.

Name

Status The status of the tradeline.

Type The type of tradeline, such as bank, first mortgage, travel card, and
SO on.

Type Code The code for the type of tradeline.

Past Due Amt

The past due amount

Balance The balance of the tradeline.

Balance Dt The balance date.

Open Dt The date the tradeline was opened.

History Dt The trade line’s history date.

History Data The trade line’s history data.

30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
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Field:

View:

920 The number of times the tradeline was 90 days past due.
Creditors The creditor’s subscriber number.

Subscriber #

Mop The method of payment.

Account # The account number.

Credit Limit The credit limit.

Term Pmt Amt

The term payment amount.

High Balance | The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.

Special Exclu-
sion

If selected, the tradeline is a special exclusion.

13. Click the Public Records sub tab to view information about public records, including each
one’s type, status, and amount, as well as the date the record was filed and resolved

14. View the following details:

Field: View:

Record The record type.
Type

Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt | The satisfied date.

15. Click the Fraud Messages sub screen to view information about fraudulent attempts to
use the applicant’s credit.

16. Click the Inquiries sub screen to view all the credit reports for the applicant in reverse
chronological order

17. View the following details:

Field:

View:

Inquirer Name

The inquirer’s name.

Inquirer Subscriber | The inquirer’s subscriber number.

#

Inquirer Industry The inquirer’s industry code.
Code

Inquiry Dt The inquiry date.
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7.10.2

Field: View:

Rate Shopping If selected, the inquiry concerned rate shopping.

Duplicate If selected, if the inquiry was a duplicate.

18. Click the Also Known As sub screen to view other names used by the applicant.

19. Click the Consumer Statements sub screen to view statements that the applicant has
issued to the credit bureau.

20. Click the Credit Scores sub screen to view the score model, the score factor, and the
score returned from the credit bureau report.

Printing the Credit Bureau Data as a Text/PDF Report

To print the credit bureau data as a text or PDF report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. In the Underwriting screen, click Bureau.

3. Inthe Bureau Report tab, the system displays the report in text format. You can also view
the report in PDF format by selecting ‘PDF’ option as View Report.

Note

Google Chrome does not support search functionality in the PDF format of the report.
Hence you have to enable the ad-hoc plug-in in chrome to use the search facility.

4. In the Print Report section, click Print Report to send the information to the default
printer.

Requesting a Credit Bureau Report Manually

The Credit Bureau Summary screen enables you to manually request a credit pull.
Information from a manual credit pull can be used to validate an application.

To manually request a credit bureau report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Bureau tab.
In the Bureau Details section click Add.

4. Specify the following information:

Field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau.
Report Select the credit bureau report type.

5. Click Create Request.
The system displays this information in the Bureau Details section.
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Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. Select Include Debt and Populate Debt in the Applicant/Customer Detail section to
populate the Liability section on the Applicants link’'s Summary sub screen with data from
the credit bureau pull.

7. If you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section. This enables you to receive a previously pulled credit report.

8. Inthe New Request section, click Submit Request.
The system displays the latest status of the currently requested bureau report in the Bureau

Details section. When the report pull process is complete, the Status field in the Bureau
Details section changes from PENDING to COMPLETED.

Collateral Tab

Having selected and loaded an application, you can view the information about the collateral
of the Loan.

The Collateral link opens screens with information regarding any collateral associated with an
application. Depending on the type of Loan, collateral can be a vehicle, home or something
such as major household appliances. The Collateral tab is unavailable if this is an unsecured
Loan.

To verify information about the collateral
1. Open the Underwriting screen and load the application you want to verify.

2. Click the Collateral tab.

Depending on the type of collateral, information about the vehicle, home, or other type
of collateral appears.

If you are entering an unsecured Loan, the Collateral link is present but inactive; in
which case, skip this step.

3. Inthe Collateral Details section (This is information that was recorded during the
application entry process or gathered during the credit pull.)
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To enter collateral information

1. On the Underwriting screen, click Collateral. If the collateral is a vehicle, the Collateral
link displays information about the vehicle.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Status

Select the asset status.

Type and Description

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year

Specify the year of the vehicle.

Age

View the age of the vehicle

Make

Specify the make of the vehicle.

Model

Specify the model of the vehicle.

Body

Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.
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Field:

Do this:

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
County Select the county.

Usage Details

The details maintained in this section is used to calculate ‘EXCESS USAGE FEE’ in pay-
off quote and termination transactions.

Start View/specify the start unit of asset usage.
Base View/specify the base units.

Extra View/specify the extra usage units.

Total View/specify the total usage units.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Interface with VINTEK (If interface is installed)

Using the Vintek interface, the system retrieves the year, make, model and body of the vehicle
when you choose Vehicle Details. This time saving feature reduces data entry errors. Using
the VIN entered in the Identification Number field, the system populates following fields in the
Type & Description section:

e Year
e Make
e Model
e Body

If the Vintek interface is unable to retrieve information based on the VIN entered in the
Identification Number field, the system displays an error message.
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If the collateral is a home, the Collateral link displays information about the home.
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1. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Indicates that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Select if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Occupancy

Select owner occupancy type.

Identification #

Specify the vehicle identification number.

Address section

Country

Select the country.

Address #

Specify the home number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

State

Specify the state.
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Field:

Do this:

County Select the county.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.

Type and Description

Census Tract/BNA | Specify census tract/BNA (block numbering area) code.
Code

MSA Code Specify the metropolitan statistical area (MSA) code.
GEO Code Specify the geographical code for the property.
Condition Select the condition of the home.

Description Specify a description of the home.

Select Make and
Model

Select the make and model from the drop-down list

Year Specify the year when the property was built.
Age View the age of the home.

Make Specify the make of the home.

Model Specify the model of the home.

Width Specify the asset width.

Length Specify the asset length.

Area Specify the area of the collateral

PO# Specify the asset purchase order number.

Legal Description

Specify the legal description.

Lot Specify the asset lot.
Sub Division Specify the asset sub division.
Parcel ID Specify the parcel id of the home.

Metes-Bounds

Check this box to indicate the home is considered Metes-Bounds.

Flood Zone

Check this box to indicate the home is in a flood zone.

1098 Not Required

Check this box to indicate that the home does not require 1098

Deed Details
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Field:

Do this:

Construction per-
mit Dt

Specify the date on when the construction is permitted.

Deed Dt

Specify the date on when the deed is issued

Deed Place Of
Issue

Specify the place where the deed is issued.

Properties Bound-
ary from East

Specify the boundary of the property from the east side.

North

Specify the boundary of the property from the north side.

West

Specify the boundary of the property from the west side.

South

Specify the boundary of the property from the south side.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

If the collateral is an

y other, the Collateral link displays information about that collateral.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.
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Field: Do this:
Asset Class Select the asset class.
Asset Type Select the asset type.
Sub Type Select the asset sub type.
Status Select the asset status.
Select Make and Select the make and model of the vehicle from drop-down list.
Model
Year Specify the year of the vehicle.
Age View the age of the vehicle
Make Specify the make of the vehicle.
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.
Registration # Specify the vehicle registration number.
Identification # Specify the vehicle identification number.
Description View the vehicle description.
Condition Select the vehicle condition.
Address
Country Select the country.
Address # Specify the apartment number.
Address Line 1 Specify the first address line.
Address Line 2 Specify the second address line.
State Select the state.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
County Select the county.
Usage Details
The details maintained in this section is used to calculate ‘EXCESS USAGE FEFE’ in pay-
off quote and termination transactions.
Start View/specify the start unit of asset usage.
Base View/specify the base units.
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Field: Do this:

Extra View/specify the extra usage units.

Total View/specify the total usage units.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Valuations Sub Tab

The Valuation sub tab contains information about the value of the asset. The Values section
enables you specify the value of the asset. The Addons section records information about any
add ons associated with the collateral.

To complete the Valuations sub tab
1. Click the Valuations sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value section

Current Select if this is the current valuation.

Valuation Dt Specify the valuation date.

Source Select the valuation source.

Currency Select the currency based on which the valuation is to be done.

Edition Specify the valuation edition.

Supplement Specify the valuation supplement.

Whole Sale

Loan Currency | Specify the Loan currency wholesale value.

Wholesale

Base Amt

Wholesale- Specify the wholesale value.

Base Amt

Usage Specify the usage value; that is, the monetary effect that the current
mileage has on the value of the vehicle.

Retail

Retail Base Specify the retail value.

Amt

Addons Amt (+)

View the add-ons value.

Usage Value
Amt (+)

Specify the usage. This pertains to Loan and usually is entered as the
current mileage on the vehicle.
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Field:

Do this:

Total Value Amt
(=)

View the total value.

LoanCurrency
Retail Base
Amt

View the Loancurrency retail value.

LoanAddons
Amt(+)

View the Loan addons.

Loan Currency
Usage Value
Amt (+)

View the Loan currency usage value.

Loan Currency
Total Value Amt

=)

View the Loan total value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Addons Section, perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the description for the attribute.
Value Specify the value of the attribute.
Amount Specify the add-on amount.

Loan Currency
Amount

Specify Loan currency amount.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Complete the Addons/Attributes, Value, and Amt fields for each of the asset’s add-ons
and attributes on the application.

Tracking Sub Tab

The Tracking sub screen enables you to record further information associated with the
collateral. What items you choose to track are setup during implementation.

To track attributes for the collateral

1. Click Tracking sub tab

2. On the Tracking sub screen, click Load Details.

3. Inthe Tracking Items section, select the item you want to track.

4. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Tracking Item

View the tracking type

Disposition

Select the disposition.

Start Dt

Specify the tracking start date.

End Dt

Specify the tracking end date.

Follow up Dt

Specify the next follow-up date.

Enabled

field.

Select to track the information from the start date in the Start Dt

Comment

Specify any comments regarding the tracking item.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Complete the Tracking Item Details section by entering information about a parameter
in the corresponding the Value field.

Seller Tab

The Collateral link’s Seller Details tab enables you to enter the seller details of the collateral

of the Loan.

To enter the Seller details

1. Click the Seller Details tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this

Seller Information section

Seller Type Select the seller type.

Seller Name | Specify the seller name

Nationality Select the seller’s nationality.

National 1D/ Specify the national identification number or registration number.
Reg #

Authorized Specify the authorized signatory of the seller.

Signatory

Seller Addres

s section

Mailing Select if this is the mailing address. Only one address entry can be
marked as the mailing address.

Current Select if this is a current address. The mailing address must be marked
as current.

Country Select the country code.

Address # Specify the address number.

Address Line | Specify the first address line.

1

AddressLine | Specify the second address line.

2

State Select the state.

Zip Select the zip code.
For non US country, you have to enter zip code.

Zip Extn Select the zip extension.

City Specify the city.

Phone Specify the telephone number.

Extn Select the telephone extension.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

tastabComments Tab

When using the Underwriting screen, you can add/delete comments to an application at any
time in the underwriting process by using the Comments screen.

Whenever an application is decisioned by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Underwriter <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of
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User2, who is the concerned Underwriter. The concerned Underwriter's name will also be
selected in Application section > 'Proxy for Underwriter' field.

To add comments

1. Click Comments tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Alert Check this box to make the comment appear on the Customer
Service screen Alert section

Type Select the type of comment you are adding.

Sub Type Select the sub type of comment you are adding.

Comment Specify your comment.

Comment By The system displays your user ID.

Comment Dt The system displays commented date and time stamp.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.12.0.1 Deleting Comment(s)

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment

1. Select the row which consists of the comment and click Delete from the actions.

2. Click “Yes’ to confirm delete in the warning message displayed.
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7.13 Tracking Tab

When using the Underwriting screen, you can add tracking attribute information to an
application at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes
1. Click Tracking tab.
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2. On the Tracking Attributes screen, click Load Tracking to load the tracking attributes.
3. Select the item you want to track.

4. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

5. Save changes you made to the account.

7.13.1 Field Investigation Sub Tab

The Field Investigation link enables lending institutions to perform field investigations and
verify an applicant’s contact points (address and employment information, for example) and
credentials (such as asset details). Clients can chose the details to be verified (address,
employment, asset or any combination of the three), as well as the verifying agency.

With the Underwriting screen’s Field Investigation screen, you can select which details from
application entry are to be verified. The verifying agency performs a field investigation of the
details and responds to the lending institution with either XML or a text file. The details are
entered in the system for an underwriter to review when making a decision.
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1. Click Field Investigation sub tab.

2. In Field Investigation section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Applicant

Select the applicant from the adjoining drop-down list

Verification Type

Select the verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the status from the adjoining drop-down list.
Spoke to Specify the name of the person applicant spoke to
Call Dt Specify the call date

# of Attempts Specify the number of attempts made.

Result Select the result from the adjoining drop-down list

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Verification Match

Check the box if the verification has matched.

Remarks

Specify remarks, if any

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Document Tab

The Document tab allows you to view documents attached to the application in the form of

GIF files, PDF files, DOC files, XLS files and TXT files and add comments regarding a

selected.

For more information, see the chapter Document Management in this User Guide.
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To view a document attached
1. Click Document tab.
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2. Inthe Application Document section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below.

Field: Do this:

Document Type View the document type.

Comment

Specify any comments regarding the document.

Field: View this:

Document Sub
Type

The document sub type.

Version
version will start with 1.0.)

The version. (Version numbers will be incremental by batch job, first

Page # The page number.

Document File
Type

The document file type.

Tracking #

The tracking number of the document.

Docket #

The docket number of the document.

Location

The location of the of the document.

Received Dt

The effective date of the document.
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Field:

View this:

Effective Dt The effective date of the document.
Expiry Dt The expiration date of the document.
Comment Any comments regarding the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

Checklist Sub Tab

The Checklist sub tab enables you to view tasks performed during the underwriting process.

To view the underwriting Checklist screen

1.

o M 0D

Click Document > Checklist.
If the Checklist section is empty, click Load Checklist in the Checklist section.

In the Checklist Actions section, click Regular sub tab.

In Checklist Actions section, complete the tasks listed in the Checklist Action column.

Use the Yes/No/NA buttons in the Yes No NA column to indicate whether you completed
the task or not.

Use the Comment field to add remarks regarding any of the tasks, if you choose.

When you are finished completing the tasks, choose Complete in the Checklist section.

= © ® N o

Click Save.

In the Checklist Actions section, click the Documents sub tab

0. In the Documents section, select the record you want to work with and click View in the
Details column.

11. In the Documents section, view the following information:

Field:

Do this:

Action

View the action to be performed.

Document Type

View the document type.

Document Sub
Type

View the document sub type.

Status Select the status of the action.

Response Use the Yes/No/NA buttons to indicate whether or not
you completed the task.

Comment Specify comment.
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Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning, or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

If it is a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed,;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Loan. Each one of these ‘edit types’ has its own set of ‘edit details’.

Note

The Edit Details section’s errors and warnings are created during the setup process.

Edit Sub Tab

To complete the Edits section

1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Edits.

opacie

Financial Services Lending and Leasing

(¥ Close
5 DashBoard Origination x ]
Origination SearchTask  Underwriting: 0000001050  Review Requests (Pending: 0)
Origination
Sales ead Application: 0000001050; GURLEY JENNIFER / TODD Zit || Eew | o auit
Simple Application Entry . " .,
Vieww Format v Freeze gzf: Detach Wrap Override OK ¥ Waming OK ¥
Application Entry % d E @ i R
Undervriting . Origination Stage N O Duplicate
et ot Apr Sub Unit Status Code Producer Name. PE: Eisting Customer it Contact Sales Agent Branch Prov
Applcation Retrigval 04062015 0000001050 'UNDEFINED NEW - REVIEW REQUIRED  REVIEW PR-00002 : PORSCHE INDU. L ¥ DEMOSALES UsHQ Lo#
Scenario Analysis )
Application Documents
Image Maintenance
Reports
Producers Summary Applicant Business Request Decision Bureau Collateral Comments Trackng Document Verification Comespondence Tools
Vendors
Edits | Audits || History
Edit Types
View Fomatv [ [l Freeze Hf Detach wap @) EditType v CheckEdits {
Date Edit Type
01202016 APPLICATION APPROVAL EDITS
12/15/2015 APPLICATION PRESCREENING EDITS
12/15/2015 APPLICATION ENTRY EDITS v
Edit Details
Viewv Fomatv 8 []Freeze g Detach wap @
> Sevicing Edit Name Result  Expected Value Actual Value  Overrde Responsibility
= XVL: DECISION LOAN AMOUNT <> SUM OF APPROVED ITEMIZATION DETAILS 347338 9579 NO RESPONSIBILITY
> Collections VL : DECISION RATE HOT EQUAL TO APP REQUESTED RATE [ [ 140 RESPONSTBILITY
» WFP REQUIRED : SIGNING DATE NG NA A NO RESPONSTRILITY
= REQUIRED : PROBABLE DELIVERY DATE NG NA A O RESPONSIBILITY
) Todls RANGE : PRIMARY APL DEBT RATIO (54) > MAX ALOWED B 999.9999 1O RESPONSIBILITY
» Setup RANGE : PRIMARY APLPMT TO INC RATIO STATED > MAX ALLOWED NG 33 993.9999 NO RESPONSIBILITY i
PARIFE L ARTADY AN ARANCEE CTATER WANTLE - LK A1 AWET u n un neenaweran T

7-75 ORACLE



3. Inthe Edits screen’s Edit Type section, select the type of edit you want to verify.

4. Click Check Edits.

The system checks the data for the verification process selected in the Edit Type section
and displays the results in the Edit Details section.

The Edit Details section contains the following display only information:

Field: View this:

Edit Name The edit.

Result The result.

Expected Value The expected value.

Actual Value The actual value.

Override Responsibility The override responsibility, if an override is required.

5. Inthe Edit Details section, view the verification results and begin making corrections on
the Underwriting screen. Remember, edits resulting in ERROR must be corrected. Edits
resulting in WARNING can be by passed.

The system begins processing the credit application.

7.15.2 Audits Sub Tab

The Audits screen is a display only screen that enables you track changes to the contents of
predetermined fields (which fields are determined during set up). For example, the Audits
screen can be configured to monitor when the contents of the Status and Sub Status is
changed. The Audits screen lists the field that was changed, who made the change, when the
change was made, and the old and new values in the field.

To view the Audits
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Audits.

3. Inthe Audit Details section, view the following display only information:

Field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.

Old Value The old value of the column which was changed.

New Value The new value of the column which was changed.

Changed By | The user code who made the change.

Changed The date and time when the change was made.
Date

7.15.3 History Sub Tab

You can track the time it took a user to complete each stage of the application process with
the History section. It displays:

e The date and time when an application changed status / sub status

7-76 ORACLE



e The user who changed the status / sub status
e The elapsed time of how long an application was in a particular status / sub status.

1. To view the History Open the Underwriting screen and load the application you want to
work with.

2. Click Verification > Historyln the Application Status History section, view the following
display only information:

Field: View this:

Status The application status.

Sub Status The application sub status.

User The user name.

Start Dt The date and time when the application moved to that status.

End Dt The date and time when the application moved from that sta-
tus.

Elapsed The elapsed time between the status change.

Time

7.16 Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’'s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

7.16.1 Correspondence Sub Tab

To generate an ad hoc correspondence

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Correspondence > Correspondence.

|ORACLE’
Financial Services Lending and Leasing
e Origination
Ongination Surmary || Applcant || Request || Dedsion | Bureau | Colatera | Comments | Tracking | Document || Verificaion | Correspondence | Tods
Orignation 2 Correspondence  Letters
Sales Lead
Simple. Application Entry
Appiication Entry Correspondence oqp add || [ view || o Audit
Underwriting View v Format~ [ Freeze  EffiDetach Wirap W
Funding ID Correspondence Date
Application Retrieval 18005 SAMPLE LOAN APPLICATION 03/14/2016
Scenario Analysis
Applcation Documents
Image Maintenance Documents
Reports View Formotw | [} | [[[Freeze EfDetach w | @ @ eenee
Prodoas Document Id Document Recpient EFormSource  Sourca Type Selected  Generated
ol 16003 SAMPLE LOAN APPLICATIONS PRIMARY oFsLL ORACLE: BI PUBLISHER
‘
Document Elements Bluen || o Audt
view v Format v [y Freeze  EffiDetach Virap 5]
Element Type Element Content
‘SYSTEM-DEFINED PRIMARY APPLICANT BIRTH DATE 08/16/1991
SYSTEM-DEFINED PRIMARY APPLICANT NAME BOBEURI MADHU
SYSTEM-DEFINED APPLICATION REQUESTED ADVANCE AMT. 10000.00 £
SYSTEM-DEFINED APPLICATION APPROX CASHPRC 0 i
SYSTEM-DEFINED APPLICATION ASSET DESC 0TOYOTA CAMRY
SYSTEM-DEFINED PRIMARY APPLICANT S5N X00K2511
SYSTEM-DEFINED APPLICANT ADDRESS1 23N NEAR YELLAMMA TEMPLE ROAD BCH N % 23
SYSTEM-DEFINED APPLICANT ADDRESS2 LE 2
- T SYSTEM-DEFINED APPLICANT ADDRESS3 COAMO PR 00763 US
jassending SYSTEM-DEFINED APPLICANT EMPLOYER NAVE GEE -
> Collections
> WP
> Tools Recipient Details dpadd | Ledt | Fvien || o audt
- Vien v Formatv B Freeze  EffiDetach @ Esend
Setup) Redpient Mode Troe FAEmai SentIndeator  Comments

[]Close

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Correspondence

Select the correspondence you want to generated.

ID

System displays the correspondence ID.

Date

System displays the correspondence generation date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Documents section displays all the types of documents available for the type of
correspondence you selected.

5. In the Documents section, view the following information for each document:

Field:

View this:

Document ID

The document ID.

Document

The document description.

Recipient

The recipient description.

E-Form Source

The e-form source.

Source Type

The source type.

Selected

If selected, indicates that this document is selected to be included
in the correspondence.

Generated

If selected, indicates that the system generated the document.

6. Inthe Documents section, select the correspondence you want to view.
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7. The Document Elements section displays the elements the system used to generate the
correspondence. You view the following information:

Field: Do this:

Element Type View the element type.

Element View the element description.

Content Specify/view the value of the element.

e Click All to view all elements in the correspondence.
- Or -
e Click User Defined, to view user-defined elements in the correspondence.

8. Inthe Document Elements section, click User Defined and complete the Content fields
for the Document Element fields you want to include in the correspondence.

9. In the Document Elements section, click Save.

10. In the Documents section, click Generate.

The system ‘locks’ the information included in the correspondence and prevents it from
being changed.

11. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

7.16.1.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Applicants,
Customers, Producers, and Others as either Fax or Email.

To add recipient details

1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.16.2 Letters Sub Tab

The Letters link enables you to generate letters using predefined letter templates for Loan.

Letters can be sent in hard copy or Email / Fax. Among the two options provided for each of
these options, you can select the required mode for sending letters.

e When 'Letters' option is selected the correspondences generated are displayed in a
table below with a button 'View Letter'.

e When 'Fax' radio button is selected, the correspondence table displays all
correspondence including those in Fax or email formats in the table below.

In addition to the above, a section for recording 'Recipient details' opens below. On clicking
'Add' you can specify recipient details, Mode, Type, provide comments and Save the same.
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Comments captured will be appended to Fax / Email sent to recipient. You will then need to
click on the 'Send' in the action block for email / fax to be sent from OFSLL. In case the
correspondence generation is dependent on any job run, then on click of 'Send' system
displays an error message "Fax / Letter not generated. Please try sending later”; else event
successful message is displayed.

On the Underwriting screen, these predefined correspondences are as follows:

e Decision Letter
e Adverse Action Letter
e Adverse Conditional Letter

To generate letters on the Underwriting screen
1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Letters.

3. Inthe Letters screen, select the type of letter you want to generate, and click View Letter.
UNDERWRITING:
— Ifyou select Decision Fax, and click View Letter, the system displays the decision
letter.

The predefined Decision letter is automatically sent after an application receives a
status of APPROVED, REJECTED, or CONDITIONED on the Underwriting screen.

The Decision fax/e-mail is available for Loan(fixed and variable rate).

— Ifyou click Adverse Action, and click View Letter, the system displays the adverse
action letter.

The predefined LoanAdverse Action letter is automatically sent to the producer after a
configurable number of days when an application receives a status of REJECTED on the
Underwriting screen.

The Adverse Action letter is available for Loan(fixed and variable rate).

— If you click Conditional Adverse Action, and click View Letter, the system
displays the adverse conditional letter.

The predefined Conditional Adverse Action letter is automatically sent to the producer
a configurable number of days after an application receives a status of CONDITIONED
on the Underwriting screen.

The Conditional Adverse Action letter is available for Loan(fixed and variable rate).

4. In the Recipient Details section, you can send the ad-hoc correspondence. You can
specify the following details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

5. In the Recipient Details section, click Save.

6. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.17 Tools Tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

7.18 Review Request

The Review Requests screen is primarily a work flow tool used to flag an Application for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Application. The Review Request tab supports iterative review of
selected Application and also to process the review with multiple reviewers.
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7.18.1

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

To complete the above mentioned tasks for an Application Review Request, use Review
Request tab available in the Origination (Application Entry, Underwriting and Funding)
screens.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.
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Query .

Options Descriptions

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Applica-
tion

Displays the Application Entry screen with the Application details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section

enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Origination screen displays the following information for

each record:

Fields

Descriptions

Request #

View the system generated review request number. The same
can be used to query and track the review requests.
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Fields

Descriptions

Originator The user id of the review request originator.
Priority The request priority: HIGH, NORMAL, or LOW.
Receiver The recipient of the review request.
Application # The Application number which needs review.

Application Status

The Application status of the request being reviewed.

Applicant Applicant’s name in the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Reason Stated reason in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an
Application review request is forwarded to multiple reviewers and is reviewed or completed
by second or third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.
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Comments From | Descriptions

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt View the Date and time when the comment was posted.

7.18.2 Create and Send Review Request

The review request tab primarily allows you to flag an Application for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen

and select ‘Review Requests’ tab.

ORACLE’
Financial Services Lending and Leasing

Origination y [dose

Review Requests

Request # 12002 Sender Application Status NEW - BLANK
Originator * Application # 0000001029 Ad Applicant CRACLE MADHAN / MADHAN
*Pririty HIGH [~ *Resson REVIEW APPLICATION = Rl dae
Address  NORMAL ADDRESS - 745
/NEWYORK,MASSACHUSETTS, 34038
Status Email EDW.SIRSI@GMAIL.COM
Comment REQUEST TO REVIEW THE FUNDED CALCULATIONS. Date 09/18/2017 12:12:23 AM

*Receiver | ANAND SHEKAR ~

SendRequest [¥]

Comment History
vews Fomatw | [Ep | [[]|Freeze [HfiDetach e @
Type Sub Type Commen t Comment it By Comment tDt

No data to display.

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.
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In this field: View this:

Originator View the requester’s user ID auto generated by system upon
creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Application # Select the Application to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Application Status
Applicant

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.
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7.18.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Application # link opens the Review Request tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service x ~ DashBoard x [®] Glose
Origination Setup Admin
My User Queues | | Product Expiring in Next One Month Critical Batch Job Status
] ] ]
Desaription Count Product End Date Batch Job Status
Mo data to display. o data to display. Mo data ta display.

My Pending Review Requests By Applications

i

App = Priority
0000001044 NORMAL

My Pending Review Requests By Priority

|
Priority Count =
Servicing Producer Vendor
Number of Queues Hard Assigned Producers Count By Status ‘Vendors Count By Status
@ @ @
Queue Desarption Count Status Count Status Count
No data to display. acTVE £ ACTIVE 27
Number of Accounts Producers Expiring in Next One Month || vendors Expiring in Next One Month
® i} @
Queue Desaription Count Producer End Date Company Name End Date
No data to display. Mo data to display. No data to display.
My Pending Review Requests By Accounts Producers Count By ACH Status o
0 a

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service x || DashBoard ¢ Origination x [ Cose

SearchfTask | Application Entry | Review Requests (Pending: 1)

Review Requests
Fadd | SEit | Elven || o audt

e Email
User - Originator @ Receiver ©) Both view Al [F] Forwarded oy [ Originator £ Receiver
View v Format+ B Freeze i Detach Wrap @ 2 Cpen Application SendRequest  [f3 SendResponse [ Close Request  [igk Complete Request (3] Remove Fiter
Request = orignator Prierty Receiver Applcation * Applcation Status Applcant Phne Addr
11002 HARISH MACHA NCRMAL ANAND SHEKAR 0000001044 NEW - BLANK DMOEE DEP 12334 NORI
< i ] v
Comment History Ben
Views Fomatv [P | [ Freese liDetach » | @
Type b Type Comment Comment By Comment Dt
REVIEW REQUEST ORIGINATOR REVIEW PHONE NO HMACHA 05/14/2017 03:59:29 PM

2. In the Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Application’. The Application details are displayed in Application Entry >
Summary tab.

4. Review the details in particular to the details specified in the comment (if any).

7.18.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.
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7.18.5

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.
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7.18.6

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ Save andReturn | {aReturn

Request # 8002 Sender MAVEEN REDDY Days PastDue 0

Originator PRITAM JENA Account # 2000010011820 Total Qutstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bolonce

et AEISE TR, = Customer ALIVE PRI / DEA SPO

Phone 9728663378

i F
o Statis WAITING FOR RESPONSE S ——
Bl G300 07 09252 1. NEVIYORK, MASSACHUSETTS, 34038
Send Request [ Email EDW.SIRSI@GMAILL.COM

Comment History | View
view v Format > Fresze  fDetach wrap @R
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REV] REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM
SYSTEM GENERATED REVIEW REQUEST : 6002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  05/06/2017 09:35:45 AM
REVIEW REQUEST RECEIVER FWD SURABHIL 09/06/2017 09:34:31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

5. (Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.
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7.18.7

7.18.8

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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8.1

8.2

8. Funding

Introduction

At this stage of the Loan origination process, the application has been entered into Oracle
Financial Services Lending and Leasing and approved manually by an underwriter or by the
system. The next step is to view and complete the contract information and make a funding
decision to finance or reject the application. This is accomplished by using the Funding
screen.

This chapter explains how to:
e Load an application on the Funding screen
e Change the status of the application to begin funding process
e Verify the applicant information
e View the credit pull and underwriting information
e Verify the collateral
e Add comments and tracking attributes
e Complete the Contract screens
e View an application’s contract edits
e Audit changed fields and status history
e Change the status at the end of the funding process.

Funding (an overview)

In Oracle Financial Services Lending and Leasing, the funding process follows these basic
steps:

1. Open the Funding screen and load the application you want to work with.

2. Inthe Funding screen’s Applications master screen, Change the status of the application
to APPROVED - VERIFYING.

3. Using the Funding screen’s Applicants link, view and verify information about the
applicant (data recorded from the Application Entry screen). This includes verifying the
applicant’s actual address and employment information.

4. Using the Funding screen’s Decision link, view and verify information supplied during the
credit bureau pull and underwriting process. This is display only information and cannot
be edited.

5. Using the Funding screen’s Collateral link, view and verify information regarding the
collateral for the application.

6. Using the Funding screen’s Contract link, complete the truth-in-lending information.

7. Inthe Funding screen’s the Applications master screen, change the status to FINAL
DOCUMENT CHECK.

8. Using the Funding screen’s Verification link, view any errors and warnings that prevent
the status change.

9. Make changes to the application data that correct the errors until you can change the
status.

When the system changes the status of the application to FINAL DOCUMENT CHECK, it
sends the application to a supervisor or Loan officer queue where it is viewed and verified.
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8.3

After this, the application’s status is changed to APPROVED - VERIFIED. If the supervisor/
Loan officer decides to fund the Loan, he or she will change status of the application to
APPROVED - FUNDED.

Loading an Application on the Funding screen

The first step in the funding process is to open the Applications form and manually or
automatically load the application you want to work with. You can manually select an
application using the Search tab’s Criteria and Results screens. If your system is configured
to load applications based on work queues, use the Queue field in the Quick Search section.

Refer the chapter Searching for Application for more information on the following:

e Using Search Criteria screen
e Using Quick Search section
e Using Result screen

e Loading an application

Funding non OFSLL Loan Applications

Oracle Financial Services Lending and Leasing can readily process credit contracts
generated from external system for funding. You can load the credit applications data
received from external system into OFSLL through the 'Application Entry' screen and proceed
with funding. For more information, refer 'Entering a Credit Application' section.

Once the application is processed or approved through OFSLL funding screen, the external
system is intimated with the decision. Those applications can still be processed further in
external system itself to validate the contract against approved credit. If agreed, the signed
contract documents can be distributed in electronic format to OFSLL for funding. Once Credit
Contract is distributed, the ‘Contract Type’ is automatically changed to eContract/Dealer in
OFSLL and notified to the user.

All communications between OFSLL and external systems are recorded into a log and is
accessible through Dashboard > System Monitor > Database Server Log Files screen. Also
the ‘Comments’ screen facilitates to exchange information regarding credit contract
processing between OFSLL and external system as comments, provided the comment Sub
Type is selected as 'OUTBOUND TO INTERFACE' for such communications.

In addition, OFSLL also supports revoking of funded credit contracts worked through external
interface by reversing the active transaction in Customer Service > Transaction History >
Transaction tab. Whereby the application/account status is changed to 'Void' and
subsequently categorized as FLAT CANCEL (indicating as fraud application and funding is
withdrawn) or UNWIND (when application still has errors and allowed to update/rectify details
and resubmit for funding).

Overall, this process minimizes the application processing time and fastens the funding
process.

Funding Screen’s Master Screen

The Funding screen’s master screen displays information from the Application Entry and
Underwriting screens, such as the application number, product and producer. It also contains
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the Status field that allows you to change the status/sub status of the application and begin
the funding process.

ORACLE’
Financial Services Lending and Leasing
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opliation By Viewv Formatw (B sze i Detach Wirap @) OverideOK _ WamingOK _
Underwriting Qrigination Stage Producer Contact oo Duplicate
= Dt App # Sub Unit Status e Producer Name 120 Bisting Customer | SRS Contact
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Stenario Analysis
Application Documents
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Reports
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[ save and stay || [ Save and Retun | (3 Retun
Vendors
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Termitory

CRBPull _

Sub Unit Bkt Gt 5 Override OK_
E i Duplicate Application — Mloerrg 00—
Origination Stage Code [
Summary | Applicant | Request | Decision || Bureau | Contract  Comments | Tracking || Document | Verificaion = Comespondence
> Super Summary
Applicant
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No data to display.
> Servicing
e
> Collections ? Ratios
> WFP
> Tools » Bureau
]
> Setup

For details on this screen refer Applications section in Underwriting chapter.

After opening the Funding screen and loading the application you want to work with, you must
change its status to APPROVED - VERIFYING before you can begin the funding process. This
allows you to begin working with the application.

To change the status and begin work on the application on the Funding screen
1. Open the Funding screen and load application you want to verify.

2. Inthe Funding screen’s Applications master screen, use the Status field to select
APPROVED - VERIFYING.

3. Click Save on the Funding screen.
You can now begin making changes to the application.

Funding an Application

After you have verified the application, entered the contract information and completed the
contract edits, the application is ready to be funded. Applications can be approved
automatically or manually. To manually fund an application, change the status to APPROVED
- FUNDED.

After an application is funded, the Loan origination cycle is over. The system moves the
application to the Loan servicing module (Customer Service form) where it receives an
account number. The system also automatically creates a check requisition for the funded
account.

Funding tasks
1. Load the application on the Funding form
2. Change the status and initiate Funding process

3. Verify the applicant information
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8.4

8.5

Complete Contract (5) details

Verify the documents

Generate letters

Attempt to change the application status

Verify edits

© ©®© N o o &

Complete Funding

After you approve the application, the information on the Decision tab is unavailable. The
application remains in this status of Approved - Verified until a user (usually a supervisor)
changes the status to Approved - Funded. When the status is changed to Approved - Funded,
the account is created.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, the user can view the applicant details, asset details, ratios (only for
Primary Applicant), trade-In, requested details, approved details, itemization, decision history,
alerts, comments, and checklist details in the respective section.

To view the Summary
1. Open the Funding screen and load the application you want to work with.

2. Click Summary.
ORACLE Y - - oo~ [ =

Financial Services Lending and Leasing
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For details on this screen refer Summary Tab section in Underwriting chapter.

Applicants Tab

Having selected and loaded an application, you can use the Applicants link to view
information about the applicant (s). This is information that was recorded on the Application
Entry screen or gathered during the credit pull. You can edit the data from the Application
Entry screen at anytime in the following steps. Remember to save your work with each
change. Information from the credit bureau pull is available to view only.
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To verify information about an applicant
1. Open the Funding screen and load the application you want to work with.
2. Inthe Funding tab, click Applicants.

3. Inthe Applicants Details section, select the applicant you want to verify and click Edit.

For details on this screen refer Applicant Tab section in Underwriting chapter.

Business tab

If this application is an SME Loan (defined in the Applications section Class field as SMALL
BUSINESS), the Business Applicant link appears on the Funding link bar. This link displays
the small business information recorded on the application entry process. You can edit the
Funding screen at anytime in the following steps. Remember to save your work with each
change.

If there is no business information associated with the application, the Business Applicant link
is unavailable.

For more information about the individual fields in this section, see the Application Entry
chapter.

To verify business information from the Business Applicant link
1. Open the Funding screen and load the application you want to work with.

2. Click Business Applicant.
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For details on this screen refer Business Tab section in Underwriting chapter.
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Request Tab

System displays the calculated Payment, Interest Rate, Term and Loan Amount in the
Request tab.

ORACLE’
Financial Services Lending and Leasing
ok Close
e Origination x Efe
Origination Search/Task Funding = Review Requests (Pending: 0)
Origination
Sales Lead Application At || [ view || o audit
Simple Applicatiol ) . )
Application Enry View v Format~  [Ep Frezze Bl Detach Wirap W overide OK _  Wamning OK __
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heniacenvisd ||| B d(ata to display. "
Scenario Analysis
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Reparts Summary = Applicant Request Decision Bursau Contract Comments Tracking Document Verification —Correspondence
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Itemization  Subvention
Itemization
E saveand stay || B save and Retum || < getum
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No data to display. 4]
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< >
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> WFP
> Tools
> Setup

For details on this screen refer Request Tab section in Underwriting chapter.

Decision Tab

With the Decision tab, the system displays information gathered during the underwriting
process. Depending on the type of application you are working with, system displays Loan
information. On Clicking Calculate, the user can calculate the Loan amount, rate, term, and
payment.
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The fields on the Decision screens and sub screens are described in detail in the Underwriting
chapter.

Financial Services Lending and Leasing
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For details on this screen refer Decision Tab section in Underwriting chapter.

8.9 Customer Credit Limit tab

This tab displays the customer credit limit details captured during the underwriting process
and is validated during application funding. Depending on the type of application you are
working with, system displays Loan information.

ORACLE’
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For details on this tab, refer Customer Credit Limit tab section in Underwriting chapter.
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8.1

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab
1. Open the Funding screen and load the underwriting application you want to work with.
2. Click Bureau
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For details on this screen refer Bureau Tab section in Underwriting chapter.

Contract Tab

The screens associated with the Contract link are the core of the funding process. They allow
you to perform the important task of completing the truth-in-lending details. These screens
include information mandated by Regulation Z; information about the financed amount, the
payment schedule, the total of these payments, the finance charge, the resulting annual
percentage rate (calculated according to Federal/Central bank guidelines; that is, within 125%
of the Treasury OCC calculated APR) for the conventional Loan, and internal rate of return for
Islamic Loan. Use the Loan packet to supply the required information.

In completing the truth-in-lending details on the Contract link, you will enter Loan information.
The truth-in-lending details must be completed before a Loan can be funded.

The tabs opened from the Contract link share the following sub tabs:
e Contract (2)
e Repayment
e Itemizations
e Trade-In
e Subvention
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e Insurances

e ESC

e Escrow

e Compensation
e Proceeds

e Disbursement
e Fees

e ACH

e Coupons

e PDC

e References

e Real Estate

You can use the quick calculator provided with the drop-down list adjacent to the ‘Calculate’
button to calculate the required Loan parameters. You can also use the calculator available
in Tools section for completing this step. For detailed information on using the Calculator
tools, refer “Tools” chapter in the document.

To enter the contract details
1. Open the Funding screen and load the application you want to work with.

2. On the Funding screen, click the Contract tab.
e If the application you opened is for a Islamic Loan, the Loan screen appears.

3. Using the information in the contract packet, complete the Contract section.
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(The system calculator may used when completing this section. For more information, see
the Tools chapter.)

4. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

8-9 ORACLE



A brief description of the fields is given below:

Field:

Do this:

Contract section

Contract Revd Dt

Specify the contract received date.

Contract Dt

Specify the contract date.

Instrument

Select the required instrument from the drop down list and click
on Load Instrument Details.

Amt Financed

Specify the amount financed: the Loan amount applied minus the
prepaid finance charges. Prepaid finance charges can be found
on the Good Faith Estimate/Settlement (HUD-1 or 1A). For exam-
ple, if the borrower’s note is for $100,000 and the prepaid finance
charge total is $5,000, the amount financed would be $95,000.
The amount financed is the figure on which the annual percent-
age rate (APR) is based.

Loan Term Specify the term/number of payments.
Index Select the index.
Index Rate View the index rate.

Contract Margin
Rate

Specify the margin rate.

Contract Rate

View the interest rate.

The following 3 fields - Regulatory Name, Regulatory Rate, and Contract Imputed Rate
are displayed only if the ‘Imputed Interest’ check box is selected in Contract Setup (i.e.
Setup > Administration > Products > Contract screen).

The value in these fields are automatically populated from setup on selecting a ‘Instru-
ment’ with imputed interest and clicking on ‘Load Details’.

Regulatory Name

The regulatory name is populated with the value defined in Setup
> Administration > Products > Regulatory Rates screen.

Regulatory Rate

The regulatory rate is populated on loading an instrument with the
‘Interest Rate’ defined for that definition in Setup > Administration
> Products > Regulatory Rates screen

Note: If there are no matching records with regulatory rate, the
Edits (underlying rules) validation fails (if Edits are enabled) and
system does not allow to save the contract information.

ORACLE



Field:

Do this:

Contract Imputed
Rate

View the contract imputed rate which is derived based on Con-
tract Rate and Regulatory rate as indicated below:

e If Contract Rate - Regulatory Rate = 0, Imputed

Rate =0
e If Contract Rate - Regulatory Rate > 0, Imputed
Rate =0

e If Contract Rate - Regulatory Rate < 0, Imputed
rate = Regulatory Rate (minus) Contract Rate.

While funding if the contract Imputed Rate is greater than ‘0’, sys-
tem automatically calculates Imputed Interest Amortization
schedule. For more information, refer ‘Imputed Interest’ section.

Balloon Method

View the balloon payment method.

Balloon Amt Specify the balloon amount.
Due Day Specify the due day.

1st Pmt Dt Specify the first payment date.
Maturity Dt Specify the maturity date.

Finance Charge
Amt

Specify the finance charge: the amount of interest, prepaid
finance charge, and certain insurance premiums (if any) that the
borrower will be expected to pay over the life of the Loan.

Total of Pmts

Specify the total of payments.

Down Pmt Amt

Specify the down payment amount.

Total Sale Price

Specify the total sales price.

Payment Amt

Specify the payment amount.

Final Pmt Amt

Specify the final payment amount.This amount will be same as
that in the Payment Amt field when the installment method is
EQUAL PAYMENTS. (required).

Repmt Currency

Specify the currency to be used for repaying the Loan.

Principal Balance

View the principal balance on the Loan.

APR

Specify the annual percentage rate: the cost of the Loan in per-
centage terms taking into account various Loan charges of which
interest is only one such charge. Other charges which are used in
calculating the APR are private mortgage insurance of FHA mort-
gage insurance premium (when applicable) and prepaid finance
charges (Loan discount, origination fees, prepaid interest and
other credit costs). The APR is calculated by spreading these
charges over the life of the Loan, which results in a rate higher
than the interest rate shown on the mortgage/deed-of-trust note.
If interest was the only finance charge, then the interest rate and
the annual percentage rate would be the same.

Verified Dt

Specify the contract verification date.
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Field: Do this:

Verified By View the user id who verified the contract.

Signing Dt Select the signing date on when the documents is signed.

Probable Delivery | Select the probably delivery date.
Dt

Note: For Islamic products the following additional fields will be displayed.

Residual Income View the residual income for the residual days.

Residual Days View the number of residual days.
IRR View the interest rate of return.
Profit Rate View the profit rate (display only).

Instrument Details — An instrument is a contract with specific rules tied to it. An instru-
ment associated with the application indicates OFSLL of the type of contract being
used for the approved loan. ltems defined in the contract are “locked in” when you
select the instrument from drop down list and click on "Load Instrument Details". These
values cannot be changed on the funding screen.

Any changes to the instrument in account will be handled by monetary/non-monetary
transactions.

The system loads all the rules established by the company that are required at the time
of funding; for example, the accrual method, billing method, type of billing, tolerance,
due dates, extensions and so on.

Accrual Method View the accrual calculation method.
Start Dt Basis View the accrual start basis.
Base Method View the accrual base method.
Bill Method View the billing method.

Bill Type View the billing type.

Time Counting View the time counting method.
Method

Installment View the installment methods.
Method

Calendar Method | View the Calendar Method.
Start Days View the accrual start days.
Stop Accrual Days | View the accrual stop days.
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Field:

Do this:

ACH Fee Ind

Indicates that the ACH fee should be applied or not. Depending
on the status of check box, the ACH fee is applied based follow-
ing conditions

- When the check box is selected and the fee amount is ZERO,
system will not apply the ACH fee.

- When the check box is selected and the fee amount is BLANK,
system will apply the ACH fee from Contract setup.

- When the check box is selected and the fee amount is specified,
system will apply the specified amount and overrides the ACH fee
amount mentioned in Contract Setup.

- When the check box is not selected, system will apply the ACH
fee amount mentioned in Contract Setup.

Promotion Details

— If applicable, enter information regarding any promotion associ-

ated with the application in the Promotion section

Promotion Select the promotion.

Type View the promotion type.
Dlg Days View the delinquency days.
Period Type View the period type.
Period View the promotion period.

Tolerance Amt

View the tolerance amount (displays only).

Index

View the promotion index (displays only).

Index Rate

View the promotion index rate (displays only).

Promotion Margin
Rate

View the promotion margin rate (displays only).

Promotion Rate

View the promotion rate.

Rate Caps and Adj

ustments section

Increase Per Year

View the maximum rate increase allowed in a year.

Increase Max Life-
time

View the maximum rate increase allowed in the life of the Loan.

Increase Floor

View the rate cap (minimum).

Increase Ceiling

View the rate cap (maximum).

Decrease Per
Year

View the maximum rate decrease allowed in a year.

Decrease Max
Lifetime

View the maximum rate decrease allowed in the life of the Loan.

# of Adjs / Year

View the maximum number rate changes allowed in a year.
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Field:

Do this:

# of Adjs / Life

View the maximum number of rate changes allowed in the life of
the Loan.

Advance section

Stage Fund If selected, indicates that multiple disbursements are allowed.
Allowed
Draw End Dt Specify the advance draw end date.

Initial Advance
Max Amt

View the maximum initial advance amount.

Initial Advance
Min Amt

View the minimum initial advance amount.

Advance Max Amt

View the maximum subsequent advance amount.

Advance Min Amt

View the minimum subsequent advance amount.

Late Charge

If selected, late charges are allowed during the disbursement

Allowed period.
Billing Allowed If selected, billing is allowed during the disbursement period.
Billing Method View the billing method during the disbursement period.

Draw Period Rate

Specify the applicable interest rate during the disbursement
period.

PDC section

PDC Ind

If selected, indicates that the customer has opted for PDC.

PDC Security Ind

If selected, indicates that the customer has submitted the PDC as
a security.

Escrow section

Allowed View the escrow allowed indicator. If selected, escrow is allowed
for this account.
Opt Out View the escrow opt out indicator. If selected, escrow is not

allowed for this account.

Post Maturity secti

on

Default Rate

If selected, indicates the default rate is available.

Index

Select the post maturity index.

Post Margin Rate

Specify the past maturity rate.

Billing section
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Field:

Do this:

Pre Bill Days

This is the number of days before the first payment is due that
accounts funded with this Loan instrument will be billed for the
first payment. Thereafter, the accounts will be billed on the same
day every month.

If an account has a first payment date of 10/25/2003 and Pre Bill
Days is 21, then first payment due will be on 10/04/2003, and
then 4th of every month.

Bill Cycle

View the billing cycle.

Payment Caps

Max Pmt Increase
/ Year

The maximum payment that can be increased for the year.

Max Pmt Increase
/ Life

The maximum payment that can be increased in the life of an
application.

Others

Stmt preference
mode

Select the account statement preference mode as either Email or
PHYSICAL from the drop-down list.

By default, the option selected in ‘Product’ setup screen (Setup >
Administration > Products > Contract screen) is displayed.

Recourse Details

Recourse

View the recourse indicator. If selected, it indicates that there is a
recourse associated with the Loan and the following recourse
details can be specified.

Recourse Type

Select the recourse type as either 'Partial' or 'Full' from the drop-
down list.

Recourse Rea-
son

Depending on the type of recourse selected, you can select the
following type of recourse reason from the drop-down list.

For recourse type as 'Partial', system defaults the recourse rea-
son as ‘Partial’.

For recourse type as 'Full', you can select one of the following
options:

- Fraud

- Titles

- Fraud and Titles
- Full

- Full and Titles

Recourse Max %

Specify the maximum percentage of recourse allowed. Ensure
that the specified amount does not exceed 100% or the amount
defined at Contract.

Note: You can specify the recourse either in percentage or as flat
amount in the below field.
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Field: Do this:

Recourse Amt If ‘Recourse Max %’ is not specified, you can specify a flat
amount to be allowed for recourse.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Quick Calculate

In the ‘Contract Information’ section, there is a drop-down list adjacent to the ‘Calculate’
button with following options to auto calculate different Loan parameters based on the
data provided. Select the required option from the drop-down list and click ‘Calculate’:

— CALCULATE PAYMENT

— CALCULATE INTEREST RATE

— CALCULATE TERM

— CALCULATE LOAN AMOUNT

The system displays the requested calculation in the respective field.

7. Click Calculate. The system displays the calculation in the respective field.

Imputed Interest

Imputed interest is the difference of interest rate arising when the regulatory rate offered is
less than the contract rate (i.e. market rate). As per the tax regulations, if the stated (regulatory
rate) and market (contract) interest rates are substantially different, it is necessary to record
the transaction using an interest rate that more closely accords with the market rate.

Hence, for a loan with imputed interest rate, along with repayment schedule which consist of
EMI, Principal, Interest and Outstanding Balance, there is also ‘Imputed Interest Amortization
Schedule’ generated to depict the imputed interest calculated with ‘Present value of Principal’
(PVP).

Though imputed interest is part of advance principal, the tax calculation is indicated as
‘Imputed Interest’ which is an additional income and is taxable. The imputed interest
calculation follows repayment schedule and amortization schedule is processed on executing
the batch job TAMIMP_BJ_100_01 (IMPUTED INTEREST AMORTIZATION
TRANSACTIONS PROCESSING).

As part of the funding, if the ‘Contract Imputed Rate’ is greater than ‘0’, system calculates
Imputed Interest Amortization schedule based on following calculation:

e Firstthe Present Value of Principal (PVP) amount is calculated with the available current
amortization schedule for each period.

e The PVP is considered as the outstanding amount and Imputed Interest amount is
calculated based on imputed interest rate for each period. While calculating, system
uses the same contract parameters which are used as part of normal interest calculation
such as First Payment Date, Accrual Base Method and so on.

e The amortization schedule is generated starting from first payment date till the maturity
date.

To record the imputed interest amount during loan creation stage, system automatically posts
FND IMPUTED INTEREST monetary transaction with total imputed interest amount. In case
of loan reversal/cancellation, REVERSE FND IMPUTED INTEREST transaction is posted to
post reversal entry on account for imputed interest.

Once the application is funded, the Contract Imputed Rate is propagated to Servicing >
Account Details > Contract Information tab.
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8.111

Amortization Transactions record is created in Servicing > GL Transactions > Amortized
Transactions with the following details:

GL Transactions x 3 £
Company Account
Ccompany
o~ Format ~  [53 o )
Short Name Hame Currency
uso1 US DOLLAR
EURe
s Amortized Transactions  WFP GL Transactions
Transactions
view = Format = [E)) ceze [ Detact v ] Show A View Last () 1 Day ) 1 Week ® 1 Month () By Date 10t )
Transaction Actount = Account Status Method Frequency Term Balanze Earned
WAPUTED INTEREST 20180300014088-HIERARCHY-SYSTEM-PARAMETER PAYMENT ACTIVE MPUTED SCHEDULE | MONTHLY 2 2.069.88 0.00
v
Amortized Transactions
View v Format~ [ 2 Detach o
GL Post Dt Transaction Tramsaction Amount
o data to displm

e Opening balance is updated with total imputed interest amount which is calculated as
part of Imputed Interest amortization schedule.

e Transaction = IMPUTED INTEREST, Method = IMPUTED SCHEDULE, and Frequency
same as account billing frequency.

If case there is a change in repayment schedule due to change in interest rate, then respective
imputed interest rate also changes since the principal changes. Along with this, if there is an
early Payoff or account Charge-off, the remaining unearned imputed interest is written-off. On
posting monetary transactions which changes the repayment schedule such as ‘Due Date
Change’, ‘Due Date Change Override’, ‘Change Term’ and so on, system recalculates
imputed interest amortization schedule along with repayment schedule and posts an Imputed
Interest amortization adjustment transaction.

In above cases, system posts the following adjustments/write-off and reversal transactions
automatically on loan account to basically write-off some amount:

e |IMPUTED INTEREST AMORTIZE and IMPUTED REVERSE INTEREST AMORTIZE

e IMPUTED INTEREST AMORTIZE WRITE-OFF and IMPUTED REVERSE INTEREST
AMORTIZE WRITE-OFF

e IMPUTED INTEREST AMORTIZE ADJUSTMENT MINUS and IMPUTED INTEREST
AMORTIZE ADJUSTMENT MINUS REVERSE

e |IMPUTED INTEREST AMORTIZE ADJUSTMENT PLUS and IMPUTED INTEREST
AMORTIZE ADJUSTMENT PLUS REVERSE

System automatically creates imputed interest related transaction/journal entries at the time
of processing of the following transactions of loan account.

e Loan creation

e Monthly amortization

e Early loan payoff

e Account Charge-off

e Reversals of loan creation, loan payoff/charge-off

Contract (2) Sub Tab

The Contract sub screen records the application’s servicing branch and collector. It also
displays additional information regarding the contract not covered on the Loan screen, such
as the tolerance, delinquencies, due dates, billings, and extensions.
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To complete the Contract sub tab

1.

Open the Funding screen and load the application you want to work with.

2. Click the Contract > Contract sub tab.

3.

chapter.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field:

Do this:

Servicing Branch

Select the servicing branch for the contract.

Collector

Select the collector for the contract.

Funder

If you are acting as a proxy for a Funder, then you can select
the Funder’s name from the adjoining options list. The list
displays all the associated Funders, Funding Supervisors,
and Funding Managers.

However, this is not mandatory and can be used while auc-
tioning an application on behalf of another Funder.

Misc section

Link To Existing Cus-
tomer

Select to link the application to the existing customer.

Anniversary Period

View the anniversary term.

Default Pmt Spread

View the spread.

HMDA section
Lien Status Select the lien status.
HOEPA Select the home owner equity protection act (HOEPA) code.

Rate Spread

Specify the rate spread. You can calculate this spread from a
tool on the Home Mortgage Disclosure Act (HMDA) website.

Others section

1st Pmt Deduction

View the first payment deduction indicator. If selected, the
first payment deduction is in use.

Days

View the first payment deduction days.

1st Pmt Refund

View the first payment refund indicator. If selected, the first
payment refund is in use.

Days

View the first payment refund days.

Pre-Pmt Penalty

View the prepayment penalty indicator. If selected, a prepay-
ment penalty can be applied.

% of Term for Penalty

View the prepayment penalty percentage of term.

Pay Off Fee

View the payoff fee indicator. If selected, a payoff fee can be
applied to the Loan.
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Field:

Do this:

Rebate section

Rebate Method

View the rebate calculation method.

Rebate Term Method

View the rebate term method.

Rebate Min Fin Chg
Method

View the rebate minimum finance charge calculation
method.

Rebate Min Fin Chg
Value

View the minimum finance charge value.

Acquisition Charge
Amt

View the acquisition charge amount.

Tolerance section - This section displays the tolerance details as defined in Setup >
Products > Contract screen.

Refund Allowed

View the refund allowed indicator. If selected, the refund pol-
icies in this section are in use.

Refund Tolerance

View the refund tolerance amount.

Pmt Tolerance Amt

View the payment tolerance amount.

Pmt Tolerance%

View the payment tolerance percentage.

Promise Tolerance
Amt

View the ‘Promise to Pay’ tolerance amount.

Promise Tolerance %

View the ‘Promise to Pay’ tolerance percentage.

Writeoff Tolerance

View the write-off tolerance amount.

Delinquency section

Late Charge Grace
Days

View the late charge grace days.

Delq Grace Days

View the delinquency grace days.

Delq Category
Method

View the delinquency category method.

Time Bar Years

View the total number of years allowed to contact the
customer starting from the first payment date as defined in
Setup > Products > Contract screen.

Due Date section

Max Due Day Change | View the maximum due days.
Days

Min Due Day View the minimum due day.
Max Due Day View the maximum due day.
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8.11.2

Field: Do this:

Max Due Day Change | View the maximum due day changes allowed (year).
Year

Max Due Day Change | View the maximum due day changes allowed (life).
Life

Extension section

Max Extn Period / View the maximum extension allowed (year).
Year

Max Extn Period / Life | View the maximum extension allowed (life).

Max # Extn / Year View the maximum number of extensions allowed (year).

Max # Extn / Life View the maximum number of extensions allowed (life).

Minimum # Payments | View the minimum number of payments.

Extension Gap in View the extension gap in months.
Months

Usage / Rental Details

Agreement Type View the Agreement Type if the current application belongs
to any of the below category. Else, the same is displayed as
UNDEFINED.

- USAGE
- RENTAL
- USAGE RENTAL

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Repayment Sub Tab

The Repayment sub screen records the application’s advance information, repayment
schedule, and skipped repayment months for variable rate Loan.

To complete the Repayment sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Repayment sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Repayment section:

Flexible Repay- | If this display only check box is selected, then the flexible repay-
ment Allowed ment functionality is set up and allowed for this application's prod-
uct type.
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Field: Do this:

Type Select the flexible repayment schedule you want to use from the
following: SKIP PERIOD, USER DEFINED, UNDEFINED.

If you select the repayment schedule type of SKIP PERIOD, you
then select the months for which borrower won't make any pay-
ments in the Skip Months section.

If you select the repayment schedule type of USER DEFINED, you
then enter the repayment schedule requested by borrower in the
Schedule section; for example, $300.00 for first 12 months,
$350.00 for next 18 months, and so on.

Note: The borrower may not provide a complete repayment sched-
ule with the contract. Provisions are available with the system to
compute the repayment schedule for remaining periods at a later
time, if borrower provides partial repayment schedule.

Skip Months section

Jan If selected, indicates that repayment is skipped for January.
Feb If selected, indicates that repayment is skipped for February.
Mar If selected, indicates that repayment is skipped for March.
Apr If selected, indicates that repayment is skipped for April.

May If selected, indicates that repayment is skipped for May.

Jun If selected, indicates that repayment is skipped for June.

Jul If selected, indicates that repayment is skipped for July.

Aug If selected, indicates that repayment is skipped for August.
Sep If selected, indicates that repayment is skipped for September.
Oct If selected, indicates that repayment is skipped for October.
Nov If selected, indicates that repayment is skipped for November.
Dec If selected, indicates that repayment is skipped for December.

Extendable Balloon section

Max Term Specify maximum number of payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
5. In the Repayment Schedule section, click View.

6. View the following information:

Repayment Schedule section

Note: Complete the Schedule section only if you have entered USER DEFINED in the
Repayment section’s Type field. Click Add to make new entries.

Seq Specify the sequence number of the repayment schedule.
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8.11.3

Pmt Amt Specify the repayment amount borrower agreed to pay during the
schedule.

# of Pmts Specify the number of payments borrower agreed to pay for stated
repayment amount during this schedule.

Generated If selected, indicates that the schedule is system generated.

Enabled If selected, indicates that the schedule is enabled.

7. Inthe Payment Change Schedule section, click View.

8. View the following information:

Payment Change Schedule section

Seq Specify the payment sequence number.
Option Type Select the option type.

Frequency Specify the payment change frequency.
Period Specify the period.

# of Adj Specify the number of adjustments.
Value Specify the adjustment value.

Itemizations Sub Tab

The system lists the distribution of the Loan proceeds on the Itemizations sub screen when
you choose Select Instrument on the Contract link. It lists amounts paid to the borrower
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ behalf
to third parties. Itemizations are categorized according to advances, finance fees, prepaid
fees, producers or escrows. If you have entered itemization amounts during application entry
or underwriting, you will see these values in the Amount or Approved Amt columns.

The Itemizations sub screen offers the option of computing the values for itemization
according to a itemization formula associated with the selected instrument based on system
setup.

If you require any new itemizations, you can add them using the Setup menu Products
command. (For more information, see the Products chapter in the Setup Guide.)

To complete the Itemizations
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Itemizations sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Iltemization View the itemization.
+/- View whether the itemization is added or subtracted.
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Field: Do this:

Amount View the amount.

Approved Amt | View the approved amount. This is information recorded on the
Underwriting screen.

Discount Rate | Specify the discount rate.

Tax View whether the itemization is taxable (Sales) if box is selected.

Sir View the seller payment.

Itemization View the itemization type.

Formula

[temization View the itemization type.

Type

Prefunding View the prefunding status.

Status

Pmt Dt View the payment date.

Pmt Ref # View the payment reference number.

Comment Specify additional comments, if any.

4. Choose the option button for the type of itemization you want to use: Advance, Financed
Fees, Pre-Paid Fees, Producer or Escrow.

5. In the Amount column, enter the amount corresponding with what is listed in the
Itemization column.

6. If the Itemization Formula field contains an entry other than UNDEFINED, you can
choose Compute to auto-compute the value in the Amount field using a predefined
itemization formula.

Itemization formulas are created on the Product Setup screen’s Origination Fees
screens. (For more information, see the Org. Fees tab section of the Products chapter
in the Setup Guide.)

To ensure you create the correct computed value, choose Compute after entering
values for all base itemizations; that is, values of all such itemizations with an
Itemization Formula of UNDEFINED.

You can also manually enter amounts for auto-computed itemizations.

If you click Initialize, the system sets the values of auto-computed itemizations to 0
(zero).

7. If you choose, use the Comment field to add remarks.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.4 Trade-In Sub Tab

If there is any information regarding an itemized trade-in, use the Trade-In sub screen to enter
the details in the system (This sub screen might already contain information supplied during
the underwriting process.)

To complete the Trade-In sub screen

1. Open the Funding screen and load the application you want to work with.
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2. Click the Contract > Trade-In sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Trade In section

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.

Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Identification # Specify the identification number.
Body Specify the body of the asset.
Description View the asset description.

Valuations section

Wholesale Amt Specify the wholesale amount.
Base Retail Amt Specify the retail amount.
Addons Amt (+) Specify the add ons amount.
Payoff Amt (-) Specify the payoff amount.

Total Amt = View the total amount.

Valuation Dt Specify the valuation date.
Source Select the valuation source.
Valuation Supple- Specify the valuation supplement.
ment

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.5 Subvention Sub Tab

With the Subvention sub screen, you can enter the subvention information and calculate the
subvention amount, as well as override the calculated subvention amount. The participant’s
information is automatically populated based on the selected subvention plan.

To use the Subventions sub screen
1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Subventions sub tab.
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3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:

Field:

Do this:

Subvention section:

Plan Select the subvention plan code.
Description View the subvention plan description
Sub Plan Select the sub plan.

Sub Plan Description

Select the subvention sub plan.

Subvention Type

View the subvention type

Subvention Amount

View the subvention amount for the plan.

Include

If selected, indicates that the subvention is included.

5. Click View in the Subvention Details section.

View the following:

Participants section:

Participant

View the participant.

Participant Type

View the participant type

Collection Method

View the collection method.

Rate

View the subvention rate.

Rent Factor

View the subvention rent factor.

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Total Subvention Rate

View the total subvention rate.

Total Subvention
Amount

View the total subvention amount.

Include

If selected, indicates that the subvention is included.

6. Click Initialize to reset the subvention amount to zero.

7. Click Calculate to calculate the subvention amount.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
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Insurance Sub Tab

If there is any information regarding an itemized insurance amount, enter the details on the

Insurance sub screen. The Insurance sub screen also enables you to calculate the
commission if there is a commission rule defined during Contract setup.

To complete the Insurance sub tab

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
Click the Contract > Insurance sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field:

Do this:

Insurance Plan

Select the insurance plan associated with the financed insurance

product.

Insurance Type

View the insurance type associated with the insurance plan.

Sub Type

Select the insurance sub type offered under the insurance plan.

Insurance Com-
pany

Specify the insurance company associated with the insurance
plan. The system populates the default insurance plan defined
during product setup.

Policy # Specify the insurance policy number.
Effective Dt Specify the insurance effective date.
Term Specify the insurance term.

Expiry Dt Specify the insurance expiry date.

Commission Rule

View the insurance premium amount.

Premium Amt

Specify the insurance premium amount.

Commission Amt

View the insurance commission amount.

Phone Specify the insurance company’s primary phone number.
Extn Specify the insurance company’s primary phone extension.
Phone Specify the insurance company’s alternate phone number.
Extn Specify the insurance company’s alternate phone extension.

Beneficiary sectio

=

Primary

Specify the primary beneficiary of the insurance.

Secondary

Specify the secondary beneficiary of the insurance.

Cancellation/Refund section
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Field:

Do this:

Cancellation
Refund Allowed

If selected, a refund is allowed. A selected box indicates that the
insurance premium can be rebated to the customer in case of
early payoff.

Grace Days View the number of grace days allowed for cancellation without
charging a cancellation fee.

Calculation View the insurance premium refund/rebate calculation method to

Method be used when insurance is cancelled.

Grace Days Can- | If selected, indicates that cancellation fees during grace is

cellation Fee allowed.

Allowed

Cancellation Fee

View the amount of the cancellation fee to be charged when the
insurance is cancelled.

Deduct Fee From

View the option defined in setup screen (Setup > Administration >
Products > Insurances) to deduct the cancellation fee.

‘Premium Amount’ indicates fee is deducted upfront before
computation and ‘Rebate Amount’ indicates fee is deducted after
computation.

4. |If you click the

Calculate button, the system computes the commission based on the

commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Policy Information section.

It also appears on the Itemizations sub screen.

You can overwrite the suggested value if you choose.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.7 ESC Sub Tab

If there is information regarding an itemized extended service contract or warranty amount,
enter the details on the ESC sub screen.

To complete the ESC (extended service contracts) sub tab

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > ESC sub tab.

3. In this section,
chapter.

you can perform any of the Basic Operations mentioned in Navigation

4. A brief description of the fields is given below:

Field:

Do this:

Warranty Information section

Service Con- View the extended service contract type.
tract
Policy # Specify the ESC number.

Effective Date

Specify the ESC effective date.
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Field: Do this:

Term Specify the ESC term.

Expiration Dt Specify the ESC expiry date.

Premium Amt | View the ESC premium amount

Commission View the commission amount.

Amt

Commission View the commission rule.

Rule

Warranty Specify the ESC company’s name.

Company

Comment Specify comment if any.

Phone No Specify the ESC company’s primary phone number.
Extn Specify the ESC company’s primary phone extension.
Phone No Specify the ESC company’s alternate phone number.
Extn Specify the ESC company’s alternate phone extension.

Cancellation/Refund

Allowed Check this box to allow cancellation/refund.

Method Specify the method of cancellation/refund.

5. In the Cancellation/Refund section, view the following information.

— Ifthe Allowed box is selected, a refund is allowed. A selected box indicates that the
ESC premium can be rebated to the customer in case of early payoff.

— The Method field displays the refund method.

6. If you click the Calculate button, the system computes the commission based on the
commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Warranty Information section.

It also appears on the Itemizations sub screen.
You can overwrite the suggested value if you choose.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.8 Escrow Sub Tab

If there is escrow information selected on the Itemization sub screen, enter information about
it on the Escrow sub screen. The Escrow sub screen records escrow details regarding
disbursement, insurance, and property tax -- information that is parsed to the Customer
Service screen on the Customer Service (2) master tab, where it is available for maintenance.

This sub tab is available if escrow is allowed for the instrument selected on the Loan screen.

The Escrow Analysis screen enables you to view and perform the initial escrow analysis. You
can perform multiple analyses; however, the system records only the most recent analysis.

8-28 ORACLE



To complete the Escrow sub screen

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Escrow sub tab.

3. The Escrow Information section displays information regarding the escrow recorded on
the Itemization sub screen. In this section, you can perform any of the Basic Operations

mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

View:

Escrow

The escrow itemization code and description.

Escrow Type

The escrow type.

Escrow Sub Type | The escrow sub type.

Advance Amt

The amount that’s been approved for the Item in the itemiza-
tion screen under the escrow.

Required Escrow If selected, indicates that this is mandatory itemization and

customer can not opt out of this escrow item.

Cushion Allowed If selected, indicates that cushion is allowed.

4. Select the Opt Out box only if you want to ignore this particular escrow.

5. In the Disbursement section, enter the following information:

Field: Do this:

Rule Select disbursement rule.

Yearly Amt Specify yearly disbursement amount.

Account # Specify reference account number for vendor.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Vendor Specify the vendor name.

Maturity Dt Specify the maturity date, if one exists.

6. If this escrow involves an insurance, use the Insurance section to enter the following
information:
Field: Do this:
Coverage Type Specify the coverage type.

Coverage Term

Specify the coverage term.

Policy #

Specify the policy number.

Coverage Amt

Specify the coverage amount.

Effective Dt

Specify the effective date.
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Field: Do this:

Expiration Dt Specify the expiration date.

7. If this escrow involves a tax, use the Tax section to enter the following information:

Field: Do this:
Property Tax Type Specify property tax code.
Comment Specify a comment.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.9 Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between

the finance company and the dealer for Loan transactions.

To complete the Compensation (Loan) sub screen

1. Open the Funding screen from the Origination master tab’s Funding bar link and load

the application you want to work with.

2. Click the Contract > Compensation sub tab.

On the Compensation sub screen’s Compensation section, select in the Compensation

Plan section the compensation plan you want to use.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method

View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Paid % View the percentage of chargeback paid.
Paid Basis View the charge back paid basis.
Paid Term View the charge back paid term.
Paid Days View the charge back paid days.

Charge off Calc Method

View the charge back calculation method (charge off).

Charge off %

View the charge back percentage (charge off).

Charge off Basis

View the charge back basis (charge off).
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Field:

Do this:

Charge off Term

View the charge back term (charge off).

Days

View the charge back days (charge off).

Calculation section

Spread Formula

View the compensation spread formula.

Buy Rate Specify the buy rate.
Factor View the compensation factor.
Addl Factor View the additional compensation factor.

Max Spread %

View the maximum spread or percent allowed.

Upfront %

View the upfront compensation percentage.

Flat Amt

View the flat amount.

Upfront Comp Amt

View the compensation amount paid upfront.

Rem Comp Amt

View the compensation amount remaining.

Comp Amt

View the compensation amount.

5. Make any necessary changes in the Buy Rate field.

6. Click Calculate.
The system displays the details and amounts for this compensation plan.

8.11.10 Proceeds Sub Tab

The Proceeds sub screen displays the payment amount due to the dealer, based on the
Compensation and ltemization sub screens. It is a view only sub screen, though you can

record comments.

To use the Proceeds

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Proceeds sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:

Itemization View the proceed itemization.

+/- View whether the itemization is added to or subtracted from the
total proceeds.

Amount Specify the amount.

Currency Specify the currency of the proceed.
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Field: Do this:

Comment Specify a comment.

Total Amount View the total amount.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.11 Disbursement Sub Tab

The Disbursement sub screen records how the Loan payment is disbursed and records
payments to third parties such as the Department of Motor Vehicles. This sub screen needs
to be completed if there is an itemized disbursement.

To complete the Disbursement sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Disbursement sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Disbursement section

Validate Payee Check this box to validate payee.

Description View the disbursement description.
Number Specify the disbursement party’s number.
Payment Mode Select the payment mode.

Name Specify the company name.

Account # Specify the account number.

Note: If the organizational parameter UIX HIDE RESTRICTED_-
DATA is setto Y, this appears as a masked number; for example,

XXXXX1234.

Amount View the payment amount.

Currency Specify the currency.

ACH Account Specify the account type.

Type

Account # Specify the ACH account number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

ACH Bank Specify the bank number.

ACH Routing # Specify the routing number.
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Field:

Do this:

BIC

Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN

Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Comment

Specify a comment.

Country

Select the country.

Address Line 1

Specify the address line 1.

Address Line 2

Specify the address line 2.

Zip Specify the zip code.
For non US country, you have to enter zip code.
City Specify the city.
State Select the state.
Phone 1 Specify the primary phone number.
Extn Specify the primary phone extension.
Phone 2 Specify the alternate phone number.
Extn Specify the alternate phone extension.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Disbursement tab will display the records only if a third party itemization is maintained
during contract setup.

8.11.12 Fee Sub Tab

The Fee sub screen is a view-only table displaying what fees on the Loan instrument are in
use, based on the contract.

To view the Fee

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Fee sub tab.
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3. Inthe Fee sub screen, view the following display only information:

Field: Do this:

Fee View the fee type.

Fee Calc Method View the fee calculation method.

Txn Amt From View the minimum transaction amount.

Amount Financed | View the minimum value of amount financed on the contract.

From

Percent View the maximum percentage.
Min Amt View the minimum fee amount.
Max Amt View the maximum fee amount.
Enabled If selected, the fee rule is enabled.

8.11.13 ACH Sub Tab

The ACH sub screen records details about automatic clearing house, if this is a direct deposit
payment account; otherwise, it remains empty. This information is used to receive payments,
primarily when working with the Payments screen.

To complete the ACH
1. Open the Funding screen and load the application you want to work with.
2. On the Funding screen, click the Contract tab, then choose the ACH sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Bank Name Specify the bank name.

Routing # Specify the routing number.

Status Select the required ACH status from the drop down list. By default,

the ACTIVE status is selected.

Default By default, this check box is selected indicating that the current
ACH is the default one. If not, you need to uncheck the same.

Start Dt Specify the ACH start date. By default the first payment date of the
contract is auto populated and can be edited.

End Dt Specify the ACH end date.

Account Type Select the account type.

Account # Specify the account number. Note: If the organizational parameter
UIX HIDE RESTRICTED DATA is set to Y, this appears as a
masked number; for example, XXXXX1234.
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Field: Do this:

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces,
and checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined
by default with length of IBAN as 18.

Pmt Day Specify the payment day. By default the payment due day specified
for the contract is auto populated and can be edited.

Pmt Amt Specify the payment amount. By default the payment amount
decided for the contract is auto populated and can be edited.

Note: If the payment amount is specified as ZERO, system will
automatically consider the EMI amount.

Pmt Amt Specify the additional payment (if any). This is the additional amount
Excess over and above the regular EMI. Appropriation of this amount is
based on the ‘Spread’ defined in the contract.

Pmt Freq Select the payment frequency. By default the bill cycle frequency
defined for the contract is auto populated and can be edited.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. If there are more than one ACH banks and an optional End Date, click Add and repeat
steps 3 through 5.

8.11.14 Coupon Sub Tab

The Coupon sub screen enables you to order (or re-order) new coupon books. This sub
screen is only available if the bill type for this application is a coupon payment, not a
statement.

To complete the Coupon
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Coupon sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

8-35 ORACLE



A brief description of the fields is given below:

Field: Do this:

Order Select to order coupon book.

Order Dt Specify the coupon book order date.

Ordered By Select the user id of the user who ordered the coupon book.

# of Coupons

Specify the number of coupons.

First Pmt Dt

Specify the first payment date.

Coupon Start-
ing #

Specify the starting number of the coupon book.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.15 References Sub Tab

The References link enables you to enter any number of people as a reference on the

application.

To complete the Reference screen (Contract link)

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > References link in this section, you can perform any of the Basic

Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Relationship Select the reference type.

Name Specify the reference name.

Status Select the status of the reference from the drop-down list.
Years Specify the number of years.

Months Specify the number of months.

Comment Specify a comment.

Country Select the country.

Address Line
1

Specify the address line 1.

Address Line
2

Specify the address line 2.

State Select the state.
Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
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Field:

Do this:

City Specify the city.
Phone 1 Specify the reference’s primary phone number.
Extn Specify the reference’s primary phone extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2

Specify the reference’s secondary phone number.

Extn

Specify the reference’s secondary phone extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

If you want to add another reference, click Add and repeat steps 3 and 4.

8.11.16 Real Estate Sub Tab

The Real Estate Fields screen records additional information regarding manufactured home

Loan.

To complete the Real Estate Fields screen

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Real Estate.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Note Transmittal Number

Specify the note transmittal number.

Deed Transmittal Number

Specify the deeding transmittal number.

Number

Cancel/Cashout Transmittal

Specify the deeding cancel/cash out transmittal
number.
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Field:

Do this:

Deed Input Date

Specify the deed input date.

Deed Recording Date

Specify the deed recording date.

Deeding Book Number

Specify the deeding book number.

ConDeeding Page Number

Specify the condeeding page number.

Mortgage Recording Date

Specify the mortgage recording date.

Mortgage Book Number

Specify the mortgage book number.

Mortgage Page Number

Specify the mortgage page number.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.17 PDC Sub Tab

The PDC sub screen displays any post dated checks associated with the contract.

To complete the PDC

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
Click the Contract > PDC sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

PDC Ind If selected, indicates that this account involves a post dated check as
a method of repayment.

PDC Type Select the post dated check type, SECURITY CHECKS or POST
DATED CHECKS FOR PAYMENT.

Account # Specify the account number, on which the cheque is drawn.

Routing # Specify the routing number of the cheque. It is the number printed on
the cheque, also called MICR number (Magnetic Ink Character Rec-
ognition).

Account Specify the type of the account

Type

Bank Name Specify the bank name of the customers cheque

Branch Specify the Branch name of the customers cheque

Name

Docket # Specify the docket number where post dated checks are supposed
to be stored.

Check # Specify the starting cheque number.
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8.12

Field: Do this:

Check Dt Select the check date. In case there are multiple checks being
deposited that have sequential serial numbers, the date of the first
cheque in the series would be entered in the date field. The remain-
ing cheque dates would be anniversary dates based on the fre-
quency set up.

For example, the cheque range could be from 111 to 180. If the date
on the first cheque-111 is October 12, 2003 and the frequency is set
to Monthly, the next cheque would be picked up for processing on
November 12, 2003.

Check Amt Specify the appropriate cheque amount.

No of Specify the total number of checks in the range.

Checks

Billing Cycle | Select the frequency at which the checks are to be sent for collec-
tion.

Comments Specify any remarks for the details.

4. Click Generate.

5. Inthe PDC Table section, select the record you want to work with and enter, view or edit
the following information:

Field: View this:

Select If selected, indicates that this is the current record.

PDC Type The type of post dated check in use.

Account # The account number of the post dated check.

Bank Name The bank name of the post dated check.

Check # The check number of the post dated check.
Status The status of the post dated check.
Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Account The account type of the post dated check.
Type

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Collateral tab

Having selected and loaded an application, you can view the information about the collateral
of the Loan.

The Collateral link opens screens with information regarding any collateral associated with an
account. Depending on the type of Loan, collateral can be a vehicle, home, or something else,
such as major household appliances. The Collateral link is unavailable if this is an unsecured
Loan.
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A detailed explanation of the fields found on the Collateral link’s screens and sub screens can
be found in the Application Entry chapter.

To verify information about the collateral

1. Open the Funding screen and load the application you want to work with.

2. Click the Collateral link.
Depending on the type of collateral, information about the vehicle, home or other type

of collateral appears.

3. Verify the information regarding the collateral and its sub screens. (This is information that
was recorded during the application entry process or gathered during the credit pull.)

If the collateral is a vehicle, the Collateral link displays information about the vehicle.
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If the collateral is a home, the Collateral link displays information about the home.
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If the collateral is anything other than a vehicle or home, the Collateral link displays
information about the other type of collateral.
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For details on this screen refer Collateral Tab section in Underwriting chapter.
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8.13

8.14

Comments Tab

When using the Underwriting screen, you can add comments to an application at any time in
the underwriting process by using the Comments screen.

Whenever an application is funded by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Funder <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of User2,
who is the concerned Funder. The concerned Funder’s name will also be selected in Contract
Tab > 'Funder field.

To add comments to an application
1. Open the Funding screen and load the application you want to work with.

2. Click Comments.
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For details on this screen refer tabtabComments Tab section in Underwriting chapter.

Tracking Tab

When using the Funding screen, you can add tracking attribute information to an application
at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes for an application
1. Open the Funding screen and load the application you want to work with.
2. Click the Tracking tab.
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For details on this screen refer Tracking Tab section in Underwriting chapter.
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8.15

8.16

Document tab

The Document Maintenance link allows you to view documents attached to an application in
the form of GIF files, PDF files, DOC files, XLS files, and TXT files and add comments
regarding a selected document.

For more information, see the chapter Document Management in this User Guide.
To view a document attached with an application
1. Open the Funding screen and load the application you want to work with.

2. Click Document.
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For details on this screen refer Document Tab section in Underwriting chapter.

Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)
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The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Loan. Each one of these “edit types” has its own set of “edit details.”

Note

The Edit Details section’s errors and warnings are created during the setup process.

To complete the Verification tab
1. Open the Funding screen and load the application you want to work with.

2. In the Edit Type drop-down list, select 'Application Approval Edits' and click on 'Check
Edits' button.

Edit details are displayed in the table below along with the result, expected value, actual
value and the override responsibility. This is based on the product and contract set up
details that is done initially.

For more information, refer to Configuring Lending and Leasing setup guides.

3. Specify all the information associated with the application on the Funding screen.

ORACLE | . . 2, Welcome, PRAKRRAO ~ @
Financial Services Lending and Leasing
iginati Close:
T Origination [Eks
Origination Search/Task | Funding | Review Requests (Pending: 0)
Orgination
Sales Lead Application A edic || 5] View | o audit
Simple Applicatiol . = = -
Application Entry| View v Formaty [ Fremze i Detach Wrap W overideok _  waring 0K _
Underwriting Origination Stage Producer Contact i Duplicate
ik Dt App # Sub Unit Status Code Producer Name Number Buasting Customer Application Contact sa
holcation Retrid || Mo deta to csplay. o
Scenario Analysis
Application Docur
Image Maintenan
Reports Summary Applicant Request | Decision Bureau Contract Comments = Tracking Document Verification Correspondence
Producers
Vendors Edits Audits  History
Edit Types
View = Fomatw Ep Freeze {4 Detach Wirap W Edit Type [V] 8 check Edits
Date Edit Type
No data to display.
“
4
Edit Details
View v Formatw [ Free pfiDetach | ¢ Wrap @
Edit Name Result Expecisd Value  Actual Value Override Responsibiliyy
No data to display.
< >
> Servicing
> Collections
> WFP
> Tools
> Setup

e If there are edits with 'Error' entries, verify and correct the data in the respective tabs
and repeat step 2 until the 'Error' entries are cleared.

e When there are only 'Warnings' left you can choose to change the status of the
application to the next stage in the Origination cycle.

4. When you are finished entering data, on the Funding link bar, click Verification.

For details on this screen refer Verification Tab section in Underwriting chapter.
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8.17

8.18

Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

To generate an ad hoc correspondence
1. Open the Funding screen and load the application you want to work with.

2. Click Correspondence.

ORACLE" . 8 & Welcome, VAVAIDYA » =
Financial Services Lending and Leasing
iginatic Close
TR Origination (=
Origination Search/Task | Funding | Review Requests (Pending: 0) ~
Qrigination
Sales Lead Application A Edt | Elvew | o audit
Simple Application Entry
application Entry View w Formatw [ resze iff Detach Wrap Override OK__ Warming OK __
Underwriting - Prc
Funding Dt App # Sub Unit Status Jrigination $120¢ producer Name Co Existing Customer 2;:,"‘:5; Cor
Nu
Apolcotion Bl No data to display.
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Summary | Applicant Request Decision ~Buresu Contract Comments Tracking Document Verficaton Correspondence
Vendors
Comespondence  Letiers
Correspondence o add ] view || of Audit
View~ Formatv [ Fresze  Ef Detach @
ID Correspondence Date
0 02/03/2016
4
Correspondence 1
Save and Add Save and Stay || [ save and Retun || (2 Return
eorrespenvissics [[55) Date 02/03/2016
Documents
Viewv Formatv [ (1] Freeze 14! Detach 5}
Document Id Document Recipient Eform Sowrcz  Source Type Selects(
No data to display.
>
Document Elements Z Ed v 7 A
View~ Formatw & Freeze (4! Detach l 50
> Servicing Element Type Element Content
No data to display.
> Collections
> WEP
Recipient Details add | Edit View | o Audit
> Tools L Had | A v u
View~ Formatv [ Fresze i Detach 0 Wrap W send v
> Setup - i
Recinient "t Made Tune FAXIFmail Sent Tndicator Cammen he

For details on this screen refer Correspondence Tab section in Underwriting chapter.

Escrow Analysis Tab

If escrow is allowed for the selected instrument, the Escrow Analysis link is available on the
Contract drop-down link. This screen enables you to view and perform the initial escrow
analysis. When you are satisfied with the analysis, complete the Approval Dt field in the
Approval section and save your entry.

The escrow payment for the Loan account starts on the 1st date of the Loan payment month.
The disbursement happens on the 10th of the month (as per the disbursement rules). The
escrow analysis lasts for a year (12 months) irrespective of the Loan term.

You can perform multiple analysis; however, the Escrow Analysis screen only records the last
analysis performed. No record of any earlier analysis is currently available.

To complete the Escrow Analysis screen

1. Open the Funding screen and load the application you want to work with.
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2. On the Funding screen, Click Escrow Analysis tab.

%ngmabon x (3] Cose
Search/Task  Funding: 0000000245 = Review Requests (Pending: 0) A
Application: 0000000245: EEVERGREEN SADIE / ROSS El view | o udt

View= Format~ [ Freeze & Detach Wrap W OverideOk ¥ Waming Ok ¥
4 Prc
- , Origination Stage 2 L Duplicate %
ot App3 Sub Unit Status ok Producer Kame: Ea Bistng Cstomer o Contact Sales Agent Branch proi
07/01/2012 0000000245 UNDEFINED APPROVED - FUNDED FUNDED MN-00001 : TN HOUSE (DIR N [} NLHQ o8

Summary ~Applicant = Request = Decision = Contract Collateral Comments Tracking Document | Verification = Correspondence —Escrow Analysis  Tools

Analyzed Escrow Ttems Elvien | o udit
View v Format v 57 Freeze gj' Detach & Wrap GE]

Escrow Disbursement Rule Yearly Amt

COUNTY TAX JANUARY MONTHLY 120000 A

COUNTY TAX JANUARY MONTHLY 120000

COUNTY TAX JANUARY MONTHLY 120000 7
Analyzed Escrow Items

<@ Return

Escrow  COUNTY TAX
Disbursement Rule JANUARY MONTHLY
Yearly Amt1,200.00

Escrow Analysis Elvien | o audit
Viewv Fomatv [ ([l Freeze Hfivetsh  dwep (@)
Date From Dt ToDt Opening Bal (Act)  Opening Bal (Est.) Cushion Type Cushion Value Cushion Amt. Std PmtAmt  Escrow Pmt Amt Spread PmtAmt () Other Pmt Amt (+
12/09/2015 08/01/2012 07/31/2013 0.00 800.20 MONTHS 20 B00.00 M7 500.00 66.68 00

»

3. Inthe Escrow Analysis section, view or enter the following information:

Field: View:

Escrow The escrow item.

Disbursement Rule The escrow disbursement rule.

Yearly Amt The escrow disbursement yearly amount.

4. Click Analyze.

5. Information on the Analysis Details screen is based on expected cash flow from contract
and escrow disbursement setup. Payments received appear before escrow disbursement
in any given month. Click View in Escrow Analysis section.

6. In the following section, enter, view, or edit the following information:

Field: View:

Parameters section

Date The date.

From Dt The FROM date for the escrow activity.
To Dt The TO date for the escrow activity.
Opening Bal (Act) The opening balance actual amount.
Opening Bal (Est) The opening balance estimated amount.

Calculation: cushion amount + low required balance

Cushion Type The cushion type.
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Field: View:

Cushion Value The cushion value.

Cushion Amt The cushion amount.

Calculation: as per the shortage /cushion Rule maintenance

Results section

Std Pmt Amt The standard payment amount.

Escrow Pmt Amt (+) The escrow payment amount.

Calculation: Yearly Amount/12.

Spread Pmt Amt (+) The spread payment amount.

Calculation: Surplus amount / 12

Other Pmt Amt (+) The other payment amount.

New Pmt Amt = The new payment amount.

Calculation: standard payment amount + escrow payment
amount + spread payment amount + other payment amount

Surplus section

Surplus /<Shortage The surplus shortage amount.

Amt> . .
Calculation: escrow account balance - opening balance

Refund Amt The refund amount.

7. Click View in the Analysis Details section.

8. On the Analysis Details sub screen, view the following information:

Field: View:

Txn Dt The transaction date.

Transaction The escrow transaction.

Vendor The vendor name.

Txn Amt The amount of the transaction.
Balance Amt (Est) The estimated amount of balance.
Balance Amt (Act) The actual amount of balance.

Information on the Analysis Details sub screen is based on expected cash flow from
contract and escrow disbursement setup. Payments received appear before escrow
disbursement in any given month.

9. If you want to re-analyze the escrow analysis, change the escrow information on the
Contract link’s screen and sub screens.
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8.19

8.20

If you want to approve the escrow analysis, complete the following information fields on
the Approval section:

Field: View:

Approval section

Approval Dt The approval date.

Approved By | The person who approved the Loan.

10. Click Save on the Funding screen.
Tool Tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.

8-48 ORACLE



9.1

9.1.1

9.1.11

9. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Loan and Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed. They cannot be copied to the application / contract.

Whereas, Tools that appear as a sub-tab in Underwriting and Funding Tabs, allows you to

import the contract values, do necessary calculations and copy the calculated values to the
respective Contract / Decision tabs.

Loan Calculator

The Loan Calculator screen facilitates you to calculate various parameters. You can also
define flexible repayment options, and generate amortization schedules.

This screen is similar to the Loan Calculator screen opened from Underwriting or Funding
screens; however, calculators opened from Tools master tab are standalone and do not link
calculations or loan information to any specific application.

Parameters

The Parameters section allows you to calculate the payment amount, term, interest rate, loan
amount, and blended rate. You can also generate a quote based on the details specified.

In the Parameters section, you can select the following parameters:

e Calculate Payment

e Calculate Interest Rate
e Calculate Term

e Calculate Loan Amount
e Calculate Blended Rate

Calculating Payments

The Calculate Payment option on Loan Calculator screen calculates the standard payment
based on information you provide, such as the amount financed, terms, interest rate and
finance fee. You can click Initialize in Loan Calculator screen to clear (or ‘refresh’) the Loan
Calculator screen at any time.
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To calculate a loan payment

1. Click Tools > Tools

> Loan Calculator.

ORACLE A - P ] & Welcome, VAVAIDYA ~ o
Financial Services Lending and Leasing
i : Close
e {oan calculator x ]
> Origination Loan Calculator
> Servicing
* Collections Parameters
S WEP @ calculate PaymentC Calculate Interest Rate ) Calculate Term ) Calculate Loan Amount () Calculate Blended Rate {Smitialize | [ Calculate (2, Print Quote
Tools Interest Amt 0.00 Rate
ool Loan Details Finance Charge 0.00
Loan Calculator Total of Pmts 0,00 *Rate 0.0000
Lease Calculator *Product Categery STANDARD [] Final Pmt Amt 0.00 APR 0.0000
VElEEvatar * Contract Dt 02/01/2016 (B
Calculator Options First Period

Flexible Repayment

Type

Max term

View v Format »

No data to display

 Setup

= Financed Fees 0.00

* Balloon Pmt Amt. 0.00

Extendable Baloon

=First Pmt Dt 03/01/2016
= Loan Term 0 *gilling Cycle MONTHLY
Maturity Dt 02/03/2016 ST A
Amt Financed 0.00

* Acorual Base Methed ACTUAL/ACTUAL
PrePaid Fees 0.00
* Time Counting Method ACTUAL DAYS

Loan Amt 0.00 = Installment Method EQUATED PAYMENTS

* Bill Method LEVEL

Calendar Method GRI

RIAN
Payment/Finance Charge

MEEEEEEE

Accrual Start Dt Basis EF

Pmt Amt 0.00 Accrual Start Days 0

Repayment Options

Amortization Schedule

Allowed [ Skip Months
UBDERED! Jan [0 reb [ mar [ apr
may [ un [ 30l [ Aug
o sep oct Nov Dec
=4 Freezz B Detach Wrap @ 8% Amortize B print Report
Seq Pmt Dt Pmt Amt Principal Amt Interest Amt

Calendar Days 0

Interest 0.0000

Balance Amt

2. Click Initialize and maintain the following fields.

Field:

Do this:

Loan Details Section

Product Category

Select the category as Standard for conventional loan product and

Islamic for the Islamic loan product.

Contract Dt

Specify the contract date. The system displays current date as the

default value.

First Pmt Dt

Specify the first payment date. The system displays the date one

month from today as default value.

Loan Term

Specify the number of payments.

Maturity Dt

System automatically displays the maturity date based on the val-
ues entered for first payment date, term and billing cycle (i.e.
Maturity Date = First Payment Date + Term (based on billing

cycle).

Amt Financed

Specify the amount financed.

Pre Paid Fees

Specify the prepaid fees, if any exist.

Financed Fees

Specify the financed fees, if any exist.

Loan Amt

View the estimated loan amount: amount financed plus the pre-

paid fees.

Balloon Pmt Amt

Specify the balloon payment amount, if any exist.
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Field:

Do this:

Payment/Finance Charge

Pmt Amt

View the payment amount.

Interest Amt

View the profit amount.

Finance Charge

View the finance charged.

Total of Pmts

View the payment amount.

Final Pmt Amount

View the final payment amount.

Calculator Options

Billing Cycle

Select the payment frequency.

Balloon Method

Select the balloon method.

Accrual Base
Method

Select the accrual base.

Time Counting
Method

Select the time counting method.

Installment Method

Select the installment method: EQUAL PAYMENTS or FINAL
PAYMENT DIFFERS. For more information, see the Installment
method section in this chapter.

Bill Method Select the billing method as either LEVEL, PERCENTAGE OF
PRINCIPAL PLUS INTEREST, INTEREST ONLY, FIXED PRINCI-
PAL PLUS INTEREST, PERCENTAGE OF OUTSTANDING BAL-
ANCE.

Calendar Method Select the calendar method as ‘Hijri’ or ‘Gregorian’ for this loan

contract. This field will be enabled only if the product category is
selected as Islamic.

Accrual Start Dt
Basis

Select to define the start date from when the interest accrual is to
be calculated for this loan instrument. If Effective Date is
selected, then the interest is calculated from Contract date and if
Payment Date is selected then the interest is calculated on basis
of (first payment date minus one billing cycle).

This field will be enabled only if the product category is selected
as Islamic.

Accrual Start Days

Select the actual date from when to start interest accrual

for loans is to be calculated. This field will be enabled only if the
product category is selected as Islamic.

Rate
Rate Specify the interest rate.

Note: For Islamic products this field is displayed as ‘Profit Rate’.
APR View the system calculated the Annual Percentage Rate.
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9.1.1.2

9.11.3

Field: Do this:

First Period section

Calendar Days View the number of calendar days between contract date and the
first payment date. The calendar days will differ based on the cal-
endar method selected.

Interest View the profit accrued for the calendar days.

3. Specify the required information and click Calculate.The system computes the standard
loan payments with the details specified.

Installment Methods

e Equal Payments: If you select Equal Payment option, then the repayment amount will
be equal for all installments including the final installment.

e Final Payment Differs: If you select Final Payment Differs option, then the final
repayment amount may be slightly more or less than the outstanding loan amount due
to precise rounding calculations. The final payment amount will be equal to the
outstanding loan amount.

When completing Frequency fields, note the following:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information on frequency, see ‘Appendix B: Payment Amount Conversions’ section.

Calculating Interest Rates

The Calculate Interest Rate option back-calculates the interest rate and APR using the
amount financed, standard payment and terms. It also provides the amortization schedule of
the loan.

To calculate an Interest Rate
1. Click Loan Calculator tab.
2. In the Parameters section, select Calculate Interest Rate.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.The system computes the
payment change schedule.
You can perform the following activities when the Interest Rate is calculated:

e Creating an amortized schedule of payments (Applications screen)
e Copying the Interest Rate Calculations to the Decision tab (underwriting)
e Copying the Interest Calculations to the Contract tab (funding)

Calculating Term

The Calculate Term option back-calculates the term and APR using the amount financed and
standard payment. It also provides the amortization schedule of the loan.

To calculate an Interest Rate

1. Click Loan Calculator tab.
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9.1.1.5

2. In the Parameters section, select Calculate Term. The system enables the required
fields based on this selection.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.
The system computes the payment change schedule.
You can perform the following activities when the term is calculated:

e Creating an amortized schedule of payments (Applications screen)
e Copying the term calculations to the Decision link (underwriting)
e Copying the interest calculations to the Contract link (funding)

The system will use this information during the funding process when you select an
instrument.

Calculating Loan Amount

The Calculate Loan Amount option calculates loan affordability of a customer based on
term, payment amount and the rate quoted.

To calculate an Interest Rate,
1. Click Loan Calculator tab.

2. In the Parameters section, select Calculate Loan Amount. The system enables the
required fields based on this selection.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.
The system computes the payment change schedule.
You can perform the following activities when the Interest Rate is calculated:

e Creating an amortized schedule of payments (Applications)
e Copying the loan amount calculations to the Decision link (underwriting)
e Copying the loan amount calculations to the Contract link (funding)

Calculating Blended Rate

The Blended Rate option calculates a combined single rate (Blended Rate) for multiple
amounts each of at different rates. On selecting this option, system displays the ‘Advances’
section to add multiple records to derive the blended rate. It also provides the amortization
schedule of the loan.

To calculate an Blended Rate,
1. Click Loan Calculator tab.

2. In the Parameters section, select Calculate Calculate Blended Rate. The system
enables the Advances section.

3. Click Add and maintain the following details:

Field Do this:
Amt Financed Specify the financed amount.
PrePaid Fees Specify the pre-paid fees.
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Field

Do this:

Financed Fees

Specify the financed fees.

Balloon Pmt Amt

Specify the balloon payment amount.

Rate

Specify the rate.

Payment Amt

The system displays the calculated payment amount
on clicking ‘Calculate’ button.

Interest Amt

The system displays the calculated interest amount
on clicking ‘Calculate’ button.

Action

Click add button to add next contract details.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

6. After you specify all the required information click calculate.
The system computes the blended rate of contracts.

You can perform the following activities when the Blended Rate is calculated:

e Creating an amortized schedule of payments (Applications)

e Copying the loan amount calculations to the Decision link (underwriting)

e Copying the loan amount calculations to the Contract link (funding)

Repayment Options

If the calculation involves flexible repayment options, you can include the same through the

following options:

Option

Description

Flexible Repay-
ment Allowed

Select the check box to include a flexible repayment schedule in cal-
culation. On selection, the following sections are enabled.

e REPAYMENT SCHEDULE

e PAYMENT CHANGE SCHEDULE

e RATE SCHEDULE

Based on the selection of repayment type in the subsequent field, any

or all of the above sections are enabled to define the required flexible
repayment schedules.

Type

Select any of the following repayment type that you want to use from
the drop-down list.

e UNDEFINED

e SKIP PERIOD

e USER DEFINED

e GRADUATED PAYMENT
e EXTENDABLE BALLOON

1. Depending on the repayment type selected, complete the following sections:

-6 ORACLE




e If you have selected the type as UNDEFINED (default), you can specify only the ‘Rate

Schedule’ as explained in step 2.

e If you have selected the type as SKIP PERIOD, select the months which you want to

exclude in repayment schedule by selecting the adjacent check box.

e If you have selected the type as USER DEFINED, click Add in ‘Repayment Schedule’

section and specify the following information:

Field: Do this:
Seq Specify the sequence number of the repayment schedule.
Pmt Amt Specify the repayment amount borrower agreed to pay during

the schedule.

# of Payments

Specify the number of payments borrower agreed to pay for
stated repayment amount during this schedule.

Generated

View if the repayment schedule is generated.

e If you have selected the type as GRADUATED PAYMENT, click Add in ‘Payment

Change Schedule’ section and specify the following information:

Field: Do this:

Seq Specify the sequence number in which the repayment is calcu-
lated.It prioritizes the calculation.

Option Type Select the repayment option type:
STEP UP, STEP DOWN and BULLET.

Frequency Select the frequency of payment. The default value is TERM.

Period Specify the loan period.

# of Adj. Specify the number of times the STEP UP, STEP DOWN or
BULLET needs to happen.

Value Specify the value. For STEP DOWN, value ranges from 1 to 99.

For STEP UP, value ranges from 1 to 990. For BULLET, value
ranges from 1 to 99999999.

e If you have selected the type as EXTENDABLE BALLOON, specify the maximum

number of terms in the ‘Extendable Baloon’ section.

2. If the calculation includes a promotion, complete the Rate Schedule section. Click Add

and specify the following information:

Field: Do this:

Seq Specify the sequence number of the rate schedule.

Rate Specify the repayment amount borrower agreed to pay during
the schedule.

Start Dt Specify the date on which the borrower agreed to make the

first payment.

3. After you specify all the required information click calculate. The system computes the

payment change schedule and populates the Repayment Schedule section.
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9.14

When you fund the loan application, the system copies repayment schedule information
to the loan account on Customer Service screen where it appears in the Repayment
Schedule section.

Amortization Schedule

You can use the calculated payment data to derive the Amortization Schedule. Click
Amortize in the ‘Amortization Schedule’ section. The system generates an amortized
schedule with the calculated data with the following headers:

Field: View this:

Seq Payment number.

Pmt Dt Payment date.

Pmt Amt Payment amount.

Principal Component of the payment amount allocated towards reduction
Amt of the principal balance.

Interest Amt | Component of the payment amount allocated towards reduction
of the interest balance.

Balance Remaining principal balance.
Amt

You can click Print Report to extract a PDF version of the generated amortized schedule.

Printing a Quote

You can generate a summarised report using the calculated loan details in the format of quote
with charges, payment structure, financed amount allocation, and amortization scheduled.

In the Loan Calculator screen, click Print Quote. The system generates a PDF document to
the default downloads repository consisting of the following information in the respective
headers:

Loan Details

The Loan Details section consists of Contract Start Date, Contract End Date, First Payment
Date, Total Loan Term, Rate, and Total Loan Amount (Inc. Fee).

Payment/Finance Charge

The Payment/Finance Charge section consists of Total Interest Amount, Finance Charge,
Total Of Payments, and Balloon Payment Amount.

Payment Structure

The Payment Structure section consists of details based on the number of payments, billing
cycle followed and the payment amount. The payment structure repeats based on the flexible
repayment options defined.

Financed Amount Allocation
The Financed Amount Allocation section consists of total amount that can be financed at the

specified rate. If there are multiple records included to derive blended rate, then the Financed
Amount Allocation varies based on the total number records.
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9.2

Amortization Schedule

The Amortization Schedule section consists of records in tabular format with the following
details:

e PmtNo.

e Payment Date

e Scheduled Payment
e Principal

e Interest

e Ending Balance

Copy Calculation to Contract or Decision tab

Depending on the screen from where you have accessed the tools sub tab, you can copy the
calculated values to either Contract or Decision tab. If you are in Underwriting stage, you can
copy the values to decision tab. Similarly during Funding stage, you can copy the values to
contract tab.

1. Click Initialize and reset the calculator.
2. Click Import values. System displays basic values entered in previous tabs.
3. Select one of the following option “Calculate Payment / Interest Rate / Term / Loan

Amount” and click Calculate. System displays calculated values based on selection.

Click Copy to Contract/Decision. The calculated details are copied to the respective fields in
Contract/Decision tab.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.

To calculate a vehicle value

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Tools > Tools
> Vehicle Evaluator

OoORACLE
Financial Services Lending and Leasing

ashBoard

Valuation

> sewup < >
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2. In the Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-or-
Complete the fields in the Vehicle section.

7. Inthe Vehicle Evaluator section, click Evaluate.

— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification number, then completes Vehicle
Evaluator screen with information about that exact match.

— If you completed the Vehicle section, system searches for the value of a vehicle
matching that description.

— In either case, the system displays following information about the vehicle:
— In the Vehicle section, view the returned information:

Field: View this:

Year The asset year.

Make The asset make.

Model The asset model.

Body The asset body style.

Usage The asset usage or current mileage.
Weight The asset weight.

In the Valuation (Total Value) block, view the returned information:

Field: View this:

MSRP Manufacturer’s suggested retail price value of the asset.
Total Total value of the asset.

Usage Adjusted usage value of the asset.

In the Base and Attribute Value section, view the returned information:

Field: View this:

Base Retail Total retail value of the asset.

Base Loan Base loan value of the asset.

Base Trade Base trade value of the asset.
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Field: View this:

Retail Retail value of the asset attributes.

Loan Loan value of the asset attributes.

Trade Base trade value of the asset attributes.
Attributes Tab
In the Attributes section, view the following information:

Field: View this:

Attribute Asset attribute.

Retail Attribute retail value.

Loan Attribute loan value.

Trade Attribute trade value.

Standard Standard indicator. If selected, indicates that the attribute is a standard.

Package If selected, indicates that the attribute is inclusive.

Incl

Selected If selected, indicates that the attribute is selected.

If you want to re-calculate the values using other data in Total Value and Base and Attribute
Value section, do the following:

e Make the required changes to the desired parameters fields in Vehicle Evaluator and
Vehicle sections.

e Inthe Vehicle Evaluator section, click Recalculate.
The system updates the values in Total Value and Base and Attribute Value sections.

If you choose, use Attributes section to select or clear the Selected box for attributes of the
vehicle. This automatically updates the values in Total Value and Base and Attribute Value
sections. (Note: Attribute amounts within brackets reduce the amount in Totals field in the
Total Value section.)

To copy the calculated value to the Collateral link

You can copy the calculated value to Collateral link only if you have accessed the tools tab
either from Underwriting or Funding Tab. Accessing Tools from the main menu does not
support this option.

1. Complete the following steps in the section To calculate a vehicle value.

2. In the Vehicle Evaluator screen, click Copy to Asset.

The system uses calculations on the Vehicle Evaluator screen to complete Valuation sub
screen on Collateral link. Any pre-existing collateral is no longer the primary collateral.
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10.1

10.2

10. Application Retrieval

Introduction

The Oracle Financial Services Lending and Leasing system includes archiving and retrieving
feature that provides you with the capability to archive old data and store it in a different table.

Archiving / Purging

The system batch process runs the purge / archive feature based on the system parameter
setup. The system archives the following items:

e Applications and related data
e General ledger data

e Securitization related data

e Producers

e Producer transactions

e Account statements

e Vendor assignments

e Vendor invoices.

The system purges the following items:

e Job request data
e Userlogins
e Output data dump related data.

In the system, archiving is a two-way process:

1. All the archived data is moved and stored in O tables.

2. The archived data in the O tables is then moved and stored into OO tables.

You may set the “default days” for the archive feature by setting the following system

parameters on the Administration screen. The parameters marked with _O are the items
moved from O to OO tables. The other parameters are the items moved to O tables.

Parameter Default Description
Days

PAP_ARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 1: PUR_APP_STATUS_CD IS USED
TO DECIDE APPLICATIONS WITH WHAT
STATUS ARE PURGED

PAP_OARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 2

PGL_ARCHIVE DAYS 999 PURGE DAYS FOR GL LEVEL 1: NO OF
DAYS AFTER THE GL TXN WAS CRE-
ATED

PGL_OARCHIVE DAYS 999 PURGE DAYS FOR GL LEVEL 2
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Parameter Default Description
Days

PJR PURGE DAYS 999 PURGE DAYS FOR JOB REQUEST LEVEL
1: NO OF DAYS AFTER JOB REQUEST
COMPLETION DATE

POD PURGE DAYS 999 PURGE DAYS FOR OUTPUT DATA DUMP
LEVEL 1: NO OF DAYS AFTER PROCESS
RUN DATE

PPR_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL

1: NO OF DAYS AFTER THE PRODUCER
STATUS IS SET TO ACTIVE AND THERE
EXISTS NO “NOT PURGED” ACCOUNT

WITH THIS PRODUCER NAME.

PPR_OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL
2:

PPX_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 1: NO OF DAYS AFTER THE PRO-
DUCER TXN WAS CREATED

PPX OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 2:

PUL PURGE DAYS 999 PURGE DAYS FOR USER LOGINS LEVEL
1: NO OF DAYS AFTER THE LOGIN END
DATE

PVA_ARCHIVE _DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-

MENTS LEVEL 1: NO OF DAYS AFTER
THE ASSIGNMENT DATE AND ASSIGN-
MENT CODE IN COMPLETED, VOID,

CLOSE

PVA_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-
MENTS LEVEL 2:

PVI_ARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE

LEVEL 1: NO OF DAYS AFTER THE
ASSIGNMENT DATE AND ASSIGNMENT
CODE IN VOID, CLOSE

PVI_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE
LEVEL 2:

10.3 Retrieving an Archived Application

You can retrieve archived applications using the Application Retrieve screen. You can retrieve
only archived applications.

To retrieve an archived application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click Application Retrieval link.
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The system opens Application retrieval Search screen.
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5. Select the application you want to work with and click Retrieve.
The system loads the application in the Applications screen.

You are now ready to begin work on the application.
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Use the Comparison Operator and Values fields to create the search criteria you want

3.
to use to find an application.
For more information about creating search criteria, see Searching for an Application
chapter of this User Guide.
4. Click Search.
The system locates and displays all the applications that meet your search criteria on
the Results screen.
Applications are sorted by priority and application number.
Field: View this:
Company The company of the application.
Branch The branch of the application.
App# The application number.
Date The date of the application.
Title The title (applicant name) of the application.
Product The product of the application.
Status The status of the application.
Sub Status The sub status of the application.
Producer The producer of the application.
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11. Scenario Analysis

11.1 Introduction

With the Scenario Analysis screen, you can simulate the customer’s Loan request Loan
amount, rate and create a mock proposal in Loan with your lending policies.

You can use scenario analysis screen to complete the following tasks:
e View an Existing Scenario Analysis
e Generating Scenario Analysis
e Auto Suggest Pricing for the Scenario Analysis
e Creating an Amortized Schedule for the Scenario Analysis
e Creating an Application from the Scenario Analysis
e Generating a quote from the scenario analysis

Note

Depending on the product licensed, you can view either Loan or Lease Calculator details.
If you have licensed both, then you are provided with an option in Scenario Analysis screen
to select the required Product Type.

11.1.1 View an Existing Scenario Analysis

You can view a previously generated scenario analysis by inquiring through the identification
code.

To view an existing scenario analysis

1. Click Origination > Origination > Scenario Analysis. The Scenario Analysis screen is
displayed in the main window.

2. Select the ‘Product Type’ as either Loan or Lease clicking on the adjacent radio button.

3. Inthe Inquiry Id field, you can either specify the identification code of a previously
generated scenario analysis, or select the identification code from the adjacent drop-
down list.

4. Click Show Details.
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11.1.2 Generating Scenario Analysis

To generate a scenario analysis

1. Click Origination > Origination > Scenario Analysis. The Scenario Analysis screen is
displayed in the main window.
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2. Click Add and complete the following Parameters. You can click Initialize to clear (or
‘refresh’) the screen details at any time.

Field

Do this:

Inquiry Id

View the inquiry identification code.

Application #

View the application number.

Company

Select the company from the drop-down list.

Branch

Select the branch from the drop-down list.

Product

Select the product from the drop-down list.

Agreement Type

View the agreement type auto populated based on the product
selected.

First Name

View/specify the first name.

Last Name View/specify the last name.
Phone Specify the phone number of the applicant.
Email Specify the email address of the applicant.

Producer Type

Select the producer type associated with the product from the
drop-down list.
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Field Do this:

Producer Name Select the producer associated with the product from the drop-
down list.

Producer Contact View the producer contact number.

Number

Region View the region where the producer belongs.

Territory View the territory where the producer belongs.

Requested Amt Specify the requested advance amount.

Term Specify the requested term (number of payments).

State Select the state code.

Asset Class View the asset class.

Asset Type View/select the asset type.

Asset Sub type View/select the asset sub type.

Make Specify the make of the vehicle.

Model Specify the model of the vehicle.

Promotion Select the requested promotion.

Pricing View the pricing if applicable.

Billing Cycle Select the billing cycle schedule.

Instrument Select the instrument.

3. Inthe Loan Calculator section, you can specify the details of various Parameters,
Repayment Options, and Amortization Schedule.

For detailed field information, refer to Loan Calculator section in Tools chapter.

4. After you have specified all the required details, click Calculate.The system computes the
standard payments with the details specified.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

The system auto assigns an identification code to your calculations on the Scenario Analysis
screen.

11.1.3 Auto Suggest Pricing for the Scenario Analysis

The Scenario Analysis screen provides an option to calculate and display the Pricing based
on previously generated scenario analysis details.

1. Inthe Scenario Analysis section, specify the required information to generate scenario
analysis and save the details. (Refer section Generating Scenario Analysis).

2. click Suggest. The system displays the Pricing details.
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11.1.4

11.1.5

11.1.6

11.2

Creating an Amortized Schedule for the Scenario Analysis

You can create the amortized schedule for the selected scenario analysis, The system
computes the and displays the amortized schedule under Amortization Schedule tab

To create an amortized schedule for the scenario analysis

1. Specify the required information to generate scenario analysis. (Refer section Generating
Scenario Analysis)

2. Click Amortization Schedule tab and then click Amortize.

The system uses the calculated payment data to complete the Amortization Schedule
section and displays the following information:

Field View this:

Seq Payment number.
Pmt Dt Payment date.
Pmt Amt Payment amount.

Principal Amt | Component of the payment amount allocated towards reduction of
the principal balance.

Interest Amt | Component of the payment amount allocated towards reduction of
the interest balance.

Balance Amt | Remaining principal balance.

Creating an Application from the Scenario Analysis

To create an application from the scenario analysis

1. Specify the required information to generate scenario analysis. (Refer section
Generating Scenario Analysis)

2. Click Create App.

Generating a quote from the scenario analysis

You can generate a summarised report using the calculated details in the format of quote.

After you have specified all the required information to generate scenario analysis, (Refer
section Generating Scenario Analysis), click Print Quote.

For detailed information, refer to Printing a Quote section in Tools chapter.

Viewing Information from Scenario Analysis

The system assigns the information on the Scenario Analysis screen an application number.
You can open this application on the Application Entry screen and view information from the
Scenario Analysis screen at the following locations:

e The Application screen
e The Request tab

e The Collateral tab

e Underwriting
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In the Underwriting screen, the Decision link’s Pricing and Approved sections display the
details from the Scenario Analysis screen. You can modify the price chosen in the Scenario
Analysis screen and re-price the application. If application has been repriced, the comments
regarding the multiple offers on the Comment screen should be manually updated before
approving the application.

11.2.1 Subvention Sub Tab

In the Subvention sub tab you can review the subvention information from the application
entry and calculate the subvention amount, as well as override the calculated subvention
amount. The participant’s information is automatically populated based on the selected
subvention plan.

The calculated Subvention details of the application created from Scenario Analysis is
populated to Origination > Request > Subvention tab.

To complete the Subvention sub screen
1. Click Origination > Origination > Scenario Analysis > Subvention sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Code Select the sub plan code from the drop-down list.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the

Other Details sub section

3. Perform any of the Basic Actions mentioned in Navigation chapter.

11.2.2 Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between
the finance company and the dealer for Loan transactions.

Note the following:

e The computations in the Compensation sub tab refers to the 'Requested Amt' in
Scenario Analysis tab.

e The 'Buy Rate' is referred from selected ‘Pricing’ definition in Scenario Analysis section.

e The'Request Rate' is referred from the ‘Rate from' field of selected 'Pricing' definition in
Scenario analysis section.

The calculated Compensation details of the application created from Scenario Analysis is
populated to Origination > Underwriting >Decision tab.
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To complete the Compensation (Loan) sub screen

1. Click Origination > Origination > Scenario Analysis > Compensation sub tab. System
load the compensation plan details.

Note that, the compensation plan will use application information to calculate
compensation.

The system loads the following information on the Compensation sub screen:

Field: Do this:

Compensation section

Compensation Plan View the compensation plan.
Disbursement Method View the compensation payment method.
Calculation Method View the compensation calculation method.

Chargeback section

Paid Calc Method View the charge back calculation method (early payoff).
Paid % View the charge back percentage (early payoff).

Paid Basis View the charge back basis (early payoff).

Paid Term View the charge back term (early payoff).

Paid Days View the charge back days (early payoff).

Chg Off Calc Method View the charge back calculation method (charge off).
Charge Off% View the charge back percentage (charge off).

Chg Off Basis View the charge back basis (charge off).

Chg off Term View the charge back term (charge off).

Chg off Days View the charge back days (charge off).

Calculation section

Spread Formula View the compensation spread formula.

Buy Rate View the approved buy rate.

Factor View the compensation factor.

Addl Factor View the additional compensation factor.

Max Spread % View the maximum spread or percent allowed.
Upfront % View the upfront compensation percentage.
Flat Amt View the flat amount.

Upfront Comp Amt View the compensation amount paid upfront.
Rem Comp Amt View the compensation amount remaining.

11-6 ORACLE



Field:

Do this:

Comp Amt

View the compensation amount.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

ORACLE



12.1

12.2

12. Application Documents

Introduction

The Documents Maintenance screen allow for paperless storage of documents within Oracle
Financial Services Lending and Leasing system. Initially with the applications during the Loan
origination cycle and later with accounts during customer service.

This chapter explains how to use the Application Document screen to:
e View animage
e Search for an image
e Split an image to more than one screen
e Change the status of an image
e Combine two images into a multiple screen image
e Attach an image to an existing application
e Print an image
e Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking screen to attach documents to
accounts and then view these documents in a browser.

Application Document screen

The Application Document screen consists of “Document Maintenance” and “Document
Details” sections.

Credit applications are often sent or faxed to financial institutions from producers (or ‘dealers’)
on behalf of the customer. These credit applications, if received as fax, can be stored in the
system as images. Frequently, more than one application is received in a single fax or a single
application is received across multiple faxes. In such cases, the Application Document
Tracking screen can help you organize and maintain your image collection.

The Application Document screen’s Document Maintenance screen allows you to upload
documents to an application in the form of GIF files, PDF files, DOC files, XLS files, and TXT
files. The Document Maintenance screen’s Document Details section allows you to view
these documents.

Application Document screen

Oracle Financial Services Lending and Leasing supports the online attachment of document
images to an application using the Application Documents screen’s Document Maintenance
section. You can attach the documents from either a client machine or server. A defaultimage
directory can be maintained in the system using the system parameter:

UIX DEFAULT IMAGE PATH.

When you choose List File in the Select Document sub section in the Document
Maintenance section, the system displays all available files in the selected directory in the
Document Details section. You can use the Document Maintenance sub-section and
Action sub-section to attach selected documents to a particular account.

12-1 ORACLE



12.2.1 Attaching a Document to an Application from a server

To attach a document to an Application from a server

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination > Origination > Application Documents link.
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2. In the Action sub-section, click Attach Document (Server).

3. Inthe Select Document sub-section, use the default image directory in the Directory
Path field. (The default path is the value for the system parameter
UIX_DEFAULT IMAGE_PATH). -or-

4. Inthe Directory Path field, specify the full path name to the document on the server that
you want to attach to an account.

You can click Reset Path at any time to return to the default image directory.

5. In the Select Document section, click List File.
The system displays the files from the entry in the Select Document section Directory
Path in the Document Maintenance record.

6. Inthe Document Details record, select the record you want to work with and click Edit
in the Details column.

7. In the Document Details record, specify, view or edit the following information:

Field: Do this:

File Name View the file name for the document.

Document Type | Select the type for the document.

Document Sub Select the sub type for the document.

Type

Application # Select the application number to attach/copy/move the docu-
ment image.

Attach Attach the document.

Status View the status of the document.
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12.2.2

Field:

Do this:

Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.
Received Dt View the document image received date.

Effective Dt

Specify the effective date of the document.

Expiry Dt

Specify the expiration date of the document.

Comment

Specify any comments regarding the document.

8. Select the Attach check box to attach the file to the account.
9. Click Save And Return.

10. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by clicking View Document in the Document
Details section.

Attaching a Document to an Application from a Client Machine

To attach a document to an application from a client machine

1.

7.
8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Attach Document (Client).

In the Select Document section, click Browse in File to upload field.

The system opens a Choose File to Upload dialog box.

In the Choose File to Upload dialog box, locate the document you want to attach to the

account. You can select multiple files by holding the Ctrl or Shift key on your keyboard.

When you have located the document you want to attach to the account in the Open

dialog box’s File name: field, click Open.

The selected files appear in the Select Document sub-section’s File to Upload field.
In the Select Document sub-section, click Upload.

In the Document Details record, select the file uploaded from your server and click Edit.

10. In the Document Details section, enter, view or edit the following information:

Field:

Do this:

File Name

View the file name for the document.

Document Type

Select the type for the document.

Document Sub Type | Select the sub type for the document.

Application #

Select the application number to attach/copy/move the docu-
ment image.
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12.2.4

Field: Do this:

Status View the status of the document.

Comment Specify any comments regarding the document.
Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.

Received Dt Specify the received date of the document.
Effective Dt Specify the effective date of the document.
Expiry Dt Specify the expiration date of the document.
Comments Specify any comments regarding the document.

11. Select the Attach check box to attach the file to the account.
12. Click Save And Return.

13. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by choosing View Document in the Action section.

Copying a Document

The Action section’s Copy Document command copies the document image from one
application to another application. This command has no impact on the source application or
the source application’s document image.

To copy a document to an application from another application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the origination master tab.

2. Click the Application Documents link.
In the Action sub-section, click Copy Document.

4. Inthe Document Maintenance sub-section, use the Application # field to specify the
application with the image you want to copy.

5. Inthe Document Maintenance sub-section, click Search. The system displays the files
attached to that application in the Document Details section.

6. Inthe Document Details section, select the document you want to copy and click Edit.

7. Inthe Copy/Move App # field, specify the application number of the application to which
you want to copy the document.

8. Click Save And Return.

9. In the Action sub-section, click Post.

Moving a Document

The Action section’s Move Document command moves an existing document image from one
application to another application. This command detaches the document image from the
source application and attach to second application.
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To move a document to an application from another application

1.

8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Move Document.

In the Document Maintenance sub-section, use the Application # field to specify the

application with the image you want to move.

In the Document Maintenance sub-section, click Search.

The system displays the files attached to that application in the Document Details

sections.

In the Document Details section, select the document you want to move and click Edit.

In the Copy/Move App # field, specify the application number of the application to which

you want to move the document.

Click Save And Return.

In the Action sub-section, click Post.

You can view the documents attached to a particular account by loading the application on
the Customer Service screen, then clicking the Customer Service tab and then clicking on the
Document Tracking sub tab.

Viewing a Document Attached to an Application

To view a document attached to an application

1.
2.

Using above method, load the application with the document you want to view.

In the Application Document section, click Edit.

3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4.

5.

information:

In the Application Document Details section, select the record you want to work with
and click Edit.

In the Application Document Details section, view the following display only

Field:

View this:

Document Sub
Type

The document sub type.

Version The version number. (version numbers will be incremental by batch
job, first version will start with 1.0).
Page # The page number.

Document File
Type

The document file type.

Status

The status.
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Field: View this:

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details sections to select
the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document
Details section to view all the pages in the document.

_Or_
— Choose a specific page number to view only that page.

7. Click View Document.
The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work in
conjunction with your Oracle Financial Services Lending and Leasing system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.

12.3 Document Tracking section

You can view the documents attached to a particular application by loading the application on
the Underwriting/Funding screen and then clicking on Document tab.

12.3.1 Locating an Application Document

To locate an account document

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click the Underwriting/Funding link.
Select and open the application you want to work with.

4. Click Document sub tab.
The Account Document screen appears.

Information about the documents attached to the Application appears in the
Application Documents and Application Document Details sections.

12.3.2 Viewing a Document Attached to an Application

To view a document attached to an account
1. Using the above method, load the account with the document you want to view.

2. In the Application Document section, click Edit.
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3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4. Inthe Application Document Details section, select the record you want to work with

and click Edit.
5. Inthe Application Document Details section, view the following display only

information:

Field: View this:

Document Sub Type The document sub type.

Version The version number (version numbers will be incremental by

batch job, first version will start with 1.0).
Page # The page number.

Document File Type

The document file type.

Status The status.

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details section to select

the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document

Details section to view all the pages in the document.

_o r_

— Choose a specific page number to view only that page.

7. Choose View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.
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13. Image Maintenance

You can view any image in the Oracle Financial Services Lending and Leasing system in the
upper list box of the Image Maintenance link.

To view an image

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination
> Origination > Image Maintenance.

ORACLE’

Financial Services Lending and Leasing

P— [=)

DashBoard

Origination

Simple: Applicatiof
Application Entry
Underwriting
Funding
Application Retrie
Scenario Analysis
Application Docur
Image Maintenan)
Reports
Producers
Vendors

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

Image Maintenance 3

Image Maintenance

Image Header

View » Fomat~ [ Frezze  Hfi Detach
Image Id Fax Header
No data to display.

Pages

View = Format~  [5 Freeze & Detach

No data to display.

Image

Application
View » Fomat [ Fresze

App # Title
No data to display.

& Detach

Action

(® None
) Split Image.
D) Change Status
O attach to an Image
© astach to an Application

@

View All mages []

Status

Company

[ Close

Branch Pages

Select Page(s)

[E] Preview

2. The Image Header section displays the images in the Oracle Financial Services Lending
and Leasing system.

3. Inthe Image Header section, select the image you want to work with.

The Image Header section displays the following information for each image:

Branch Branch

Select If selected, indicates that this is the current record.
Image Id The image identification number.

Fax Header | The fax header.

Status The image status.

Pages The total number of pages of the image.

Company The company the image came from.

Branch The branch the image came from.

4. If an image is more than one page long, select the page you want to view in the Pages

section and click on the page number to preview the image.

5. Select the required transpose type to change the appearance of the image.
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Splitting an Image

If an image is more than one page long, you can split it into two separate images using the

Split Image button in the Action section. This option button is only available when an image
contains more than one page. Also, you cannot splitimages with a status of “PROCESSED” or
“SKIP.”

To split an image

1. On the Image Maintenance section Image Header section, select the multiple page
image you want to split.
2. Inthe Action section, select Split Image.
The Pages and New Image Id fields appear in the Action block.
3. Inthe Pages block, select the page where you want to split the image.
The selected pages appear in the Pages field on the Action section.
You can select more than one page; however, you cannot select page # 1.
4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing removes the selected pages and
completes the New Image Id field with the image id of the new image.

The new image does not appear in the Image Header section after you click Post.
However, if you refresh the Image Maintenance screen by closing and opening the
screen, the new image id appears in the Image Header section and the change of page
length in the original image is displayed.

Changing the Status of an Image

The Action section on the Image Maintenance screen allows you to change the status of the

image.

The Image Maintenance screen uses the following statuses:

Status: What is does:

RUSH Moves the image to the front of the queue of images to be pro-
cessed.

NEW Places an image in a queue in the order of which it was received
and allows you to process it as an application.

SKIP Makes the image unavailable for processing until the status is
changed.

BAD Notes that the image is illegible and should be deleted.

PROCESSED | Notes that the information on the image has been entered and is
attached to an application or account.

Only images with a status of Rush or New can be attached to an application or account.

To change the status of an image

1. On the Image Maintenance screen’s Image Header section, select the image whose

status you want to change.

2. In the Action section, select Change Status.The Status field appears.

3. In the Status field, select the new status for the image.
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4. In the Action section, click Post.
Oracle Financial Services Lending and Leasing changes the status of the image.

Attaching an Image to an Existing Image

You can combine two images to make one image. This is the reverse of splitting an image.

To combine images

1. On the Image Maintenance screen’s Image Header section, select the image to which
you want to attach an existing image.

2. In the Action section, select Attach to an Image.
The Image Id field appears.

3. Inthe Image Id field, select the image id of the image to which you want to attach the
selected image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing joins the two images: the Id of the image
you selected in step 3 remains on the Image Header section. The image you selected
in step 1 now appear as part of the remaining image.

Attaching an Image to an Existing Credit Application

You can attach one or more images to an existing credit application. To attach specific pages
from a multiple page image to an application or account you have to split the image to isolate
the pages you want to attach. You can then attach those pages and, if necessary, link pages
of the original image back together.

To attach an image to an existing application image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to attach to an existing application.

2. In the Action section, select Attach to an Application. The App# field appears.

3. Inthe App # field, select the application number of the application to which you want to
attach the image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing attaches the image to the application.
You can view the image in the Image (8) master tab on the Underwriting and Funding
forms.

Printing an Image

The Print Image button sends the selected image to a predefined printer.
To print an image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to print.

2. In the Action section, click Print Image.
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14. Oracle Financial Services Lending and Leasing
Reports

During the day, or at the end of day, you may want to retrieve information on any of the several
operations that were performed during the day in your financial institution. You can generate
this information in the form of reports in Oracle Financial Services Lending and Leasing. You
can specify the values in the Report Parameters section and generate a report using that
information.

Navigation to Reports

On the Oracle Financial Services Lending and Leasing home page, click Origination >
Origination > Reports.

ORACLE’ : RAKRRAO o
Financial Services Lending and Leasing

DashBoard Repatax
Origination
Reports
View v Format+ | B Freeze i Detach weo | @
Description Module
ORIGINATION

ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION W
ORIGINATION

ACCOUNT PAYABLE(ORIGINATION)
COLLATERAL TRACKING LOG
FUNDED CONTRACTS LEASE
FUNDED CONTRACTS LINE

Report Parameters
View ~ Format- [ Freeze  f: Detach J Wrap B %5 Run Report
Description value
FROM MM/DD/YYTY 2
TO MM/DD/YYYY &
REPORT FORMAT POF [~]

»» Servicing
> Collections
> WFP

> Tools

> Setup

14.1 Number of Credit Applications Entered by User

This application entry report lists the amount of credit applications entered by user.

Parameters:
e Company/Branch

e User Name

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format
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Example of the Number of Credit Applications Entered by User report

Report: Number of Credit Applications Entered

Date: 10/14/2013 10:16 AM

NLO2
NLR1

ORACLE"

Financial Services Lending and Leasing

Entered By

Date Entered

# of Applications

ARNATH 07/09/2013 2

Total: 2

Branch Total: 2

Company Total: 2
Usol
USHQ

Entered By Date Entered # of Applications

ARNATH 05/16/2013 1

ARNATH 06/25/2013 2

ARNATH 06/26/2013 1

RENATH 07/03/2013 2

Total: [

Branch Total: 6

Company Total: 3

Grand Total: 8

14.2 Collateral Tracking Log

This servicing report lists collateral tracking details.

Parameters:

e Company/Branch
e Tracking Type
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Example of the Collateral Tracking Log

6 1:17 AM

NLD2

eral Tracking Log

report

ORACLE

Financial Services Lending and Leasing

NLHQ
Type =eest state Focount § Follow D Start Dt Disposition
‘omments Date
SPARROW JACK / MARYY M 20120200010081 12/12/2015 12/12/2015  NWOT DEFINED
3
SPARROW JACK / MARYY e 201202000100%1 12/13/2015 12/12/2015  NOT DEFINED
3
SPARROW JACK / MARYY M 20120200010091  12/12/2015 12/12/2015  WOT DEFINED
1
3
Customer State Fcocount # Follow Up Start DL Disposition
Date
¢« SMITH JOHN an 20150600011323  12/12/2015 12/13/2015 NOT DEFINED
3
BHANDARI ARPAN PR 7 01/06/2016 01/06/2016  NOT DEPINED
SIGG MARK MR 20150900014267 01/30/2016 01/30/2016 NOT DEFINED
RODRIGUEZ MILDRED M 20150900014275 01/30/2016 01/30/2016 NOT DEFINED
2015 A Al RODRIGUEZ ROBINSON ma 20150900014283  01/30/2016 01/30/2016  ROT DEFINED
RODRICUEZ ROBINSON M 20150900014283  01/30/2016 01/30/2016 WOT DEF:
5 sam = 20160200014338 02/02/2016 02/02/2016 WOT DEF
®F EF ca 20160200014346 02/02/2016 02/02/2016 NOT DEFINED
2015 ITALIAN SMITH JOHN an 20150600011323  12/12/2015 12/12/2015 NWOT DEFPINED
MODELE

24

14.3 Credit Bureau Report

14.4

This report lists the credit bureau details.

Parameters:

e Credit Request ID

e Credit Request Detail

e Report Format

Example for Credit Bureau report

Report: Credit Bureau Report

Date: 9/13/2013 16:37 PM

Account Payable (Origination)

This report lists the payable accounts.

Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format
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Example for Origination Account payable report

(Onigination) ORACLE

Financial Services Lending and Leasing

14.5 Number of Credit Application Images by Status

This report lists the number of credit application images by status.

Parameters:

e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
Report: Number of Credit Applications Images By Status

Month/Year From: 01/01/1800 To: 01/01/2048
Date: 10/15/2013 12:04 PM

ORACLE’

Financial Services Lending and Leasing

usol

USHQ
Image Status Date Entered # of Applications
BAD 07/23/2013 i1
BAD 07/29/2013 1
BAD 08/23/2013 1
BAD 08/26/2013 1
NEW 07/23/2013 4
NEW 07/26/2013 1
NEW 08/19/2013 1
NEW 08/26/2013 3
NEW 09/24/2013 2
PROCESSED 09/24/2013 E
RUSH 08/26/2013 1
RUSH 09/24/2013 9
Total: 26
Branch Total: 26
CompanyTotal : 26
Grand Total: 26
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14.6 Dealer Reserve Report

This report lists the reserve amount balance of producers.
Parameters:

e Company/Branch

e Producer

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Report : Dealer Reserve Report ORACLE'
Date: 2/29/2016 11:27 AM Financial Services Lending and Leasing

USHQ
Producer # Producer Name Incr Due To New Loans Adj Due Payoff/ Chgoff Adj Due To Cr Adj Due To Dr Reserve Amt
CA-00004 VOLKSWAGEN OF 0.00 0.00 0.00 0.00 0.00
WOODLAND HIL
CA-00005 RUTO JUNGLE 0.00 0.00 0.00 0.00 981.00
GA-00002 ADVANCE 0.00 0.00 0.00 0.00 0.00
LEASING
(MARIETR)
Branch Total: 0.00 0.00 0.00 0.00 991.00
Company Total: 0.00 0.00 0.00 0.00 991.00
Grand Total: 0.00 0.00 0.00 0.00 991.00

14.7 Batch Job Report

This report lists the batch jobs scheduled and status of execution for the selected period.
Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY
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14.8

14.9

Report Format

Report : Batch Job Report
Date: 2/22/2016 11:53 AM
Job Bet Job Code

SET-AAL ARTPRC_BJ_100_01
SET-RAL TXNACT_BJ_100_01
SET-ACR TABACC BJ_100_01
SET-ACR TXNACE_BJ_100_01
SET-ACR TENACR_BJ_100_02
SET-ACR TXNACRE_BJ_100_03
SET-ACR TENACE_BJ_100_04
SET-ADT ADTPRC_EJ_100_01
SET-ACE ACAAPP_EJ_100_01
SET-AGE ACCCON_EJ_100_01
SET-AGS AGSSAL BJ_100_01

Job Description
APPLICATION TO
ACCOUNT INTERFACE

ACCOUNT ACTIVATION

ILY TRIAL BALANCE
GENERATICN

INTEREST ACCRUAL
AND DELINQUENCY
PROCESSTNG

PREPARE BATCH DATA
FOR INTEREST
ACCRUAL END
DELINQUENCY
PROCESSING

P INTEREST
ACCRUAL PROCESSING

RE-START INTEREST
ACCRUAL

ATE ROWID IN
IT TABLE (RUN
JOB AFTER
EXPORT-IMPORT OF
TRABLES)
APPLICATION AGING
PROCESS

CONTRACT RCING
PROCESS

SRLE LEAD AGING

Start Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

End Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

0Z/25/2016

0z/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

ORACLE’

Financial

Btatus
COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

User Report and Access by Responsibility

Services Lending and Leasing
Result

This report lists the users with their name, code, responsibility and active status for the
selected period.

Parameters:

Report Format

Report : User RspothUSER REPORT & ACCESS BY RESPONSIBILITY)

Date: 2/29/2016 11:52 AM

ORACLE'
Financial Services Lending and Leasing

Taer Code TUser Rame Responsibility Active Stact Date End Date
(¥/N}

AJITHA M YES /11/1800 12/31/4000

BATCH EATCH USER YES /11715892 12/31/9959

DEMOCOLL DEMO COLLECTOR COLLECTOR YES /11/1992 12/31/9559

DEMOEUNDER DEMO FUNDER FUNDING SPECIALIST YES /11/1g992 12/31/9559

DEMOSALES DEMO ALES LEADER WES /1171592 12/31/9559

DEMOSUER DEMO YES /11/15892 12/31/95539

DEMOUNDW DEMO UNDERWRITER T YES 11/1992 12/31/9559

EVENT EATCH USER ONDEF INED YES /11/1592 12/31/9553

INTERNAL INTERNAL INTERNAL SUPERUSER YES /11/1B00 11/11/4000

TAYANTA JAYANTA C SUPERUSER wES /1171800 12/31/4000

NAVEEN NAVEEN REDDY ERUSER vES /11/1800 12/31/4000

SUPERUSER YES /11/1800 12/31/4000

SUPERUSER YES 02/18/2018 12/31/4000

SUPERD. YES 02/18/2016 12/31/4000

TRITAM JENA SUPERUSER YES 11/11/1800 12/13/4000

SHASHANK S YES /11/1800 12/31/4000

vES /11/1800 12/31/4000

YES /12/1B00 12/31/4000

Transactional Access by Responsibility

This report lists the transactional access to users with their Transaction Code, Transaction
Description and access permission.

Parameters:

e User Responsibility
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e Report Format

Report : Transactional Access by Responsibility ORACLE
Date: 3/9/2016 11:54 AM Financial Services Lending and Leasing
}Lesponsibiliiy Code \ Responsibility Description |
COLLECTOR | COLLECTOR |
Transaction Code Transaction Description Allowed

ACCOUNT CLOSE ACCOUNT CLOSE Y

ACCOUNT CLOSE REV REVERSE ACCOUNT CLOSE Y

ACCRUAL START START ACCRUAL Y

ACCRUAL_STOP STOP ACCRUAL Y

ACCRUAL_STOP_REV REVERSE STOP ACCRUAL Y

ACC_ACH_FEE_MAINT ACH FEE MAINTENANCE Y

ACC_ACH_MAINT ACH MAINTENANCE Y

ACC_ACH _NEW NEW ACH MAINTENANCE Y

ACC_CASA_PHP_BATCH ONE TIME INCOMING CASA BATCH Y

PAYMENT
ACC_CASA_PHP_REAL ONE TIME INCOMING CASA REAL TIME Y
PAYMENT
ACC_CHANGE_PMT_DEFAULT_SPREA | CHANGE DEFAULT PAYMENT SPREAD Y
D
ACC_COMP_ADJ_MINUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - SUBTRACT

ACC_COMP_ADJ_PLUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - ADD

ACC_CPN_MAINT COUPON BOOK MAINTENANCE Y

ACC_CRB_PMT_RATING_MAINT MAINTAIN CREDIT BUREAU PAYMENT Y

RATING

ACC_ESC_MAINT WARRANTY MAINTENANCE Y

ACC_ESC_PMT_MAINT WARRANTY PAYMENT MAINTENANCE Y

ACC_INS_MAINT INSURANCE MAINTENANCE Y

ACC INS PMT MAINT INSURANCE PAYMENT MAINTENANCE Y

ACC_OFF_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR OFF

ACC_ON_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR ON

ACC_PDC_CHK_VOID VOID OPEN PDC CHECKS Y

14.10 Front End Access by Responsibility

This report lists the front end screen access permissions depending on the user responsibility.
Parameters:

e User Responsibility
e Report Format

Report : Front End Access by Responsibility ORACLE

Date: 3/9/2016 13:02 PM Financial Services Lending and Leasing
[ Responsibility Code [ Responsibility Description |
| coLLECTOR | COLLECTOR |

[Entity: | COLLECTIONS |

Menu / Screen Menu / Screen / Tab / Sub Tab Item
CUSTOMER SERVICE BANKRUPTCY MENU

CUSTOMER SERVICE COLLECTIONS MENU
CUSTOMER SERVICE DEFICIENCY MENU

CUSTOMER SERVICE RESPOSSESSICN MENU

Entity: | COMMON

Menu / Screen Menu / Screen / Tab / Sub Tab Item
REVIEW REQUEST REVIEWREQUEST ADD BUTTON
REVIEW REQUEST REVIEWREQUEST AUDIT BUTTON
REVIEW REQUEST REVIEWREQUEST EDIT BUTTON
REVIEW REQUEST REVIEWREQUEST VIEW BUTTON
CALCULATOR AMORTIZATIONSCH TAB
CALCULATOR CALCULATORLEASE TAB
CALCULATOR CATCULATORLOAN TAB
CALCULATOR FLLSUITE LEASECALCULATOR MENU
CALCULATOR LOANCALCULATOR MENU
CALCULATOR RATESCH TAB
UNDERWRITING FLLSUITE VEHICLEEVALUATOR MENU
USER PRODUCTIVITY DASHBOARDUSERSPRODUCTIVITY MENU

USER PRODUCTT
USER PRODUCTIVIT
USER PRODUCTIV.

USERPRODUCTIVITYAPPLICATIONENTRY TAB
USERPRODUCTIVITYCOLLECTORUSER TAB
USERPRODUCTIVITYFUNDING TAB

USER PRODUCTIVIT USERPRODUCTIVITYORGQUEUESTATUS TAB
USER PRODUCTIVITY USERPRODUCTIVITYSERCOLQUEUE TAB
USER PRODUCTIVITY USERPRODUCTIVITYUNDERWRITING TAB
PRODUCER PRODUCERCOMMENT TAB
PRODUCER PRODUCERCOMMENT VIEW BUTTON
PRODUCER PRODUCERCOMMENT EDIT BUTTON
PRODUCER PRODUCERCCMMENT AUDIT BUTTON
PRODUCER RCOMMENT ADD BUTTON
PRODUCER COMPENSATIONBALANCE TAB
PRODUCER PRODUCERCOMPENS ONDETAIL VIEW BUTTON
PRODUCER PRODUCERCO] CT AUDIT BUTTON
PRODUCER PRODUCERCONTACT TAB
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14.11 Underwriting Status by Month and Producer Loan

This underwriting report lists application status by month and producer for loans.

Parameters:

Company/Branch
Producer

From MM/DDYYYY
To MM/DD/YYYY
Report Format

Example of the Underwriting Status by Month and Producer loan report

Report: Underv

Date: 10/31/2013 10:31 AM

writing Status by Month & Producer (LOAN) ORACLE’
Financial Services Lending and Leasing

nth/ Year From: 01/1800 To: 01/2048

ALL AMOUNT ARE IN USD

Month Producer Type Producer § & Name Approved Conditioned Rejected Total Funded % Tot Apps Funded
% # %
2006-01 DEALER MN-00001 H&R BLOCK 1 100.000% 1 ©0.000% 1 0.000% 1 1 100.000%
Monthly Total 1 100.000% 1 0.000% 1 0.000% 1 100.000%
2006-02 DEALER MN-00001 H&R BLOCK 1 100.000% 1 0.000% % 0.000% 1 1 33.333%
Monthly Total 1 1 o T 0.000% 1 33.333%
2006-03 DEALER MN_00DD1 HER BLOCK T 1 0.0 0.000% % 1 100.000%
Monthly Total 1 1 0.000% 1 0.000% 1 100.000%
Branch Total: I 1 0.000% 1 0.000% 1 60.000%
Ch: NLR1
ALL AMOUNT ARE IN USD
Month Producer Type Producer ¥ & Name Approved conditioned Rejected Total Funded % Tot Apps Funded
% # %
2006-02 DEALER IL-00003 SAM LEMAN 0 0.000% 0 0.000% 0 0.000% 0 0 0.000%
CHRYSLER PLYMOUTH MAZDA
00.000% 0.000% 0 .000% o 0 0.000%
2006-03 DEALER L 0 0.000% 0 0.000% o 0.000% 0 0 0.000%
CHRYSLE!

Monthly Total o 000% 0 0.000% 0 0.0f 0

Branch Total a ooo¥ o 0.000% o a o

Company Total: 3 00 1 0.000% 1 a 1

Crand Total 1 __100.000% 1__0.0008% 1 [ 3

14.12 Underwriting Status

By Month and Underwriter Loan

This underwriting report lists application status by month and underwriter for loans.

Parameters:
e Company/Branch
e Underwriter
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format

14-8 ORACLE



Example of the Underwriting Status By Month and Underwriter Loan report

)y Month & ORACLE’
inancial Services Lending and Leasing
Month Underwriter Name Approved Conditioned Bejected Total Funded % Tot Appe Funded
£ ) # % E3 %
Z2006- VINAY BEATIR T 1o S 1 a00%
Wonthly Total 0.000%
2006 000% 2
1 no0%
Wonthly Tot: z z 0.000%
2006 TEND GUPERUSER T I 1 G008
RLET
ALL AMOUNT RRE IN USD
month Underwriter Name Approved Conditioned Rejected Total Funded % Tot Apps Funded
T T T T 3 T
2005 SREERAN NARAYAN 1 1 T.000%
T 1
ot 1
Grand Toral T00.600% 0 o0 T

14.13 Underwriting Status By Month Loan

This underwriting report lists application status by the month for loans.

Parameters:

Company/Branch
From MM/DD/YYYY
To MM/DD/YYYY
Report Format

Example of the Underwriting Status By Month Loan report

Re
Da

port: underwriti
te: 10/31/2013 10:19 AM

ng status by month (loan) oRAcCLe
Financial Services Lending and Leasing

o1r1800 o1/2018
ALL AMOUNT ARE IN USD
a2

7ot ABPS Approvals  Conditionsd Rejected Funded

14.14 Funded Contracts Loan

This funding report lists applications funded for loans.

Parameters:
e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY
e Producer
e Report Format
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Example of the Funded Contracts Loan report

ORACLE

Report: Funded Contracts (Loan) Financial Services Lending and Leasing
Month / Year From: 03/2004 To: 03
NLo2
L
ALL AMOUNT ARE IN USD
Producer Name Product Collateral Underwriter Application# ContractDt amount Rate Term
LOAN-UN VINAY 0000097055 10/02/2012 10,000.00 13.580% 36
BEATIA
BHATIA VINAY / S LOAN-UN VINAY 0000097057 10/02/2012 10,000.00 13.980% 36
BHATIA
count 2 Total: 20,000.00
Branch 2 Branch Total 20,000.00
Company count: 2 Company Total: 20.000-00
AMOUNT ARE IN USD
Producer ‘Name produckt collateral onderwriter application¥ ‘Contractpt ‘Amount Rate Term
C0-00002 MILE TEST TEST LOAN-VE 2012 TOYOTA VINAY 0000086046 02/08/2013 32,000.00 4.930% E
COROLLA 4DR EEATIA
1 Total: 32,000.00
FL-00002 VICAR DELIQUENCY TEST 0 TOYOTA CAMRY DEMO 000005E066 02/11/2013 10,100.00 1.330% 12
232 UNDERWRITER
1 Total: 10,100.00
2 h Total
2 ¥ Total:
4 Total:

14.15 Pre Funding Contracts Loan

This funding report lists applications verified for loans.
Parameters:

e Company/Branch

e From MM/DD/YYYY

e To MM/DD/YYYY

e Producer

e Report Format

Example of the Pre Funding Contracts Loan report

ORACLE

Financial Services Lending and Leasing

Report: Pre-Funding Contracts (Loan)

U501
USHQ
ALL AMOUNT ARE IN USD
Producer Name Product Collateral Underwriter Application # Contract Dt Amount Rate Term
CA-00004 UNDEFINED LOAN-VE DEMO 0000001371 0.o0 0.000% 0
VOLKSWAGEN UNDERWEITER
OF
WOODLAND
HIL
Count: 1 T 0.00
Branch Count: 1 Branch T 0.00
Company Count: 1 Company T 0.00
Total Count: 1 rand Total: 0.00
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15. Producer

Oracle Financial Services Lending and Leasing is capable to create and service direct as well
as indirect Loan. Indirect Loan are generated through Producer Entities like Dealerships and
Agents. It is essential to create and maintain such entities to enable incentive tracking and
business development achieved through each entity.

Applications are sent to financial institutions indirectly through producer entities like dealers
or agents on behalf of a customer. Specifying Producer details is mandatory while creating a
application since the system associates a credit application with the producer entity which
sent it, on the Application Entry, Underwriting, and Funding screens. When the credit
application is approved and funded, the system associates the account with the producer
entity.

When the credit application is approved and funded, system associates account with the
producer.

The following three different status are defined for Producer Entities in OFSLL:

e Active: Only if Producer Status is Active, the application sourced through that Producer
Entity can be funded.

e Inactive: If the Producer Status is Inactive, the application sourced through that
Producer Entity cannot be funded.

e Temporary: If the Producer Status is Temporary, the application sourced through that
Producer Entity can only be reviewed. However it cannot be funded.

The producers are paid for their participation, either:

e Up front during funding
-or-
e Up front on a monthly basis
-or-
e When the interest is earned
-or-
e When the payment is received from customer based on the set up compensation plans.
The Producer Setup screen contains pages that enable you to maintain and administer

producer compensation, compensation payments, charge back plans, and chargeback
parameters.

While setting up Producer entities it is also essential to setup the Producer Cycles under
'Setup' in main menu. For more details, refer to Configuring Lending and Leasing guides.
While working with the Producer Setup screen, you will primarily use the following sub tabs:
1. Payment Details

Tracking Attributes

Contracts

Comments

o M 0N

Summary

The Producers screen completed during setup, can be used to view and maintain producer
details.
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15.1

The ‘Producers’ screen consists of the following tabs:

e Producer Details tab
e Search tab

Producer Details tab

The Producer details screen allows you to record or edit basic information about the producer.
You can set up dealers or producers for a company and branch. You can also set up a default
underwriter and a default collector for a producer. The system uses this information in the
origination work flow to select a queue.

The producer number, name, contact information, company and branch to which the producer
is associated with, federal tax number, status, and license information can be stored in this
screen.

Navigating to Producer Details

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Producers > Producer Details.

2. The system displays the Producers setup screen.

ORACLE'
Financial Services Lending and Leasing

Producers x [l close
Producer Details e add | P Edit View || o Audt
View v Format v [Gp Freeze S Detach wap @@
& CA-D0002 [ [
Producer # OldProducer & Name Company Branch Start Dt End Dt Status Enabled Contact Group Trpe z
cA-00002 cA-0on02 RANDYS AUTO SA... USO1 UsHo 05/27/1554 12/31/4000 ACTIVE < JACK GROLP 1 DEALER s

« i v
Cobumns Hidden 32
Producer Details

i

[ saveandstay | [ save andReturn || GaRetum

Producer = CA-00002 Address = emal
4 Old Producer % CA-00002 Address Line 1 12800 ROSCOR BLVD, *Loss Reserve Amount 0
*Name RANDYS ALTO SALES Address Line 2 Max Float 99,999
* Company  USO1 = * Country UNITED STATES =] Remaining Float 99999
*Branch USHQ = *7p 91352 = * Enabled (7]
*strtot 05/27j1994 (B ZpExin

Subvention Participation
*EndDt 12314000 (B

* Contact JACK

*City SUN VALLEY

*State | CALIFORNIA = Subvention Particpant [

*Growp GROUP = * permisson to.cal * Colection Type  STATEMENT [+
Grade PLATINUM [=] * Permission o Text [7] * Collection Frequency MONTHLY [=]
=Type DEALER = *Phone 1 (909)-531-4116 *Refund Disbursement Method  NONE =
*Statis | ACTIVE =1 EgaiL *Regon ALL =] e

To set up the Producer

1. In the Producer section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Producer # Based on the system setup, either:
Specify the producer number

-or-

The system generates producer number.

Producer will be activated on the next system date (current system
date + 1) and not on the start date.

Old Producer # Specify the old producer number.

Name Specify the producer name.
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Field: Do this:

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Select the producer start date by clicking on the adjoining Calendar
icon.

End Dt Select the producer end date by clicking on the adjoining Calendar
icon.

Contact Specify the producer contact.

Group Select the producer contact group from the drop-down list.

Grade Select the producer grade as per business processes from the drop-
down list. The list consist of values which are used only for
categorizing at the producer level and can be changed periodically
as per business requirement.

Type* Select the producer type from the drop-down list. The Group and
Type fields help in setting up the pricing schemes on Pricing screen.

Status Select the appropriate status from the drop-down list. The contents
of this field can be linked to edits in Loan origination cycle so that
only applications from Producers whose status is 'Active' can be
funded.

Sales Agent Select the sales agent associated with this producer from the drop-

down list.

Underwriter

Select the default underwriter assigned to this producer from the
drop-down list. Only users with a responsibility for an
UNDERWRITER can be designated as underwriters for producers.

Funder

Select the users with responsibility as Funding Specialist, from the
drop-down list.

Collector

Select the default collector or agent assigned to this producer from
the drop-down list. (This will appear in the Collector field in
Delinquency Information section of Account Details screen on
the Customer Service screen).

Fed Tax #

Specify the federal tax identification number. If the organizational
parameter UIX HIDE RESTRICTED_ DATA is set to Y, this appears
as a masked number; for example, XXXXX1234.

Address section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1

Address Line 2

Specify address line 2

Zip

Select the zip code from the drop-down list.

Zip Extn

Specify the extension of the zip code.

15-3 ORACLE



Field: Do this:
City Specify the city.
State Select the state from the drop-down list.

Permission to
call

Check this box if customer has provided permission to contact

through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact

through text message.

Phone 1

Specify phone number 1.

Exnt 1

Specify phone number 1 extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2 Specify phone number 2.

Extn2 Specify phone number 2 extension.

Fax Prefix1 Select fax prefix number 1 from the drop-down list.

Fax1 Specify fax number 1.

Fax Prefix2 Select fax prefix number 2 from the drop-down list.

Fax2 Specify fax number 2.

E-Mail Specify the producer mail address.

Loss Reserve Specify the loss reserve amount

Amount

Max Float Specify the value of maximum float allowed for the Producer.

A Float represents the application sourced by the producer that is

Funded and awaiting 'Title perfection' from the concerned authorities
for marking lien. If you do not know the exact value but want to
provide a maximum float, then specify the value as 99999.

Remaining Float

System automatically displays the available number of floats by
calculating the remaining float value based on 'Max Float' and Title
perfections under processing.

Enabled

Check this box to enable the product.

Subvention Partici

pation Details

Subvention
Participant

Check this box to maintain the producer as subvention participant

Collection Type

Select the collection type from the drop-down list.
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Field: Do this:

Collection Select the collection frequency from the drop-down list.
Frequency

Refund Select the refund disbursement method from the drop-down list.
Disbursement

Method

Region Select the region of producer from the drop-down list.

Territory Select the territory of producer from the drop-down list.

License Details

Valid From Specify the date from when the producer’s license is valid.

Valid To Specify the date till when the producer’s license is valid.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Oracle Financial Services Software recommends that you double-check the fax numbers
(especially the 10 digit number) and email addresses you enter on this screen, since the
system uses this information to send its system-generated underwriting decisions.

Payment Details

You can setup ACH as the payment mode for a dealer or producer on Payment Details sub
screen. The Payment Details sub screen stores information regarding the payment mode,
currency and producer’s bank details, such as bank’s name, routing number, account type,
account number, BIC and IBAN. Once the details are updated the same has to be verified and
approved in the payment details section before processing.

The dashboard of Oracle Financial Services Lending and Leasing displays all the producers
whose payment details are either APPROVED or WAITING FOR APPROVAL in the
‘Producers Count By ACH Status’ section. You can click on the respective links to view the
details in ‘Producers’ screen.

To complete the Payment Details
1. Click Origination > Origination > Producers > Payment Details.

2. In the Payment Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Pmt Mode Select the payment mode from the drop-down list.

Bank Specify the ACH bank name.

Start Dt Select ACH start date if payment mode is ACH. You can even
select the date from adjoining Calendar icon.

Routing # Specify the ACH bank routing number.
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Field: Do this:

Account Type Select the ACH bank account type from the drop-down list.
Account # Specify the ACH bank account number.
Currency View the currency of the Producer. System defaults the

currency depending on the Company or Branch selected for
the Producer.

BIC Select the Business Identifier Code from the drop-down list.
The list displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN
is used for identifying bank accounts across national borders
with a minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required
as per the country code in the user defined table (Setup >
Administration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency from the drop-down list.
Currency System defaults the currency depending on the Company or
Branch selected for the Producer.

Approval Detail section - When the payment details are approved, system
automatically populates the following fields with the approver details along with the
status as ‘Approved’. However on subsequent update, the details are reset till
further approval and status is changed to ‘Waiting for approval’.

Approved By View the user who has approved the payment details.

Approved Dt View the date and time when the payment details were
approved.

Status View the status of producer payment details.

Perform any of the Basic Actions mentioned in Navigation chapter.

To Approve Payment Details

You can verify and approve the producer payment details defined by another user in the
Producers > Payment Details section. You can either directly select the required record in the
‘Producers’ screen or sort the list of payment details awaiting approval using the Dashboard.

Before you proceed, ensure that you have approval rights assigned to your login. Else,
contact your system administrator.

1. To access the payment details to be approved, do one of the following:
e Click Origination > Origination > Producers.

15-6 ORACLE



15.1.2

15.1.3

e Click Dashboard and navigate to ‘Producer’ section. In the ‘Producers Count By ACH
Status’ sub section, click WAITING FOR APPROVAL. The payment details are sorted
accordingly and displayed in ‘Producers’ screen.

2. In the Producer Details section, select the required Producer. The payment details
associated with the producer are displayed in the ‘Payment Details’ section.

3. Inthe ‘Payment Details’ section, click Approve Payment Detail.

The payment details are approved and approver information is captured in Approval Detail
section. Also on approval, the Dashboard counters in ‘Producers Count By ACH Status’
section are updated.

Compensation Plan

The Compensation Plan sub screen displays information related to compensation and
chargeback for the producer. It displays summaries as well as account level information. The
data is gathered from relevant applications and accounts in the system that are approved and
funded.

A brief description of the fields in the Compensation Plan sub screen is given below:

Field: View this:

Account/Application | The account/application number and title

Compensation Plan The compensation plan defined for the producer.

Upfront Amt The Upfront Amount defined for the producer.
Remaining Amt The remaining amount for the producer.
Total Amt The total amount defined for the producer.

1. In the Loss Reserve section, view the loss reserve amount.

You can view additional details of the Compensation Plan, Chargeback Methods, and
Compensation/Chargeback Amounts in the sub screen.

Subvention

The Subvention sub screen displays information related to Subvention Receivables for the
producer. It displays summaries as well as account level information.

In the Subvention Receivables section, you can view the following details. A brief description
of the fields is given below:

Field: View this:

Subvention Participant The status of subvention participant.

Collection Type The collection type defined for the subvention.
Collection Frequency The collection frequency defined for the subvention.

Refund Disbursement Method The Refund Disbursement Method for the
subvention.

Receivable Amt(Open) The outstanding receivable amount for the
subvention.
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15.1.5

Field:

View this:

Receivable Amt(Current) The current receivable amount for the subvention.

Received Amt

The received amount for the subvention.

Netted Refund Amt The netted refund amount for the subvention.
Net Receivable Amt The net receivable amount for the subvention.
Payable Refund Amt The payable refund amount for the subvention.

Transactions

The Transactions sub screen facilitates you to post the following types of transactions based
on the selection in the action block.

e All transactions relating to Payment to / from Producers, Disbursements transactions
from Holdback / Reserve, adjust/add Recourse amount from/to dealer reserve can be
posted by selecting ‘Others’ option in the action block.

e Subvention Receivables / Payments and adjustments can be posted by selecting
‘Subvention’ option in the action block.

In the Transactions sub screen, you can sort the list of transactions to be displayed based on
elapsed days by selecting the ‘View Last’ option as 1 Day / 1 Week / 1 Month / By Date. When
‘By Date’ is selected, you can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

Select ‘Others’ or ‘Subvention’ option, click Add and specify the following field information. A
brief description of the fields is given below:

Field:

View this:

Effective Dt

Select the Effective Date of the transaction from the calendar.

Transaction

Select the transaction from the drop down list.

Amount Specify amount for the transaction.
Reference Specify the transaction reference.
Account # Select the account from the drop down list.

Account Title

View the account title information.

Comment

Specify additional details of the transaction if any.

Click Post to post the transaction for processing.

Holdback/Loss Reserve

The Holdback/Loss Reserve sub screen displays information related to Proceed Holdback
and Loss Reserve for the producer.

To view the Holdback/Loss Reserve

1. Click Producers > Holdback/Loss Reserve.

2. Inthe Proceed Holdback section, you can view the account and Holdback amount details.
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In the Loss Reserve section, you can view Loss Reserve amount details.

Tracking Attributes

The Tracking Attributes sub screen allows you to link information to a producer who is not
tracked in the system, by default, however is part of company’s business practices.

To complete the Tracking Attributes
1. Click Origination > Origination > Producers > Tracking Attributes.
2. In the Tracking section, you can edit the parameter and Value details.

3. A brief description of the fields is given below:

Field: View this:

Sub-Parameter View the sub-parameter details.

Parameter View the parameter details.

Value Enter the required value for the selected parameter.

4. In the Statements Transactions section, view the following information:

Field: View this:

Effective Dt | The statement transaction date.

Transaction | The statement transaction.

Account The statement account number.

Debit Amt The statement debit amount.

Credit Amt The statement credit amount.

15.1.7 Contacts

The Contacts sub screen allows you to record information regarding contacts associated with
a producer, such as employees at a dealership.

To complete the Contacts
1. Click Origination > Origination > Producers > Contacts sub tab.

2. On the Contacts sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Contact Type Select the producer contact type from the drop-down list.
Name Specify the producer contact name.

Phone Specify producer contact phone number.

Extn Enter phone number extension.

Fax Enter producer contact fax number.
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15.1.9

Field: Do this:

Enabled Check this box to indicate this is a current contact.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

The Comments sub screen allows you to view and enter comments regarding the producer.

To enter a comment on the Comments
1. Click Origination > Origination > Producers > Comments sub tab.

2. Inthe Comments section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment Enter comment.
Comment By Displays user id.
Comment Dt Displays comment date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary

The display only Summary sub screen allows you to view summary information regarding the
producer.

To view summary on the Summary
1. Click Origination > Origination > Producers > Summary sub tab.

2. In the Summary section, view the following information.

A brief description of the fields is given below:

Field: View this:

Year Month | The year and month.

Total Apps The application total status count.

Approved The application approved status count.

Conditioned | The application conditioned status count.

Rejected The application rejected status count.

Withdrawn The application rejected status count.

Funded The application withdrawn status count.

Amount The application funded status total amount.
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15.1.10 Title Status Summary

15.2

The Title Status Summary screen displays the various stages of titles of assets for
applications sourced by the producer. The details are available for specific periods based on
elapsed days like last 1 Day / 1 Week / 1 Month or by a specific date range.

To view Title Status Summary on the Summary

1.

Click Origination > Origination > Producers > Title Status Summary sub tab.

2. Sortthe list of statuses to be displayed based on elapsed days by selecting the ‘View Last’
option as 1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected, you can specify
a date range (within 3 months) in ‘Start Dt’ and ‘End D’ fields using the adjoining calendar
and click ‘Search’. View the following field details.
Field: View this:
New Status Displays lien status as 'New'
Perfection Displays lien status as either Sent for Perfection/ Sent for Re-

Processing Status

perfection

Perfected Status

Displays if lien status has 'Perfected Title'

Release
Processing Status

Displays lien status as either Sent for Title Release/Re-sent for
Title Release

Released Status

Displays lien status as either Service Requested/Pending Delete

Hold Release

Displays lien Hold Release status

To be Released

Displays lien status if ‘To be released’

Closed Status

Displays lien status if ‘Deleted’

Exception Status

Displays lien status as either Pending Lien Holder/ Pending DMV

Lien Event Date

Displays lien Event Date attached against each status.

Search Tab

A Search tab is available on the Producers screen to help locate producer information such
as producer number, name, status, group, type, grade, and zip code maintained in the
system. This is the information that is used on the Producer Details screen.
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To search for a producer

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Producers > Search tab.

ORACLE’ ABSHEKAR ¥ 1 Snout O
Financial Services Lending and Leasing
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Producer Detalls | Search 2
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PRODUCER # LikE [+ %
PRODUCER NAVE e =
PRODUCER STATUS LI [+l [l
PRODUCER GROLP LIE [+ [+l
PRODUCER TYPE LIKE [+ [E2)
PRODUCER GRADE LK [+ [=] 3
PRODUCER ZIP CODE LIKE [+
»
L1 gpen
Search Results
View~ Formatw & cze  fiDetach ap @
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FL0000S FL-00005 TEXAS AUTO MAR... USO1 usHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
A-00001 GA-00001 ALTO SOURCE OF... US01 usHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
GA-00002 GA-00002 ADVANCELEASIN... US01 usHQ 05/27/1994 13/31/4000 ACTIVE ek NOT DEFINED DEALER
A-00003 GA-00003 DAUGHTRY AUTO .. US01 usHQ 05/27/1994 13/31/4000 ACTIVE ek NOT DEFINED DEALER
GA-00004 GA-00004 ADVANCELEASIN... USO1 usHQ 05/27/1994 12/31/4000 AcTIVE ek NOT DEFINED DEALER
A-00005 GA-00005 CARRIAGE NISSAN  US01 usHQ 05/27/1994 12/31/4000 ACTIVE ek NOT DEFINED DEALER
1A-00001 1a-00001 DAN DEERY TOYOTA N.02 NLRL 05/27/1994 ACTIVE ek NOT DEFINED DEALER
1a-00002 1a-00002 REEDERMOTOR .. NLOZ R 05/27/1994 ACTIVE ek NOT DEFINED DEALER
1A-00003 1A-00003 CAROUSEL MOTORS NLOZ NLRL 05/27/1994 ACTIVE MK NOT DEFINED DEALER

2. Inthe Search Criteria section, use Comparison Operator and Value columns to enter
search criteria you want to use to locate a producer.

3. Click Search.

System displays the result in the ‘Search Results’ section at the bottom of the screen with the
following details:

e Producer #
e Old Producer #
e Name

e Company
e Branch

e Start Dt

° End Dt

e Status

e Contact

e Group

e Type

e Grade

4. Select the required record and click ‘Open’. The details of only that particular Producer is
displayed in ‘Producer Details’ tab. However, system displays the producer details only
for authorized users based on access/permissions defined in setup.

Note

When a single producer record is opened from Search tab, the ‘Producer Details’ tab en-
ables a ‘Remove Filter’ option. Clicking on the same removes the filter criteria and displays
all the producer records maintained in the system.
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You can click Reset Criteria at any time to clear Comparison Operator and Values columns
on the Search Criteria section.
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16. Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings or making field calls. With the system’s Vendors
screen, you can:

e Maintain vendor information

e Maintain services offered by the vendor

e Assign tasks to the vendors and subsequently track and process those tasks
e Charge vendor expenses to customers

e Enter and update invoices raised by the vendors

e Post vendor transactions

e Process vendor payments

Once an invoice has been presented for a service performed by a vendor, you can enter
information on Vendor Management form and create a monetary transaction. You can then
choose if the customer should pay any particular expense or not.

The Vendors screen allows you to set up vendor information. You can also use the copy
feature to quickly create new vendors with the existing details. By default it will show current
address but if the vendor receives escrow disbursement at an address which is different from
current business address the information can be entered in Payment Details sub screen. Also,
the Payment Details sub screen allows you to enter number of days prior to the due date by
which payment to vendor must be processed.

Navigating to Vendor Detail Screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Vendors.

2. The system displays the Vendor screen. The details are grouped under four tabs:
e Vendors
e Assignment Allocation
e Work Orders
e Follow-up
e Invoices
e Search

Vendors tab

1. Click Origination > Origination > Vendors > Vendors. The details in the screen are
grouped into the following tabs:

e Payment Details
e Vendor Groups
e Tracking Attributes

e Comments
2. In the Origination > Origination > Vendors > Vendors > Vendor Details section, you
can create or edit vendor details. While creating new, you can also use the copy feature

to copy the existing details to new vendor. The copy option in the Vendor Details screen
is controlled by the system defined parameter (UVN_VEN_NBR_SYS_GENERATED).
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Based on the valued defined for the parameter in Setup > Administration > System >
System Parameter screen, you can copy the existing vendor details in the following ways:

e If the value of the parameter is set to ‘Y’ (default), specify a new name in ‘New Vendor
Name’ field and click ‘Create Copy’.

e If the value of the parameter is set to ‘N’, specify a vendor number in ‘New Vendor #
field and click ‘Create Copy’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’
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A brief description of the fields is given below:

Field: Do this:

Enabled Check this box to enable the vendor.

Vendor # The vendor number is either editable (default) or auto generated
depending on the system parameter defined at setup screen.
System auto generates the vendor number when the following sys-
tem parameter is set to ‘Yes’ in Setup > Administration > System >
System Parameter screen.
- Parameter: UVYN_VEN_NBR_SYS_GENERATED
- Description: VENDOR NUMBER IS SYSTEM GENERATED

Channel Select the vendor channel from the drop-down list.

Old Vendor # Displays the old vendor number if exists.

Name Specify the vendor name.

Status Select the vendor status from the drop-down list.

Company Select the vendor portfolio company from the drop-down list.

Branch Select the vendor portfolio branch from the drop-down list.

Start Dt Specify the vendor start date. You can select data even from the
adjacent Calendar icon.

End Dt Specify the vendor end date. You can select data even from the

adjacent Calendar icon.

Contact Person

Specify the vendor contact name.
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Field:

Do this:

Fed Tax # If available, enter the vendor federal tax identification number. If the
organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXXXX1234.

Credit Days Specify the credit days for the vendor invoice. This number is used

to check that Invoice Due Date is not more than the credit days from
Invoice Date.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 1

Specify primary phone number.

Extn 1

Specify the primary phone extension.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number. When selected, system auto
validates this option against the phone number specified.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2 Specify alternate phone number.

Extn 2 Specify the alternate phone’s extension.

Fax Specify the fax number.

Fax 2 Specify the fax number 2.

Country Select the country code from the drop-down list.
Address # Specify the vendor address.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the Zip code.

City Specify the city.

State Select the state from the drop-down list.
Email Specify the email address.

Payment Details

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Click Origination > Origination > Vendors > Vendors > Vendor Details > Payment
Details. The Payment Details sub tab allows you to set up automatic clearing house
information for vendors.
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On the Payment Details sub tab, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Remittance section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Specify zip code from the drop-down list.
Zip Extn Specify extension of the zip code.

City Specify city.

State Select state from the drop-down list.

Pre-Process Days

Specify the remittance pre-process days. This is the number of
days prior to due date by which payment to the vendor must be
processed.

Currency

View the currency attached to vendor.

Payment Details section

Mode Select the mode of payment from the drop-down list.

Bank Specify the ACH bank.

Start Dt View ACH start date.

Routing # Specify the bank routing number.

Account Type Select the account type from the drop-down list.

Account # Specify the account number. If the organizational parameter UIX-
_HIDE RESTRICTED DATA is set to “Y’, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The

list displays the BIC codes defined in the system.

16-4

ORACLE



16.1.2

16.1.3

Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during post-
ing non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency for vendor payment from the
Currency drop-down list. The list displays all the available currencies appli-
cable to the vendor.

Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Groups

Click Origination > Origination > Vendors > Vendors > Vendor Details > Vendor Groups.
The Vendors Groups allows you to set up vendor groups.

On the Vendor Groups section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Sort Specify sort sequence.
Group Select the vendor type to which the vendor belongs from drop-down list,

based on services provided by the vendor.

Enabled Check this box to enable the vendor service.

Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes

Click Origination > Origination > Vendors > Vendors > Vendor Details > Tracking
Attributes. The Tracking Attributes allows you to load tracking attributes and define the
parameter value for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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16.1.4

16.2

16.2.1

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

Click Origination > Origination > Vendors > Vendors > Vendor Details > Comments. The
Comments sub tab allows you to add comments and also view comments posted through AP

interface.

On the Comments sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment View or add the required comment.

Comment System automatically selects the logged in user details.
By

Comment System automatically displays the current date.

Dt

Perform any of the Basic Actions mentioned in Navigation chapter.

Assignment Allocation

The Assignment Allocation tab allows you to define criteria for selecting a specific vendor to
execute a work order. A criteria here refers to a combination of a Channel, Work Order Type,
Company and Branch associated to a vendor. If the same combination or criteria is selected
during work order creation, system selects a specific vendor or highest weighted vendor in the
list by default for the work order.

Click Origination > Origination > Vendors > Assignment Allocation. The details are
grouped under two sections:

e Vendor Assignment Criteria
e Vendor Assignment Allocation

Vendor Assignment Criteria

In the Vendor Assignment Criteria section, you can define the criteria used for vendor
selection.
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1. In the Origination > Origination > Vendors > Work Order > Assignment Allocation,

perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

Vendors x [ Close:

Vendors  Assignment Allocation  \Work Orders  Folow-up  Invoices

Vendor Assignment Criteria
View v Format~ [Er Freeze [ Detach Wrap o)

apadd | A Edt | [5 Yew

Channel Work Order Type Company Branch Enabled State Country
GENERIC AUCTIO... RE SALE DEMO BANK U... US HEAD QUA. ¥ FLORIDA UNITED STATES
INTERNAL BANKRUPTCY DEMO BANK U... US HEAD QUA. ¥

DEMO BANK U... US HEAD QUA... Y

DEMO BANK U... US HEAD QUA. ¥ ALASKA
DEMO BANK U... US HEAD QUA. Y

DEMO BANK ... US HEAD QUA... ¥

DEMO BANK JP  JP HEAD QUA

GENERIC RECOVE... DOCR KNOCK {GRI)
GENERIC AUCTIO... RE SALE
GENERIC RECOVE... REPOSSESSION

UNITED STATES

GENERIC RECOVE... IMPOUND INVOLUNTARY REFOSSESSION (GRI)
GENERIC RECOVE... BANKRUPTCY

Vendor Assignment Allocation AEit | Evew | o audt
vewv Formatw g Fresze i Detach frap )
Vendor = Name Assigned Cases % Alocation Assignment %
V04814 SAND CASTLE INVESTMENTS LLC o
GA-03001 PRITAM o

V05329 RDN DEMO FLORIDA o -

A brief description of the fields is given below:

Field: Do this:

Channel Select the OFSLL interfaced channel from the drop-down list.
If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.

Work Order Select the work order type from the drop-down list.

Type

Repo Storage This field is available only if the channel is selected as ‘GENERIC

Country AUCTION INTERFACE'. Select the Country where the repossessed
asset is currently stored from the drop-down list.

Repo Storage This field is available only if the channel is selected as ‘GENERIC

State AUCTION INTERFACE’. Select the State where the repossessed
asset is currently stored from the drop-down list.

Company Select the Company from the drop-down list.

Branch Select the company’s Branch from the drop-down list.

Enabled Check this box to enable the vendor assignment criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.2.2 Vendor Assignment Allocation

In the Vendor Assignment Allocation section, system fetches the list of vendors qualifying the
combination of channel, work order, company and branch selected and allows you to define
the weightage for each vendor in percentage.

By default, the allocated assignment percentage for each vendor is ‘0’. During subsequent
update, the total of assignment percentage allocation for all vendors should be equal to “100’.
A vendor with the highest weightage is selected by default during work order creation.

For ‘GENERIC AUCTION INTERFACE' related Vendor Assignment Criteria, you can add
vendors to the defined criteria from ‘Vendor Assignment Allocation’ section. For more
information, refer to ‘Remarketing’ chapter in Collections User Guide.
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1.

In the Origination > Origination > Vendors > Work Order > Assignment Allocation,

perform any of the Basic Operations mentioned in Navigation chapter.

Field: Do this:

Vendor # View the Vendor number. The same is either specified manually or
system generated in the Vendors tab.

Name View the name of the vendor.

Assigned Cases

View the total number of cases assigned to the vendor.

% Allocation

View the percentage of total cases assigned to the vendor.

Assignment %

Specify the percentage allocation value (out of 100) for each vendor.
However, ensure that the total of all assignment % is equal to “100’.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.3 Work Orders Tab

The Work Orders link allows you to assign an account to a vendor for a service that the vendor
provides, view the history of work order changes and define tracking attributes.

3.

under three tabs:
e Services

e Work Order History
e Tracking Attributes

Click Origination > Origination > Vendors > Work Order. The details are grouped

In the Origination > Origination > Vendors > Work Order > Work Order, sort the list

of work orders based on status using the ‘View Options’ drop down list. You can further
sort the list of work orders based on elapsed days by selecting the ‘View Last’ option as
1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected you can specify a date
range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining calendar and

clicking ‘Search’.

ORACLE"

Financial Services Lending and Leasing

Perform any of the Basic Operations mentioned in Navigation chapter.

R~ 1g Snout O

Vendors »

Work Order

View Options

view v Format~ [ Freeze i Detach
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«
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Work Order

Work Order

Work Order # UNDEFINED
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* Channel INTERNAL
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20170500010118:

Vendors | Assignment Allocation |~ Work Orders | Folow-up | Invoices

View Last
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m
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Company
FL-01001-TESTT.
V05328-RDN DEM
FL-01001-TESTIT
FL-01001-TESTIT.

uso1
uso1
uso1
uso1

Work Order Details
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A brief description of the fields is given below:

Field: Do this:

Work Order # Displays the work order number.

Case # Displays the case number received from third party vendor interface.

Channel Select the OFSLL interfaced channel from the drop-down list.
If the channel is selected as ‘GENERIC RECOVERY INTERFACE,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIY.

Work Order Select the work order type from the drop-down list.

Type

Account Select account number for the work order from the drop-down list.

Company Displays the company name based on the account selected.

Branch Displays the branch based on the account selected.

Vendor Select vendor who will service the work order from the drop-down

list. The list of vendors are displayed based on the selected Chan-
nel, Work Order Type, and Account.

Override Rea-
son

In case of vendor re-assignment, select the appropriate override
reason for the selected Vendor.

Status Select the work order status from the drop-down list.

If the status is selected as ‘SEND TO GRUI’, the work order is pro-
cessed through an external system. For more information, refer to
Appendix chapter - ‘Generic Recovery Interface (GRI)'.

Reason This field is enabled only if the status of work order is selected as
PENDING ON HOLD, RLRELEASED, or PENDING CLOSE. You
can select the appropriate reason from the drop-down list.

Collector Select the Collector from the drop-down list. The list displays all the
users defined with ‘Collector’ responsibility.

Work Order Details section

Dt Displays the date when work order was created.

Status Dt Displays the last work order status-change date.

Currency Displays the vendor company currency based on the vendor
selected.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Reference #

Specify vendor reference details if any.

16-9

ORACLE



Field:

Do this:

Assigned By

Displays the user who created/assigned the work order to vendor.

Followup Dt

Select the subsequent follow-up date from adjoining calendar.

Account Information section - System displays the following information depending on
the account selected for the work order in ‘Work Order’ section.

Account Status

Displays the status of the account.

Charged off Dt

Displays the date when the account was charged off.

Due Amt

Displays the due amount to be paid to the account.

Total Outstand-

Displays either ‘Account outstanding principal balance’ for active

ing Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Total Due Displays the total of all dues pending on the account.
Due Dt Displays the last elapsed due date on the account.

Days Past Due

Displays the total number of days elapsed past due date.

Service
Address

Displays the combined details of Customer, Address Type and
Address based on the account selected. You can also select the
required service address from the drop-down list only while creating
work order details (i.e. when status = New).

Note: When selecting the service address for an external interfaced
channel (i.e. changing primary address), ensure to select the sec-
ondary address only. Else, system displays an error message.

Collateral Details section - This section displays the asset details associated with the

work order.
Collateral System displays the primary collateral associated with the account
Description by default. You can also select the collateral from the drop-down list.

The list displays all the assets associated with the account.

Identification #

Displays the identification number of the asset.

Year Displays the manufacturing year of the asset.
Make Displays the asset’s manufacturing company.
Model Displays the asset’s model.

Vendor Information section

Contact Specify the vendor contact for the work order.

Phone Specify the vendor contact phone for the work order.

Extn Specify the vendor contact phone extension for the work order.
Fax Specify the vendor contact fax for the work order.

Comment Specify any comments regarding the work order.
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Field: Do this:

Vendor Messages section - This section is displayed only when the selected channel is
‘GENERIC RECOVERY INTERFACE’ and allows you to add specific communication or
instructions as a message to the vendor.

Vendor Msg Select the type of vendor message from the drop-down list.

Type

Vendor Msg Specify additional information that is to be communicated to the
external interface.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

16.3.1 Services

In the Origination > Origination > Vendors > Work Order > Services, perform any of the
Basic Operations mentioned in Navigation chapter.

Click ‘Load Services’ button in the Services section header to load all the services associated
with the selected combination of ‘Work Order Type’ and ‘vendor (Vendor Group)'.

A brief description of the fields is given below:

Field: Do this:

Service # Specify an unique service number for the work order.

Service Select the service type from the drop-down list (required).

Currency System defaults the currency defined in work order which is the vendor
currency.

Estimated System defaults the Estimated cost of the service offered by the vendor

as defined in vendor administration setup screen (Setup > Administra-
tion > System > Vendors > Vendor Fees > Vendor Service Fee Defini-
tion).

However, you can also modify the estimated value to the required
amount.

Billed Amt Displays amount billed by the vendor for the service.

Paid Amt Displays amount paid to the vendor for the service.
Status Select the status from the drop-down list.
Status Dt Displays the last service status change date.

Perform any of the Basic Actions mentioned in Navigation chapter.

16.3.2 Work Order History

The Work Order History sub tab displays the details of the selected work orders in the
sequence of the changes done i.e. last change details appear as the first record.
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In the Work Order History section, select the required work order and click View.

ABSHEKAR ¥ g Sign Qut o

ORACLE

Financial Services Lending and Leasing
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16.3.3 Tracking Attributes

16.4

Click Origination > Origination > Vendors > Work Order > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value for
various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Sub-Param-
eter

View the Sub-Parameter.

Parameter

View the listed Parameter.

Value

Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Follow-up Tab

The Work Orders link lists the work orders that are not complete and hence require follow-up.

1. Click Origination > Origination > Vendors > Follow-up tab. The details are grouped

into two:

e Work Order Follow-up

e Assigned Services
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2.

In the Origination > Origination > Vendors > Follow-up > Work Order Follow-up,

perform any of the Basic Operations mentioned in Navigation chapter except for creating

a new record.

vendors ; ] dose
Vendors | Work Orders  Follow-up | Invoices
Work Order Follow-up AEit | Eview | o audit
Views Formatv B3 Freeze ffiDetach  Jwap @)
Company  Branch FolowupDt  WorkOrders Dt Assignment Type  Account Vendor Status Status Dt Assigned By Estin
UstL uskQ 1/12/2015  WO:0001001 13122015 COLECTION  20150100011170:ROBERTEOREN PR-OL00L-PINNACLE PARTS & SERVICE NEW Ljp0ls  VEROUTHU 000
uso1 UsHQ 1142015 WO:0001003 /142015 BANKRUPTCY 20120100010406:LEWIS LESLIE / JOH  1L-00005- MICHAEL D, CLARK 1142015 VINOARUM 124
uso1 usHQ 12/29/2015 jisPNs  SERVICING 2015120001 1333:ER00K BROOK CA-D2001-ANDREWS TOWING 15015 VAVAIDYA 102
uso1 usHQ j19PNs  SERVICING 2015120001131 CA-D4001-PHANINDRAL 12192015 PHACHODA 1004
uso1 usHQ 1W/19Ns  BANKRUPTCY 2015060001323 11-00005- MICHAEL D. CLARK 5 PHACHODA 1004
uso1 usHQ 1142015 COLLECTION 2012010010373 11-00002-GRTR QUAD CITY AUTO ALC 5 VANKAYA 000
uso1 usHQ Wj1pNs  SERVICING 2015010010023 1L-00001-DECATUR AUTO AUCTION /42015 VIBRRTA 000
uso1 usHQ /192015 20120100010373:ANDRE PETER | VICT... CA-04002-HARRY RECOVER 1192015 VEROUTHU 0.0
uso1 usHQ WO:0004001 0/PNs BANKRUPTCY 20120100010373:ANDRE PETER | VIC... CA-02001-ANDREWS TOWING 122015 VINOARUM 0.0
uso1 UsHQ WO:0005001 10205 BANKRUPTCY 20120100010406:LEWIS LESLIE / JOH  CA-04004-STAR SERVICES 12/22/2015  VINOARUM 000 T
»
4
Work Order Follow-up
[ saveand stay | [ saveand Retum | GaRetum
Vendor  PR-0100L-PINHACLE PARTS & SERVICE Paid 0.00
Work Order Follow-up i N v
. o Vendor Information
Company UL Status Dt 12/12/2015
N ;
Branch USHQ & N— TRy
Followup Dt 12/12/2015 B Phone (973}539-4539
Work Order # WO:0001001 Curtency US DOLLAR =i
Dt 12/1202015 Estimated 0.00 Comment
Account 20150100011170:ROBERT BOREN Billed Amt 0.00
A
Assigned Services A Eit | Elyien | o audit
Views Formatw B Frezze 7 Detach w @ &

A brief description of the fields is given below:

Field:

Do this:

Company

Displays the vendor company.

Branch

Displays the vendor branch.

Followup Dt

Specify the next follow-up date. You can even select the date from
adjoining Calendar icon.

Work Order #

Displays the work order number.

Dt

Displays the work order date.

Account

Displays the account associated with the work order.

Vendor

Displays the vendor associated with the work order.

Status

Select the work order status from the drop-down list.

Status Dt

Displays the last work order status change date.

Work Order section

Currency

Displays the currency for the work order.

Estimated

Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Amt

Displays amount billed by the vendor for the work order.

Paid

Displays amount paid to the vendor for the work order.
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16.4.1

16.5

Field: Do this:

Vendor Information section

Contact Displays the vendor contact name.

Phone Displays the vendor contact phone number.

Extn Displays the vendor contact phone number’s extension.
Comment Specify a comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Assigned Services

In the Origination > Origination > Vendors > Follow-up > Assigned Service, perform any
of the Basic Operations mentioned in Navigation chapter except for creating a new record. A
brief description of the fields is given below:

Field: Do this:

Services Displays the service provided by the vendor.
Currency Select currency for the vendor from the drop-down list.
Estimated Specify the estimated amount for the service.

Billed Amt Specify amount billed by the vendor for the service.

Paid Specify amount paid to the vendor for the service.
Status Select the service status from the drop-down list.
Status Dt Specify the last service status change date. You can even select the

date from the adjoining Calendar icon.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Invoices Tab

In the invoice tab of vendors screen, you can define invoices and process them along with
internally generated and externally received invoices. Invoice processing involves validating
the invoice information either manually or through an automated process.

Manual validation involves verifying the invoice information, accepting or rejecting the details,
updating the invoice status and indicating if the invoiced amount is Collectible.

Auto validation is supported for invoices which are in ‘OPEN’ status and generated internally
(i.e. channel = Internal). During auto validation, the invoice details are verified against specific
business rules defined in the system and corresponding status update and collectible
indicator is updated accordingly.

However, other invoices received from externally interfaced channel would get auto validated

with specific business rules when they are received and corresponding status is appended to
the invoice while listing in the Invoice Information section.
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Post the validation, invoices may still have difference in estimated and invoiced amount. Such
invoices are marked with status ‘FOR APPROVAL” and requires to be manually approved.

Further in the Invoices tab, you can define Tracking Attributes, Payment Schedules and view
the Related Invoice/Work Orders (if any) in the system.

1. Click Origination > Origination > Vendors > Invoices tab. The details are grouped into

following sections:
e Details
— Payment Schedules sub tab
— Related Invoice/Work Orders sub tab
e Tracking Attributes

2. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice based on status using the ‘View Options’ drop down list. You can further sort
the list of invoice based on elapsed days by selecting the ‘View Last’ option as 1 Day / 1
Week /1 Month / By Date. When ‘By Date’ is selected you can specify a date range (within
3 months) in ‘Start Dt' and ‘End Dt fields using the adjoining calendar and clicking

‘Search’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE
Financial Services Lending and Leasing
Vendors y,
Vendors  Assignment Allocation ~ Work Orders ~ Follow-up  Invoices
Invoice Information
View Options ViewLast © 1Day @) 1 Week© 1Month@ ByDate startDt 07/01/2017 (BpEndDt 09022017 o @B
view Formstv [ Freeze  EffiDetach ap ® Validate Invoice
vendor Company Branch Invoice = ExternalRef=  InvoiceDt
IN-0000 1-DYER ALITO AUCTION uso1 UsHQ 33453462 4143252465 08/20/2017
Invoice Information
»
External Ref # 41432524965
Invoice
*Imvoice Dt 09/20/2017 By
* Invoice Type  PAYABLE [=] “DueDt 09/20/2017 (B
*Vendor IN-00001-DYER AUTO AUCTION i ¢ *Status | APPROVED E‘
Company US01
Branch USHQ Detatls
* Invoice # 33453462
Status Dt 09/20/2017
Details  Tracking Attributes
Invoice Details
View = Format~ 2 Freeze RliDetach Wrap @

o3/20/2017 AFPROVED INTERNAL

[ save andstay || [ save andReturn || {aRetum

Status Channel

Address P OBOX 115 DYER, IN 46311
Currency
Estimated
Invoice Amt 0.00
Agreed Amt 0.00
Paid Amt 0.00
Channel INTERNAL

A brief description of the fields is given below:

Field: Do this:

Vendor Select the vendor name for whom the invoice is to be created.
Company Displays the vendor portfolio company.

Branch Displays the vendor portfolio branch.

Invoice # Specify the invoice number.

The invoice number should be unique for every vendor. In case the
Invoice # already exists for Vendor, system displays a warning message.

External Ref
#

Specify the reference number which can be used for invoice tracking.

For invoice received from external system, this field is auto populated
with the reference number generated in external interfaced system.

Invoice Dt

Specify the invoice date. You can even select the date from the adjoining

Calendar icon.
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16.5.1

16.5.2

Field: Do this:

Due Date Select the due date. You can even select the date from the adjoining
Calendar icon.

Status Select the invoice status from the drop-down list.

Details section

Status Dt Displays the last invoice status change date.

Address Displays the vendor address.

Currency Select the currency from the drop-down list.

Estimated Displays the total estimated amount of all the invoices defined in ‘Invoice

Details’ sub tab.

Invoice Amt | Displays the total invoice amount.

Agreed Amt | Displays the total agreed amount.

Paid Amt Displays the total paid amount.

Channel Displays the Channel as ‘Internal’ for manually defined or internally gen-
erated invoice and ‘Generic Recovery Interface (GRI)’ for externally gen-
erated invoice.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Auto Validate Invoice

You can auto validate the invoice details in the Invoice Information section for those invoice
which are in ‘OPEN’ status. Auto validation with system defined business rules ensure that
every approved invoice comply to required processing standards and helps to quickly proceed
with further action.

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice with status as ‘OPEN’ from the ‘View Options’ drop down list.

2. Select the required invoice form the list and click ‘Validate Invoice’ button on the Invoice
Information section header.

The invoice details are validated and the status of the invoice is updated based on validation.
For more information on validations, refer to ‘Business Rules’ section.

Invoice Details sub tab

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Details, perform any
of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Work Order | Select the work order from the drop-down list. This list displays the gen-
erated work orders. Each work order name is defined in the format which
consists of work order number, account number, service number and
service name.
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Field: Do this:

Case # System displays the Case number only if there is a Case number is
associated for the selected work order.

Estimated Displays the estimated cost of selected work order as defined in Vendors
> Work Order > Services section.

Invoice Amt | Specify the invoice amount.

Agreed Amt | Specify the agreed amount.

Paid Amt Displays the paid amount.

Txn Post Dt | Specify transaction effective date. You can even select the date from the
adjoining Calendar icon.

Status Select the status from the drop-down list.

Status Dt Displays the last status change date. On edit, system updates the cur-
rent date by default.

Authorized Displays the name of the user who verified (accepted/rejected) the
By invoice details.

Authorized Displays the date when the invoice details were verified.
Dt

Collectible Check this box to indicate if the agreed amount is collectible from the
customer. When checked, the collectible amount is posted as an
expense on the customer account.

During auto invoice validation, this check box is automatically selected if
the same combination of a service and work order status matches with
the state specific rule defined in Setup > Administration > System > Ven-
dors > Invoice Rules tab.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.5.3 Accept/Reject Invoice details

In the Invoice Details sub section, you can accept or reject the details of those invoices which
are in ‘FOR APPROVAL'’ status. This status is updated during invoice processing and when
there is difference in estimated and invoiced amount which needs manual approval.

1. In the Origination > Origination > Vendors > Invoices > Invoice Details, select the
required invoice record.

2. Click ‘Accept’ or ‘Reject’ in the Invoice Details section header and click ‘Yes’ to confirm
the action.

3. Click Refresh button to view the status update.
On Accepting or Rejecting the invoice details, the ‘Authorized By’ and ‘Authorized Dt fields
are auto updated with user name and current date. Also the status of Invoice information and

Payment Schedules are updated as either ‘CLOSE’ or ‘REJECTED’ respectively. However,
auto update of status is controlled by the ‘Current/Next’ status defined in Cycle Setup screen.

If the status of a particular invoice is updated from ‘APPROVED’ to ‘CLOSE’, system
generates a payment requisition record for payment processing.
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16.5.4 Payment Schedules sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Payment
Schedules, you can maintain the payment schedules information. Perform any of the
Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Currency System displays the vendor currency.

Payment Specify the actual payment amount for the invoice.

Amt

Status Select the payment status from the drop-down list.

Payment Dt | Select the payment date from the adjoining calendar.

Payment (Optional) Specify reference details for the payment if any.

Reference

Payable Id View the auto-generated payable ID which is the requisition ID in the AP
Transaction screen.

Payment Id | View the Requisition ID generated during AP transaction.

Disburse- View the vendor disbursement currency. However, you can select the

ment Cur- vendor payment disbursement currency from the drop-down list.

rency

Account View the currency of the account selected at in ‘Invoice Details’ sub tab.

Currency

Amount in View the Invoice Currency amount equivalent of the Account Currency.

Account System displays the ‘Amount in Account Currency’ by converting Vendor

Currency Currency value to Account Currency and considering the exchange rate
as per the scheduled payment date.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.5.5 Related Invoice/Work Order Details sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Related
Invoice/Work Order Details, view the following details.

A brief description of the fields is given below:

Field: Do this:

Invoice # View the invoice number for the work order.

Invoice Sta- | View the status of invoice generated for the work order.
tus

Status Dt View the date on which the status of invoice is recorded.
Currency View the currency in which the invoice is generated.
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Field: Do this:

WO Esti- View the estimated amount for the work order.
mated Amt

WO Agreed | View the vendor agreed amount for the work order.
Amt

WO Paid View the amount paid for the work order.
Amt

16.5.6 Tracking Attributes sub tab

1. In the Origination > Origination > Vendors > Invoices > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value
for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

16.5.7 Business Rules

Business rules facilitate to auto validate invoices and approve only those which comply to the
invoice processing requirements in OFSLL. Business Rules are always validated on Invoice
information, Invoice details and payment schedules which are in ‘OPEN’ status.

Business rule validation for Invoices created or generated internally can be performed in the
Vendors > Invoices tab and external invoices are auto validated before listing in Invoices tab.

For invoices received from external system, following pre-validation checks are also
performed before validating with the business rules.

e A duplicity check is performed based on External Reference number to ensure that
there are no two invoices with same details. In case the external reference number of
new and existing invoice in the system are same, the status is auto updated as
‘Rejected’ and invoice is not processed further.

e When the payment for a ‘Service’ in work order is already paid and the same work order
is again received with a new external reference number, system validates the ‘Paid’
status and if ‘“Yes’, would auto update the invoice status as ‘Rejected’.

Following business rules are defined in the system for invoice validation. During the process,

if any of the business rule validation fails, system stops the validation process and updates
the status of Invoice as ‘Rejected’.
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Rule 1

Every work order should have a specific closure status corresponding to the type of work
order defined. Accordingly, an invoice generated for that work order should comply with any
of the following combination of ‘Work order Type’ and ‘Work Order status’.

Work Order Type Work Order Status
Door Knock Completed
Involuntary Repossession Repossessed
Voluntary Repossession Repossessed
Impound Involuntary Repossessed
Impound Voluntary Repossessed
Involuntary Repossession Closed
Voluntary Repossession Closed
Impound Involuntary Closed
Impound Voluntary Closed
Skip Investigation Repossessed
Skip Investigation Closed
Rule 2

Validate invoice for the status of ‘Collectible’ check box in Vendors > Invoice tab > Invoice
Details section.

During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System >
Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is allowed to
process the next business rule.

In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’ check box
is NOT selected and the invoice is still allowed to process the next business rule.

Rule 3

Validate invoice based on Estimated and Invoiced amount and updated the corresponding
status in Invoice Information, Invoice Details and Payment Schedules sections of Vendors
screen.

e If the Invoice Amount is ‘Less than or equal’ to Estimated amount, the invoice is
approved and the status of Invoice Details and Payment Schedules is updated to
‘APPROVED’.

e If the Invoice Amount is ‘greater than’ the Estimated amount, then the invoice needs
manual approval and the status of Invoice Details and Payment Schedules is updated
to 'FOR APPROVAL'.

An invoice status in Invoice Information section is auto updated to “APPROVED’ if both
Invoice Details and Payment Schedules have the same status. Else, if status is rejected in
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either of the sections, the status of invoice is also updated as ‘REJECTED’ in Invoice
Information section without allowing further edits on the same.

Search tab

A Search tab is available on the Vendors screen to help locate the details of a Vendor,
Workorder, and/or an Invoice information maintained in the system. This is the information
that is used in the respective tabs of Vendors screen.

To search for a Vendor/Workorder/Invoice

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Vendors > Search tab.

ORACLE’ MBSHEKAR + 1g signout &
Financial Services Lending and Leasing

Vendors [ Close
Vendors | Assignment Alocation || Work Orders | Invoices  Search =
Search Optiors: @ Vendor © Warkarder © Invoice:
Search Criteria
& ResetCritera | @ Search
View ¥ Format~ [ Freeze i Detach rap @
Criteria Comparison Operator value
VENDOR: # LIKE [=] %
VENDOR NAME LIE =)
STATUS LIE [=] [+
CHANNEL LIKE [+ =]
PHONE 1% LKE [+l 3
¥ CoUNTRY e [=] =
il e [=]
L Open
Search Results
View v Fomat~ Freeze [ Detach wep @
Vendor = Charnel 0ld Vendor & Name Status Company Branch Start Dt End Dt Zp
1L-00001 INTERNAL DECATUR AUTO AUCTION ACTIVE DEMOBANKUSA  USHEAD QUARTERS 06/14/1334 12/31/4000 60440 =
1L-00002 INTERNAL GRTR QUAD CITY AUTO AUCTION ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1394 12/31/4000 61244
1L-00003 INTERNAL CRAIG PHELPS, TRUSTEE ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1334 12/31/4000 60603 =
1L-00004 INTERNAL JAY A STEINBERG, ESQ ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1394 1231/4000 60602
1L-00005 INTERNAL MICHAEL D, CLARK ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1594 1231/4000 61602
1L-00005 INTERNAL B AND K TOWING ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1394 1231/4000 61701
1L-00007 INTERNAL ILLINOIS AUTO RECOVERY ACTIVE DEMOBANKUSA  US HEAD QUARTERS 06/14/1594 1231/4000 s25%8 -

2. Inthe ‘Search Options’, select the option against Vendor or Workorder or Invoice.

In the ‘Search Criteria’ section, use ‘Comparison Operator’ and ‘Value’ columns to enter
search criteria you want to use to locate a producer.

4. Click ‘Search’.
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System displays the result in the ‘Search Results’ section at the bottom of the screen
with the following details:

Vendor Details Workorder details Invoice details
Vendor # Work order # Vendor
Channel Case # Company
Old Vendor # Channel Branch
Name Account Invoice #
Status Collateral Desc External Ref #
Company Vendor Invoice Dt
Branch work order Dt Due Dt
Start Dt Company Status
End Dt Branch Channel
Zip Status

Reason

Workorder Type

5. Select the required record and click ‘Open’. The details of only that particular Vendor /
Workorder / Invoice is displayed in the respective tab of Vendors screen. However,
system displays the selected record details only for authorized users based on access/
permissions defined in setup.

Note

When a single producer record is opened from Search tab, the Vendors / Work Orders /
Invoices tab enables a ‘Remove Filter’ option. Clicking on the same removes the filter cri-
teria and displays all the corresponding records maintained in the system.

You can click ‘Reset Criteria’ at any time to clear ‘Comparison Operator’ and ‘Values’ columns
on the Search Criteria section.
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Appendix A:Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising of or cutting off calculated
amounts.

e Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

e Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

The system only rounds calculated amounts (calculated fees, calculated payment, and
so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT _ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system

parameter CMN_AMOUNT _ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 23414
Cut off 234.13

Example 3: Amount: 234.1319999

Method

Result

Round

234.13
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Method Result

Raise 234.14
Cut off 234.13
Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index
rounding method on the Product tab’s Product Definition screen for variable rate Loan.

Note

Index rounding does not apply to fixed rate Loan.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST.25
3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Method Result

Current rate: 5.125

Round of rate: | 5.25

Method Result

Current rate: 5.124

Round of rate: | 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:

Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Method Result
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Current rate: 5.325
Rate rounded 5.375
to:

Method Result
Current rate: 5.312
Rate rounded 5.250

to:
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Appendix B: Payment Amount Conversions

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for instalment accounts.

Payment Frequency:

Scheduled Monthly Income Amount:

D = Deferred

Zero fill

P = Single payment Loan

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) | Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) | Divide by 2
Q = Quarterly (due every three Divide by 3
months)

T = Triannually (due every four Divide by 4
months)

S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12
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Appendix C:Generic Recovery Interface (GRI)

Introduction

In general, a Generic Recovery Interface (GRI) is a platform to connect Oracle Financial
Services Lending and Leasing (OFSLL) with any third party recovery system. This integration
facilitates auto lending institutions to repossess non-performing assets and recover them
through a network of third party vendor managed systems.

Accordingly, in an integrated system a particular account in OFSLL can be assigned to a
vendor (third party) through GRI for recovery services. Depending on each stage of the
process, OFSLL triggers appropriate web service requests to create and update the details
into the third party system. Subsequently, the acknowledged details and case updates are
retrieved into the corresponding work order(s) and account(s) in OFSLL.

Also the system parameter ‘GRI_WEBSERVICE_LOG_IND’ when enabled, logs all the GRI
related web service communications between OFSLL and external interfaced system. The
same can be viewed in Dashboard > System Monitor > Database Server Log Files tab by
selecting ‘Interfaces’ view option.

Following type of web service requests are supported:

e Create Case

e Update Case

e Case Comments

e Hold Case

e Reopen Case

e Reassign Case

e Close Case

e Case Updates Received via FireHose WebService
e Case Repossession

e Case Invoice

Pre-requisites

Following are the pre-requisites while working with third party integrated system:

e Ensure that 'Cycle' setup (Setup > Vendors> Cycles tab) is defined for the Work Order,
where channel is selected as 'Generic Recovery Interface'. Also if the system is defined
to automatically post any specific conditions on account, you need to maintain the
Action and Result Code.

e Ensure that Vendor Fees (Setup > Vendors > Vendor Fees tab) defaults the 'Estimated
Amount'.

e Ensure that the Work Order Types are mapped consistently and are in sync between
OFSLL and third party system. The following table lists the Work Order Types
maintained in the system.

Work Order Type | Description

DRK DOOR KNOCK (GRI)

IR IMPOUND INVOLUNTARY REPOSSESSION (GRI)

C-1 ORACLE



C.2

Work Order Type | Description

VRP VOLUNTARY REPOSSESSION (GRI)

IVR IMPOUND VOLUNTARY REPOSSESSION (GRI)
SKP SKIP TRACE (GRI)

IRP INVOLUNTARY REPOSSESSION (GRI)

e Ensure that the details of Vendors, Collectors and Service types are mapped
consistently and are in sync between OFSLL and third party system.

e Define Invoice Rules (Setup > Vendors > Invoice Rules tab) that are applicable to each
Vendor Service with appropriate Work Order Status, Close Reason, and State
combinations. This ensures that the 'Collectible’ flag is set to "Y' for selected invoice
during processing.

Create Case

Once a non-performing account is identified in OFSLL, the details are to be registered in the
third party system for further action. Using the Work Orders tab (Vendors > Work Orders tab),
you can create a work order with the identified account details and selecting the channel as
Generic Recovery Interface (GRI).

Note that, system does not allow to create a work order during the following conditions:

e If there is already a case created with the same work order type which is active on the
account. On updating the details and clicking ‘Save’, system displays an error message
as ‘Active Work Order with same Order Type already exists on account’.

e If a CURE letter is issued on an account and the same is in-force. If the case creation
date is before the cure letter expiry date, then system displays an error message as
‘Cure Letter Issued and Active. Cannot create work order’.

For information on creating a work order, refer to section Vendors > Work Orders tab.

When the 'Channel' is selected as GENERIC RECOVERY INTERFACE, the Work Orders tab
enables 'Vendor Messages' section to specify additional details that are required by the third
party vendors to act upon the case. For more information, refer to ‘Case Comments’ section.

After the work order details are created, the same needs to be registered as a case in third
party system by updating the status. Accordingly, when the Status of Work Order is selected
as 'SEND TO GRI', the 'add Case()' web service is initiated to create a case in third party

system.

ORACLE'
Financial Services Lending and Leasing

@ Vendors x [®Dose
Work Order
Save and Stay. SaveandRetun || {3 Return
> DashBoard
Origination Work Order Work Order Details
Ot 12/26/2016 Collateral Details

Work Order # WO:0021410 StatsDt 12/26/2016

Case # UNDEFINED Currency USDOLLAR Collateral | 2006 CHEVROLET MONTECARLO 2D |

el DTERNAL Estimated 100.00 Desaition
rk Order  IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00

Identification # 2B4GPASG IXR378252

Padioing Year 2006
00:SMITH 5 Make CHEVROLET

Reference = Model MONTECARLO
Assigned By PRITAM

Followup Dt B Vendor Information
Account Information
B Account Status  ACTIVE:DELQ:BKRP:REPO Contact ME

= | Charged off Dt Phone
Due Amt 450.03

= Total Outstanding 20500.36
Balance

Total Due  5050.33 Commen! t
DueDt 02/10/2017
DaysPastDue 315

Service Address
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The 'add Case()' web service request consists of the following Case details to be registered
in third party system:

e Primary Customer

e Secondary Customer (Based on the sequence)

e Address Details

e Account Details

e Collateral Details

When the web service request is successful, the response would contain the new case
number created in third party system. The case # is then appended to the work order and the
status is changed from 'SEND TO GRI' to 'ASSIGNED'. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = [Case No]: "NEW CASE CREATED"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Search | Customer Service: 20000100015971 | Review Request (Pending: 0) | Queus Assignment

Account(s): 2000 SMITH E] view || « Audit
View = Format= & Freeze EfiDetach Virap W & @ curent@ show Al © Group Follow-up
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due !
uso1 USHQ SUB UNIT1 2000 LOAN WEHICLE (FR) 315 UsD 27,947.17 4,950.33!

4 m r

Summary Customer Service AccountDetails Customer Details  Transaction History ~PmtModes Bankruptcy RepofForedosure Defidency Colateral Bureau CrossUpSellAc > ™

Call Activities | Maintenance ~Comments | Promises | Cheddists = Tracking Atiributes = Field Investigation | References | Correspondence | Letters | DocumentTracking | Scenario Ar > ¥

Comments dpadd | AEdt | B vew | o Auit
View v Formatv P Freeze ot Detach Wrap @ 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERMAL 12/06/2016 07:45:48 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE GOT REPOSSESS... INTERNAL 12/21/2016 06:55:39 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE WAS ACCEFTED  INTERNAL 12/21/2016 06:48:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE __2044312529:90DEMO-GRI_INTERFACE-ACCEFTED CASE INTERNAL 12/21/2016 05:48:07 AM
I N SYSTEM GENERATED INSOUND FROM INTERFACE  2044312529: NEW CASE CREATED INTERNAL 12/21/2016 05:59:15 AM | I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:90DEMO-GRI_INTERFACE-ACKNOWLEDGED CASE... INTERNAL 12/20/2016 10:08:05 PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. {CORRESPONDENCE: C... INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILLS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:49 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETALLS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:48 AM

In case of an error in the web service response received from third party system, the status
of work order is changed from 'SEND TO GRI' to 'GRI FAILED' and a comment is posted on
the corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE
e Comment = "<<Error Message>>"

e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Note

Error in web service response can also arise when a work order type is not mapped be-
tween the two systems and a case creation request is sent to third party system.

Update Case

Once the details of a work order has been registered as a case in third party system, there
can be subsequent updates in the details of the mapped account arising due to mismatch in
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account details, change in address, collateral and so on. These changes need to be
incrementally updated into the third party system and are done through the following web
services which are triggered when corresponding details are updated.

Web Service Type of change in mapped account

updateCaseAccountinfo() | When Account details are updated.

updateCaseAddress() When Address details are updated.

updateCaseCollateral() When Collateral details are updated.

updateCaseDebtor() When Primary Customer details are updated.

updateCaseCosigner() When Secondary Customer details are updated.

Secondary Customer can also be the next customer type
defined in the sequence.

The update web service request consists of the modified field details that are to be updated
in third party system.

ORACLE' SR + 1g Sanut O
Financial Services Lending and Leasing

Customer Service 3 (3 Close

Search  Customer Service: 2000010015971 Review Request (Pending: ) | Queue Assignment

Account(s): 20000100015971: EDWIN Elvew | o audt
View v Format~ [ Freeze i Detach Wirap W & @ curent show AlO Group Folow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt. ‘AmountDue Status Oldest Due Dt
uso1 UsHQ SUB UNITL 20000100015971  LOAN VEHICLE (FR) 338 USD 27,894.99 5,400.36 [JoppqlR =ReF: [ W 02/10/2016

« M » o

Summary = CustomerService | AccountDetsls | Customer Detals | Transaction History ~PmtModes —Barkruptcy | RepofForecosure | Defidency | Collateral | Bureau | CrossiUp Sell Activities  External Interfaces

Call Activities | Maintenance | Comments  Promises | Cheddists | Tracking Attributes || Field Investigation | References | Correspondence || Letters | Document Tracking || Scenario Analysis | Access History

Comments dradd | AEdt | Fven | o At
view v Formatv  Ep Freeze  EfiDetach wrap W 38 Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ ADDRESS UPDATED - ADDRESS NUMBER: OLD VALUE : 745 NEW VALUE : 111ADDRESS UPDATED - ADD INTERNAL 01/13/2017 03:01:58 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:56 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:54 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: VEHICLE, PRIMARY IND: Y INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER UPDATED - NAME: UPDATE-1 ADD CASE-2, RELATION: PRIMARY, DATE OF BIRTH CHAN... INTERNAL 01/13/2017 03:01:24 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER URDATED - NAME: COSIGNER DETAILS-1, RELATION: SPOUSE, DATE OF BIRTHCHANGED  INTERNAL 12/06/2016 02:03:51 FM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044258164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57: 11 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044287557:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:09 AM =

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:07 AM

If the web service request is successful, the modified details are updated into the case in third
party system. Also a comment is posted on the corresponding account in Customer Service
> Comments tab, with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.

In case of an error in the web service response received from third party system, case details
are not updated and the following details are posted as a comment against the account.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<UPDATED ACCOUNT DETAILS NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.
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Case Comments

Case comments refers to additional details provided in the 'Vendor Messages' section of
Work Orders tab that are required by the third party vendors to act upon the case.

The ‘Vendor Messages’ section can be updated after the case has been created in third party
system and serves as a communication channel between the integrated system.

'Vendor Messages' section is available in the Work Orders tab only when the 'Channel' is
selected as GENERIC RECOVERY INTERFACE and by default, the Vendor Message Type
is selected as ‘CLIENT UPDATE'.

ORACLE
Financial Services Lending and Leasing

@ vendors (3 Close:
Work Order Work Order Details =
Dt 12/26/2016 Collateral Details
St Work Order # UNDEFINED StatusDt 12/26/2016
Origination et i currency (ot )
* Channel GENERIC RECOVERY INTERFACE [ Estimated 0.00 . n:“‘ﬂ‘” 2
Origination -  ork O [ITERNAL R e fentification #
SalesLead W G-1\ERIC RECOVERY INTERFACE pad 0.00 e
Smple Application Entr Moke
ooy E; * Account = Reference
Appication Entry Model
ol Company Assigned By ABSHEKAR
Funding Brench Folowup Dt ) Vendor Information
Applcation Retrieval Voo = Account Information
Scenario Analysis Override Reason Account Status Contact
Application Documents *Status NEW [=] Charged off Dt o
Image Maintenance o Due Amt i
Reports Total Cutstanding
Producers . Clecix; = Balence Fax
Vendors i Total Due Comment
Due Dt
Days Past Due
Service Address [=]
Vendor Messages
Vendor Msg Type | CLIENT UPDATE -
= Vendor Msg
> Servicing
* Collections
> WFP
» Tools
> Setup

Accordingly, in the ‘Vendor Messages’ section when the details of Vendor Message Type and
Vendor Message are updated for a work order, system triggers ‘addCaseUpdate()’ to update
the same details in the third party system.

An outbound comment is posted on the corresponding account in Customer Service >
Comments tab, with the following details and the update details are also captured as a record
in Work Order History tab.

e Type =SYSTEM GENERATED

e Sub Type = OUTBOUND TO INTERFACE

e Comment = “[Case No]: <<Vendor Msg Text >>"
e Comment By = “USER”
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e Comment Dt = Comment Posted date

ORACLE’ ¥ SSHEKAR ¥ i Sign out =
Financial Services Lending and Leasing

Vendors 3 Customer Service y [%] Close:

Search | Customer Service: 20160900013226  Review Request (Pending: 0) | Queue Assignment

Account(s): 20160900013226: CHAKS JACY E View | & Audit
view = Format ~ [ Freeze i Detach Wrap B & @ curent® Show Al ©) Group Follow-up
Company Branch Sub Uit Account £ Product Days Past Due Currency Pay Off Amt Amount Due Status a
uso1 usHQ SUB UNIT1 20160800013226  LOAN VEHICLE (FR) 108 USD 51,936.86 17,405.28

Summary || Customer Service AccountDetals | Customer Detals | Transacton History | PmtModes  Bankruptcy | RepofForedosure | Defidency  Colatersl | Bureau  Cross/Up Sell Activities | E > 7

Cal Activiies | Maintenance =~ Comments | Promises | Cheddists = Tracking Attributes  Field Investigation |~ References | Correspondence  Letters  DocumentTracking | Scenario Analysis | A > ™

Comments add | Aedt | 5 vew | o audt
view = Format » [ Freeze  f Detach Wrap W 8¢ Delet=
Alert Type Sub Type Comment Comment By Comment Dt
= SYSTEM GENERATED OUTBOUND TO INTERFACE __2044317321:0THER: TOYOTA CAMRY _ NEW EDITION 2017 MODEL ABSHEKAR Oya7017 052250 A
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/24/2017 01:07:20 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 03:00:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:58:09 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02 AN
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:53:53 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:51:26 AM ql.

Hold Case

A particular work order or case which is already scheduled for repossession can undergo a
status change when a payment is received (either full outstanding due or partial) on the non-
performing account associated with the work order.

Also, an automatic case status change can happen on work order for an account based on
Delinquency Days. Whenever the delinquency days falls below certain number of days as
defined in system parameter “GRI_DLQ_DAYS_AUTO_STATUS_CHG” (DELINQUENCY
DAYS FOR AUTOMATIC CASE STATUS CHANGE), system auto updates the case status
as ‘PENDING ON HOLD/ON HOLD’ on running the batch job SET-GRI
(RDNDLQ_BJ_100_01-AUTOMATIC CASE STATUS CHANGE).

Accordingly, when the status of a work order is changed to ‘PENDING ON HOLD’ in Work
Orders screen, system triggers ‘holdCase()’ web service request to update the status of
corresponding mapped case in third party system. This ensures that a work order in hold
status is not processed further with third party vendor managed systems.

For information on updating the work order details, refer to section Vendors > Work Orders
tab.

ORACLE
Financial Services Lending and Leasing

Vendors 3 (%] Close
view » Format v [f5] Freeze  EfiDetach Wrap 2]
Override
Work Order # Case # Channel Account. Collateral Deseripton ~ Vendor o= - Company  Branch Status Reason Work Order Type  Assigned By Reference #
WO:0021105 2044299014 GENERIC RECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... S0DEMO- uso1 UsHQ ONHOLD  JCUSTOMER .. IMPOUIND TNVOLU... HMACHA
WO:0021117 2044256035 GENERIC RECOVERY INTERFACE  20151... 2006 CHEVROLET MONT... S0DEMO- usol UsHQ ONFOLD  CUSTOMER ... IMPOUND INVOLU... VENKAT
WO:0021122 2044299038 GENERIC RECOVERY INTERFACE 20160... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... VENKAT
WO:0021106 2044299023 GENERIC RECOVERY INTERFACE 20000... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... HMACHA
WO:0021067 2044297345 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA
WO:0021070 2044297557 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA

« i »

services | Work Order History | Tracking Attributes

m

‘Work Order History 5] view
View  Format + H | Freeze  [fiDetach Wrap o]
¢
Viork Order # Case # Chamnel  Account ;z!‘z:fp’:ln Vendor RD:EE;E:E Company  Branch Status Reason Work Order Type  Assigned By R
W0:0021105 2044299014  GENERICRE... 20000100013892:... 2006 CHEVROLET .. S0DEMO-RON_INT. uso1 usHQ PENDING ONHOLD CUSTOMER .. IMPOUND INVOLU... HMACHA
WO:0021105 2044299014 GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. S0DEMO-RDN_INT. uso1 USHQ (OPEN IMPOUND INVOLU... HMACHA
WO:0021105 2044299014 GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 USHQ | ASSIGNED IMPOUND INVOLU... HMACHA T
WO:0021105 UNDEFINED ~ GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 USHQ INEW IMPOUND INVOLU... HMACHA
« i v o

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE HOLD REQUEST ACCEPTED BY THIRD PARTY
INTERFACE (Reference No)>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date.

ORACLE’
Financial Services Lending and Leasing

Customer Service x [ Close

Search  Customer Service: 20160300018800 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160318800: FOSTER RICK [El view || & Audit
View » Formatv Freeze i Detach Wrap @ & © curent® show Al © Group Fallew-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
uso1 usHQ SUBUNIT1 2016030018800  LOAN VEHICLE (FR) 50 USD 32,536.20 3,861.52 ACTIVE:DELQ 11/24/2016

Summary ~ Customer Service ~AccountDetails = Customer Detais || Transaction History | PmtModes || Bankruptcy | RepofForedosure | Deficency | Colateral | Bureau  Cross/Up Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Checists | Trading Attributes | Field Investigation | References | Correspondence || Letters || DocumentTracking || Scenario Analysis || Access History

Comments Apadd | AEdt | [Hvew | of Audt
View » Format v [ Freeze i Detach Wirap @ 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27 PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR1_VR JOB REQUEST ID: 21... INTERNAL 12/13/2016 12:47:35 AM

12/06/2016 02:03:51 PM

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL
(CORRESP: :

N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. ESPONDENCE: CNLNCE_WEL | TR VR JOB REQUEST ID: 17499)  INTERNAL

| SYSTEM GENERATED INEQUND FROM INTERFACE 2044275575 : CASE HOLD ACCEPTED BY THIRD PARTY INTERFACE : INTERNAL 11/10/2016 03:00:35 AM
N SYSTEM GENERATED TNBOUND FROM INTERFACE _ 2044275575:30DEMO -RDN_INTERFACE-CASE WAS ACCEPTED. TNTERNAL T1/10/2016 02:5%:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275575:90DEMO-RDN_INTERFACE-ACCEFTED CASE INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275575:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 11/10/2016 02:51:43 AM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

o Alert=Y
e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<CASE HOLD REQUEST NOT UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date.

Reopen Case

When the status of a work order is updated from ‘ON HOLD’ to ‘RELEASED’ in Work Orders
screen, system triggers ‘reopenCase()’ web service request to update the status of
corresponding mapped case in third party system.
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This ensures that a work order in hold status is processed further with third party vendor
managed systems.

ORACLE BAR 1 signout O
Financial Services Lending and Leasing

Vendors 5. @ dose

Vendors | Assignment Alocation | Work Orders  Folow-up  Invoices b

‘Work Order
Fradd | FEdt | Evew | o Audt

View v Format~ [ Freeze  {fiDetach Wrap 5]
& woooa1117
Colateral Override Assig

Work Order # Case # Channel Actount Vendor Company  Branch Status Reasor Work Order Type Reference # Fol |2
Description Reason By |

WO:0021117 2044299035 GEMERIC RE... 20151100019817:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 UsHQ ONHOLD CUS... IMPOUND INVOLUNTARY REPOSSE.... VE.

< [ B

Work Order
Eseveandsay | | saveandreum || (agetm
4 Work Order Work Order Details
ot 12/01/2016 Collateral Details
Work Order # WO:0021117 Status Dt 12/01/2016
Case & 2044293035 Currency USDOLLAR Colateral Description 2006 CHEVROLET MONTECARLO 2DR
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 284GP45G DR378252
Work Order Type IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00 Year 2006
Account 20151100013817:DON TAMPRI Paid 0.00 Make CHEVROLET
Cempeny Us01 Reference # Madel MONTECARLO
G fesmedby- AT Vendor Information
* Vendor  GODEMO-RDN_INTERFACE - e B e
Querride Rezson Select the work order status R s S
= Status | ON HOLD [=] Account Status CLOSED:ACTIVESTTP Phone
o — Gt
s, A DueAmt 1078.8 Exin
RerEaseD | Total Qutstanding Balance -207.84 Fax
S— Total Due 0 Comment

Due Dt 02/02/2017
Davs Past e 22

The processing update of REOPEN case request at the third party system is tracked
separately through a FIREHOSE web service scheduled at specific interval using a batch
process. For more information, refer ‘Case Updates Received via FireHose WebService’
section.

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE KAR ~  ug Signout
Financial Services Lending and Leasing

Vendors x| Customer Service x [ Close
View v Format= | g7 rreeze g Demn wrap GRS} @ LUENTL SNOW AN LrOUD FOIOW-UP .
Company Branch Sub Unit Account £ Praduct Days Past Due Currency Pay Off Amt Amount Due Status
uso1 usHQ SUB UNITL 0160300021035 LOAN VEHICLE (FR) 254 USD 46,032.86 17,561.52 ACTIVE:DE

Summary ~ Customer Service AccountDetails | Customer Detaiis | Transaction History | PmtModes | Bankruptcy  RepofForedosure  Deficency | Collateral | Bureau | CrossfUp Sell Activiies | E >

Call Activities | Masintenance  Comments | Promises  Checklsts | Tracking Atrbutss | Field Investigation | References | Correspondence  Letters  DocumentTracking | Scenario Analyss A >

Comments Fadd | et | Fyew || o Audt =
View v Format = [ Fresze  Hff Detach \Wrap W 58 Delet=
» Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016:CASE REOPEN UPDATED IN THIRD PARTY INTERFACE INTERNAL 12/06/2016 07:26:30 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR... INTERNAL 12/13/2016 12:48:39 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL _LTR... INTERNAL 12/13/2016 12:47:35 AM I
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GEMERATED. (CORRESPOMDEMCE: CNLNCE_WEL_LTR_VR ... INTERNAL 12/06/2016 02:03:15PM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044302016: NEW CASE CREATED INTERNAL 12/06/2016 07:22:53 AM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

e Alert=Y
e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

Reassign Case

A particular work order or case which is already scheduled for repossession in third party
system can be reassigned to a different vendor due to delay in action, response, status
updates or any such conditions.

Accordingly, when a case is reassigned to a different vendor, the change is processed for
update in third party system depending on the current case status maintained across systems
as indicated below:

. OFSLL Work | GRI Case .
Scenario Order Status | Status Case Reassignment Update

1 Send to GRI NEW Case is assigned to new Vendor.
FROM
CLIENT
2 Open Open Existing case is closed (i.e. status is updated

as ‘PENDING REASSIGN/CLOSE’) and new
case is created and assigned to new Vendor.

Also, system automatically updates the work order status to ‘PENDING REASSIGN/CLOSE’
based on the days defined in the lookup code ‘VEN_REASSIGN_DAYS_CD (VENDOR
REASSIGNMENT DAYS CODES). If the case status is OPEN for specific number of days as
maintained in the sub code of the above lookup code, system auto updates the case status
as ‘PENDING REASSIGN/CLOSE’ on running the batch job SET-GRI (RDNVNA_BJ_100_01
- AUTOMATIC VENDOR REASSIGNMENT).

Accordingly, when a case is reassigned, system triggers ‘reassignCase()’ web service
request for reassigning the case to new vendor in third party system. Depending on the case
status, the case is either directly assigned to new vendor, or a new case is created with new
vendor by closing the existing case.

e If Case status is ‘'NEW FROM CLIENT’ in GRI, the case is reassigned to new vendor in
GRI and no New CASE is created in OFSLL.

e If Case statusis ‘OPEN’ in GRI, the case is updated to ‘Pending on Close’ status in GRI,
new case is created in OFSLL with New Case # and assigned to new Vendor.

If a new case is created in third party system due to vendor reassignment, then the web
service response will include the new case number. Subsequently, when a close confirmation
is received on the existing case as part of case status update from FIREHOSE web service
response, the work order in OFSLL is closed (status = ‘CLOSE’) and new work order is
created with new case number, new assigned vendor and previous work order account
details.

Note the following:

— New work order is created in OFSLL only if the ‘reassignCase()’ web service
response consists of new case number created in third party system.
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— If the web service response is successful but does not contain a case #, then the
case is directly assigned to new vendor in third party system.

A comment is posted on the corresponding account in Customer Service > Comments tab,
with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = NEW CASE NO: “<<CASE REASSIGNMENT REQUEST ACCEPTED BY
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’
Financial Services Lending and Leasing

Vendors ¢ Customer Service yx (] Clos=

Search  Customer Service: 20160100025071  Review Request (Pending: 0)  Queue Assignment

Account(s): 20160100025071: JENA PRITAM Elvew | o Audit
View > Format v [Ep Freeze i Detach Wrap W & © curent® show Al©) Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status =
Us01 UsHQ SUB UNIT1 20160100025071  LOAN VEHICLE (FR) 349 USD 15,748.99 5,400.36
<l _ 11 — — »
Summary = Customer Service | AccountDetsls ~Customer Detsils | Transaction History | PmtModes  Bankruptcy | RepojForecosure | Defidency | Colateral | Bureau  Cross/Up Sel Acthities | E > ¥

Call Activities ~ Maintenance = Comments  Promises  Cheddists | Tracking Attrbutes | Field Investigation | References  Correspondence | Letters  DocumentTracking | Scenario Analysis A > 7

Comments dpadd | AEdt | [Fuew | o At
View v Format~  [Ep Fresze i Detach \rap ) 5% Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/24/2017 01:06:33 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:59: 12 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/13/2017 02:50:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/08/2017 09:45:22 PM
N SYSTEM GENERATED INBOUND FROM INTERFACE _ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/02/2017 12:23:35 AM
| D SYSTEM GENERATED INBOUND FROM INTERFACE | =

IGNMENT IN PROGRESS

INTERNAL 12/29/2016 04:4;

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account and the work status is not updated nor
a new work order is created with new assigned vendor.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE REASSIGNMENT REQUEST NOT UPDATED IN
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

C.8 Close Case

A particular work order or case which is already scheduled for repossession can be closed
after validating the preceding status and subsequently a repossession may not be required
on the account mapped to the work order.

Accordingly, when the status of a work order is changed to ‘PENDING CLOSE’ in Work
Orders screen, system triggers ‘closeCase()’ web service request to update the status of
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corresponding mapped case in third party system. This ensures that the work order is not
processed further with third party vendor managed systems.
ORACLE’

HEKAR = 1g SignOut

Financial Services Lending and Leasing
Vendors 5 (3] Close
Work Order &
dpadd | ZEdt | Guew | o Audt
view = Format v (57 Freeze i Detach rap o]
Work Order # Case # channel Account i vendor OV oy Branch Status Reasor Work Order Type  Assigned By Reference
Description Reason
WO:0021175 2044302017 GENERIC RE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsH cLose CUS... IMPOUND INVOLLL... HMACHA
« i v
b Services  Work Order History | Tracking Attributes
Work Order History [E] view
View = Format v [(5¢ Freeze  {ffiDetach rap o]
Work Order # Case = Channel Account &= Vendor O Company  Branch Status Reason Work Order Type  Assigned By R
Desaription Reason
WO:0021175 2044302017  GENERIC RE... 20160300021051:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 UsHQ PENDING CLOSE | CUSTOMER .. IMPOUND INVOLLL... HMACHA
WO:0021175 2044302017 GENERICRE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 USHQ GPEN IMPOUND INVOLU... HMACHA
WO:0021175 2044302017 GENERICRE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsHQ ASSIGNED IMPOUND INVOLUL... HMACHA
WO:0021175 UNDEFINED  GENERIC RE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 USHQ NEW IMPOUND INVOLU... HMACHA
<[ i »

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Alert=N
e Type = SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE
Comment = CASE NO: “<<CASE CLOSE REQUEST ACCEPTED BY THIRD PARTY
° o} ent= :
INTERFACE >>”
—_ ”
e Comment By = “INTERNAL
e Comment Dt = Comment Posted date
ORACLE’ -
Financial Services Lending and Leasing
Customer Service » [3€] Close
Search  Customer Service: 20160300018545  Review Request (Pending: 0)  Queue Assignment =
Account(s): 20160300018545: FOSTER Bl view || o Audt
View = Format~ [Ep Freeze  f Detach Wrap M & @ curentO show AlD Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt. Amount Due Status Oldest Due Dt
uso1 USHQ SUB UNIT1 20150300018545 LOAN VEHICLE (FR) 264 USD 46,345.17 17,561.52 ACTIVE:DELQ 04/24/2016
2l I T =
Summary ~Customer Service = AccountDetais ~Customer Details ~ Transaction History ~PmtModes Bankruptcy = RepofForedosure  Defidency Collateral  Bureau  Cross/Up Sell Activities  External Interfaces
Cal Activities  Maintenance  Comments  Promises  Cheddists  Tracking Attrbutes | Field Investigation  References  Correspondence  Letters DocumentTracking  Scenario Analysis  Access History
Comments dpadd | ZEdt | Guven | o Audt
View v Format~ &P Freeze i Detach wrap W 3¢ Delete
Alert Type sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27 PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR2 VR JOB REQUEST ID: 18... INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED (COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR3_VR JOB REQUEST ID: 18.. INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE | 2044274356 : CASE CLOSE ACCEPTED BY THIRD PARTY INTERFACE [INTERNAL 11/08/2016 10:44:43 PM
N SYSTEM GENERATED SYSTEM GENERATED 'WELCOME LETTER GENERATED. (CORRESPOMDENCE: CNLNCE_WEL_LTR VR JOB REQUEST ID: 17330) INTERNAL 11/09/2016 09:27:10 FM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044274356: NEW CASE CREATED INTERNAL 11/09/2016 09:19:10 PM a8

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work

Order is not changed.

e Alert=Y

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date
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Case Updates Received via FireHose WebService

Retrieving case status updates from the third party system is through a FIREHOSE web
service response received into OFSLL through a pull service. Each response is channelled
through an individual Event ID and Event Type.

A FIREHOSE web service 'getGriFireHose' - scheduled at specific interval using batch
(GRIFRH_BJ_100_01) retrieves the case updates. This response consists of case activities
recorded in third party system between specific intervals (based on Max event ID).

Note that, the FIREHOSE web service response always contains specific Event Type Code
from the third party system which are updated in the database and inturn is validated for
appropriate action in OFSLL. The table below indicates the list of Event Type and the
corresponding action updated in the system.

Event Event Description Action

Type

600 ACCEPTED CASE Change Work order status to “OPEN”

601 DECLINED CASE Change Work order status to “DECLINED”

602 ACKNOWLEDGED Change Work order status to “CLOSE”

CLOSE
603 ACKNOWLEDGED Change Work order status to “ON HOLD”
HOLD

300 CASE WAS REPOED Change Work order status to “REPOSSESSED”
And
Trigger “getRepossessionDetails()” web service to
get repossession details and update in Servicing >
Repo/Foreclosure” tab.

302 CASE COMPLETED Change Work order status to “COMPLETED”

200 FIRST UPDATE ADDED | Post the received update as “Inbound Comment”

CUSTOM from Interface in Servicing >Customer Service
>Comments tab.

201 UPDATE EDITED Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

203 UPDATE UNHIDDEN Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

811 INVOICE SENT TO CLI- | Call the “getCaselnvoiceData()” web service and

ENT create the invoices in OFSLL.

1300 CR ADDED Update ‘Condition Report Status =Y’ and Condition

Report Recd Dt = Event Received Date

Based on the web service response received from third party system, the status updates are
posted onto corresponding work order(s) and account(s) in OFSLL.
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For example, if the FIREHOSE web service response consists of the Event Type ‘600’, it
indicates that the case is accepted by the assigned vendor in third party system and status of
the work order is to be updated to ‘OPEN’ in OFSLL. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = "[Case No]: <<[Vendor] ACCEPTED CASE>>"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date and time

Note

Work order status change is permitted only if the previous status matches with the defined
cycle setup (Setup > Products > Cycles). Else, update is not allowed and comment is post-
ed on the account with the message ‘Work Order Status Update failed due to mismatch of
previous status’.

Case Repossession

When a case has been repossessed, the status of the case is updated by the assigned vendor
in third party system. The case status is then retrieved through a FIREHOSE web service
scheduled at specific interval using a batch process.

On receiving the case status update as ‘REPOSSESSED’ (i.e. Event Type 300) from
FIREHOSE web service response, system triggers ‘getRepossessionDetails() web service
request to fetch the repossession details and update the status of corresponding mapped
work order and account in OFSLL.

If the web service request is successful and repossession details are received as part of the
response, the status of the work order is updated in Work Orders tab and a comment is posted
on the corresponding account in Customer Service > Comments tab, with the following
details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: REPO DETAILS RECEIVED FROM THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time

ORACLE 3 SSHEKAR + 1) Sgnout
Financial Services Lending and Leasing

[EEE R e trymer Service x [ Close
Search | Customer Service: 2016060001 Review Request {Pending: 0) | Queue Assignment =
Account(s): 2016060001: COSIGNER Elview || o Audit
View ¥ Format~ [y Freeze i Detach Wrap W & @ curent© Show Al Group Follow-up
Company Branch Sub Uit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status OldestDue Dt
uso1 usHQ SUBUNITL 20160600018906  LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTIVETDELQ 07/27/2016

Summary || Customer Service | Account Details | Customer Details | Transaction History | PmtModes | Bankruptcy = RepojForedosure | Defidency | Colateral | Bureau = CrossfUp Sell Activities | External Interfaces

Call Activities | Maintenance | Comments | Promises | Cheddists | Tracking Attributes || Field Investigaion | References | Correspondence || Letters | Document Tracking | Scenario Analysis | Access History

Comments dpadd || ZEdit || [F view || o Audt
View v Fomat~  Ep Freeze i Detach Wrap W 38 ekt

Alert Type Sub Type Comment ‘Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR VR JOB REQUEST ID: 25332) INTERNAL 01/12f2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 20948) INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR2_VR JOB REQUEST ID: 18520) INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR3_VR JOB REQUEST ID: 18506) INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMNDENCE: CNLNCE_WEL _LTR_VR JOB REQUEST ID: 17499) INTERNAL 11/10/2016 02:02:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275584: GRI_INTERFACE:REPOSESSION DETAILS FROM GRL UPDATED INTERNAL 11/10/2016 05:02:30 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE GOT REPOSSESSED INTERNAL 11/10/2016 05:02:25 AM “
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-AGENT UPDATED LICENSE PLATE FROM UNDEFINED TO 123456 INTERNAL 11/10/2016 05:02:25 AM
N SYSTEM GEMERATED INBOUND FROM INTERFACE  2044275584: 90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE WAS ACCEPTED INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275584 NEW CASE CREATED INTERNAL 11/10/2016 04:51:00 AM =
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The Repossession details are also updated in Repo/Foreclosure tab of Customer Service

screen.

ORACLE"
Financial Services Lending and Leasing

3 Oose

Customer Service ¢ Customer Service x

Search | Customer Service: 2016060001 Review Request (Pending: 0) | Queue Assignment

Account(s): 2016060001: COSIGNER Elvew || o audit
View v Formatv [ Freeze & Detach Wrap B & © Curent® Show Al O Group Folow-up
Company Branch Sub Unit Account = product Days Past Due Currency Pay Off amt Amount Due Status Cldest Due Dt
uso1 usHg SUB UNITL 20160600018906  LOAN VEHICLE {FR) 170 usD 102,758.36 51,382.32 ACTVEDELQ 07/27/2016

Summary || Customer Service || Account Details || Customer Detals || Transaction History || Pt Modes | Bankuptcy | RepofForeclosure | Deficency || Colateral || Bureau || Cross/Up Sell Activities || Extemal Interfaces

Repossession Anslyss

Repossession Details: 2B4GP45G1XR378254 dadd | Pedt || Elven || & audt L
view v Formatv [ Freeze i Detach Wrap o
Current FolowupDt  Work Order Type  Collateral Disposition File Received Dt Repo Dt RepoEndDt  Comment
¥ ¥ 12/31/4000 INVOLUNTARY 2010 VOLVO AMD007 NEWLY RECEIVED
Repossession Details
{aRetum
Current ¥ File Received Dt
Followup Dt 12/31/4000 Repo Dt i

Work Order Type  INVOLUNTARY Repo End Dt
Collateral 2010 VOLVO AMDOO7 Comment

Disposition NEWLY RECEIVED

Case Repo Details

Phone {123)-333-4444
Fax (333)-444-5555

Iz Drivable ¥
Personal Items HGIHG]

Case 2044275584 Storage Location Space 12123123
Vendor Work IMPOUND VOLUNTARY REPOSSESSION (GRI)
Order Type

Identification 2BAGP4SGIXR378254

Storage Days 0 Storage Location
Transport Release Date 11/09/2016
Delivered Released To 0

Condition Report Status _

Repo Location
Address 999 SESAME ST
Country UNITED STATES

Vehice Color RED

Address ADD 1

C.11 Case Invoice

When a case has been repossessed, an invoice with the actual cost incurred for repossession
and the details of the asset repossessed are updated in the third party system by the assigned
vendor.

Subsequently, when the case status update is received as ‘REPOSSESSED’ (i.e. Event Type
300) from FIREHOSE web service response, system triggers ‘getCaselnvoiceData()’ web
service request to retrieve the invoice and asset details from the third party system.
ORACLE’

KAR ~ g Sign Qut o

Financial Services Lending and Leasing
Vendors x [ Close
Work Order o
[ saveandstay | [ saveandRetun | {aReturn
Work Order Work Order Details
Dt 12/22/2016 Collateral Details
Work Order # W0:0021380 StatusDt 12/22/2016
Case # 2044312777 Currency USDOLLAR Collateral Description 2006 CHEVROLET MONTECARLO 2DR.
Channel GENERIC RECOVERY INTERFACE Estmated 0.00 Identification # 2B4GP45G 1R 378252
Wark Order Type  IMPOUND INVOLUNTARY REPOSSESSION (GRT) Siled Amt 0,00 Year 2006 |
b Account  20160100011187: Paid 0.00 WMake CHEVROLET 3
Company USO1 Reference # Model MONTECARLO
Branch USHQ Assigned By VENKAT
Vendor Information
Wendor 90DEMO_INTERFACE Followup Dt
; Account Information
i RSEZI REPOSSESSED Aczount Status ACTIVEDELQ:BKRP:REPO C:';‘::E' HEHOINIEREAE
e Charged off Dt -
e Due Amt 450,03 i
Total Qutstanding Balance  15834.6
Total Due 5625.36 P
DueDt 03/10/2017 <

If the web service request is successful and repossession details are received as part of the
response, the details are updated in Vendors > Invoices tab and a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: INVOICE RECEIVED FROM THIRD PARTY
INTERFACE >>”

e Comment By = “INTERNAL”
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e Comment Dt = Comment Posted date and time

ORACLE’
Financial Services Lending and Leasing

Vendors Customer Service 5 [3€] Close

Search  Customer Service: 2016010001187 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160100011187: Elyen | o Audit
view v Format~  [Ep Fresze i Detach Wirap W & © curent® show Al Group Follow-up i
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status
uso1 UsHQ SUB UNIT1 2016010001187  LOAN VEHICLE (FR) 343 USD 15,809.54

Summary | Customer Service | AccountDetals Customer Detals | Transaction History | PmtModes Bankruptcy RepofForedosure  Defidency | Collateral | Bureau | CrossfUp Sell Activies | E > ¥

Cal Activities  Maintenance Comments Promises  Checkists  Tracking Atrbutes  Field Investigation ~ References | Correspondence  Letters DocumentTracking = Scenario Analysis A > ~

Comments dpadd | ZEdt | [Jven | o Audt
view v Format~ [y Freeze fiDetach Wrap W 3¢ Delete

Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE:INVOICE RECEIVED FROM THIRD PA... INTERNAL 12/22/2016 03:37:12 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-ORACLE ONE HAS APPROVED THE [N INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-INVOICE CREATED IN THIRD PARTY ... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED TNBOUND FROM INTERFACE 20443 12777:90DEMO-GRI_INTERF ACE:REPOSESSICN DETAILS FROM GRI LI . INTERNAL 12/22/2016 03:30:53 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GR I_INTERFACE-CASE GOT REPOSSESSED INTERNAL 12/22/2016 03:30:51 AM -

The details of the invoice in the web service response are captured in Vendors > Invoice
Information tab with invoice details and Payment Schedule. By default, the status of the
invoice is ‘OPEN’ to update the payment details.

ORACLE’
Financial Services Lending and Leasing

Vendors x [®]close

Vendors | Assignment Allocation | Work Orders | Follow-up | Invoices

Invoice Information o Add | ZEdt || [E]Vew || o Audit
View Options AL [=
View = Format v Freeze i Detach Wrap o) Validate Invoice
¢ ) £
Vendor Company Branch Invoice # ExternalRef=  Invoice Dt Due Dt Status Channel
S0DEMO-RDN_INTERFACE uso1 UsHQ 3851 23086216 12/22/2016 12/22/2016 aose GENERIC RECOVE
‘S0DEMO-RDN_INTERFACE uso1 UsHQ £ 23066207 12/21/2016 12/21/2016 OPEN GENERIC RECOVE
Invoice Information
Gagewm | [
Invoice Dt 12/22/2016 Currency USDOLLAR
B Invoice Due Dt 12/22/2016 Estmated 122,00
Status CLOSE Invoice Amt 122,00

Vendor SODEMO-RDN_INTERFACE Agreed Amt 122,00

Company US01 Details Paid Amt 122.00
Branch USHQ Channel GENERIC RECOVERY INTERFACE
Inveice = 3651 Status Dt 12/22/2016
External Ref # 23066216 Address ADD12 ADD13 REDDING, CA 96001
Details | Tracking Attributes
Invoice Details [Elvew || o auit
view v Formatv [} Freeze gt Detach ] wirap o)
Wiork Order # Estimated Invoice Amt Agreed Amt Paid Amt Txn Post Dt Status Status Dt Authorized By Authorized Dt Colectble
WO:0021380 2016010001187 2738 10.00 10.00 10.00 10.00 12/22/2016 close 12/22/2016 N
WIO:0021380 2016010001187 2798 100.00 100.00 100.00 100.00 12/22{2016 CLose 12/22[2016 ¥
WQ:0021380 20160 100011187 2798... 12.00 12.00 12.00 12,00 12/22/2016 CLOSE 12/22/2016 N

Payment Schedule  Relsted Tnvoice Work Orders

System auto validates the invoice details which are received from third party system with
specific business rules before creating a record in the Invoice Information tab. Hence the
‘Validate Invoice’ button in the Information tab is disabled for invoice records from external
channel (Generic Recovery Interface) and the details are marked as view only.

For more information on business rules and working with Invoices tab, refer to ‘Vendors’
chapter.
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